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Preface

Welcome to the Oracle Advanced Security Administrator’s Guide for Release 2 (9.2)
of Oracle Advanced Security.

Oracle Advanced Security contains a comprehensive suite of security features that
protect enterprise networks and securely extend them to the Internet. It provides a
single source of integration with multiple network encryption and authentication
solutions, single sign-on services, and security protocols.

The Oracle Advanced Security Administrator’s Guide describes how to implement,
configure and administer Oracle Advanced Security.

This preface contains these topics:
« Audience

« Organization

» Related Documentation

« Conventions

« Documentation Accessibility
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Audience

The Oracle Advanced Security Administrator’s Guide is intended for users and
systems professionals involved with the implementation, configuration, and
administration of Oracle Advanced Security including:

« Implementation consultants
« System administrators

«  Security administrators

Organization

This document contains:
Part I: Introduction

Chapter 1, Introduction to Oracle Advanced Security

This chapter provides an overview of Oracle Advanced Security features provided
with this release.

Part Il: Encryption, Integrity, and JDBC

Chapter 2, Configuring Data Encryption and Integrity

This chapter describes how to configure data encryption and integrity within an
existing Oracle Net Services Release 2 (9.2) network.

Chapter 3, Thin JDBC Support

This chapter provides an overview of the Java implementation of Oracle Advanced
Security, which lets Thin Java Database Connectivity (JDBC) clients securely
connect to Oracle9i databases.

Part Ill: Configuring Authentication Methods

Chapter 4, Configuring RADIUS Authentication

This chapter describes how to configure Oracle for use with RADIUS (Remote
Authentication Dial-In User Service). It provides an overview of how RADIUS
works within an Oracle environment, and describes how to enable RADIUS
authentication and accounting. It also introduces the challenge-response user
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interface that third party vendors can customize to integrate with third party
authentication devices.

Chapter 5, Configuring CyberSafe Authentication

This chapter describes how to configure Oracle for use with CyberSafe, and
provides a brief overview of steps to configure CyberSafe to authenticate Oracle
users.

Chapter 6, Configuring Kerberos Authentication

This chapter describes how to configure Oracle for use with MIT Kerberos and
provides a brief overview of steps to configure Kerberos to authenticate Oracle
users.

Chapter 7, Configuring Secure Sockets Layer Authentication

This chapter describes the SSL feature of Oracle Advanced Security and explains
how to configure SSL.

Chapter 8, Configuring Entrust-Enabled SSL Authentication

This chapter describes how to configure and use Entrust-enabled Oracle Advanced
Security for Secure Socket Layer (SSL) authentication.

Chapter 9, Configuring Multiple Authentication Methods

This chapter describes the authentication methods that can be used with Oracle
Advanced Security, and how to user conventional user name and password
authentication. It also describes how to configure the network so that Oracle clients
can user a specific authentication method, and Oracle servers can accept any
method specified.

Part IV: Oracle DCE Integration

Chapter 10, Overview of Oracle DCE Integration

This chapter provides a brief discussion of Open Software Foundation (OSF) DCE
and Oracle DCE Integration.

Chapter 11, Configuring DCE for Oracle DCE Integration

This chapter describes what you need to do to configure DCE to use Oracle DCE
Integration. It also describes how to configure the DCE CDS naming adapter.
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Chapter 12, Configuring Oracle9i for Oracle DCE Integration

This chapter describes the DCE parameters that you need to add to the
configuration files to enable clients and servers to access Oracle servers in the DCE
environment. It also describes some Oracle Server configuration that you need to
perform, such as setting up DCE groups to map to external roles. Additionally, it
describes how to configure clients to use the DCE CDS naming adapter.

Chapter 13, Connecting to an Oracle Database in DCE
This chapter describes how to connect to an Oracle database in a DCE environment.

Chapter 14, DCE and Non-DCE Interoperability

This chapter describes how clients outside of DCE can access Oracle databases
using another protocol such as TCP/IP.

Part V: Oracle9i Enterprise User Security

Chapter 15, Managing Enterprise User Security

This chapter describes Oracle directory and security integration. It describes its
components and provides an overview of the interaction between the components.

Chapter 16, Migrating Local or External Users to Enterprise Users

This chapter describes the User Migration Utility, which can be used to perform
bulk migrations of database users to an LDAP directory where they are stored and
managed as enterprise users. It provides utility syntax, prerequisites, and usage
examples.

Chapter 17, Using Oracle Wallet Manager
This chapter describes how to configure and use the Oracle Wallet Manager.

Chapter 18, Using Oracle Enterprise Login Assistant

This chapter describes how to configure and use the Oracle Enterprise Login
Assistant.

Chapter 19, Using Oracle Enterprise Security Manager

This chapter describes how an Enterprise DBA uses Oracle Enterprise Security
Manager to administer database security in an enterprise domain of Oracle9i
databases.



Part VI: Appendixes

Appendix A, Data Encryption and Integrity Parameters

This appendix describes Oracle Advanced Security data encryption and integrity
configuration parameters.

Appendix B, Authentication Parameters

This appendix describes Oracle Advanced Security authentication configuration file
parameters.

Appendix C, Integrating Authentication Devices Using RADIUS

This appendix explains how third party authentication device vendors can integrate
their devices and customize the graphical user interface used in RADIUS
challenge-response authentication.

Appendix D, Oracle Advanced Security FIPS 140-1 Settings

This appendix describes the Sglnet.ora configuration parameters required to comply
with the FIPS 140-1 Level 2 evaluated configuration.

Appendix E, Using Enterprise User Security with Microsoft Active Directory

This appendix explains how to use Microsoft Active Directory as the
LDAP-compliant directory service for enterprise user security.

Appendix F, Oracle Implementation of Java SSL
This appendix provides an overview of components and usage of the Oracle

implementation of Java SSL.

Appendix G, Abbreviations and Acronyms
This appendix defines abbreviations and acronyms used in this document.

XXVil



Related Documentation

XXViii

For more information, see these Oracle resources:
«  ACE/Server Administration Manual, from Security Dynamics
«  ACE/Server Client for UNIX, from Security Dynamics
«  ACE/Server Installation Manual, from Security Dynamics
«  Oracle9i Net Services Administrator’s Guide
«  Oracle9i Heterogeneous Connectivity Administrator’s Guide
«  Oracle9i JDBC Developer’s Guide and Reference
« Oracle Internet Directory Administrator’s Guide
«  Oracle9i Database Administrator’s Guide

Many of the examples in this book use the sample schemas of the seed database,
which is installed by default when you install Oracle. Refer to Oracle9i Sample
Schemas for information on how these schemas were created and how you can use
them yourself.

In North America, printed documentation is available for sale in the Oracle Store at
http://oracl estore. oracl e. cond

Customers in Europe, the Middle East, and Africa (EMEA) can purchase
documentation from

ht t p: // wawe or acl ebookshop. coni

Other customers can contact their Oracle representative to purchase printed
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http://otn. oracl e. com adm n/ account / nenber shi p. ht m

If you already have a username and password for OTN, then you can go directly to
the documentation section of the OTN Web site at

http://otn. oracl e. cont docs/ i ndex. ht m

To access the database documentation search engine directly, please visit
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XXiX



Conventions

This section describes the conventions used in the text and code examples of this
documentation set. It describes:

« Conventions in Text
« Conventions in Code Examples

« Conventions for Windows Operating Systems

Conventions in Text

We use various conventions in text to help you more quickly identify special terms.
The following table describes those conventions and provides examples of their use.

Convention Meaning Example
Bold Bold typeface indicates terms that are When you specify this clause, you create an
defined in the text or terms that appear in index-organized table.
a glossary, or both.
Italics Italic typeface indicates book titles or Oracle9i Database Concepts
emphasis. Ensure that the recovery catalog and target
database do not reside on the same disk.
UPPERCASE Uppercase monospace typeface indicates  You can specify this clause only for a NUVMBER
nmonospace elements supplied by the system. Such column.
(fixed-wi dth elementsinclude parameters, privileges, .
font) datatypes, RMAN keywords, SQL You can back up the database by using the

XXX

keywords, SQL*Plus or utility commands, BACKUP command.
packages and methods, as well as Query the TABLE_NAME column in the USER _
system-supplied column names, database TABLES data dictionary view.

(r)ct))IJ:;:ts and structures, usernames, and Use the DBVS_STATS.GENERATE_STATS
' procedure.



Convention Meaning Example
| ower case Lowercase monospace typeface indicates Enter sql pl us to open SQL*Plus.
nonospace executables, filenames, directory names, . e .
(fixed-wi dth andsample user-supplied elements. Such The password is specified in the or apwa file.
font) elements include computer and database  Back up the datafiles and control files in the
names, net service names, and connect / di sk1/ or acl e/ dbs directory.
identifiers, as well as user-supplied .
database objects and structures, column z:g ?ggg{ f gﬁn? a' c%igriﬂiratrg?nn:hﬁnaml
names, packages and classes, usernames hr . depar t ment s table
and roles, program units, and parameter - dep '
values. Set the QUERY_REWRI TE_ENABLED
Note: Some programmatic elements use a initialization parameter to t r ue.
mixture of UPPERCASE and lowercase. Connect as oe user.
Enter these elements as shown. The JRepUti | class implements these
methods.
| ower case Lowercase monospace italic font You can specify the par al | el _cl ause.
nonospace represents placeholders or variables.
(fixed-wi dth Run Uol d_r el ease. SQL where ol d_

font) italic

r el ease refers to the release you installed
prior to upgrading.
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Conventions in Code Examples

Code examples illustrate SQL, PL/SQL, SQL*Plus, or other command-line
statements. They are displayed in a monospace (fixed-width) font and separated
from normal text as shown in this example:

SELECT user nane FROM dba_users WHERE usernane = ' M GQRATE ;

The following table describes typographic conventions used in code examples and

provides examples of their use.

Convention Meaning Example
[1 Brackets enclose one or more optional DECI MAL (digits [ , precision ])
items. Do not enter the brackets.
{} Braces enclose two or more items, one of { ENABLE | DI SABLE}
which is required. Do not enter the
braces.
| A vertical bar represents a choice of two  { ENABLE | DI SABLE}
or more options within brackets or braces. COVP NOCOVP
Enter one of the options. Do not enter the [ RESS | RESS]
vertical bar.
Horizontal ellipsis points indicate either:
«  That we have omitted parts of the CREATE TABLE ... AS subquery;
code that are not directly related to
the example
. SELECT col 1, col2, ... , coln FROM
« Thatyou can repeat a portion of the enpl oyees:

XXX

code

Vertical ellipsis points indicate that we
have omitted several lines of code not
directly related to the example.

SQL> SELECT NAME FROM V$DATAFI LE;
NAME

/fsl/dbs/tbs_01. dbf
/fsl/dbs/tbhs_02. dbf

/fsl/dbs/tbs_09. dbf
9 rows sel ected.



Convention

Meaning Example

Other notation

You must enter symbols other than acctbal NUMBER(11, 2);

brackets, braces, vertical bars, and ellipsis 4.
points as shown. acct CONSTANT NUMBER(4) : = 3;

Italics Italicized text indicates placeholders or CONNECT SYSTEM syst em passwor d
variables for which you must supply _
particular values. DB_NAME = dat abase_narre
UPPERCASE Uppercase typeface indicates elements SELECT | ast _name, enpl oyee_id FROM
supplied by the system. We show these enpl oyees;
terms in uppercase in order to distinguish « FROM .
them from terms you define. Unless terms SELECT F USER_TABLES;
appear in brackets, enter them in the DROP TABLE hr. enpl oyees;
order and with the spelling shown.
However, because these terms are not
case sensitive, you can enter them in
lowercase.
| ower case Lowercase typeface indicates SELECT | ast _name, enpl oyee_id FROM
programmatic elements that you supply. enpl oyees;
For example, lowercase indicates names
of tables, columns, or files. sql plus hr/hr
Note: Some programmatic elements use a CREATE USER nj ones | DENTI I ED BY ty3MB;
mixture of UPPERCASE and lowercase.
Enter these elements as shown.
Conventions for Windows Operating Systems
The following table describes conventions for Windows operating systems and
provides examples of their use.
Convention Meaning Example
Choose Start > How to start a program. To start the Database Configuration Assistant,

Choose Start > Programs > Oracle - HOME_
NAME > Configuration and Migration Tools >
Database Configuration Assistant.
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Convention

Meaning

Example

File and directory
names

C\>

Special characters

HOME_NAME

File and directory names are not case
sensitive. The following special characters
are not allowed: left angle bracket (<),
right angle bracket (>), colon (), double
quotation marks (), slash (/), pipe (]),
and dash (-). The special character
backslash (\) is treated as an element
separator, even when it appears in quotes.
If the file name begins with \\, then
Windows assumes it uses the Universal
Naming Convention.

Represents the Windows command
prompt of the current hard disk drive.
Your prompt reflects the subdirectory in
which you are working. Referred to as the
command prompt in this guide.

The backslash (\) special character is
sometimes required as an escape
character for the double quotation mark
(") special character at the Windows
command prompt. Parentheses and the
single quotation mark (’) do not require
an escape character. Refer to your
Windows operating system
documentation for more information on
escape and special characters.

Represents the Oracle home name. The
home name can be up to 16 alphanumeric
characters. The only special character
allowed in the home name is the
underscore.

c:\winnt"\"syst enB2 is the same as
C: \ W NNT\ SYSTEM32

C.\oracl e\ or adat a>

C.\>exp scott/tiger TABLES=enp

QUERY=\ "WHERE j ob=" SALESMAN and
sal <1600\ "

C.\>i np SYSTEM password
FROMUSER=scott TABLES=(enp, dept)

C\> net start Oracl eHOVE_
NAMETNSLI st ener
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Convention

Meaning

Example

ORACLE_HOMVE
and ORACLE_
BASE

In releases prior to Oracle8i release 8.1.3,
when you installed Oracle components,
all subdirectories were located under a
top level ORACLE_HQOVE directory that by
default used one of the following names:

. C:\ or ant for Windows NT
. C: \ or awi n98 for Windows 98

This release complies with Optimal
Flexible Architecture (OFA) guidelines.
All subdirectories are not under a top
level ORACLE_HOVE directory. There is a
top level directory called ORACLE_BASE
that by defaultis C: \ or acl e. If you
install the latest Oracle release on a
computer with no other Oracle software
installed, then the default setting for the
first Oracle home directory is

C:\ oracl e\ or ann, where nn is the
latest release number. The Oracle home
directory is located directly under
ORACLE_BASE.

All directory path examples in this guide
follow OFA conventions.

Refer to Oracle9i Database Getting Started
for Windows for additional information
about OFA compliances and for
information about installing Oracle
products in non-OFA compliant
directories.

Go to the ORACLE_BASE\ ORACLE _
HOME\ r dbns\ adni n directory.
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Documentation Accessibility

XXXVI

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with other
market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program Web site at

ht t p: // waw or acl e. cond accessi bi i ty/

Accessibility of Code Examples in Documentation JAWS, a Windows screen
reader, may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, JAWS may not always read a line of text that
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This
documentation may contain links to Web sites of other companies or organizations
that Oracle Corporation does not own or control. Oracle Corporation neither
evaluates nor makes any representations regarding the accessibility of these Web
sites.
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Introduction

This part introduces Oracle Advanced Security and describes its features. It
contains the following chapter:

« Chapter 1, Introduction to Oracle Advanced Security
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Introduction to Oracle Advanced Security

This chapter introduces Oracle Advanced Security and describes its features. These
features are available to database and related products that interface with Oracle
Net Services, including Oracle9i, Oracle Designer, and Oracle Developer.

This chapter contains the following topics:

About Oracle Advanced Security

Oracle Advanced Security Features

Oracle Advanced Security Architecture

Secure Data Transfer Across Network Protocol Boundaries
System Requirements

Oracle Advanced Security Restrictions
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About Oracle Advanced Security

About Oracle Advanced Security

Oracle Advanced Security provides a comprehensive suite of security features to
protect enterprise networks and securely extend corporate networks to the Internet.
It provides a single source of integration with network encryption and
authentication solutions, single sign-on services, and security protocols. By
integrating industry standards, it delivers unparalleled security to the Oracle
network.

This section contains the following topics:
« Security in an Intranet or Internet Environment

=  Security Threats

Security in an Intranet or Internet Environment

Oracle databases power the largest and most popular web sites on the Internet. In
record numbers, organizations throughout the world are deploying distributed
databases and client/server applications based on Oracle9i and Oracle Net Services.
This proliferation of distributed computing is matched by an increase in the amount
of information that organizations place on computers. Employee and financial
records, customer orders, product information, and other sensitive data have
moved from filing cabinets to file structures. The volume of sensitive information
on the web has thus increased the value of data that can be compromised.

Security Threats

The increased volume of data in distributed environments exposes users to a
variety of security threats, including the following:

« Eavesdropping and Data Theft
« Data Tampering
« Falsifying User Identities

« Password-Related Threats

Eavesdropping and Data Theft

Over the Internet and in wide area network environments, both public carriers and
private networks route portions of their network through insecure land lines,
vulnerable microwave and satellite links, or a number of servers— exposing
valuable data to interested third parties. In local area network environments within
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About Oracle Advanced Security

a building or campus, the potential exists for insiders with access to the physical
wiring to view data not intended for them, and network sniffers can be installed to
eavesdrop on network traffic.

Data Tampering

Distributed environments bring with them the possibility that a malicious third
party can compromise integrity by tampering with data as it moves between sites.

Falsifying User Identities

In a distributed environment, it is more feasible for a user to falsify an identity to
gain access to sensitive information. How can you be sure that user Pat connecting
to Server A from Client B really is user Pat ?

Moreover, in distributed environments, malefactors can hijack connections. How
can you be sure that Client B and Server A are what they claim to be? A transaction
that should go from the Personnel system on Server A to the Payroll system on
Server B could be intercepted in transit and re-routed to a terminal masquerading as
Server B.

Password-Related Threats

In large systems, users typically must remember multiple passwords for the
different applications and services that they use. For example, a developer can have
access to a development application on a workstation, a PC for sending email, and
several computers or intranet sites for testing, reporting bugs, and managing
configurations.

Users typically respond to the problem of managing multiple passwords in several
ways:

« They may select easy-to-guess passwords—such as a name, fictional character,
or a word found in a dictionary. All of these passwords are vulnerable to
dictionary attacks.

« They may also choose to standardize passwords so that they are the same on all
machines or web sites. This results in a potentially large exposure in the event
of a compromised password. They can also use passwords with slight
variations that can be easily derived from known passwords.

« Users with complex passwords may write them down where an attacker can
easily find them, or they may just forget them—requiring costly administration
and support efforts.
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All of these strategies compromise password secrecy and service availability.
Moreover, administration of multiple user accounts and passwords is complex,
time-consuming, and expensive.
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Oracle Advanced Security Features

Data Privacy

Oracle Advanced Security provides data privacy, integrity, authentication, single
sign-on, and access authorization in a variety of ways.

For example, you can configure either Oracle Net native encryption or Secure
Sockets Layer (SSL) for data privacy. Oracle Advanced Security also provides the
choice of several strong authentication methods, including Kerberos, smart cards,
and digital certificates.

Oracle Advanced Security features are described in the following sections:
« Data Privacy

« Data Integrity

« Authentication

« Single Sign-On

=« Authorization

Oracle Advanced Security protects the privacy of data transmissions through the
following encryption methods:

« RC4 Encryption

« DES Encryption

« Triple-DES Encryption

« Advanced Encryption Standard

Selection of the network encryption method is a user configuration option,
providing varying levels of security and performance for different types of data
transfers.

Prior versions of Oracle Advanced Security provided three editions: Domestic,
Upgrade, and Export—each with different key lengths. Release 2 (9.2) now contains
a complete complement of the available encryption algorithms and key lengths,
previously only available in the Domestic edition. Users deploying prior versions of
the product can obtain the Domestic edition for a specific product release.
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Oracle Advanced Security Features

Note: The U.S. government has relaxed its export guidelines for
encryption products. Accordingly, Oracle can now ship Oracle
Advanced Security with its strongest encryption features—to
virtually all of its customers.

RC4 Encryption

The RC4 encryption module uses the RSA Security, Inc. RC4 encryption algorithm.
Using a secret, randomly-generated key unique to each session, all network traffic is
fully safeguarded—including all data values, SQL statements, and stored procedure
calls and results. The client, server, or both, can request or require the use of the
encryption module to guarantee that data is protected. Oracle’s optimized
implementation provides a high degree of security for a minimal performance
penalty. For the RC4 algorithm, Oracle provides encryption key lengths of 40-bits,
56-bits, 128-bits, and 256-bits.

DES Encryption

The U.S. Data Encryption Standard algorithm (DES) uses symmetric key
cryptography to safeguard network communications. Oracle Advanced Security
implements DES with a standard, optimized 56-bit key encryption algorithm, and
also provides DES40, a 40-bit version, for backward compatibility.

Triple-DES Encryption

Oracle Advanced Security also supports Triple-DES encryption (3DES), which
encrypts message data with three passes of the DES algorithm. 3DES provides a
high degree of message security, but with a performance penalty—the magnitude of
which is dependent upon on the speed of the processor performing the encryption;
3DES typically takes three times as long to encrypt a data block as compared with
the standard DES algorithm.

3DES is available in two-key and three-key versions, with effective key lengths of
112-bits and 168-bits, respectively. Both versions operate in outer Cipher Block
Chaining (CBC) mode.

Advanced Encryption Standard

Approved by the National Institute of Standards and Technology (NIST) in Federal
Information Processing Standards (FIPS) Publication 197, Advanced Encryption
Standard (AES) is a new cryptographic algorithm standard developed to replace
DES. AES is a symmetric block cipher that can process data blocks of 128 bits, using
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Data Integrity

cipher keys with lengths of 128, 192, and 256 bits, which are referred to as AES-128,
AES-192, and AES-256, respectively. All three versions operate in outer-CBC mode.

Federal Information Processing Standard
Oracle Advanced Security Release 8.1.6 has been validated under U.S. Federal
Information Processing Standard 140-1 (FIPS) at the Level 2 security level. This
provides independent confirmation that Oracle Advanced Security conforms to
federal government standards. FIPS configuration settings are described by
Appendix D, Oracle Advanced Security FIPS 140-1 Settings.

See Also:

« Chapter 2, Configuring Data Encryption and Integrity

« Appendix A, Data Encryption and Integrity Parameters

To ensure the integrity of data packets during transmission, Oracle Advanced
Security can generate a cryptographically secure message digest—using MD5 or
SHA encryption algorithms—and include it with each message sent across a
network.

Data integrity algorithms add little overhead, and protect against the following
attacks:

« Data modification
« Deleted packets
« Replay attacks

Note: SHA is slightly slower than MD5, but produces a larger
message digest, making it more secure against brute-force collision
and inversion attacks.

See Also: Chapter 2, Configuring Data Encryption and Integrity,
for information about MD5 and SHA.
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Authentication

Authenticating user identity is imperative in distributed environments, without
which there can be little confidence in network security. Passwords are the most
common authentication method, and Oracle Advanced Security provides enhanced
user authentication through several third-party authentication services, and
through the use of SSL and digital certificates (See: Figure 1-1).

Many Oracle Advanced Security authentication methods use centralized
authentication. This can give you high confidence in the identity of users, clients,
and servers in distributed environments. Having a central facility authenticate all
members of the network (clients to servers, servers to servers, users to both clients
and servers) is one effective way to address the threat of nodes on a network
falsifying their identities.

How Centralized Network Authentication Works

Figure 1-1 shows how a centralized network authentication service typically
operates:
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Figure 1-1 How a Network Authentication Service Authenticates a User
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User Authentication Oracle
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1. A user (client) requests authentication services and provides identifying
information, such as a token or password.

2. The authentication server validates the user’s identity and passes a ticket or
credentials back to the client—which may include an expiration time.

3. Theclient passes these credentials to the Oracle server concurrent with a service
request, such as connection to a database.
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4. The server sends the credentials back to the authentication server for
authentication.

5. If the authentication server accepts the credentials, it notifies the Oracle Server;
the user is authenticated.

6. If the authentication server does not accept the credentials, authentication fails
and the service request is denied.
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Supported Authentication Methods
Oracle Advanced Security supports the following authentication methods:

« Secure Sockets Layer (with digital certificates)
«  Entrust/PKI

« Remote Authentication Dial-In User Service

« Kerberos and CyberSafe

« Smart Cards

« Token Cards

Secure Sockets Layer

Secure Sockets Layer (SSL) is an industry standard protocol for securing network
connections. SSL provides authentication, data encryption, and data integrity, and
it contributes to a public key infrastructure (PKI).

Oracle Advanced Security SSL can be used to secure communications between any
client and any server. You can configure SSL to provide server authentication only;,
client authentication only, or both client and server authentication.

SSL uses digital certificates (X.509 v3), and a public/private key pair to authenticate
users and systems.

SSL features can be used by themselves or in combination with other authentication
methods supported by Oracle Advanced Security.

Entrust/PKI

Oracle Advanced Security supports the public key infrastructure provided by the
Entrust/PKI software from Entrust Technologies, Inc. Entrust-enabled Oracle
Advanced Security lets Entrust users incorporate Entrust single sign-on into their
Oracle applications, and it lets Oracle users incorporate Entrust-based single
sign-on into Oracle applications.

Remote Authentication Dial-In User Service

Remote Authentication Dial-In User Service (RADIUS) is a client/server security
protocol that is most widely known for enabling remote authentication and access.
Oracle Advanced Security uses this standard in a client/server network
environment to enable use of any authentication method that supports the RADIUS
protocol. RADIUS can be used with a variety of authentication mechanisms,
including token cards, smart cards, and Biometrics.
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Kerberos and CyberSafe

Oracle Advanced Security support for Kerberos and CyberSafe provides the
benefits of single sign-on and centralized authentication of Oracle users. Kerberos is
a trusted third-party authentication system that relies on shared secrets. It presumes
that the third party is secure, and provides single sign-on capabilities, centralized
password storage, database link authentication, and enhanced PC security. It does
this through a Kerberos authentication server, or through Cybersafe Active Trust, a
commercial Kerberos-based authentication server.

Note: Oracle authentication for Kerberos provides database link
authentication (also called proxy authentication). CyberSafe does
not support proxy authentication.

Smart Cards

A RADIUS-compliant smart card is a credit card-like hardware device. It has
memory and a processor and is read by a smart card reader located at the client
workstation.

Smart cards provide the benefits described in Table 1-1.

Table 1-1 Smart Card Benefits

Benefit Description
Enhanced password Smart cards rely on two-factor authentication. The smart
security card can be locked, and only the user who (i) possesses

the card and (ii) knows the correct personal
identification number (PIN) can unlock it.

Improved performance Some sophisticated smart cards contain hardware-based
encryption chips that can provide better throughput
than software-based implementations. A smart card can
also store a user name.

Accessibility fromany  Users log in by inserting the smart card in a hardware

workstation device that reads the card and prompts the user for
whatever authentication information the card requires,
such as a PIN. Once the user enters the correct
authentication information, the smart card generates and
enters whatever other authentication information is
required.
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Table 1-1 Smart Card Benefits (Cont.)

Benefit Description

Ease of use Users need only remember a PIN—instead of multiple
passwords.

Token Cards

Token cards (SecurlD or RADIUS-compliant) can improve ease of use through
several different mechanisms. Some token cards dynamically display one-time
passwords that are synchronized with an authentication service. The server can
verify the password provided by the token card at any given time by contacting the
authentication service. Other token cards have a keypad and operate on a
challenge-response basis. In this case, the server offers a challenge (a number) that
the user enters into a token card. The token card provides a response (another
number cryptographically derived from the challenge) that the user enters and
sends to the server.

Token cards provide the benefits described in Table 1-2.

Table 1-2 Token Card Benefits

Benefit Description
Enhanced password To masquerade as a user, a malefactor must have the
security token card as well as the personal identification number

(PIN) required to operate it. This is called two-factor
authentication.

Ease of use Users need only remember a PIN—instead of multiple
passwords.

Enhanced Token cards provide a stronger authentication

accountability mechanism; users are thus more accountable for their
actions.

Access from any Users can log on from any workstation using their PIN,

workstation which provides strong, two-factor authentication

without any additional hardware devices.

You can use SecurlD tokens through the RADIUS adapter.
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Single Sign-On

Authorization

Centralized authentication can enable a single, integrated user sign-on (single
sign-on (SSO)). This feature lets users access multiple accounts and applications
with a single password, eliminates the need for multiple passwords, and simplifies
management of user accounts and passwords for system administrators.

Oracle Advanced Security single sign-on authenticates the user once upon initial
connection, with strong authentication occurring transparently in subsequent
connections to other databases or services. Using single sign-on, users can access
multiple accounts and applications with a single password. Oracle Advanced
Security supports many forms of single sign-on, including Kerberos and CyberSafe.

Oracle Advanced Security also provides SSL-based single sign-on for Oracle users
by integrating with LDAP v3-compliant directory services. The combination of
integrated directory services and Oracle’s PKI implementation enable SSL-based
single sign-on to Oracle9i databases. Single sign-on lets users be authenticated once,
with subsequent connections relying on the user’s digital certificate.

This enhances ease-of-use for users, and provides centralized management to
security administrators.

User authorization, a function of Oracle9i roles and privileges, is significantly
enhanced by using the authentication methods supported by Oracle Advanced
Security. For example, on certain operating systems, such as Solaris, Oracle
Advanced Security supports authorization with DCE.

Authorizations are also provided by Oracle Advanced Security Enterprise User
Security (See: Chapter 15, Managing Enterprise User Security). Oracle Advanced
Security can integrate with LDAP version 3-compliant directories to centrally
manage users and authorizations. Your Oracle Advanced Security license entitles
you to deploy Oracle Internet Directory for user management as well as
authorization storage and retrieval. You must license Oracle Internet Directory
separately if you use it for additional purposes.
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Oracle Advanced Security Architecture

Oracle Advanced Security is an add-on product that complements an Oracle server
or client installation. Figure 1-2 shows the Oracle Advanced Security architecture
within an Oracle networking environment.

Figure 1-2 Oracle Advanced Security in an Oracle Networking Environment
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Oracle Advanced Security supports authentication through adapters that are
similar to the existing Oracle protocol adapters. As shown in Figure 1-3,
authentication adapters integrate below the Oracle Net interface and let existing
applications take advantage of new authentication systems transparently, without
any changes to the application.
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Figure 1-3 Oracle Net with Authentication Adapters
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See Also: Oracle9i Net Services Administrator’s Guide, for more
information about stack communications in an Oracle networking
environment
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Secure Data Transfer Across Network Protocol Boundaries

Oracle Advanced Security is fully supported by Oracle Connection Manager,
making secure data transfer a reality across network protocol boundaries. Clients
using LAN protocols such as NetWare (SPX/I1PX), for example, can securely share
data with large servers using different network protocols such as LU6.2, TCP/IP, or
DECnet. To eliminate potential weak points in the network infrastructure and to
maximize performance, Connection Manager passes encrypted data from protocol
to protocol without the cost and exposure of decryption and re-encryption.
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System Requirements

Oracle Advanced Security is an add-on product bundled with the Oracle Net Server
or Oracle Net Client. It must be purchased and installed on both the client and the
server.

Oracle Advanced Security Release 2 (9.2) requires Oracle Net Release 2 (9.2) and
supports Oracle9i Enterprise Edition. Table 1-3 lists additional system
requirements.

Note: Oracle Advanced Security is not available with Oracle9i
Standard Edition.

Table 1-3 Authentication Methods and System Requirements

Authentication Method | System Requirements

Cybersafe Active Trust «  CyberSafe GSS Runtime Library, version 1.1 or later,
installed on both the machine that runs the Oracle client
and on the machine that runs the Oracle server.

«  Cybersafe Active Trust, release 1.2 or later, installed on a
physically secure machine that runs the authentication
server.

«  Cybersafe Active Trust Client, release 1.2 or later, installed
on the machine that runs the Oracle client.

Kerberos . MIT Kerberos Version 5, release 1.1

«  The Kerberos authentication server must be installed on a
physically secure machine.

RADIUS « A RADIUS server that is compliant with the standards in
the Internet Engineering Task Force (IETF) RFC #2138,
Remote Authentication Dial In User Service (RADIUS) and
RFC #2139 RADIUS Accounting.

« To enable challenge-response authentication, you must run
RADIUS on an operating system that supports the Java
Native Interface as specified in release 1.1 of the Java
Development Kit from JavaSoft.

SSL « A wallet that is compatible with the Oracle Wallet Manager
version 2.1. Wallets created in earlier releases of the Oracle
Wallet Manager are not forward compatible.

Entrust/PKI «  Entrust IPSEC Negotiator Toolkit Release 5.0.2
«  Entrust/PKI5.0.2
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Oracle Advanced Security Restrictions

Oracle Applications support Oracle Advanced Security encryption and data
integrity. However, because Oracle Advanced Security requires Oracle Net Services
to transmit data securely, Oracle Advanced Security external authentication features
are not supported by some parts of Oracle Financial, Human Resource, and
Manufacturing Applications when they are running on Microsoft Windows. The
portions of these products that use Oracle Display Manager (ODM) do not take
advantage of Oracle Advanced Security, since ODM does not use Oracle Net
Services.
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Encryption, Integrity, and JDBC

This part describes how to configure data encryption and integrity for your existing
Oracle network, and the Java implementation of Oracle Advanced Security. It
contains the following chapters:

« Chapter 2, Configuring Data Encryption and Integrity
« Chapter 3, Thin JDBC Support

See Also: Oracle operating system-specific documentation
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Configuring Data Encryption and Integrity

This chapter describes how to configure native Oracle Net Services data encryption
and integrity for Oracle Advanced Security. It contains the following topics:

« Oracle Advanced Security Encryption
« Oracle Advanced Security Data Integrity
« Diffie-Hellman Based Key Management

« Configuring Data Encryption and Integrity
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Oracle Advanced Security Encryption

Overview

This section describes data encryption algorithms available in the current release of
Oracle Advanced Security:

«  Overview

« Advanced Encryption Standard

« DES Algorithm Support

« Triple-DES Support

« RSA RC4 Algorithm for High Speed Encryption

Note: Prior to Release 8.1.7, Oracle Advanced Security provided
three editions: Domestic, Upgrade, and Export—each with different
key lengths. This release now contains a complete complement of
the available encryption algorithms and key lengths, previously
only available in the Domestic edition. Users deploying prior
versions of the product can obtain the Domestic edition for a
specific product release.

The purpose of a secure cryptosystem is to convert plaintext data into unintelligible
ciphertext based on a key, in such a way that it is very hard (computationally
infeasible) to convert ciphertext back into its corresponding plaintext without
knowledge of the correct key. In a symmetric cryptosystem, the same key is used
both for encryption and decryption of the same data. Oracle Advanced Security
provides the DES, 3DES, and RC4 symmetric cryptosystems for protecting the
confidentiality of Oracle Net Services traffic.

Advanced Encryption Standard

In this release, the new Federal Information Processing Standard (FIPS) encryption
algorithm, Advanced Encryption Standard (AES), is supported. AES can be used by
all U.S. government organizations and businesses to protect sensitive data over a
network. This encryption algorithm defines three standard key lengths, which are
128-bit, 192-bit, and 256-bit. All versions operate in outer Cipher Block Chaining
(CBC) mode.
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DES Algorithm Support

Oracle Advanced Security provides the Data Encryption Standard (DES) algorithm.
DES has been a U.S. government standard for many years and is sometimes
mandated in the financial services industry. Because it has been a standard for so
long, DES is deployed throughout the world for use in a wide variety of
applications.

Triple-DES Support

Oracle Advanced Security supports Triple-DES encryption (3DES), which encrypts
message data with three passes of the DES algorithm. 3DES provides a high degree
of message security, but with a performance penalty—the magnitude of which is
dependent upon on the speed of the processor performing the encryption; 3DES
typically takes three times as long to encrypt a data block as compared with the
standard DES algorithm.

3DES is available in two-key and three-key versions, with effective key lengths of
112-bits and 168-bits, respectively. Both versions operate in outer Cipher Block
Chaining (CBC) mode.

DES40 Algorithm

The DES40 algorithm, available in every release of Oracle Advanced Security,
Oracle Advanced Networking Option, and Secure Network Services, is a variant of
DES in which the secret key is preprocessed to provide 40 effective key bits. It was
designed to provide DES-based encryption to customers outside the U.S. and
Canada at a time when the U.S. export laws were more restrictive. Now, in Oracle
Advanced Security Release 2 (9.2), DES40, DES, and 3DES are all available for
export. DES40 is still supported to provide backward-compatibility for international
customers.

RSA RC4 Algorithm for High Speed Encryption

The RC4 algorithm, developed by RSA Data Security Inc., has become the
international standard for high-speed data encryption. RC4 is a variable key-length
stream cipher that operates at several times the speed of DES, making it possible to
encrypt large, bulk data transfers with minimal performance consequences.

Oracle Advanced Security Release 2 (9.2) provides an RC4 implementation with
40-bit, 56-bit, 128-bit, and 256-bit key lengths. This provides backward-compatibility
and strong encryption, with no material performance compromise.
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See Also:

« Configuring Encryption on the Client and the Server on
page 2-11.

« Table 2-2, Valid Encryption Algorithms on page 2-13.
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Oracle Advanced Security Data Integrity

Encryption of network data provides data privacy, so that unauthorized parties are
not able to view plaintext data as it passes over the network. Oracle Advanced
Security also provides protection against two forms of active attack:

« Data modification attack

This type of attack occurs when an unauthorized party intercepts data in
transit, alters it, and retransmits it. For example, if a bank deposit of $100 is
intercepted and the monetary amount is to $10,000, and then the higher amount
is retransmitted that is a data modification attack.

« Replay attack

This type of attack occurs when an entire set of valid data is repetitively
retransmitted. For example, if a bank withdrawal of $100 is intercepted and
then retransmitted ten times so the final withdrawal amount equals $10,000
then that is a replay attack.

Data Integrity Algorithms Supported

Oracle Advanced Security lets you select a keyed, sequenced implementation of the
Message Digest 5 (MD5) algorithm or the Secure Hash Algorithm (SHA-1) to
protect against both of these forms of attack. Both of these hash algorithms create a
checksum that changes if the data is altered in any way. This protection operates
independently from the encryption process—you can enable data integrity with or
without enabling encryption.

See Also:

« Configuring Integrity on the Client and the Server on
page 2-14.

« Table 2-3, Valid Integrity Algorithms on page 2-15.
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Diffie-Hellman Based Key Management

The secrecy of encrypted data depends upon the existence of a secret key shared
between the communicating parties. A key is a secret exclusively shared by parties
on both sides of a connection. Without the key, it is extremely difficult
(computationally infeasible) to decrypt an encrypted message or to alter a
cryptographic-checksummed message without detection. Providing and
maintaining such secret keys is referred to as key management.

Secure key distribution is difficult in a multiuser environment. Oracle Advanced
Security uses the well known Diffie-Hellman key negotiation algorithm to
perform secure key distribution for both encryption and data integrity.

When encryption is used to protect the security of encrypted data, keys must be
changed frequently to minimize the effects of a compromised key. Accordingly, the
Oracle Advanced Security key management function changes the session key with
every session.

Authentication Key Fold-in

The purpose of Authentication Key Fold-in is to defeat a possible third party attack
(historically called the man-in-the-middle attack) on the Diffie-Hellman key
negotiation. It strengthens the session key significantly by combining a shared
secret, known only to the client and the server, with the original session key
negotiated by Diffie-Hellman.

The client and the server begin communicating using the session key generated by
Diffie-Hellman. When the client authenticates to the server, they establish a shared
secret that is only known to both parties. Oracle Advanced Security combines the
shared secret and the Diffie-Hellman session key to generate a stronger session key
designed to defeat a man-in-the-middle attack.

Note: The authentication key fold-in function is an imbedded
feature of Oracle Advanced Security and requires no configuration
by the system or network administrator.
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Configuring Data Encryption and Integrity

This section describes how to configure Oracle Advanced Security native Oracle
Net Services encryption and integrity, and presumes the prior installation of Oracle
Net Services.

The network or security administrator sets up the encryption and integrity
configuration parameters. The profile on client and server systems using data
encryption and integrity (sql net. ora fil e) must contain some or all of the
parameters listed in this section, under the following topics:

« Activating Encryption and Integrity
« Negotiating Encryption and Integrity
»  Setting the Encryption Seed

« Configuring Encryption and Integrity Parameters Using Oracle Net Manager

See Also: Chapter 7, Configuring Secure Sockets Layer
Authentication, to configure the SSL feature for encryption,
integrity, and authentication

Activating Encryption and Integrity

In any network connection, it is possible for both the client and server to each
support more than one encryption algorithm and more than one integrity
algorithm. When a connection is made, the server selects which algorithm to use, if
any, from those algorithms specified in the sql net . or a files.

The server searches for a match between the algorithms available on both the client
and the server, and picks the first algorithm in its own list that also appears in the
client list. If one side of the connection does not specify an algorithm list, all the
algorithms installed on that side are acceptable. The connection fails with error
message ORA- 12650 if either side specifies an algorithm that is not installed.

Encryption and integrity parameters are defined by modifying a sql net . or a file on
the clients and the servers on the network.

You can choose to configure any or all of the available Oracle Oracle Advanced
Security encryption algorithms (Table 2-2), and either or both of the available
integrity algorithms (Table 2-3). Only one encryption algorithm and one integrity
algorithm are used for each connect session.
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Note: Oracle Advanced Security selects the first encryption
algorithm and the first integrity algorithm enabled on the client and
the server. Oracle Corporation recommends that you select algorithms
and key lengths in the order in which you prefer negotiation—probably
with the strongest key length first.

See Also:  Appendix A, Data Encryption and Integrity Parameters
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Negotiating Encryption and Integrity

To negotiate whether to turn on encryption or integrity, you can specify four
possible values for the Oracle Advanced Security encryption and integrity
configuration parameters. The four values are listed in the order of increasing
security. The value REJECTED provides the minimum amount of security between
client and server communications, and the value REQUIRED provides the maximum
amount of network security:

« REJECTED

« ACCEPTED

« REQUESTED

« REQUIRED

The default value for each of the parameters is ACCEPTED.

REJECTED

Select this value if you do not elect to enable the security service, even if required by
the other side.

In this scenario, this side of the connection specifies that the security service is not
permitted. If the other side is set to REQUIRED, the connection terminates with error
message ORA- 12650. If the other side is set to REQUESTED, ACCEPTED, or
REJECTED, the connection continues without error and without the security service
enabled.

ACCEPTED

Select this value to enable the security service if required or requested by the other
side.

In this scenario, this side of the connection does not require the security service, but
it is enabled if the other side is set to REQUIRED or REQUESTED. If the other side
is set to REQUIRED or REQUESTED, and an encryption or integrity algorithm
match is found, the connection continues without error and with the security
service enabled. If the other side is set to REQUIRED and no algorithm match is
found, the connection terminates with error message ORA- 12650.

If the other side is set to REQUESTED and no algorithm match is found, or if the
other side is set to ACCEPTED or REJECTED, the connection continues without
error and without the security service enabled.
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REQUESTED
Select this value to enable the security service if the other side permits it.

In this scenario, this side of the connection specifies that the security service is
desired but not required. The security service is enabled if the other side specifies
ACCEPTED, REQUESTED, or REQUIRED. There must be a matching algorithm
available on the other side—otherwise the service is not enabled. If the other side
specifies REQUIRED and there is no matching algorithm, the connection fails.

REQUIRED
Select this value to enable the security service or preclude the connection.

In this scenario, this side of the connection specifies that the security service must be
enabled. The connection fails if the other side specifies REJECTED or if there is no
compatible algorithm on the other side.

Table 2-1 shows whether the security service is enabled, based on a combination of
client and server configuration parameters. If either the server or client has specified
REQUIRED, the lack of a common algorithm causes the connection to fail. Otherwise,
if the service is enabled, lack of a common service algorithm results in the service
being disabled.

Table 2-1 Encryption and Data Integrity Negotiation

Client

REJECTED ACCEPTED REQUESTED | REQUIRED

Server | REJECTED OFF OFF OFF Connection
fails
ACCEPTED | OFF OFF! ON ON
REQUESTED | OFF ON ON ON
REQUIRED | Connection | ON ON ON

fails

1 This value defaults to OFF. Cryptography and data integrity are not enabled until the user changes
this parameter using Oracle Net Manager or by modifying the sql net . or a file.
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Setting the Encryption Seed

Three seeds are used to generate a random number on the client and on the server.
One of the seeds is a user-defined encryption seed (sqgl net . crypt o_seed=) that
can be 10 to 70 characters in length—and changed at any time. The Diffie-Hellman
key exchange uses the random numbers to generate unique session keys for every
connect session.

Configuring Encryption and Integrity Parameters Using Oracle Net Manager

You can set up or change encryption and integrity parameter settings using Oracle
Net Manager. This section describes the following topics:

« Configuring Encryption on the Client and the Server

« Configuring Integrity on the Client and the Server

See Also:

« Appendix A, Data Encryption and Integrity Parameters, for
valid encryption algorithms

« Oracle Net Manager online help, for more detailed
configuration information

Configuring Encryption on the Client and the Server
To configure encryption on the client and on the server:

1. Start Oracle Net Manager:
«  On UNIX, run net ngr from $ORACLE_HOME/ bi n.

« On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

2. In the Navigator window, expand Local > Profile.

3. From the list in the right window pane, select Oracle Advanced Security; the
Oracle Advanced Security tabbed window appears (Figure 2-1):
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Figure 2-1 Oracle Advanced Security Encryption Window

Oracle Advanced Security -

Encryption: | SERVER

Encryption Type: i accepted

Encryption Seed: |

Available Methods: Selected Methods:
AESZSE [«]
RC4_23E |
AES192
3DESTES
AES128
RC4_128

4. Choose the Encryption tab.

5. Depending upon which system you are configuring, select CLIENT or SERVER
from the pull-down list.

6. From the Encryption Type list, select one of the following:
« REQUESTED

« REQUIRED
« ACCEPTED
« REJECTED

7. Inthe Encryption Seed field, enter between 10 and 70 random characters; the
encryption seed for the client should not be the same as that for the server.

8. Select an encryption algorithm in the Available Methods list. Move it to the
Selected Methods list by choosing the right arrow [>]. Repeat for each
additional method you want to use.

9. Choose File > Save Network Configuration; the sql net . ora file is updated.

10. Repeat this procedure to configure encryption on the other system. The
sgl net . or a file on the two systems should contain the following entries:
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« Onthe server:

SQNET. ENCRYPTI ON_ SERVER = [accepted | rejected | requested | required]
SQLNET. ENCRYPTI ON TYPES SERVER = (val id_encryption_algorithm[,valid_
encryption_al gorithnj)

SQNET. CRYPTO SEED = "10- 70 random char act er s"

« On theclient:

SQLNET. ENCRYPTI ON QLI ENT = [accepted | rejected | requested | required]
SQLNET. ENCRYPTI ON _TYPES QLI ENT = (valid_encryption_algorithm[,valid_
encryption_al gorithnj)

SQNET. RYPTO SEED = " 10- 70 random char act er s"

Valid encryption algorithms and their associated legal values are summarized by
Table 2-2:

Table 2-2 Valid Encryption Algorithms

Algorithm Name Legal Value
RC4 256-bit key RC4_256
RC4 128-bit key RC4_128
RC4 56-bit key RC4_56
RC4 40-bit key RC4_40
AES 256-bit key AES256
AES 192-bit key AES192
AES 128-bit key AES128
3-key 3DES 3DES168
2-key 3DES 3DES112
DES 56-bit key DES
DES 40-bit key DES40
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Configuring Integrity on the Client and the Server
To configure data integrity on the client and on the server:

1. Start Oracle Net Manager:
«  On UNIX, run net mgr from $ORACLE_HOVE/ bi n.

=« On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

2. In the Navigator window, expand Local > Profile.

3. From the list in the right pane, select Oracle Advanced Security; the Oracle
Advanced Security tabbed window appears (Figure 2-2):

Figure 2-2 Oracle Advanced Security Integrity Window

Oracle Advanced Security -

Integrity [CLIENT

Checksum Level: [accepted

fvailable Methods: Selected Methods:
MDS

SHAT ‘ N
_<

4. Choose the Integrity tab.

5. Depending upon which system you are configuring, choose the Server or Client
check box.
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6. From the Checksum Level list, select one of the following checksum level

values:

« REQUESTED
« REQUIRED

« ACCEPTED
« REJECTED

7. Select an integrity algorithm in the Available Methods list. Move it to the
Selected Methods list by choosing the right arrow [>]. Repeat for each
additional method you want to use.

8. Choose File > Save Network Configuration; the sql net . or a file is updated.

9. Repeat this procedure to configure integrity on the other system. The
sqgl net . or a file on the two systems should contain the following entries:

« Onthe server:

SQNET. CRYPTO CHECKSUM SERVER = [accepted | rejected | requested |

requi red]

SQNET. QRYPTO CHECKSUM TYPES SERVER = (val i d_crypt o_checksumal gorit hm
[,valid_crypto_checksumal gorithnj)

« On theclient:

SQNET. CRYPTO CHECKSUM QLI ENT = [accepted | rejected | requested |

requi red]

SQLNET. CRYPTO CHECKSUM TYPES CLI ENT = (val i d_crypt o_checksum al gorit hm
[,valid_crypto_checksumal gorithnj)

Valid integrity algorithms and their associated legal values are displayed by
Table 2-3:

Table 2-3 Valid Integrity Algorithms

Algorithm Name Legal Values
MD5 MD5
SHA-1 SHAl
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Thin JDBC Support

This chapter describes the Java implementation of Oracle Advanced Security, which
lets thin Java Database Connectivity (JDBC) clients securely connect to Oracle9i
databases. This chapter contains the following topics:

« About the Java Implementation

« Configuration Parameters

See Also: Oracle9i JDBC Developer’s Guide and Reference, for
information about JDBC, including examples
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About the Java Implementation

The Java implementation of Oracle Advanced Security provides network
encryption and integrity protection for Thin JDBC clients communicating with
Oracle9i databases that have Oracle Advanced Security enabled.

This section contains the following topics:
« Java Database Connectivity Support

« Securing Thin JDBC

« Implementation Overview

« Obfuscation

Java Database Connectivity Support

Java Database Connectivity (JDBC), an industry-standard Java interface, is a Java
standard for connecting to a relational database from a Java program. Sun
Microsystems defined the JDBC standard and Oracle Corporation implements and
extends the standard with its own JDBC drivers.

Oracle JDBC drivers are used to create JDBC applications to communicate with
Oracle databases. Oracle implements two types of JDBC drivers: Thick JDBC
drivers built on top of the C-based Oracle Net client, as well as a Thin (Pure Java)
JDBC driver to support downloadable applets. Oracle extensions to JDBC include
the following features:

« Data access and manipulation

« LOB access and manipulation

« Oracle object type mapping

«  Object reference access and manipulation
« Array access and manipulation

« Application performance enhancement
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Securing Thin JDBC

Because the Thin JDBC driver is designed to be used with downloadable applets
used over the Internet, Oracle designed a 100% Java implementation of Oracle
Advanced Security encryption and integrity algorithms for use with thin clients.
Oracle Advanced Security provides the following features for Thin JDBC:

« Dataencryption
« Data integrity checking
« Secure connections from Thin JDBC clients to the Oracle RDBMS

« Ability for developers to build applets that transmit data over a secure
communication channel

« Secure connections from middle tier servers with Java Server Pages (JSP) to the
Oracle RDBMS

« Secure connections from Oracle9i databases to older versions of Oracle
databases with Oracle Advanced Security installed

The Oracle JDBC Thin driver implements the Oracle O3LOGON protocol for
authentication. It does not support Oracle Advanced Security SSL implementation,
nor does it support third party authentication features such as RADIUS, Kerberos,
and SecurlD. However, the Oracle JDBC OCI (thick) driver support is the same as
thick client support, where all Oracle Advanced Security features are implemented.

Oracle Advanced Security continues to encrypt and provide integrity checking of
Oracle Net Services traffic between Oracle Net clients and Oracle servers using
algorithms written in C. The Oracle Advanced Security Java implementation
provides Java versions of the following encryption algorithms:

. RC4 256
. RC4 128
. RC4 56
. RC4_40
. DES56

. DES40

Note: In Oracle Advanced Security, DES runs in Cipher Block
Chaining (CBC) mode.
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In addition, this implementation provides data integrity checking for Thin JDBC
using Message Digest 5 (MD5), a cryptographically secure message digest.

Implementation Overview

Obfuscation

On the server side, the negotiation of algorithms and the generation of keys
function exactly the same as Oracle Advanced Security native encryption. This
enables backward and forward compatibility of clients and servers.

On the client side, the algorithm negotiation and key generation occur in exactly the
same manner as C-based Oracle Advanced Security encryption. The client and
server negotiate encryption algorithms, generate random numbers, use
Diffie-Hellman to exchange session keys, and use the Oracle Password Protocol
(O3LOGON key fold-in), in the same manner as traditional Oracle Net clients. Thin
JDBC contains a complete implementation of a Oracle Net client in pure Java.

Java cryptography code is obfuscated in this release. Obfuscation protects Java
classes and methods that contain encryption and decryption capabilities with
obfuscation software.

Java byte code obfuscation is a process frequently used to protect intellectual
property written in the form of Java programs. It mixes up Java symbols found in
the code. The process leaves the original program structure intact, letting the
program run correctly while changing the names of the classes, methods, and
variables in order to hide the intended behavior. Although it is possible to
decompile and read non-obfuscated Java code, obfuscated Java code is sufficiently
difficult to decompile to satisfy U.S. government export controls.
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Configuration Parameters

A properties class object containing several configuration parameters is passed to
the Oracle Advanced Security interface. This chapter lists the configuration
parameters for the following:

= Client Encryption Level: ORACLE.NET.ENCRYPTION_CLIENT
= Client Encryption Selected List: ORACLE.NET.ENCRYPTION_TYPES_CLIENT
= Client Integrity Level: ORACLE.NET.CRYPTO_CHECKSUM_CLIENT

= Client Integrity Selected List: ORACLE.NET.CRYPTO_CHEKSUM_TYPES_
CLIENT

Client Encryption Level: ORACLE.NET.ENCRYPTION_CLIENT

This parameter defines the level of security that the client wants to negotiate with
the server. Table 3-1 describes this parameter’s attributes.

Table 3-1 ORACLE.NET.ENCRYPTION_CLIENT Parameter Attributes

Attribute Description

Parameter Type String

Parameter Class Static

Permitted Values REJECTED; ACCEPTED; REQUESTED; REQUIRED
Default Value ACCEPTED

Syntax up. put ("oracle.net.encryption_client",|evel)
Example up. put ("oracl e. net. encryption_client",

"REQUI RED'), where up is defined as Properties
up=new properties()
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Client Encryption Selected List: ORACLE.NET.ENCRYPTION_TYPES CLIENT

This parameter defines the encryption algorithm to be used. Table 3-2 describes this
parameter’s attributes.

Table 3-2 ORACLE.NET.ENCRYPTION_TYPES_CLIENT Parameter Attributes

Attribute Description

Parameter Type String

Parameter Class Static

Permitted Values RC4_256; RC4_128; RC4_56; RC4_40; DES56C; DESC40C
Syntax up. put ("oracl e. net. encrypti on_types_

client", al g)

Example up. put ("oracl e. net. encryption_types_client",
"DESC40C"'), where up is defined as Properties
up=new Properties()

Note: In this context, "C" refers to CBC (Cipher Block Chaining)
mode.

Client Integrity Level: ORACLE.NET.CRYPTO_CHECKSUM_CLIENT

This parameter defines the level of security that it wants to negotiate with the server
for data integrity. Table 3—-3 describes this parameters attributes.

Table 3-3 ORACLE.NET.CRYPTO_CHECKSUM_CLIENT Parameter Attributes

Attribute Description

Parameter Type String

Parameter Class Static

Permitted Values REJECTED; ACCEPTED; REQUESTED; REQUIRED
Default Value ACCEPTED

Syntax up. put ("oracl e. net.crypto_checksum_

client",level)

Example up. put ("oracl e. net.crypto_checksumclient"”,
"REQUI RED'), where up is defined as Properties
up=new Properties()
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Client Integrity Selected List: ORACLE.NET.CRYPTO_CHEKSUM_TYPES_ CLIENT

This parameter defines the data integrity algorithm to be used. Table 3—-4 describes
this parameter’s attributes.

Table 3-4 ORACLE.NET.CRYPTO_CHEKSUM_TYPES_CLIENT Parameter Attributes

Attribute Description

Parameter Type String

Parameter Class Static

Permitted Values MD5

Syntax up. put ("oracl e. net. crypto_checksum types_

client", al g)

Example up. put ("oracl e. net.crypto_checksum types_
client","MD5"), where up is defined as
Properties up=new Properties()
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Part Il

Configuring Authentication Methods

This part describes how to configure authentication methods into your existing
Oracle network. It contains the following chapters, each of which describes a
particular authentication method supported by Oracle Advanced Security:

Chapter 4, Configuring RADIUS Authentication

Chapter 5, Configuring CyberSafe Authentication

Chapter 6, Configuring Kerberos Authentication

Chapter 7, Configuring Secure Sockets Layer Authentication
Chapter 8, Configuring Entrust-Enabled SSL Authentication
Chapter 9, Configuring Multiple Authentication Methods

Note: Oracle Advanced Security Release 2 (9.2) supports dynamic
loading of authentication methods. As a consequence, you no
longer need to specify all possible authentication methods at install
time; you can implement any available authentication method at
any time subsequent to the initial installation of Oracle Advanced
Security.







A

Configuring RADIUS Authentication

This chapter describes how to configure Oracle Advanced Security for the Oracle9i
server, for use with RADIUS (Remote Authentication Dial-In User Service). This
chapter contains the following topics:

RADIUS Overview
RADIUS Authentication Modes

Enabling RADIUS Authentication, Authorization, and Accounting

Using RADIUS to Log In to a Database
RSA ACE/Server Configuration Checklist

Note: SecurlD, an authentication product of RSA Security, Inc.,
though not directly supported by Oracle Advanced Security, has
been certified as RADIUS-compliant. You can therefore run SecurlD

under RADIUS.

See the RSA Security SecurlD documentation for further

information.
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RADIUS Overview

RADIUS is a client/server security protocol widely used to enable remote
authentication and access. Oracle Advanced Security uses this industry standard in
a client/server network environment.

You can enable the network to use any authentication method that supports the
RADIUS standard, including token cards and smart cards, by installing and
configuring the RADIUS protocol. Moreover, when you use RADIUS, you can
change the authentication method without modifying either the Oracle client or the
Oracle database server.

From the user’s perspective, the entire authentication process is transparent. When
the user seeks access to an Oracle database server, the Oracle database server, acting
as the RADIUS client, notifies the RADIUS server. The RADIUS server:

« Looks up the user’s security information.

» Passes authentication and authorization information between the appropriate
authentication server or servers and the Oracle database server.

« Grants the user access to the Oracle database server.

« Logs session information, including when, how often, and for how long the
user was connected to the Oracle database server.

The Oracle/RADIUS environment is displayed in Figure 4-1:

Figure 4-1 RADIUS in an Oracle Environment
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The Oracle database server acts as the RADIUS client, passing information between
the Oracle client and the RADIUS server. Similarly, the RADIUS server passes
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information between the Oracle database server and the appropriate authentication
servers. The authentication components are listed in Table 4-1:

Table 4-1 RADIUS Authentication Components

Component Stored Information

Oracle client Configuration setting for communicating through RADIUS.
Oracle database Configuration settings for passing information between the Oracle
server/ client and the RADIUS server.

RADIUS client

The secret key file.

RADIUS server

Authentication and authorization information for all users.
Each client’s name or IP address.
Each client’s shared secret.

Unlimited number of menu files enabling users already authenticated
to select different login options without reconnecting.

Authentication
Server or servers

User authentication information such as passcodes and PINs,
depending on the authentication method in use.

Note: The RADIUS server can also be the authentication server.

A RADIUS server vendor is often the authentication server vendor as well, in which
case authentication can be processed on the RADIUS server. For example, the RSA
ACE/Server is both a RADIUS server and an authentication server. It thus
authenticates the user’s passcode.

See Also:

Oracle9i Net Services Administrator’s Guide, for

information about the sql net . or a file
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RADIUS Authentication Modes
User authentication can take place in either of two ways:
= Synchronous Authentication Mode

» Challenge-Response (Asynchronous) Authentication Mode

Synchronous Authentication Mode

In the synchronous mode, RADIUS lets you use various authentication methods,
including passwords and SecurlID token cards. Figure 4-2 shows the sequence in
which synchronous authentication occurs:

Figure 4-2 Synchronous Authentication Sequence
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1. Auser logs in by entering a connect string, passcode, or other value. The client
system passes this data to the Oracle database server.

2. The Oracle database server, acting as the RADIUS client, passes the data from
the Oracle client to the RADIUS server.

3. The RADIUS server passes the data to the appropriate authentication server,
such as Smart Card or SecurlD ACE for validation.

4. The authentication server sends either an Access Accept or an Access Reject
message back to the RADIUS server.

5. The RADIUS server passes this response to the Oracle database server /
RADIUS client.

6. The Oracle database server / RADIUS client passes the response back to the
Oracle client.

Example: Synchronous Authentication with SecurlD Token Cards

With SecurlID authentication, each user has a token card that displays a dynamic
number that changes every sixty seconds. To gain access to the Oracle database
server/RADIUS client, the user enters a valid passcode that includes both a
personal identification number (PIN) and the dynamic number currently displayed
on the user’s SecurlD card. The Oracle database server passes this authentication
information from the Oracle client to the RADIUS server, which in this case is the
authentication server for validation. Once the authentication server (RSA
ACE/Server) validates the user, it sends an "accept” packet to the Oracle database
server, which, in turn, passes it to the Oracle client. The user is now authenticated
and able to access the appropriate tables and applications.

See Also:
« Chapter 1, Introduction to Oracle Advanced Security
« Token Cards on page 1-13

« Documentation provided by RSA Security, Inc.
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Challenge-Response (Asynchronous) Authentication Mode

When the system uses the asynchronous mode, the user does not need to enter a
user name and password at the SQL*Plus CONNECT string. Instead, a graphical
user interface asks the user for this information later in the process.

Figure 4-3 shows the sequence in which challenge-response (asynchronous)
authentication occurs.

Note: If the RADIUS server is the authentication server, Steps 3, 4,
and 5, and Steps 9, 10, and 11 in Figure 4-3 are combined.
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Figure 4-3 Asynchronous Authentication Sequence

@ = = =
‘ q‘!
Client Oracle RADIUS ' Authentication
server/ Server Server

5
L&
__o

o

I

L*

L*
L&
__ o

o

+—0

1. A user seeks a connection to an Oracle database server. The client system passes
the data to the Oracle database server.
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2. The Oracle database server, acting as the RADIUS client, passes the data from
the Oracle client to the RADIUS server.

3. The RADIUS server passes the data to the appropriate authentication server,
such as a Smart Card, SecurlD ACE, or token card server.

4. The authentication server sends a challenge, such as a random number, to the
RADIUS server.

5. The RADIUS server passes the challenge to the Oracle database server /
RADIUS client.

6. The Oracle database server / RADIUS client, in turn, passes it to the Oracle
client. A graphical user interface presents the challenge to the user.

7. The user provides a response to the challenge. To formulate a response, the user
can, for example, enter the received challenge into the token card. The token
card provides a dynamic password to be entered into the graphical user
interface. The Oracle client passes the user’s response to the Oracle database
server / RADIUS client.

8. The Oracle database server / RADIUS client sends the user’s response to the
RADIUS server.

9. The RADIUS server passes the user’s response to the appropriate
authentication server for validation.

10. The authentication server sends either an Access Accept or an Access Reject
message back to the RADIUS server.

11. The RADIUS server passes the response to the Oracle database server /
RADIUS client.

12. The Oracle database server / RADIUS client passes the response to the Oracle
client.

Example: Asynchronous Authentication with Smart Cards

With smart card authentication, the user logs in by inserting the smart card—a
plastic card (like a credit card) with an embedded integrated circuit for storing
information—into a hardware device which reads the card. The Oracle client sends
the login information contained in the smart card to the authentication server by
way of the Oracle database server/RADIUS client and the RADIUS server. The
authentication server sends back a challenge to the Oracle client, by way of the
RADIUS server and the Oracle database server, prompting the user for
authentication information. The information could be, for example, a PIN as well as
additional authentication information contained on the smart card.
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The Oracle client sends the user’s response to the authentication server by way of
the Oracle database server and the RADIUS server. If the user has entered a valid
number, the authentication server sends an "accept" packet back to the Oracle client
by way of the RADIUS server and the Oracle database server. The user is now
authenticated and authorized to access the appropriate tables and applications. If
the user has entered incorrect information, the authentication server sends back a
message rejecting the user’s access.

Example: Asynchronous Authentication with ActivCard Tokens

One particular ActivCard token is a hand-held device with a keypad and which
displays a dynamic password. When the user seeks access to an Oracle database
server by entering a password, the information is passed to the appropriate
authentication server by way of the Oracle database server/RADIUS client and the
RADIUS server. The authentication server sends back a challenge to the client—by
way of the RADIUS server and the Oracle database server. The user types that
challenge into the token, and the token displays a number for the user to send in
response.

The Oracle client then sends the user’s response to the authentication server by way
of the Oracle database server and the RADIUS server. If the user has typed a valid
number, the authentication server sends an "accept" packet back to the Oracle client
by way of the RADIUS server and the Oracle database server. The user is now
authenticated and authorized to access the appropriate tables and applications. If
the user has entered an incorrect response, the authentication server sends back a
message rejecting the user’s access.
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Enabling RADIUS Authentication, Authorization, and Accounting
To enable RADIUS authentication and accounting, perform the following tasks:
« Task 1: Install RADIUS on the Oracle Database Server and on the Oracle Client
« Task 2: Configure RADIUS Authentication
» Task 3: Create a User and Grant Access
» Task 4: Configure External RADIUS Authorization (optional)
« Task 5: Configure RADIUS Accounting
» Task 6: Add the RADIUS Client Name to the RADIUS Server Database
« Task 7: Configure the Authentication Server for Use with RADIUS.
« Task 8: Configure the RADIUS Server for Use with the Authentication Server
« Task 9: Configure Mapping Roles

Task 1: Install RADIUS on the Oracle Database Server and on the Oracle Client

RADIUS is installed with Oracle Advanced Security during a typical installation of
Oraclegi.

See: Oracle9i operating system-specific installation
documentation, for information about installing Oracle Advanced
Security and the RADIUS adapter

Task 2: Configure RADIUS Authentication

This task includes the following steps:

« Step 1. Configure RADIUS on the Oracle Client

« Step 2: Configure RADIUS on the Oracle Database Server
« Step 3: Configure Additional RADIUS Features

Unless otherwise indicated, perform these configuration tasks by using Oracle Net
Manager or by using any text editor to modify the sql net . or a file.
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Step 1: Configure RADIUS on the Oracle Client
1. To start Oracle Net Manager:

«  On UNIX, run net mgr from $ORACLE_HOVE/ bi n.

«  On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

2. In the Navigator window, expand Local > Profile.

3. From the list in the right pane, select Oracle Advanced Security; the Oracle
Advanced Security tabbed window appears (Figure 4-4):

Figure 4-4 Oracle Advanced Security Authentication Window
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4. Choose the Authentication tab.
5. From the Available Methods list, select RADIUS.

6. Choose the right-arrow [>] to move RADIUS to the Selected Methods list. Move
any other methods you want to use in the same way.
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Arrange the selected methods in order of required usage by selecting a method
in the Selected Methods list, and clicking Promote or Demote to position it in
the list. For example, put RADIUS at the top of the list for it to be the first
service used.

Choose File > Save Network Configuration.
The sql net . or a file is updated with the following entry:
SQLNET. AUTHENTI CATI ON_SERVI CES=( RADI US)

Step 2: Configure RADIUS on the Oracle Database Server

Create the RADIUS Secret Key File on the Oracle Database Server
Configure RADIUS Parameters on the Server (sqlnet.ora file)

Set Oracle Database Server Initialization Parameters

Create the RADIUS Secret Key File on the Oracle Database Server

1.

Obtain the RADIUS secret key from the RADIUS server. For each RADIUS
client, the administrator of the RADIUS server creates a shared secret key,
which must be longer than 16-characters.

On the Oracle database server, create a directory $ORACLE
HOVE/ net wor k/ security on UNIX or ORACLE_HOVE\ net wor k\ security on
Windows NT.

Create the file r adi us. key to hold the shared secret copied from the RADIUS
server. Place the file in the directory you just created in Step 2.

Copy the shared secret key and paste it (and nothing else) into the r adi us. key
file created on the Oracle database server.

For security purposes, change the file permission of r adi us. key to read only,
accessible only by the Oracle owner (Oracle relies on the file system to keep this
file secret).

See Also: The RADIUS server administration documentation, for
information about obtaining the secret key
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Configure RADIUS Parameters on the Server (sql net. or afile)

1.

w

N o &

Start Oracle Net Manager:
«  On UNIX, run net ngr from $ORACLE_HOME/ bi n.

«  On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

In the Navigator window, expand Local > Profile.

From the list in the right pane, select Oracle Advanced Security; the Oracle
Advanced Security tabbed window appears (Figure 4-4).

Choose the Authentication tab.
From the Available Methods list, select RADIUS.
Move RADIUS to the Selected Methods list by choosing the right-arrow [>].

To arrange the selected methods in order of desired use, select a method in the
Selected Methods list, and choose Promote or Demote to position it in the list.
For example, if you want RADIUS to be the first service used, put it at the top of
the list.

Choose the Other Params tab; the Other Params window appears (Figure 4-5):

Figure 4-5 Oracle Advanced Security Other Params Window
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9. From the Authentication Service list, select RADIUS.

10. In the Host Name field, accept the | ocal host as the default primary RADIUS
server, or enter another host name.

11. Ensure that the default value of the Secret File field is valid.
12. Choose File > Save Network Configuration.
The sql net . or a file is updated with the following entries:
SQLNET. AUTHENTI CATI ON_SERVI CES=RADI US

SQLNET. RADI US_AUTHENTI CATI ON=RADI US_ser ver _{ host name| | P_
addr ess}

Set Oracle Database Server Initialization Parameters
Configure the initialization parameter file, located in

=« On Unix, $ORACLE_BASE\ admi n\ db_nane\pfile
«  On Windows NT, ORACLE_BASE/ adni n/ db_nane/ pfile
with the following values:

REMOTE_CS AUTHENT=FALSE
OB AUTHENT PREFI X=""

Caution: Setting REMOTE_OS_AUTHENT to TRUE can enable a
security breach because it lets someone using a non-secure protocol,
such as TCP, perform an operating system-authorized login
(formerly called an OPS$ login).

See Also: Oracle9i Database Reference and the Oracle9i Database
Administrator’s Guide, for information about setting initialization
parameters on the Oracle9i database server
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Step 3: Configure Additional RADIUS Features

Change Default Settings
Configure Challenge-Response

Set Parameters for an Alternate RADIUS Server

Change Default Settings

1.

To start Oracle Net Manager:
«  On UNIX, run net ngr from $ORACLE_HOME/ bi n.

« On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

In the Navigator window, expand Local > Profile.

From the list in the right window pane, select Oracle Advanced Security; the
Oracle Advanced Security tabbed window appears (Figure 4-5).

Choose the Other Params tab.
From the Authentication Service list, select RADIUS.
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6. Change the default setting for any of the following fields:

Field

Description

Port Number

Specifies the listening port of the primary RADIUS server. The
default value is 1645.

Timeout (seconds)

Specifies the time the Oracle database server waits for a
response from the primary RADIUS server. The default is 15
seconds.

Number of Retries

Specifies the number of times the Oracle database server
resends messages to the primary RADIUS server. The default is
three retries.

For instructions on configuring RADIUS accounting, see: Task
5: Configure RADIUS Accounting on page 4-22.

Secret File

Specifies the location of the secret key on the Oracle database
server. The field specifies the location of the secret key file, not
the secret key itself.

For information about specifying the secret key, see: Create the
RADIUS Secret Key File on the Oracle Database Server on
page 4-12.

7. Choose File > Save Network Configuration.

The sql net . or a file is updated with the following entries:

SQNET. RADI US_AUTHENTT CATI ON_PCRT=( PCRT)
SQNET. RAD US_ AUTHENTI CATI ON_TI MEQUT=
(NUMBER OF SEQONDS TO WAI T FCR response)
SQNET. RAD US_AUTHENTI CATI ON_RETR ES=
(NUMBER CF TI MES TO RE- SEND TO RAD US server)
SQLNET. RAD US_SECRET=( pat h/ r adi us. key)
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Configure Challenge-Response

The challenge-response (asynchronous) mode presents the user with a graphical
interface requesting first a password, then additional information—for example, a
dynamic password that the user obtains from a token card. With the RADIUS
adapter, this interface is Java-based to provide optimal platform independence.

Note: Third party vendors of authentication devices must
customize this graphical user interface to fit their particular device.
For example, a smart card vendor would customize the Java
interface so that the Oracle client reads data, such as a dynamic
password, from the smart card. When the smart card receives a
challenge, it responds by prompting the user for more information,
such as a PIN.

See Also:  Appendix C, Integrating Authentication Devices Using
RADIUS, for information about how to customize the
challenge-response user interface

To configure challenge-response:

If you are using JDK 1.1.7 or JRE 1.1.7, set the JAVA_HOME environment
variable to the JRE or JDK location on the system where the Oracle client is run:

1.

On UNIX, enter this command at the prompt:
%set env JAVA HOME / usr/ | ocal / packages/jrel. 1. 7B

On Windows NT, choose Start> Settings > Control Panel > System >
Environment, and set the JAVA_HOME variable as follows:

c:\java\jrel. 1. 7B

Note: This step is not required for any other JDK 7/ JRE version.

Start Oracle Net Manager:

On UNIX, run net ngr from $ORACLE_HOME/ bi n.

On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

In the Navigator window, expand Local > Profile.
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© N o u

10.

From the list in the right pane, select Oracle Advanced Security; the Oracle
Advanced Security Other Params window appears (Figure 4-5).

Choose the Other Params tab.
From the Authentication Service list, select RADIUS.
In the Challenge Response field, enter ON to enable challenge-response.

In the Default Keyword field, accept the default value of the challenge or enter
a keyword for requesting a challenge from the RADIUS server.

Note: The keyword feature is provided by Oracle and supported
by some, but not all, RADIUS servers. You can use this feature only
if your RADIUS server supports it.

By setting a keyword, you let the user avoid using a password to
verify identity. If the user does not enter a password, the keyword
you set here is passed to the RADIUS server which responds with a
challenge requesting, for example, a driver’s license number or
birth date. If the user does enter a password, the RADIUS server
may or may not respond with a challenge, depending upon the
configuration of the RADIUS server.

In the Interface Class Name field, accept the default value of

Def aul t Radi usl nt er f ace or enter the name of the class you have created to
handle the challenge-response conversation. If other than the default RADIUS
interface is used, you also must edit the sql net . or a file to enter

SQLNET. RADI US_CLASSPATH=(| ocat i on) ,where | ocati on is the
complete path name of the jar file. It defaults to

$ORACLE _HOVE/ network/jlib/netradius.jar: $oracle_

home/ JRE/ i b/ vt.j ar

Choose File > Save Network Configuration.
The sql net . or a file is updated with the following entries:

SQNET. RAD US_ CHALLENCE RESPONSE=([ON | CFF])

SQNET. RAD US_CHALLENGE KEYWIRD=( KEYWIRD)

SQLNET. RAD US_AUTHENTI CATI ON | NTERFACE=( nane of interface including the
package nane delimted by "/" for ".")
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Set Parameters for an Alternate RADIUS Server

If you are using an alternate RADIUS server, set these parameters in the
sql net . or a file using any text editor.

SQNET. RAD US_ ALTERNATE=( host nare or i p address of alternate radi us server)
SQNET. RAD US_ALTERNATE _PCRT=(1812)

SQNET. RAD US_ ALTERNATE_TI MEQUT=( nunber of seconds to wait for response)
SQLNET. RAD US ALTERNATE_RETR ES=(nunber of tines to re-send to radi us server)

Task 3: Create a User and Grant Access
To grant user access.

1. Launch SQL*Plus and execute these commands to create and grant access to a
user identified externally on the Oracle database server.

SQ > QONNECT syst end nanager @lat abase_nane;

SQ> CREATE USER user nane | DENTI FI ED EXTERNALLY;
SA> RANT CREATE SESSI ON TO USER user nang;
SQA>EAT

If you are using Windows NT, you can use the Security Manager tool in the
Oracle Enterprise Manager.

See Also:
« Oracle9i Database Administrator’s Guide

«  Oracle9i Heterogeneous Connectivity Administrator’s Guide

2. Enter the same user in the RADIUS server’s users file.

See Also:  Administration documentation for the RADIUS server
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Task 4: Configure External RADIUS Authorization (optional)

If you require external RADIUS authorization for RADIUS users who connect to an
Oracle database, then you must perform the following steps to configure the Oracle
server, the Oracle client, and the RADIUS server:

To configure the Oracle server (RADIUS client):
1. Addthe OS_ROLE parameter to thei ni t . or a file and set this parameter to
TRUE as follows:

5 RAETRE

Then restart the database so the system can read the change totheinit. ora
file.

2. Set the RADIUS challenge-response mode to ON for the server if you have not
already done so by following the steps listed in "Configure
Challenge-Response" on page 4-17.

3. Add externally identified users and roles.

To configure the Oracle client (where users log in):

Set the RADIUS challenge-response mode to ON for the client if you have not
already done so by following the steps listed in "Configure Challenge-Response” on
page 4-17.
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To configure the RADIUS server:
1. Add the following attributes to the RADIUS server attribute configuration file:

ATTRIBUTE NAME CODE TYPE
VENDOR_SPECI FI C 26 Integer
ORACLE_RCLE 1 String

2. Assign a Vendor ID for Oracle in the RADIUS server attribute configuration file
that includes the SMI Network Management Private Enterprise Code of 111.

For example, enter the following in the RADIUS server attribute configuration
file:

VALUE VENDCR SPEA H C CRACLE 111

3. Using the following syntax, add the ORACLE_ROLE attribute to the user profile
of the users who will use external RADIUS authorization:
CRA dat abaseSI D rol enane[ _[Al|[O]

where:
« ORAdesignates that this role is used for Oracle purposes

« dat abaseSI Dis the Oracle system identifier that is configured in the
database server’si ni t . or a file

« rol enane is the name of role as it is defined in the data dictionary. For
example, SYSDBA

« Aisan optional character that indicates the user has adminstrator’s
privileges for this role

« Disan optional character that indicates this role is to be enabled by default

Ensure that RADIUS groups which map to Oracle roles adhere to the ORACLE _
ROLE syntax.
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For example:

USERNAME USERPASSWD=" user _passwor d*,
SERVI CE_TYPE=! ogi n_user,
VENDCR_SPEQ H C=CRACLE,
CRACLE_ROLE=CRA or a920_sysdba

See Also: The RADIUS server administration documentation for
information about configuring the server.

Task 5: Configure RADIUS Accounting

RADIUS accounting logs information about access to the Oracle database server
and stores it in a file on the RADIUS accounting server. Use this feature only if both
the RADIUS server and authentication server support it.

Set RADIUS Accounting on the Oracle Database Server
To enable or disable RADIUS accounting:

1.

Start Oracle Net Manager:
=  On UNIX, run net ngr from $ORACLE_HOME/ bi n.

« On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

In the Navigator window, expand Local > Profile.

From the list in the right window pane, select Oracle Advanced Security; the
Oracle Advanced Security Other Params window appears (Figure 4-5).

Choose the Other Params tab.
From the Authentication Service list, select RADIUS.

In the Send Accounting field, enter ON to enable accounting or OFF to disable
accounting.

Choose File > Save Network Configuration.
The sql net . or a file is updated with the following entry:
SQ.NET. RADI US_SEND_ACCOUNTI NG= ON
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Configure the RADIUS Accounting Server

RADIUS Accounting consists of an accounting server residing on either the same
host as the RADIUS authentication server or on a separate host.

See Also: Administration documentation for the RADIUS server,
for information about configuring RADIUS accounting

Task 6: Add the RADIUS Client Name to the RADIUS Server Database

You can use virtually any RADIUS server that complies with the standards in the
Internet Engineering Task Force (IETF) RFC #2138, Remote Authentication Dial In
User Service (RADIUS) and RFC #2139 RADIUS Accounting. Because RADIUS
servers vary, consult the documentation for your particular RADIUS server for any
unique interoperability requirements.

Perform the following steps to add the RADIUS client name to a Livingston
RADIUS server:

1. Open the clients file, which can be found at/ et c/ raddb/ cl i ent s. The
following text and table appear:

@(#) clients 1.1 2/21/96 Copyright 1991 Livingston Enterprises Inc

This file contains a list of clients which are allowed to nake

aut hentication requests and their encryption key. The first fieldis avalid
host name. The second field (separated by bl anks or tabs) is the encryption
key.

dient Nane Key

2. Inthe CLIENT NAME column, enter the host name or IP address of the host on
which the Oracle database server is running. In the KEY column, type the
shared secret.

The value you enter in the CLIENT NAME column, whether it is the client’s
name or IP address, depends on the RADIUS server.

3. Save and close the clients file.

See Also: Administration documentation for the RADIUS server
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Task 7: Configure the Authentication Server for Use with RADIUS

See the authentication server documentation for instructions about configuring the
authentication servers.

See Also: "Related Documentation” on page -xxviii, which
contains a list of possible resources.

Task 8: Configure the RADIUS Server for Use with the Authentication Server

See the RADIUS server documentation.

Task 9: Configure Mapping Roles

If the RADIUS server supports vendor type attributes, you can manage roles by
storing them in the RADIUS server. The Oracle database server downloads the roles
when there is a CONNECT request using RADIUS.

To use this feature, configure roles on both the Oracle database server and the
RADIUS server.

Perform these steps to configure roles on the Oracle database server:

1. Use atext editor to set the OS_ROLES parameter in the initialization parameters
file on the Oracle database server.

2. Stop and restart the Oracle database server.

3. Create each role the RADIUS server is to manage on the Oracle database server
with IDENTIFIED EXTERNALLY.

To configure roles on the RADIUS server, refer to Table 4-1 and use the
following syntax:

ORA Dat abaseNane. Dat abaseDomai nNarre_Rol eNane
Example:
ORA_USERDB. US. ORACLE. COM_MANAGER

Table 4-1 RADIUS Configuration Parameters

Parameter Description

DatabaseName The name of the Oracle database server for which the role is
being created. This is the same as the value of the DB_NAME
initialization parameter.
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Table 4-1 RADIUS Configuration Parameters

Parameter

Description

DatabaseDomainName

The name of the domain to which the Oracle database server
belongs. The value is the same as the value of the DB_DOMAIN
initialization parameter.

RoleName

The name of the role created in the Oracle database server.

4. Configure RADIUS challenge-response mode.

To configure challenge-response mode, See:

« Challenge-Response (Asynchronous) Authentication Mode on page 4-6

« Configure Challenge-Response on page 4-17
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Using RADIUS to Log In to a Database

If you are using the synchronous authentication mode, launch SQL*Plus and enter
the following command at the prompt:

QONNECT  user nane/ passwor d@at abase_al i as
Note that you can log in with this command only when challenge-response is not
turned to ON.

If you are using the challenge-response mode, launch SQL*Plus and, at the prompt,
enter the command that follows:

QO\NECT / @at abase_al i as

Note that you can log in with this command only when challenge-response is
turned to ON.

Note: The challenge-response mode can be configured for all
login cases.

RSA ACE/Server Configuration Checklist

If you are using an RSA ACE/Server as a RADIUS server, check the following items
before making your initial connection:

« Ensure that the host agent in the RSA ACE/Server is set up to send a node
secret. In version 5.0, this is done by leaving the SENT Node secret box
unchecked. If the RSA ACE/Server fails to send a node secret to the agent, then
a node verification failure message will be written to the RSA ACE/Server log.

« If you are using RSA SecurlD tokens, then ensure that the token is synchronized
with the RSA ACE/Server.

See Also: RSA ACE/Server documentation for specific
information about troubleshooting.
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Configuring CyberSafe Authentication

This chapter describes how to configure Oracle Advanced Security for Oracle9i, or
for the Oracle9i server, so that CyberSafe TrustBroker, a Kerberos-based
authentication server, can be used to authenticate Oracle users. This chapter
contains the following topics:

« Configuring CyberSafe Authentication

« Troubleshooting
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Configuring CyberSafe Authentication
To configure CyberSafe authentication:
« Task 1: Install the CyberSafe Server
« Task 2: Install the CyberSafe TrustBroker Client
« Task 3: Install the CyberSafe Application Security Toolkit
« Task 4: Configure a Service Principal for an Oracle Database Server
« Task 5: Extract the Service Table from CyberSafe
» Task 6: Install an Oracle Database Server
« Task 7: Install Oracle Advanced Security With CyberSafe
« Task 8: Configure Oracle Net and Oracle9i
« Task 9: Configure CyberSafe Authentication
« Task 10: Create a CyberSafe User on the Authentication Server

« Task 11: Create an Externally Authenticated Oracle User on the Oracle Database
Server

« Task 12: Get the Initial Ticket for the CyberSafe/Oracle User
« Task 13: Connect to an Oracle Database Server Authenticated by CyberSafe

Task 1: Install the CyberSafe Server

Perform this task on the system that functions as the authentication server.

See Also: CyberSafe documentation listed under Related
Documentation on page -xxviii

Task 2: Install the CyberSafe TrustBroker Client

Perform this task on the system that runs the Oracle database server and the client.

See Also: CyberSafe documentation listed under Related
Documentation on page -xxviii

Task 3: Install the CyberSafe Application Security Toolkit

Perform this task on both the client and server systems.
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See Also:  CyberSafe documentation listed under Related
Documentation on page -xxviii

Task 4: Configure a Service Principal for an Oracle Database Server

For the Oracle database server to validate the identity of clients, configure a service
principal for an Oracle database server on the system running the CyberSafe
TrustBroker Master Server. If required, also configure a realm.

The name of the principal has the following format:
kser vi ce/ ki nst ance@EALM

The field values in the service principal name are described in Table 5-1.

Table 5-1 CyberSafe TrustBroker Service Principal Name Field Values

Field Description

kservice A case-sensitive string that represents the Oracle service.
This might not be the same as the database service name

ki nstance Typically, this is the fully-qualified name of the system
on which Oracle is running

REALM The domain name of the server. REALM must always be
uppercase, and is typically named the DNS domain
name. If you do not enter a value for REALM when
using xst, kdb5_edit uses the realm of the current
host and displays it in the command output.

Note: The utility names in this section are executable programs.
However, the CyberSafe user name CYBERUSER and the realm
SOVECO. COMare examples only.

For example, if the Oracle service is oracle, the fully-qualified name of the system
on which Oracle is running is dbser ver . soneco. com and the realm is
SOVECO. COM the principal name is:

or acl e/ dbser ver . soneco. cond@@MEGQ QM

Run kdb5_edi t as root to create the service principal as follows:
# cd /krb5/ adnin
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# ./ kdb5_edit

To add a principal named or acl e/ dbser ver. soneco. com@QOVECO. COMto the
list of server principals known by CyberSafe, enter the following in kdb5_edi t :

kdb5 edit: ark oracl e/ dbserver. soneco. com@CMECQ QM

Task 5: Extract the Service Table from CyberSafe

Extract a service table from CyberSafe and copy it to both the Oracle database
server and CyberSafe TrustBroker client systems.

For example, to extract a service table for dbser ver . soneco. com perform the
following steps.

1.

Enter the following in kdb5_edi t :

kdb5_edit: xst dbserver. soneco. comoracl e

" or acl e/ dbser ver . soneco. com@CMECQ QM added to keyt ab
' WRFl LE: dbser ver . soneco. com new sr vt ab'

kdb5 edit: exit

# [krb5/bin/klist -k -t dbserver. sonmeco. com new srvt ab

If you do not enter a realm (SOVECO. COMin the example) when using xst ,
kdb5_edi t uses the realm of the current host and displays it in the command
output, as shown in the proceeding input example.

After the service table has been extracted, verify that the new entries are in the
table, in addition to the old entries. If the new entries are not in the service
table, or if you need to add additional new entries, use kdb5_edi t to append
them.

Move the CyberSafe service table to the CyberSafe TrustBroker client system. If
the service table is on the same system as the CyberSafe client, move it as in the
following example:

# nv dbser ver. soneco. com new srvtab /kr b5/ v5srvt ab

If the service table is on a different system from the CyberSafe TrustBroker
client, transfer the file with a program such as FTP. If using FTP, transfer the file
in binary mode.

Ensure that the owner of the Oracle database server executable can read the
service table (in the previous example, / kr b5/ v5sr vt ab). Set the file owner to
the Oracle user, or make the file readable by the group to which Oracle belongs.
Do not make the file readable to all users—this can enable a security breach.
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Task 6: Install an Oracle Database Server

Install an Oracle database server on the same system that is running the CyberSafe
TrustBroker client.

See Also: Oracle9i operating system-specific installation
documentation

Task 7: Install Oracle Advanced Security With CyberSafe

Install CyberSafe, along with Oracle Advanced Security, during a custom
installation of Oracle9i. The Oracle Universal Installer guides you through the entire
installation process.

See Also: Oracle9i operating system-specific installation
documentation

Task 8: Configure Oracle Net and Oracle9i
Configure Oracle Net and Oracle9i on both the server and client systems.

See Also: Oracle9i operating system-specific installation
documentation

Task 9: Configure CyberSafe Authentication

Perform the following tasks to set parameters in the Oracle database server and
client sql net . or a files to configure CyberSafe:

« Configure CyberSafe on both the Client and the Oracle Database Server
« Set REMOTE_OS_AUTHENT in the Initialization Parameter File (i nit. ora).
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Configure CyberSafe on both the Client and the Oracle Database Server

To configure CyberSafe authentication service parameters on both the client and the
database server:

1. Start Oracle Net Manager:
«  On UNIX, run net mgr from $ORACLE_HOVE/ bi n.

=« On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

2. In the Navigator window, expand Local > Profile.

3. From the list in the right pane, select Oracle Advanced Security; the Oracle
Advanced Security Authentication window appears (Figure 5-1):

Figure 5-1 Oracle Advanced Security Authentication Window (Cybersafe)

Oracle Advanced Security -

#uthentication

fyailable Methods: Selected Methods:
P E——

P ——
KERBEROSS = |CYBERSAFE
NTS
RaDIUS

Promote
Demote

4. Choose the Authentication tab.
5. Inthe Available Methods list, select CYBERSAFE.
6. Move CYBERSAFE to the Selected Methods list by choosing the right-arrow [>].
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7. Arrange the selected methods in order of desired use. To do this, select a
method from the Selected Methods list and choose Promote or Demote to
position it in the list. For example, if you want CYBERSAFE to be the first
service used, put it at the top of the list.

8. Choose the Other Params tab (Figure 5-2):

Figure 5-2 Oracle Advanced Security Other Params Window (Cybersafe)

9. From the Authentication Service list, select CYBERSAFE.
10. Enter the name of the GSSAPI Service, as in the following example:
or acl e/ dbser ver . soneco. con@OMECQ M

Insert the principal name, using the format described in Task 4: Configure a
Service Principal for an Oracle Database Server.

11. Choose File > Save Network Configuration.
The sql net . or a file is updated with the following entries:

SQLNET. AUTHENTI CATI ON_SERVI CES=( CYBERSAFE)
SQLNET. AUTHENTI CATI ON_GSSAP! _ SERVI CE=KSERVE G KI NSTANCE@REALM
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Set REMOTE_OS_AUTHENT in the Initialization Parameter File
Add the following parameter to the Initialization Parameter File (init.ora):

REMOTE_CS AUTHENT=FALSE

Note: Setting REMOTE_OS_AUTHENT to TRUE can enable a
security breach because it lets someone using a non-secure protocol,
such as TCP, perform an operating system-authorized login
(formerly called an OPS$ login).

Because CyberSafe user names can be long, and Oracle user names are limited to 30
characters, Oracle Corporation recommends using null for the value of
OS_AUTHENT _PREFIX, as follows:

G5 AUTHENT_PREF X=""

Restart the Oracle database server after modifying the configuration files to enable
the changes.

See Also: Oracle operating system-specific documentation and
Oracle9i Database Administrator’s Guide for more information about
how to restart the Oracle database server

Task 10: Create a CyberSafe User on the Authentication Server

5-8

For CyberSafe to authenticate Oracle users, you must create them on the CyberSafe
authentication server where the administration tools are installed. The following
steps assume that the realm already exists.

Note: The utility names in this section are executable programs.
However, the CyberSafe user name CYBERUSER and realm
SOVECO. COMare examples only.

Run / kr b5/ admi n/ kdb5_edi t as root on the authentication server to create the new
CyberSafe user, such as CYBERUSER.

Enter the following:

# kdb5_edi t
kdb5_edit:
ank cyber user
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Enter password:

<passwor d> (password does not di spl ay)
Re-enter password for verification:
<passwor d> (password does not di spl ay)
kdb5_edit: quit

See Also: Cybersafe documentation listed in Related
Documentation on page -xxviii for information about creating the
realm

Task 11: Create an Externally Authenticated Oracle User on the Oracle Database

Server

Run SQL*Plus to create the Oracle user, and enter the following commands on the
Oracle database server (note that the Oracle user name must be uppercase and enclosed in
double quotation marks):

In this example, OS_AUTHENT_PREFIX is set to null (").
SQ> QONNECT / AS SYSDBA

SQA> CREATE USER " CYBERUSER@OMECQ GOM | DENTI FH ED EXTERNALLY;
SQA> CRANT CREATE SESSI ON TO " CYBERUSER@OMECQ QM

See Also: Oracle9i Database Administrator’s Guide
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Task 12: Get the Initial Ticket for the CyberSafe/Oracle User

Before users can connect to the database, they must run ki ni t on the clients for an
initial ticket:

1. Enter the following:

%Kkinit cyberuser

2. Enter the password (password does not display).

3. To list currently owned tickets, run ki i st on the clients. Enter the following at
the system command prompt:

%Kkl i st

The system displays the following information:

Creation Date Expiration Date Service

11-Aug-99 16:29:51 12-Aug-99 00:29:21  krbtgt/SCMECO.COM@SOMECO.COM
11-Aug-99 16:29:51 12-Aug-99 00:29:21  oracle/dbserver.someco.com@SOMECO.COM

Task 13: Connect to an Oracle Database Server Authenticated by CyberSafe

After running ki ni t to get an initial ticket, users can connect to an Oracle database
server without using a user name or password. Enter a command similar to the
following:

% sql plus / @et_servi ce_nane

where net _servi ce_nane isa Oracle Net service name.
For example:

% sql pl us / @pddoc_db

See Also: Chapter 1, Introduction to Oracle Advanced Security,
and Oracle9i Heterogeneous Connectivity Administrator’s Guide
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Troubleshooting

This section describes some common configuration problems and explains how to
resolve them:

If you cannot get your ticket-granting ticket using kinit:
« Ensure that the default realm is correct by looking at kr b. conf .

« Ensure that the TrustBroker Master Server is running on the host specified for
the realm.

« Ensure that the Master Server has an entry for the user principal and that the
passwords match.

« Ensure that the kr b. conf and kr b. r eal ns files are readable by Oracle.

If you have an initial ticket, but still cannot connect:
« After trying to connect, check for a service ticket.

« Check that the sql net . or a file on the database server side has a service name
that corresponds to a service known to the CyberSafe Master Server.

« Check that the clocks on all the involved systems are within a few minutes of
each other.

If you have a service ticket, and you still cannot connect:
« Check the clocks on the client and database server.

« Check that the v5sr vt ab file exists in the correct location and is readable by
Oracle.

« Check that the v5sr vt ab file has been generated for the service named in the
profile (sql net . or a) on the database server side.

If everything seems to work fine, but then you issue another query and it fails:

« Check that the initial ticket is forwardable. You must have obtained the initial
ticket by running kinit -f.

« Check the expiration date on the credentials.

« If the credentials have expired, close the connection and run ki ni t to get a new
initial ticket.
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Configuring Kerberos Authentication

This chapter describes how to configure Oracle Advanced Security for Oracle9i for
use with Kerberos authentication—and how to configure Kerberos to authenticate
Oracle database users. This chapter contains the following topics:

« Enabling Kerberos Authentication
« Utilities for the Kerberos Authentication Adapter
« Configuring Interoperability with a Windows 2000 Domain Controller KDC

« Troubleshooting
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Enabling Kerberos Authentication

To enable Kerberos authentication:

Task 1: Install Kerberos

Task 2: Configure a Service Principal for an Oracle Database Server
Task 3: Extract a Service Table from Kerberos

Task 4: Install an Oracle Database Server and an Oracle Client
Task 5: Install Oracle Net Services and Oracle Advanced Security
Task 6: Configure Oracle Net Services and Oracle9i

Task 7: Configure Kerberos Authentication

Task 8: Create a Kerberos User

Task 9: Create an Externally Authenticated Oracle User

Task 10: Get an Initial Ticket for the Kerberos/Oracle User

Task 1: Install Kerberos
Install Kerberos on the system that functions as the authentication server.

See Also:  Notes about building and installing Kerberos from
Kerberos version 5 source distribution for information about how
to install Kerberos.
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Task 2: Configure a Service Principal for an Oracle Database Server

To enable the Oracle database server to validate the identity of clients that
authenticate themselves using Kerberos, you must create a service principal for
Oraclegi.

The name of the principal should have the following format:
kservi ce/ ki nst ance @EALM

Each of the fields in the service principal specify the following values:

kservice A case-sensitive string that represents the Oracle service; this
can be the same as the database service name.

ki nst ance This is typically the fully qualified name of the system on
which Oracle9i is running.

REALM The domain name of the database server. REALM must

always be uppercase and is typically the DNS domain name.

Note: The utility names in this section are executable programs.
However, the Kerberos user name kr buser and the realm
SOVECO. COMare examples only.

For example, if kser vi ce is or acl e, the fully qualified name of the system on
which Oracle9i is running is dbser ver . soneco. comand the realm is
SOVECO. COM The principal name is:

or acl e/ dbser ver . soneco. com@MECQ M
It is a convention to use the DNS domain name as the name of the realm. To create

the service principal, run kadni n. I ocal . On UNIX, run this command as the root
user, by using the following syntax:

# cd /kerberos-install-directory/shin
# ./kadnin. | ocal

To add a principal named or acl e/ dbser ver. someco. com@QVECO. COMto the
list of server principals known by Kerberos, enter the following:

kadmi n. | ocal : addpri nc -randkey oracl e/ dbser ver. soneco. com@CMECQ COM
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Task 3: Extract a Service Table from Kerberos

Extract the service table from Kerberos and copy it to the Oracle database
server/Kerberos client system.

For example, use the following steps to extract a service table for
dbserver. soneco. com

1.

Enter the following to extract the service table:

kadm n.l ocal: ktadd -k /tnp/keytab
oracl e/ dbser ver. soneco. com

Entry for principal oracl e/ dbserver.soneco.comw th kvno 2,
encryption DES-CBC- CRC added to the keytab WRFI LE:
"VWRFI LE: / t np/ keyt ab

kadm n.l ocal : exit
oklist -k -t /tnp/keytab

After the service table has been extracted, verify that the new entries are in the
table in addition to the old ones. If they are not, or you need to add more, use
kadmi n. |l ocal toappend to them.

If you do not enter a realm when using kt add, it uses the realm of the current
host and displays it in the command output, as shown in Step 1.

If the Kerberos service table is on the same system as the Kerberos client, you
can move it. If the service table is on a different system from the Kerberos client,
you must transfer the file with a program such as FTP. If using FTP, transfer the
file in binary mode.

The following example shows how to move the service table on a UNIX
platform:

# nv /tnp/ keytab /etc/v5srvtab

The default name of the service file is/ et ¢/ v5sr vt ab.

Verify that the owner of the Oracle database server executable can read the
service table (/ et ¢/ v5srvt ab in the previous example). To do so, set the file
owner to the Oracle user, or make the file readable by the group to which
Oracle belongs.

Caution: Do not make the file readable to all users. This can cause
a security breach.
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Task 4: Install an Oracle Database Server and an Oracle Client
Install the Oracle database server and client software.

See Also: Oracle9i operating system-specific installation
documentation

Task 5: Install Oracle Net Services and Oracle Advanced Security

Install Oracle Net Services and Oracle Advanced Security on the Oracle database
server and Oracle client systems.

See Also: Oracle9i operating system-specific installation
documentation

Task 6: Configure Oracle Net Services and Oracle9i
Configure Oracle Net Services on the Oracle database server and client.

See Also:
« Oracle9i operating system-specific installation documentation

. Oracle9i Net Services Administrator’s Guide.

Task 7: Configure Kerberos Authentication

Perform these tasks to set required parameters in the Oracle database server and
client sql net . or a files:

« Step 1. Configure Kerberos on the Client and on the Database Server
« Step 2: Set the Initialization Parameters

= Step 3: Set sqlnet.ora Parameters (optional)

Step 1: Configure Kerberos on the Client and on the Database Server

Perform the following steps to configure Kerberos authentication service
parameters on the client and on the database server:

1. Start Oracle Net Manager:
«  On UNIX, run net ngr from $ORACLE_HOME/ bi n.

« On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.
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2. In the Navigator window, expand Local > Profile.

3. From the list in the right pane, select Oracle Advanced Security; the Oracle
Advanced Security window appears (Figure 6-1):

Figure 6-1 Oracle Advanced Security Authentication Window (Kerberos)

Oracle Advanced Security -

futhentication

Available Methods: Selected Methods:

PP ——
NTS KERBEROSS
R&DIUS
CYBERSAFE

Promote

Demaote

_ < |
Promote

Choose the Authentication tab.
From the Available Methods list, select KERBERCS5.
Move KERBERGOSS to the Selected Methods list by clicking the right arrow (>).

N oo o &

Arrange the selected methods in order of use. To do this, select a method in the
Selected Methods list, then click Promote or Demote to position it in the list. For
example, if you want KERBEROS5 to be the first service used, move it to the top
of the list.

8. Choose the Other Params tab (Figure 6-2).
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Figure 6-2 Oracle Advanced Security Other Params Window (Kerberos)

Oracle Advanced Security hd

H cath,. | Other Params |

Authentication Service: [ KEREE ROIS(YS)

Service: |Kerberos

Credential Cache File: il,n"usrl,l"tmp..l"krbcache
Caonfiguration File: i,-’krbS,-’krb.conf

Realm Translation File: [/krbS/krbrealms
Key Tahle: i,-’etc,-’v!isrvtah

Clock Skew: 300

9. From the Authentication Service list, select KERBEROS( V5) .

10. Type Ker ber os into the Service field. This field defines the name of the service
Oracle9i uses to obtain a Kerberos service ticket. When you provide the value
for this field, the other fields are enabled.

11. Optionally enter values for the following fields:
= Credential Cache File
« Configuration File
» Realm Translation File
« Key Table
« Clock Skew

See Also: Oracle Net Manager online help, and "Step 3: Set
sglnet.ora Parameters (optional)” on page 6-9, for more information
about the fields and the parameters they configure

12. Choose File > Save Network Configuration.

Configuring Kerberos Authentication 6-7



Enabling Kerberos Authentication

The sql net . or a file is updated with the following entries:
SQLNET. AUTHENTI CATI ON_SERVI CES=( KERBEROS5)
SQLNET. AUTHENTI CATI ON_KERBEROS5_SERVI CE=kser vi ce

Step 2: Set the Initialization Parameters
To set parameters in the initialization parameter file:

1. Add the following parameter to the initialization parameter file:
REMOTE_OS_AUTHENT=FALSE

Caution: Setting REMOTE_OS_AUTHENT to TRUE can enable a
security breach, because it lets someone using a hon-secure
protocol, such as TCP, perform an operating system-authorized
login (formerly called an OPS$ login).

2. Because Kerberos user names can be long, and Oracle user names are limited to
30 characters, Oracle Corporation strongly recommends that you set the value
of OS_AUTHENT _PREFI X to null as follows:

OS_AUTHENT_PREFI X=""

Setting this parameter to null overrides the default value of OPS$.
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Step 3: Set sqlnet.ora Parameters (optional)

In addition to the required parameters, you can optionally set the following
parameters in the sqgl net . or a file on the client and the Oracle database server:

Parameter:

Description:

Example:
Parameter:

Description:

Example:

Parameter:

Description:

Example:
Parameter:

Description:

SQLNET. KERBEROS5 _CC_NAME=pat hnanme_t o_
credentials _cache file

Specifies the complete path name to the Kerberos credentials
cache (CC) file. The default value is operating
system-dependent. For UNIX, it is/t np/ kr b5cc_useri d.

You can also set this parameter by using the KRB5CCNAME
environment variable, but the value set in the sql net . or a file
takes precedence over the value set in KRBSCCNAME.

SQLNET. KERBERCS5 CC NAME=/ usr/ t np/ kr bcache

SQLNET. KERBERCOS5 CLOCKSKEWENnumber _of _seconds_
accepted_as_networ k_del ay

This parameter specifies how many seconds can pass before a
Kerberos credential is considered out-of-date. It is used when
a credential is actually received by either a client or a database
server. An Oracle database server also uses it to decide if a
credential needs to be stored to protect against a replay attack.
The default is 300 seconds.

SQLNET. KERBEROS5_ CLOCKSKEW-1200

SQLNET. KERBEROS5 _CONF=pat hnane_t o_Ker ber os_
configuration_ file

This parameter specifies the complete path name to the
Kerberos configuration file. The configuration file contains the
realm for the default KDC (key distribution center) and maps
realms to KDC hosts. The default is operating
system-dependent. For UNIX; it is/ kr b5/ kr b. conf .

SQLNET. KERBEROS5 CONF=/ kr b/ kr b. conf
SQ.NET. KERBEROS5_CONF_M T=[ TRUE| FALSE]

This parameter specifies whether the new MIT Kerberos
configuration format is used. If the value is set to TRUE, it will
parse the file according to the new configuration format rules.
When the value is set to FALSE, the default (non-MIT)
configuration is used. The default is FALSE.
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Example:
Parameter:

Description:

Example:

Parameter:

Description:

Example:

SQLNET. KERBEROS5_CONF_M T=Fal se

SQ.NET. KERBEROS5_KEYTAB=
pat hnane_t o_Ker beros_princi pal / key_tabl e

This parameter specifies the complete path name to the
Kerberos principal/secret key mapping file. It is used by the
Oracle database server to extract its key and decrypt the
incoming authentication information from the client. The
default is operating system-dependent. For UNIX, it is

/ et c/v5srvtab.

SQLNET. KERBEROS5_KEYTAB=/ et c/ v5sr vt ab

SQLNET. KERBEROS5 REALMsS=
pat hname_to_Kerberos_real mtranslation_file

This parameter specifies the complete path name to the
Kerberos realm translation file. The translation file provides a
mapping from a host name or domain name to a realm. The
default is operating system-dependent. For UNIX, it is
/etc/krb.real irs.

SQLNET. KERBEROS5_REALMS=/ kr b5/ kr b. r eal ns
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Task 8: Create a Kerberos User

To create Oracle users that Kerberos can authenticate, perform this task on the
Kerberos authentication server where the administration tools are installed. The
realm must already exist.

Note: The utility names in this section are executable programs.
However, the Kerberos user name kr buser and realm
SOVECO. COMare examples only; they can vary among systems.

Run/ kr b5/ adm n/ kadm n. | ocal as root to create a new Kerberos user, such as
kr buser.

The following example is UNIX-specific:

# ./ kadnin. | ocal

kadmin. | ocal : addprinc krbuser

Enter password for principal: "krbuser @MEGQ QM : (password does not di spl ay)
Re-enter password for principal: "krbuser @OMEQQ QM (password does not

di spl ay)

kadmn. | ocal : exit

Task 9: Create an Externally Authenticated Oracle User

Run SQL*Plus on the Oracle database server to create the Oracle user that
corresponds to the Kerberos user. In the following example, OS_AUTHENT_PREFI X
is set to null (""). The Oracle user name is in uppercase enclosed in double
guotation marks as shown in the following example:

S>> CONNECT / AS SYSDBA
Q> CREATE USER " KRBUSER@XOMEQQ OOM! | DENTI FI ED EXTERVALLY:
SQL> GRANT CREATE SESSI ON TO " KRBUSER@OMECD OO ;
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Task 10: Get an Initial Ticket for the Kerberos/Oracle User

Before you can connect to the database, you must ask the Key Distribution Center
(KDC) for an initial ticket. To do so, run the following on the client:

% oki nit usernane
If, when making a database connection, a reference such as the following follows a
database link, you must use the forwardable flag (- f ) option:

sql plus / @racl e

Executing oki nit -f enables credentials that can be used across database links.
Run the following commands on the Oracle client:

%okinit -f
Password for krbuser @COMEGQ GCM passwor d
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Utilities for the Kerberos Authentication Adapter

Three utilities are shipped with the Oracle Kerberos authentication adapter. These
utilities are intended for use on an Oracle client with Oracle Kerberos
authentication support installed. Use the following utilities in for these specified

tasks:

« Obtaining the Initial Ticket with the okinit Utility

« Displaying Credentials with the oklist Utility

« Removing Credentials from the Cache File with the okdstry Utility

Note: Solaris is shipped with Kerberos version 4. Ensure that the
Kerberos version 5 utilities are in the path so that the version 4
utilities are not used inadvertently.

Obtaining the Initial Ticket with the okinit Utility

The oki ni t utility obtains and caches Kerberos tickets. This utility is typically used
to obtain the ticket-granting ticket, using a password entered by the user to decrypt
the credential from the key distribution center (KDC). The ticket-granting ticket is
then stored in the user's credential cache.

The options available with oki ni t are listed in Table 6-1:

Table 6-1 Options for the okinit Utility

Option

Description

-f

Ask for a forwardable ticket-granting ticket. This option is necessary to follow
database links.

Specify the lifetime of the ticket-granting ticket and all subsequent tickets. By
default, the ticket-granting ticket is good for eight (8) hours, but shorter or
longer-lived credentials may be desired. Note that the KDC can ignore this
option or put site-configured limits on what can be specified. The lifetime
value is a string that consists of a number qualified by w (weeks), d (days), h
(hours), m (minutes), or s (seconds), as in the following example:

okinit -1 2w d6h20nB0s

The example requests a ticket-granting ticket that has a life time of 2 weeks, 1
day, 6 hours, 20 minutes, and 30 seconds.
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Description

Specify an alternative credential cache. For UNIX, the default is
/t mp/ kr b5cc_ui d. You can also specify the alternate credential cache by
using the SQLNET. KERBERCS5_CC_NAME parameter in the sqgl net . or a file.

List command line options.

Displaying Credentials with the oklist Utility

Run the okl i st utility to display the list of tickets held; available okl i st options
are listed in Table 6-2:

Table 6-2 Options for the oklist Utility

Option

Description

-f

Show flags with credentials. Relevant flags are I, credential is a ticket-granting
ticket, F, credential is forwardable, and f, credential is forwarded.

Specify an alternative credential cache. In UNIX, the defaultis/ t np/ kr b5cc_
ui d. The alternate credential cache can also be specified by using the
SQLNET. KERBERCS5_CC_NAME parameter in the sql net . or a file.

List the entries in the service table (default/ et ¢/ v5sr vt ab) on UNIX. The
alternate service table can also be specified by using the SQLNET. KERBEROS5 _
KEYTAB parameter in the sql net . or a file.

The show flag option (- f ) displays additional information, as shown in the
following example:

%oklist -f

27-Jul -1999 21:57:51  28-Jul -1999 05: 58: 14
kr bt gt / SOMEQQ COM@BOMECQ GM

Hags: H
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Removing Credentials from the Cache File with the okdstry Utility
Use the okdst r y utility to remove credentials from the credentials cache file:
$ okdstry -f
where the - f command option lets you specify an alternative credential cache. For
UNIX, the default is / t np/ kr b5cc_ui d. You can also specify the alternate

credential cache by using the SQLNET. KRB5_CC_NAME parameter in the
sgl net. ora file.

Connecting to an Oracle Database Server Authenticated by Kerberos

You can now connect to an Oracle database server without using a user name or
password. Enter a command similar to the following:

$ sql plus / @et_service_nane
where net _servi ce_nane is an Oracle Net Services service name. For example:

$ sql pl us / @racl e_dbnane

See Also: Chapter 1, Introduction to Oracle Advanced Security,
for information about external authentication and Oracle9i
Heterogeneous Connectivity Administrator’s Guide
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Configuring Interoperability with a Windows 2000 Domain Controller
KDC

Oracle Advanced Security, which complies with MIT Kerberos, can interoperate
with tickets that are issued by a Kerberos Key Distribution Center (KDC) on a
Windows 2000 domain controller to enable Kerberos authentication with an Oracle
database. To configure Kerberos authentication that uses a Windows 2000 domain
controller KDC, perform the following tasks:

« Task 1: Configuring an Oracle Kerberos Client to Interoperate with a Windows
2000 Domain Controller KDC

« Task 2: Configuring a Windows 2000 Domain Controller KDC to Interoperate
with an Oracle Client

« Task 3: Configuring an Oracle Database to Interoperate with a Windows 2000
Domain Controller KDC

» Task 4: Getting an Initial Ticket for the Kerberos/Oracle User
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Task 1: Configuring an Oracle Kerberos Client to Interoperate with a Windows 2000
Domain Controller KDC
The following steps must be performed on the Oracle Kerberos client.

Step 1: Creating Client Kerberos Configuration Files to Use a Windows Domain
Controller KDC

Create the following Kerberos client configuration files that refer to the Windows
2000 domain controller as the Kerberos KDC. In the examples that follow, the
Windows 2000 domain controller is running on a node named

sal es3854. us. acnme. com

krb. conf file
For example:
SALES3854. US. AOVE. M

SALES3854. US. ACME. M sal es3854. us. acne. com adm n ser ver

kr b5. conf file
For example:

[1ibdefaul ts]
def aul t _r eal n¥SALES. US. AOVE CM
[real n3]
SALES. Us. AOME OOME {
kdc=sal es3854. us. acne. com 88

}
[ donai n_real nj
. us. acne. comrSALES3854. US. AQVE M

kr b5. r eal ns file
For example:
us. acrme. com SALES. Us. AOME QM
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Step 2: Specifying Oracle Configuration Parameters in the sqglnet.ora File

Configuring an Oracle client to interoperate with a Windows 2000 domain
controller KDC uses the same sql net . or a file parameters that are listed in "Step 1:
Configure Kerberos on the Client and on the Database Server" on page 6-5.

Set the following parameters in the sql net . or a file on the client:

SQNET. KERBERCE5_ONF=pat hnane_t o_Ker beros_configuration file
SQNET. KERBEROS5_GONF_M T=TRE

SQLNET. AUTHENTI CATI ON_KERBERCE5  SERVI CE=Ker ber os_ser vi ce_nane
SQLNET. AUTHENTI CATI ON_SERV CES=( BEQ KERBERCED)

Note: Ensure that the SQLNET. KERBERCS5 CONF_ M T
parameter is set to TRUE because the Windows 2000 operating
system is designed to interoperate only with security services that
are based on MIT Kerberos version 5.

Step 3: Specifying the Listening Port Number

The Windows 2000 domain controller KDC listens on UDP/TCP port 88. Ensure
that the system file entry for ker ber 0s5 is set to UDP/TCP port 88 as follows:

. (UNIX)

Ensure that the ker ber 0s5 entry inthe / et ¢/ ser vi ces file is set to 88
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Task 2: Configuring a Windows 2000 Domain Controller KDC to Interoperate with an
Oracle Client
The following steps must be performed on the Windows 2000 domain controller.

See Also: Microsoft documentation for information about how to
create users in Active Directory.

Step 1: Creating the User
Create a new user for the Oracle client in Microsoft Active Directory.

Step 2: Creating the Oracle Database Principal
1. Create a new user for the Oracle database in Microsoft Active Directory.
For example, if the Oracle database runs on the host

sal es3854. us. acne. com then use Active Directory to create a user with the
username sal es3854. us. acne. comand the password or acl e.

Note: Do not create a user as host / host nanme. dns. com such as
oracl e/ sal es3854. us. acne. com in Active Directory.
Microsoft’s KDC does not support multipart names like an MIT
KDC does. An MIT KDC allows multipart names to be used for
service principals because it treats all principals as usernames.
However, Microsoft’s KDC does not.

2. Use the Kt pass command line utility to extract the keytab file with the
following syntax:

Kt pass -princ servicel host nane@\T- DNS- REALM NAME - napuser account - pass
password -out keytab.file

Using the database user created in the previous step, the following is an
example of Kt pass usage:

C > Ktpass -princ oracl e/ sal es3854. us. acne. cCOm@ALES. US. M - napuser

sal es3854 -pass oracle -out C\tenp\vbsrvtab

This utility is part of the Windows 2000 Support Tools and can be found on the
Windows 2000 distribution media in the
\ support\reskit\netngnt\security folder.
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3. Copy the extracted keytab file to the host computer where the Oracle database
is installed.

For example, the keytab that was created in the previous step can be copied to
[ kr b5/ v5svrtab.

See Also: Detailed information about Windows 2000
interoperability with Kerberos 5 that is available at the following
URL:

ht t p: // waw m cr osof t . cond WNDOMB2000/ t echi nf of pl anni ng/ securi ty/
ker bst eps. asp
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Task 3: Configuring an Oracle Database to Interoperate with a Windows 2000 Domain
Controller KDC

The following steps must be performed on the host computer where the Oracle
database is installed.

Step 1: Setting Configuration Parameters in the sqglnet.ora File

Specify values for the following parameters in the sqlnet.ora file for the database
server:

SQNET. KERBERCE5_OONF=pat hnane_t o_Ker ber os_configuration file
SQNET. KERBERCES5_KEYTAB=pat hnane_t o_Ker ber os_pri nci pal / key_t abl e
SQNET. KERBEROS5_GONF_M T=TRE

SQLNET. AUTHENTI CATI ON_KERBERCE5 SERVI CE=Ker ber os_ser vi ce_nane
SQLNET. AUTHENTI CATI ON_SERVI CES=( BEQ KERBERCES)

Note: Ensure that the SQUNET. KERBEROS5_CONF_M T
parameter is set to TRUE because the Windows 2000 operating
system is designed to interoperate only with security services that
are based on MIT Kerberos version 5.

Step 2: Creating an Externally Authenticated Oracle User

Follow the task information for "Task 9: Create an Externally Authenticated Oracle
User" on page 6-11 to create an externally authenticated Oracle user. Ensure that the
username is created in all uppercase characters. For example,

ORAKRB@BALES. US. ACVE. COM

See Also: «"Task 7: Configure Kerberos Authentication" on
page 6-5 for information about using Oracle Net Manager to set
the sqgl net . or a file parameters.

Task 4: Getting an Initial Ticket for the Kerberos/Oracle User

Before a client can connect to the database, the client must request an initial ticket.
To request an initial ticket, follow the task information for "Task 10: Get an Initial
Ticket for the Kerberos/Oracle User" on page 6-12.
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Troubleshooting

This section lists some common configuration problems and explains how to
resolve them.

« If you cannot get your ticket-granting ticket using OKINIT:
— Ensure that the default realm is correct by examining the kr b. conf file.
— Ensure that the KDC is running on the host specified for the realm.

— Ensure that the KDC has an entry for the user principal and that the
passwords match.

— Ensure that the kr b. conf and kr b. r eal s files are readable by Oracle.
« Ifyou have an initial ticket, but still cannot connect:
— After trying to connect, check for a service ticket.

— Check that the sql net . or a file on the database server side has a service
name that corresponds to a service known by Kerberos.

— Check that the clocks on all systems involved are set to times that are
within a few minutes of each other (or change the SQLNET. KERBEROS5
CLOCKSKEWparameter in the
sql net . or afile).

« Ifyou have a service ticket and you still cannot connect:
— Check the clocks on the client and database server.

— Check that the v5sr vt ab file exists in the correct location and is readable by
Oracle (remember to set the sqgl net . or a parameters).

— Check that the v5sr vt ab file has been generated for the service named in
the sql net . or a file on the database server side.

« If everything seems to work fine, but then you issue another query and it fails:

— Check that the initial ticket is forwardable. (You must have obtained the
initial ticket by running the oki ni t utility.)

— Check the expiration date on the credentials. If the credentials have expired,
then close the connection and run oki ni t to get a new initial ticket.
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Configuring Secure Sockets Layer
Authentication

This chapter describes how to use the Secure Sockets Layer (SSL) protocol in Oracle
Advanced Security. It contains the following topics:

= SSL in an Oracle Environment

= SSL between Non-Oracle Clients and Oracle Database Servers
=« SSL Combined with Other Authentication Methods

« SSL and Firewalls

« SSL Usage Issues

« Enabling SSL

« Using an nCipher Secure Accelerator
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SSL in an Oracle Environment

Secure Sockets Layer (SSL) is an industry standard protocol designed by Netscape
Communications Corporation for securing network connections. SSL uses RSA
public key cryptography to provide authentication, encryption, and data integrity
in a public key infrastructure (PKI).

This section discusses the following topics:

=« What You Can Do with SSL

« Components of SSL in an Oracle Environment

« How SSL Works in an Oracle Environment: The SSL Handshake

What You Can Do with SSL

Oracle Advanced Security supports authentication by using digital certificates over
SSL in addition to the native encryption and data integrity capabilities of the SSL
protocol.

By using Oracle Advanced Security SSL functionality to secure communications
between clients and servers, you can

« Use SSL to encrypt the connection between clients and servers
« Authenticate any client or server to one or more Oracle database servers
« Authenticate an Oracle database server to any client

You can use SSL features by themselves or in combination with other authentication
methods supported by Oracle Advanced Security. For example, you can use the
encryption provided by SSL in combination with the authentication provided by
Kerberos. SSL supports any of the following authentication modes:

«  Only the server authenticates itself to the client
« Both client and server authenticate themselves to each other

= Neither the client nor the server authenticates itself to the other, thus using the
SSL encryption feature by itself
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See Also:

« The SSL Protocol, Version 3.0, published by the Internet
engineering Task Force, for a more detailed discussion of SSL

« Chapter 1, Introduction to Oracle Advanced Security, for more
information about authentication methods
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Components of SSL in an Oracle Environment
The components of SSL in an Oracle environment include the following:

« Certificate Authority
« Certificate

«  Wallet

Certificate Authority

A certificate authority (CA) is a trusted third party that certifies the identity of third
parties and other entities, such as users, databases, administrators, clients, and
servers. The certificate authority verifies the party identity and grants a certificate,
signing it with its private key.

Different CAs may have different identification requirements when issuing
certificates. One may require the presentation of a user’s driver’s license, while
others may require notarization of the certificate request form, or fingerprints of the
requesting party.

The CA publishes its own certificate, which includes its public key. Each network
entity has a list of certificates of the CAs it trusts. Before communicating with
another entity, a given entity uses this list to verify that the signature on the other
entity’s certificate is from a known, trusted CA.

Network entities can obtain their certificates from the same or different CAs. By
default, Oracle Advanced Security automatically installs trusted certificates from
VeriSign, RSA, Entrust, and GTE CyberTrust when you install a new wallet.

See Also: "Wallet" on page 7-5

Certificate

A certificate is created when a party’s public key is signed by a trusted certificate
authority (CA). A certificate ensures that a party’s identification information is
correct, and that the public key actually belongs to that party.

A certificate contains the party’s name, public key, and an expiration date—as well
as a serial number and certificate chain information. It can also contain information
about the privileges associated with the certificate.

When a network entity receives a certificate, it verifies that it is a trusted
certificate—one issued and signed by a trusted certificate authority. A certificate
remains valid until it expires or until it is terminated.

7-4 Oracle Advanced Security Administrator's Guide



SSL in an Oracle Environment

Wallet

A wallet is a container that is used to store authentication and signing credentials,
including private keys, certificates, and trusted certificates needed by SSL. In an

Oracle environment, every entity that communicates over SSL must have a wallet
containing an X.509 version 3 certificate, private key, and list of trusted certificates.

Security administrators use the Oracle Wallet Manager to manage security
credentials on the server. Wallet owners use it to manage security credentials on
clients. Specifically, you use Oracle Wallet Manager to do the following:

« Generate a public-private key pair and create a certificate request for an identity
to submit to a certificate authority

« Store a certificate for an entity in the wallet

« Configure trusted certificates for an entity

Note: Installation of Oracle Advanced Security Release 2 (9.2) also
installs Oracle Wallet Manager release 3.0 and Oracle Enterprise
Login Assistant release 9.2.

See Also:

« Chapter 17, Using Oracle Wallet Manager

« Creating a New Wallet on page 17-11.

« Managing Trusted Certificates on page 17-24.
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How SSL Works in an Oracle Environment: The SSL Handshake

When a network connection over SSL is initiated, the client and server perform an
SSL handshake that includes the following steps:

« The client and server establish which cipher suites to use. This includes which
encryption algorithms are used for data transfers.

« The server sends its certificate to the client, and the client verifies that the
server’s certificate was signed by a trusted CA. This step verifies the identity of
the server.

« Similarly, if client authentication is required, the client sends its own certificate
to the server, and the server verifies that the client’s certificate was signed by a
trusted CA.

« Theclient and server exchange key information using public key cryptography.
Based on this information, each generates a session key. All subsequent
communications between the client and the server is encrypted and decrypted
by using this set of session keys and the negotiated cipher suite.

In an Oracle environment, the authentication process consists of the following steps:

1. Onaclient, the user initiates an Oracle Net connection to the server by using
SSL.

2. SSL performs the handshake between the client and the server.

3. If the handshake is successful, the server verifies that the user has the
appropriate authorization to access the database.
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SSL between Non-Oracle Clients and Oracle Database Servers

You can use the Oracle Advanced Security SSL feature to secure connections
between non-Oracle clients and Oracle database servers. For example, SSL can grant

secure access to a browser client outside an Oracle network to authorized data
within the Oracle network.

Figure 7-1 shows how SSL is used to secure connections between Oracle and
non-Oracle entities over the Internet. In this example, a Web server runs as an
Oracle9i Java client. It receives messages over HTTPS (HTTP secured by SSL), and
sends CORBA requests to the Oracle database server over 11OP/SSL (I11OP secured
by SSL). In this example, the Web server passes its own certificate to the Oracle
server, rather than the certificate of the Web client.

Figure 7-1 Connecting to an Oracle Server over the Internet
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SSL Combined with Other Authentication Methods

You can configure Oracle Advanced Security to use SSL concurrently with other
supported authentication methods, such as Kerberos, RADIUS, or CyberSafe, which
are discussed in the following sections:

« Architecture: Oracle Advanced Security and SSL

« Using SSL with Other Authentication Methods
See Also: Appendix A"Data Encryption and Integrity
Parameters" for information about how to configure SSL with other

supported authentication methods, including an example of a
sqgl net . or a file with multiple authentication methods specified.
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Architecture: Oracle Advanced Security and SSL

Figure 7-2, which displays the Oracle Advanced Security implementation
architecture, shows that Oracle Advanced Security operates at the session layer on
top of SSL and uses TCP/IP at the transport layer. This separation of functionality
lets you employ SSL concurrently with other supported protocols.

Figure 7-2 SSL in Relation to Oracle Advanced Security
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See Also: Oracle9i Net Services Administrator’s Guide, for
information about stack communications in an Oracle networking
environment
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Using SSL with Other Authentication Methods

Figure 7-3 illustrates a configuration in which SSL is used in combination with
another authentication method supported by Oracle Advanced Security. In this
example, SSL is used to establish the initial handshake (server authentication), and
an alternative authentication method is used to authenticate the client.

Figure 7-3 SSL in Relation to Other Authentication Methods
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1. The client seeks to connect to the Oracle database server.

2. SSL performs a handshake during which the server authenticates itself to the
client and both the client and server establish which cipher suite to use.

3. Once the SSL handshake is successfully completed, the user seeks access to the
database.

4. The Oracle database server authenticates the user with the authentication server
using a non-SSL authentication method such as Kerberos, CyberSafe, or
RADIUS.

5. Upon validation by the authentication server, the Oracle database server grants
access and authorization to the user.

6. The user accesses the Oracle database securely using SSL.

See Also: "How SSL Works in an Oracle Environment: The SSL
Handshake" on page 7-6
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SSL and Firewalls

Oracle Advanced Security supports two types of firewalls:

« Application proxy-based firewalls, such as Network Associates Gauntlet, or
Axent Raptor.

« Stateful packet inspection firewalls, such as Check Point Firewall-1, or Cisco
PIX Firewall.

When you enable SSL, stateful inspection firewalls behave like application proxy
firewalls because they do not decrypt encrypted packets.

Firewalls do not inspect encrypted traffic. When a firewall encounters data
addressed to an SSL port on an intranet server, it checks the target IP address
against its access rules and lets the SSL packet pass through to permitted SSL ports,
rejecting all others.

With the Oracle Net Firewall Proxy Kit, firewall applications can provide specific
support for database network traffic. If the proxy kit is implemented in the firewall,
the following processing takes place:

« The Net Proxy (a component of the Oracle Net Firewall Proxy kit) must know
where to route its traffic.

« The database listener requires access to a certificate in order to participate in the
SSL handshake. The listener inspects the SSL packet and identifies the target
database, returning the port on which the target database listens to the client.
This port must be designated as an SSL port.

« The client communicates on this server-designated port in all subsequent
connections.

« The number of ports that are open in the firewall increase as a function of the
number of database connections requested. This approach prohibits the
database server from using randomly chosen SSL ports, because the SSL ports
on the firewall must match those chosen by the database. You can avoid this
condition by deploying Oracle Connection Manager, an application included
with Oracle Advanced Security Enterprise Edition.

Oracle Connection Manager lets you route client connections over multiple Net
Manager protocols. Each client connection request establishes an SSL connection
between the client and Oracle Connection Manager, which in turn establishes a
TCP/IP connection with the target database. Multiple clients can thus connect to
multiple databases behind the firewall, using a single SSL port through the firewall.
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Note: Although Oracle Connection Manager can be used to avoid
opening up multiple SSL ports through the firewall, consider the
following:

« The internal connection, between Oracle Connection Manager
and the database, is not an SSL connection. You should encrypt
such connections, using Oracle Advanced Security native
encryption.

« Because such connections do not use SSL, clients cannot use
certificate-based authentication.
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SSL Usage Issues

Consider the following issues when using SSL:

SSL use enables authorization retrieval from an LDAP-based directory service.
Client-side SSL authentication is required in order to manage enterprise users
and their privileges in a directory.

Because SSL supports both authentication and encryption, the client database
server connection is somewhat slower than the standard Oracle Net TCP/IP
transport (using native encryption).

Each SSL authentication mode requires configuration settings.

Note:

U.S. government regulations prohibit double encryption.
Accordingly, if you configure Oracle Advanced Security to use SSL
encryption and another encryption method concurrently, the
connection fails (you also cannot configure SSL authentication
concurrently with non-SSL authentication).

If you configure SSL encryption, you must disable non-SSL
encryption. To disable such encryption, see: Disabling Oracle
Advanced Security Authentication on page 9-3.

See Also:

"Using an nCipher Secure Accelerator" on page 7-35 for
information about improving SSL performance with hardware
accelerators

"Enabling SSL" on page 7-14
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Enabling SSL

To enable SSL:

Task 1: Install Oracle Advanced Security and Related Products
Task 2: Configure SSL on the Client

Task 3: Configure SSL on the Server

Task 4: Log on to the Database

Task 1: Install Oracle Advanced Security and Related Products

Install Oracle Advanced Security on both the client and server. When you do this,
the Oracle Universal Installer automatically installs SSL libraries, Oracle Wallet
Manager, and Oracle Enterprise Login Assistant on your system.

See Also: Oracle9i platform-specific installation documentation

Task 2: Configure SSL on the Client

To configure SSL on the client:

Step 1: Confirm Wallet Creation on the Client

Step 2: Configure Service Name to Include Server DNs and Use TCP/IP with
SSL

Step 3: Specify Required Client Configuration (Wallet Location)
Step 4: Set the SSL Cipher Suites on the Client (Optional)

Step 5: Set the Required SSL Version (Optional)

Step 6: Set SSL as an Authentication Service (Optional)

See Also: Appendix B, "Authentication Parameters"”, for the
dynamic parameter names.
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Step 1: Confirm Wallet Creation on the Client

Before proceeding with the next step, you must confirm that a wallet has been
created.

See Also:

» Chapter 17, Using Oracle Wallet Manager, for general
information about wallets

« Opening an Existing Wallet on page 17-13, for information
about opening an existing wallet

» Creating a New Wallet on page 17-11, for information about
creating a new wallet

Step 2: Configure Service Name to Include Server DNs and Use TCP/IP with SSL
This step contains the following two parts:

« Step 2a. To configure the service name to include server DNs
« Step 2b. To configure the service name to use TCP/IP with SSL
Step 2a. To configure the service name to include server DNs

Oracle Advanced Security Release 2 (9.2) matches the server’s global database name
against the distinguished name (DN) from the server certificate. This protects
against the threat of connections to a server potentially faking its identity, where the
server has a valid X.509 v3 certificate, but not the proper certificate for the
respective database.

To enable DN matching against server certificates, you must manually edit the

t nsnanes. or a file to specify the server’s DN by defining the SSL_ SERVER _
CERT_DN parameter. The client uses this information to obtain the list of DNs it
expects for each of the servers, enforcing the server’s DN to match its service name.
Example 7-1 shows an entry for the Finance database in the t nsnames. or a file.
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Example 7-1 Sample tnsnames.ora File with Server Certificate DN and TCP/IP with
SSL Specified

fi nance=
(DESCR PTI ON\=
(ADDRESS LI ST=
(ACDRESS= (PROTQOCL = tcps) (HCBT = finance_server) (PCRT = 1575)))
( CONNECT_DATA=
(SERV CE_NAME= F nance. us. acne. con))
(SEAR TY=
(SSL_SERVER (ERT_DN="cn=f i nance, cn=Q acl eCont ext , c=us, o=acne"))

The t nsnanes. or a file can be located on the client or in the LDAP directory.

Alternatively, the administrator can ensure that DNs in the certificates from a
trusted certificate authority have a common name (CN) that matches the service
name.

Note: Oracle Corporation recommends that you use Oracle Wallet
Manager to remove the trusted certificate in your Oracle wallet
associated with each certificate authority that you do not use.

See Also:

« "SSL X.509 Server Match Parameters" on page B-14, for
information about the server match parameters

« Chapter 17, Using Oracle Wallet Manager, for information
about using Oracle Wallet Manager

Step 2b. To configure the service name to use TCP/IP with SSL

Example 7-1 also shows an entry that specifies TCP/IP with SSL as the connecting
protocol in the t nsnanes. or a file. To specify TCP/IP with SSL, you must enter

t cps as the PROTOCCL in the ADDRESS parameter of the t nsnanes. or a file. In
addition, you must enter the same information in the ADDRESS parameter of the

I i st ener. or a file. Example 7-2 shows an entry that specifies TCP/IP with SSL as
the protocol.
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Example 7-2 Sample listener.ora File with TCP/IP with SSL Specified as the Protocol

LI STENER=
(DESCR PTI QN LI ST=
(DESCR PTI ON\=
(ACDRESS= (PROTQOCL = tcps) (HOBT = finance_server) (PORT = 1575))))

Alternatively, the administrator can use Oracle Net Manager to configure TCP/IP
with SSL.

See Also:

« Oracle9i Net Services Administrator’s Guide

«  Oracle9i Net Services Reference Guide

For information about using Oracle Net Manager to configure
TCP/IP with SSL.

Step 3: Specify Required Client Configuration (Wallet Location)
To specify required configuration parameters for the client:

1. Start Oracle Net Manager:
«  On UNIX, run net ngr from $ORACLE_HOME/ bi n.

« On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

2. In the Navigator window, expand Local > Profile.

3. From the list in the right pane, select Oracle Advanced Security; the Oracle
Advanced Security SSL window appears (Figure 7-4):
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Figure 7-4 Oracle Advanced Security SSL Window (Client)

Oracle Advanced Security -

~— wallet Configuration
Configuration Method: [File Systern ,]

Wallet Directory:
|a"etc,"0RACLEIWALLETSIDP-THBASES Browse...

— Configure SSL for: ® Client © Server

~— Cipher Suite Configuration

futhentication |Encryption Data Integrity [

L€ ¥

fadd | Remove

Require SSL Wersion: fny v]

Match server ¥.509 name | Yes -

Mote:Ih order to use S5Lfor client connections, you must choose the
protacal, TCPAP with 5L, when configuring net service names,

4. Choose the SSL tab.
5. Select Configure SSL for Client.

6. Inthe Wallet Directory box, enter the directory in which the Oracle wallet is
located, or click Browse to find it by searching the file system.

Important:

» Use Oracle Wallet Manager to create the wallet. See "Step 1:
Create a Database Wallet" on page 15-42.

« Use Oracle Net Manager to set the wallet location in the
sql net . or afile.

Be sure to enter the same wallet location when you create it and
when you set the location in the sqgl net . or a file.
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From the Match server X.509 name drop-down list, choose one of the following
options:

Yes: Requires that the server’s distinguished name (DN) match its service
name. SSL ensures that the certificate is from the server and connections
succeed only if there is a match.

Note: This check can be made only when RSA ciphers are
selected, which is the default setting.

No (default): SSL checks for a match between the DN and the service name,
but does not enforce it. Connections succeed regardless of the outcome, but
an error is logged if the match fails.

Let Client Decide: Enables the default.

Note: The following alert appears when you select No:
Security Alert

Not enforcing the server X.509 name match allows a server to
potentially fake its identity. Oracle Corporation recommends
selecting YES for this option so that connections are refused when
there is a mismatch.

Choose File > Save Network Configuration.

The sql net . or a file on the client is updated with the following entries:

SSL QLI ENT_AUTHENTI CATI ON =TRUE
val l et _|ocation =

(SOURCE=
(METHOD=Fi | €)
( METHD DATA=

(D RECTCRY=wal | et _| ocation)))

SSL_SERVER DN MATCHE( N OFF)
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Step 4: Set the SSL Cipher Suites on the Client (Optional)

A cipher suite is a set of authentication, encryption, and data integrity algorithms
used for exchanging messages between network entities. During an SSL handshake,
two entities negotiate to see which cipher suite they will use when transmitting
messages back and forth.

When you install Oracle Advanced Security, several SSL cipher suites are set for
you by default. You can override the default by setting the SSL_Cl PHER_SUI TES
parameter. For example, if you use Oracle Net Manager to add the cipher suite
SSL_RSA W TH_RC4_128 SHA, all other cipher suites in the default setting are
ignored.

You can prioritize the cipher suites. When the client negotiates with servers
regarding which cipher suite to use, it follows the prioritization you set. When you
prioritize the cipher suites, consider the following:

« The level of security you want to use. For example, triple-DES encryption is
stronger than DES.

= The impact on performance. For example, triple-DES encryption is slower than
DES.

« Administrative requirements:

The cipher suites selected for a client must be compatible with those required
by the server. For example, in the case of an Oracle Call Interface (OCI) user, the
server requires the client to authenticate itself. You cannot, in this case, use a
cipher suite employing Diffie-Hellman anonymous authentication which
disallows the exchange of certificates. By contrast, in the case of an Enterprise
JavaBeans (EJB) user, the server does not require the client to authenticate itself.
In this case, you can use Diffie-Hellman anonymous authentication.

You typically prioritize cipher suites starting with the strongest and moving to the
weakest.

Table 7-1 lists the SSL cipher suites supported in the current release of Oracle
Advanced Security. These cipher suites are set by default when you install Oracle
Advanced Security. This table also lists the authentication, encryption, and data
integrity types each cipher suite uses.

7-20 Oracle Advanced Security Administrator's Guide



Enabling SSL

Table 7-1 Oracle Advanced Security Cipher Suites

Cipher Suite Authentication Encryption :?litaagrity
SSL_RSA_WITH_3DES_EDE_CBC_SHA RSA 3DES EDE CBC SHA
SSL_RSA WITH_RC4 128 SHA RSA RC4 128 SHA
SSL_RSA_WITH_RC4 128 MD5 RSA RC4 128 MD5
SSL_RSA_WITH_DES_CBC_SHA RSA DES CBC SHA
SSL_DH_anon_WITH_3DES_EDE_CBC_SHA DH anon 3DESEDE CBC  SHA
SSL_DH_anon_WITH_RC4 128 MD5 DH anon RC4 128 MD5
SSL_DH_anon WITH_DES_CBC_SHA DH anon DES CBC SHA
SSL_RSA_EXPORT WITH_RC4 40 MD5 RSA RC4 40 MD5
SSL_RSA_EXPORT WITH_DES40 CBC_SHA RSA DES40 CBC SHA
SSL_DH_anon_EXPORT_WITH_RC4 40 MD5 DH anon RC4 40 MD5
SSL_DH_anon_EXPORT_WITH_DES40_CBC_SHA DH anon DES40 CBC SHA

Note: Ifthe SSL_CLI ENT_AUTHENTI CATI ON parameter is set to
true inthe sqgl net . or a file, then disable all cipher suites that use
Diffie-Hellman anonymous authentication. Otherwise, the
connection fails.

To specify cipher suites for the client:

1.

Start Oracle Net Manager:
«  On UNIX, run net mgr from $ORACLE_HOVE/ bi n.

=« On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

In the Navigator window, expand Local > Profile.

From the list in the right pane, select Oracle Advanced Security; the Oracle
Advanced Security SSL window appears (Figure 7-4).

Choose the SSL tab.
Select Configure SSL for Client.
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6. Choose the Add button; a dialog box displays available cipher suites
(Figure 7-5):

Figure 7-5 SSL Cipher Suites Window

I Select a Cipher Suite to enable

fguthentication |Encryption |Data Integrity |:
RSA_EXPORT  RCA_40 MDO5S
RSA_EXPORT DES40_CBC SHA
RSA RC4_128 MDO5S
RSA MULL SHA
RSA MULL MDO5S
RSA JDES_EDE_CBC 5HA
RSA DES_CBC SH#A
RSA RC4_128 SHA
DH_anon JDES_EDE_CBC SHA
DH_anon RC4_128 MDS
DH_anon DES40_CBC SH#A
DH_anon RCg_40 MDS 5
D_k] Cance|
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7. Select a suite and choose OK; the Cipher Suite Configuration list is updated
(Figure 7-6):

Figure 7-6 Oracle Advanced Security SSL Window (Client)

Oracle Advanced Security -

~— wallet Configuration
Configuration Method: [File Systern v]

Wallet Directory:
|fetchRACLEIWALLETSIDHTABASES Browse...

— Configure SSL for: @ Client O Server
~— Cipher Suite Configuration

futhentication |Encryption Data Integrity [
RS& RC4_128 SHA

#dd | Remove

Require SSL Wersion: finy v]

Match server ¥.509 name |‘Yes v]

Mote: In order to use S5Lfor client connections, you must choose the
protocal, TCRAR with 551, when configuring net seruice names,

8. Use the up and down arrows to prioritize the cipher suites.

9. Choose File > Save Network Configuration.
The sqgl net . or a file is updated with the following entry:
SSL_ A PHER SU TES= (SSL_ci pher _suitel [, SSL_ci pher_suite2])
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Step 5: Set the Required SSL Version (Optional)
You can set the SSL_VERSION parameter in the sqgl net . or a file. This parameter
defines the version of SSL that must run on the systems with which the client
communicates. You can require these systems to use SSL 3.0, or any valid, future
version. The default setting for this parameter in sql net . ora isundet er nmi ned,
which is set by selecting Any from the list in the SSL tab of the Oracle Advanced
Security window.
To set the SSL version for the client:
1. Start Oracle Net Manager:

«  On UNIX, run net mgr from $ORACLE_HOVE/ bi n.

=« On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

2. In the Navigator window, expand Local > Profile.

3. From the list in the right pane, select Oracle Advanced Security; the Oracle
Advanced Security SSL window appears (Figure 7-4).

4. Choose the SSL tab.
5. Select Configure SSL for Client.

6. Inthe Require SSL Version scroll box the default is Any; accept this default or
select the SSL version you want to configure.

7. Choose File > Save Network Configuration.
The sqgl net . or a file is updated with the following entry:
SSL VERS ON-UNDETERM NED
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Step 6: Set SSL as an Authentication Service (Optional)

The SQLNET. AUTHENTI CATI ON_SERVI CES parameter in the sql net . or a file
sets the SSL authentication service.

Set this parameter if you want to use SSL authentication in conjunction with
another authentication method supported by Oracle Advanced Security. For
example, use this parameter if you want the server to authenticate itself to the client
by using SSL and the client to authenticate itself to the server by using Kerberos.

To set the SQLNET. AUTHENTI CATI ON_SERVI CES parameter:

Add TCP/IP with SSL (TCPS) to this parameter in the sqgl net . or a file by using a
text editor. For example, if you want to use SSL authentication in conjunction with
RADIUS authentication, set this parameter as follows:

SQNET. AUTHENTI CATI QN SERVI CES = (TCPS, radi us)

If you do not want to use SSL authentication in conjunction with another
authentication method, then do not set this parameter.
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Task 3: Configure SSL on the Server

During installation, Oracle sets defaults on both the Oracle database server and on
the Oracle client for all SSL parameters except the location of the Oracle wallet. To
configure SSL on the server, perform these steps:

« Step 1: Confirm Wallet Creation

« Step 2: Specify Required Server Configuration (Wallet Location)
« Step 3: Set the SSL Cipher Suites on the Server (Optional)

« Step 4: Set the Required SSL Version (Optional)

« Step 5: Set SSL Client Authentication (Optional)

« Step 6: Set SSL as an Authentication Service (Optional)

« Step 7: Create Listening Endpoint that Uses TCP/IP with SSL

See Also:  Appendix B, "Authentication Parameters" for the
dynamic parameter names

Step 1: Confirm Wallet Creation

Before proceeding with the next step, you must confirm that a wallet has been
created.

See Also:

« Chapter 17, Using Oracle Wallet Manager, for general
information about wallets

« Opening an Existing Wallet on page 17-13, for information
about opening an existing wallet

« Creating a New Wallet on page 17-11, for information about
creating a new wallet
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Step 2: Specify Required Server Configuration (Wallet Location)
To specify required configuration parameters for the server:

1.

Start Oracle Net Manager:
«  On UNIX, run net mgr from $ORACLE_HOVE/ bi n.

=« On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

In the Navigator window, expand Local > Profile.

From the list in the right pane, select Oracle Advanced Security; the Oracle
Advanced Security SSL window appears (Figure 7-4).

Choose the SSL tab.
Select Configure SSL for Server.

In the Wallet Directory box, enter the directory in which the Oracle wallet is
located, or click the Browse button to find it by searching the file system.

Important:

» Use Oracle Wallet Manager to create the wallet. See "Step 1:
Create a Database Wallet" on page 15-42.

« Use Oracle Net Manager to set the wallet location in the
sgl net . or a file.

Be sure to enter the same wallet location when you create it and
when you set the location in the sqgl net . or a file.

Choose File > Save Network Configuration.

The sgl net.oraandl i st ener. or a files are updated with the following
entries:

wal l et _|ocation =
(SARE=
(METHOD=F | €)
(METHOD DATA=
(D RECTCRY=wval | et _| ocation)))
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Note: The listener uses the wallet defined in | i st ener. or a (it
can use any database wallet). When SSL is configured for a server
using Net Manager, the wallet location entered into

I i st ener. ora is the same as that entered into sqgl net . or a.

The location of the listener wallet is not relevant to the Oracle
client, because the client is only performing an SSL handshake with
the listener.

To change the listener wallet location (so that the listener has its
own wallet), you can edit | i st ener . or a to enter the new
location.

Step 3: Set the SSL Cipher Suites on the Server (Optional)

A cipher suite is a set of authentication, encryption, and data integrity algorithms
used for exchanging messages between network entities. During an SSL handshake,
two entities negotiate to see which cipher suite they will use when transmitting
messages back and forth.

When you install Oracle Advanced Security, several SSL cipher suites are set for
you by default. You can override the default by setting the SSL_Cl PHER _SUI TES
parameter. For example, if you use Oracle Net Manager to add the cipher suite SSL_
RSA W TH RC4_128 SHA, all other cipher suites in the default setting are ignored.

You can prioritize the cipher suites. When the client negotiates with servers
regarding which cipher suite to use, it follows the prioritization you set. When you
prioritize the cipher suites, consider the following:

« The level of security you want to use. For example, triple-DES encryption is
stronger than DES.

« The impact on performance. For example, triple-DES encryption is slower than
DES.

« Administrative requirements:

The cipher suites selected for a server must be compatible with those required
by the client.

You typically prioritize cipher suites starting with the strongest and moving to
the weakest.
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Note: In Oracle Advanced Security Release 2 (9.2), if you set a
cipher suite employing Diffie-Hellman anonymous authentication
on the server, you must also set the same cipher suite on the client.
Otherwise, the connection fails.

If you use a cipher suite employing Diffie-Hellman anonymous,
you must set the SSL_CLIENT_AUTHENTICATION parameter to
FALSE. See: Step 5: Set SSL Client Authentication (Optional) on
page 7-32.

Table 7-1 lists the SSL cipher suites supported in the current release of Oracle
Advanced Security. These cipher suites are set by default when you install Oracle
Advanced Security. This table also lists the authentication, encryption, and data
integrity types each cipher suite uses.
To specify cipher suites for the server:
1. Start Oracle Net Manager:

«  On UNIX, run net ngr from $ORACLE_HOME/ bi n.

« On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

2. In the Navigator window, expand Local > Profile.

3. From the list in the right pane, select Oracle Advanced Security; the Oracle
Advanced Security SSL window appears (Figure 7-4).

4. Choose the SSL tab.
5. Select Configure SSL for Server.

6. Choose the Add button; a dialog box displays available cipher suites
(Figure 7-5).
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7. Select a suite and choose OK; the Cipher Suite Configuration list is updated
(Figure 7-7):

Figure 7-7 Oracle Advanced Security SSL Window (Server)

Oracle ddvanced Security -

wWallet Directory:
|a"etc;"0RHCLE!WHLLETSJ’DATHBASES Browse..,

Cipher Suite Configuration

P.uthentication|Encryption |Data Integrity |
RSA RC4_128 SH&

&

fAdd | Remove
Require SSL Wersion:

W Require Client Authentication

Mote:In order to use S5LTar server connections, pou must choose
the protocal, TCPAP with 551, when configuring the Listener,

8. Use the up and down arrows to prioritize the cipher suites.

9. Choose File > Save Network Configuration.
The sql net . or a file is updated with the following entry:
SSL A PHER SU TES= (SSL_ci pher_suitel [, SSL_ci pher_suite2])
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Step 4: Set the Required SSL Version (Optional)
You can set the SSL_VERSION parameter in the sql net . or a file. This parameter
defines the version of SSL that must run on the systems with which the client
communicates. You can require these systems to use SSL 3.0, or any valid, future
version. The default setting for this parameter in sql net . ora is undet er ni ned,
which is set by selecting Any from the list in the SSL tab of the Oracle Advanced
Security window.
To set the SSL version for the server:
1. Start Oracle Net Manager:

«  On UNIX, run net mgr from $ORACLE_HOVE/ bi n.

=« On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

2. In the Navigator window, expand Local > Profile.

3. From the list in the right pane, select Oracle Advanced Security; the Oracle
Advanced Security SSL window appears (Figure 7-4).

4. Choose the SSL tab.
5. Select Configure SSL for Server.

6. Inthe Require SSL Version scroll box the default is Any; accept this default or
select the SSL version you want to configure.

7. Choose File > Save Network Configuration.
The sqgl net . or a file is updated with the following entry:
SSL VERS ON-UNDETERM NED

Note: SSL 2.0 is not supported on the server side.
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Step 5: Set SSL Client Authentication (Optional)

The SSL_CLIENT_AUTHENTICATION parameter in the sql net . or a file controls
whether the client is authenticated using SSL. The default value is TRUE.

You must set this parameter to FALSE if you are using a cipher suite that contains
Diffie-Hellman anonymous authentication (DH_anon). Also, you can set this
parameter to FALSE for the client to authenticate itself to the server by using any of
the non-SSL authentication methods supported by Oracle Advanced Security, such
as Kerberos or CyberSafe.

To set this parameter to FALSE:
1. Start Oracle Net Manager:
«  On UNIX, run net mgr from $ORACLE_HOVE/ bi n.

=« On Windows NT, choose Start > Programs > Oracle - HOME_NAME >
Network Administration > Oracle Net Manager.

2. In the Navigator window, expand Local > Profile.

3. From the list in the right pane, select Oracle Advanced Security; the Oracle
Advanced Security SSL window appears (Figure 7-8):
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Figure 7-8 Oracle Advanced Security SSL Window (Server)

Oracle Advanced Security A

— Wwallet Configuration
Cenfiguration Method: [File System ,]

Wallet Directory:

0 Browse..

— Configure SSL for © Client ® Server

~— Cipher Suite Configuration

Authentication |Encryption Data Integrity r

&add | Remove
Require S5L Wersion: |P.ny -

W Require Client Authentication

Mote: Ih order to use S5L for server connections, you must choose the
protocal, TCPAP with 551, when configuring the Listener,

Choose the SSL tab.

Select Configure SSL for Server.

Deselect Require Client Authentication.

N oo o &

Choose File > Save Network Configuration.
The sqgl net . or a file is updated with the following entry:
SSL_CLI ENT_AUTHENTI CATI ON=FALSE
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Step 6: Set SSL as an Authentication Service (Optional)
The SQLNET. AUTHENTI CATI ON_SERVI CES parameter in the sql net . or a file
sets the SSL authentication service.

Set this parameter if you want to use SSL authentication in conjunction with
another authentication method supported by Oracle Advanced Security. For
example, use this parameter if you want the server to authenticate itself to the client
by using SSL and the client to authenticate itself to the server by using Kerberos.

To set the SQLNET. AUTHENTI CATI ON_SERVI CES parameter:

Add TCP/IP with SSL (TCPS) to this parameter in the sqgl net . or a file by using a
text editor. For example, if you want to use SSL authentication in conjunction with
RADIUS authentication, set this parameter as follows:

SQNET. AUTHENTI CATI QN SERVI CES = (TCPS, radi us)

If you do not want to use SSL authentication in conjunction with another
authentication method, then do not set this parameter.

Step 7: Create Listening Endpoint that Uses TCP/IP with SSL

Configure the listener with a TCP/IP with SSL listening endpoint in the
l'i stener.ora file. Oracle Corporation recommends a port number 2484 for typical
Oracle Net clients and 2482 for client connections to Oracle9i JServer.

See Also: Oracle9i Net Services Administrator’s Guide.

Task 4: Log on to the Database

If you are using SSL authentication, launch SQL*Plus and enter the following:
QO\NECT/ @Inet _ser vi ce_nane

If you are not using SSL authentication, launch SQL*Plus and enter the following:

QO\NECT  user nane/ passwor d@et _ser vi ce_nane
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Using an nCipher Secure Accelerator

SSL handshake operations make heavy processing demands on a system, which
may result in slower server and transaction performance. SSL hardware accelerators
offload SSL processing from the server, freeing the CPU to respond to other
transactions. Oracle Advanced Security uses nCipher BSAFE Hardware APIs
(BHAPI), to support SSL hardware acceleration. Using this interface, Oracle
integrates with nCipher secure accelerators.

Note: You must contact your nCipher representative to obtain the
certified versions of nCipher cards and software.

Required Oracle Components To Use an nCipher Secure Accelerator
To use an nCipher Secure Accelerator, you need the following components:

« nCipher Secure Accelerator

« Supporting nCipher BHAPI library for your platform as follows:
—  (Unix) | i bnf bhapi . so library
— (Windows NT) nf bhapi . dl | library

Note: You must contact your nCipher representative to have the
secure accelerator installed and to acquire the necessary library.

These tasks must be performed before you can use an nCipher
Secure Accelerator with Oracle Advanced Security.
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Configuring Oracle Advanced Security To Use an nCipher Secure Accelerator

To use the secure accelerator, you must place the path to the directory that contains
the nCipher BHAPI library in the following locations:

«  (UNIX) user’'sLD_LI BRARY_PATH
« (Windows) user’s PATH

This enables the library to be loaded at runtime. Typically, the nCipher card is
installed at the following locations:

« (UNIX)/ opt/ nf ast
« (Windows) C: \ nf ast

The nCipher BHAPI library is in the directory where the secure accelerator is
installed at the following location:

/tool ki t s/ nf bhapi /

Troubleshooting Using nCipher Secure Accelerator

To detect whether the nCipher accelerator is being used, you can turn on SQL*Net
tracing. If nCipher software is being used, then you will see the following entries in
the SQL*Net tracing file without error messages logged between ent ry and exi t :

nzos_i ni tbhapi: entry
nzos_i ni tbhapi : exit
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SQL*Net Tracing File Error Messages Associated with Using nCipher Secure
Accelerator

If error messages are logged between the ent ry and exi t entries in the SQL*Net
tracing file, then check the following list of possible error messages for information
about how to resolve them.

nzos_initbhapi: Failed to load libnfbhapi.so. BHAPI will not be used
Cause: The system cannot locate the nCipher BHAPI library.

Action: Ensure that the directory which contains the nCipher BHAPI library is
present in the user’s system path.

See Also: "Configuring Oracle Advanced Security To Use an
nCipher Secure Accelerator" on page 7-36 for information about
where to include the path to the nCipher BHAPI library in the
user’s system path.

nzos_initbhapi: Error in B_CreateSessionChooser. Returned <err #>
Cause: The nCipher secure accelerator may not be running.

Action: Ensure that the secure accelerator is up by running the / bi n/ enqui ry
utility from the directory where the nCipher card is installed.

Note: The nCipher log file is in the directory where the secure
accelerator is installed at the following location:

/log/logfile

See Also: nCipher documentation for further information about
troubleshooting.
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Configuring Entrust-Enabled SSL
Authentication

This chapter describes how to configure and use Entrust-enabled Oracle Advanced
Security for Secure Socket Layer (SSL) authentication. It contains the following
topics:

Overview

System Components

Entrust Authentication Process
Enabling Entrust Authentication
Issues and Restrictions

Troubleshooting Entrust In Oracle Advanced Security
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Overview

A public key infrastructure (PKI) includes various elements, such as a public key,
bound into a digital certificate, a private key, and certain other security credentials.
These credentials can be used for secure authentication over a Secure Sockets Layer
(SSL) connection, to establish a secure communication channel, and to generate and
process digital certificates—including digital signatures. A complete PKI includes
the following:

« Certificate revocation status checking

« Easy management of user keys and certificates

« Easy deployment, hiding PKI complexity from users

This section describes the PKI implementation provided by the following:
« Oracle Advanced Security

«  Entrust/PKI

« Entrust-Enabled Oracle Advanced Security

Oracle Advanced Security

Oracle Advanced Security includes elements of a PKI, such as Oracle Wallet
Manager, which creates and securely stores a user's public/private key pair, as well
as the trust points (the list of root certificates the user trusts). The user's PKI
credentials, stored in Oracle Wallet Manager, can be used to create a secure,
authenticated session over SSL. However, Oracle Advanced Security does not
provide certificate creation or certificate revocation status checking, which are
important elements of a complete PKI.

For example, although Oracle Wallet Manager can generate a PKCS#10 certificate
signing request, users must obtain certificate fulfillment from a certificate authority
and load the resulting certificate into an Oracle wallet. Oracle wallets only support
authentication to Oracle applications.

Entrust/PKI

Entrust/PKI is a PKI product provided by Entrust Technologies, Inc., that provides
certificate generation, certificate revocation, and key and certificate management.
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Entrust-Enabled Oracle Advanced Security

The integration of Oracle Advanced Security with Entrust/PKI enables users of
both Entrust and Oracle to utilize the extensive PKI capabilities of Entrust to
enhance the security of their Oracle environment.

Entrust-enabled Oracle Advanced Security provides:
« Enhanced X.509-Based Authentication and Single Sign-On
« Integration with Entrust/PKI Key Management

« Integration with Entrust/PKI Certificate Revocation

Note:

« Oracle Advanced Security has been certified as Entrust-Ready
by Entrust Technologies Inc., as of Release 8.1.7.

« SeeAlso:http://ww. entrust.com

Enhanced X.509-Based Authentication and Single Sign-On

Entrust-enabled Oracle Advanced Security supports the use of Entrust credentials
for X.509-based authentication and single sign-on. Instead of using an Oracle wallet
to hold user PKI credentials, Oracle Advanced Security can access PKI credentials
that are created by Entrust/Authority and held in an Entrust profile (a . epf file).
Users who have deployed Entrust software within their enterprise are thus able to
use it for authentication and single sign-on to Oracle9i.

Integration with Entrust/PKI Key Management

Entrust-enabled Oracle Advanced Security uses the extensive key management and
rollover functionality provided by Entrust/PKI, which shields users from the
complexity of a PKI deployment. For example, users are automatically notified
when their certificates are expiring, and certificates are reissued according to
preferences that administrators can configure.

Integration with Entrust/PKI Certificate Revocation
Entrust provides a certificate authority component, which natively checks certificate
revocation status and enables the revocation of certificates.

Users using Entrust credentials for authentication to Oracle are assured that the
revocation status of the certificate is checked, and connections are prevented if the
certificate is revoked.
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System Components

This section describes the system components required for using Entrust-enabled
Oracle Advanced Security:

« Entrust/PKI 6.0 for Oracle
« Entrust/Toolkit Server Login 6.0
« Entrust IPSEC Negotiator Toolkit 6.0

Note: In the following sections, the term client refers to a client
connecting to an Oracle database, and the term server refers to the
host on which the Oracle database resides.

Entrust/PKI 6.0 for Oracle can be downloaded from the Entrust Web site:

htt p: //waw ent rust . com

Entrust/Toolkit Server Login and Entrust IPSEC Negotiator Toolkit can be
downloaded from the Entrust Developer Network by registered members. Users

can register for membership and download these products at the following Web
address:

htt p: // wa ent rust . cond devel oper / menber shi ps/regi stration. ht m

Note: Oracle Advanced Security supports Entrust/PKI versions
5.0.2,5.1, and 6.0.

Entrust/PKI 6.0 for Oracle

Entrust/PKI 6.0 for Oracle requires a database for storing information about Entrust
users and the infastructure, and a Lightweight Directory Access Protocol
(LDAP)-compliant directory for information such as user names, public certificates,
and certificate revocation lists.

Entrust/PKI 6.0 for Oracle is comprised of the following software components:
« Entrust/Authority
« Entrust/RA

« Entrust/Entelligence
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Entrust/Authority

Entrust/Authority is the centerpiece of Entrust/PKI. It performs core certificate
authority, certificate, and user management functions, such as creating users and
user profiles containing the user’s credentials.

Note: Oracle Corporation only supports the use of
Entrust-enabled Oracle Advanced Security with versions of
Entrust/Authority that run on Oracle9i.

See Also: Chapter 7, Configuring Secure Sockets Layer
Authentication, for information about certificate authorities.

Entrust/Authority supports unattended login, also called Server Login, which
eliminates the need for a Database Administrator (DBA) to repeatedly enter a
password for the Entrust profile on the server. With unattended login, the DBA
need only enter a password once to open the Entrust profile for the server to
authenticate itself to multiple incoming connections.

Entrust/RA
Entrust/RA is the administrator’s secure interface to Entrust/Authority.

Entrust/Entelligence

Entrust/Entelligence provides support for user key management and single sign-on
functionality on both clients and server by enabling Oracle9i server process access
to incoming SSL connections.

Note: Do not install Entrust/Entelligence on the server computer
if it is running on a Windows platform.
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Entrust/Toolkit Server Login 6.0

Entrust IPSEC

Entrust/Toolkit Server Login Toolkit Release 6.0 is required for single sign-on
functionality on servers operating on UNIX platforms.

Entrust/Server Login Toolkit provides single sign-on by enabling Oracle9i server
process access to incoming SSL connections. Without this capability, a database
administrator or other privileged user would have to enter the password for the
Entrust profile on the server for every incoming connection.

You can download Entrust/Toolkit Server Login from the Entrust \Web site:

http: // wan ent rust . com devel oper/ sof twar e/ fi | es/ desc_serverl ogi n. cfm

Negotiator Toolkit 6.0

The Entrust IPSEC Negotiator Toolkit Release 6.0 is required on both clients and
servers for integrating the Oracle Advanced Security SSL stack with Entrust/PKI,
enabling SSL authentication to use Entrust profiles.

You can download the IPSEC Negotiator Toolkit from the Entrust Web site:

ht t p: // waw ent rust . cond devel oper / sof t war e/ i ndex. ht m
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Entrust Authentication Process
Figure 8-1 illustrates the following Entrust authentication process:

1. The Entrust user on the Oracle client establishes a secure connection with the
server using SSL and Entrust credentials.

2. The Oracle SSL adapter on the server communicates with the Entrust Authority
to check the certificate revocation status of the Entrust user.

Note: Figure 8-1 does not include client and server profiles
creation, which is presumed.

Figure 8-1 Entrust Authentication Process

Entrust

Administration

User's ~ Server's
Entrust N Entrust
Profile Profile

See Also: How SSL Works in an Oracle Environment: The SSL
Handshake on page 7-6

Configuring Entrust-Enabled SSL Authentication 8-7



Enabling Entrust Authentication

Enabling Entrust Authentication

This section describes the following tasks that enable Entrust-enabled Oracle
Advanced Security SSL authentication:

« Creating Entrust Profiles

« Installing Oracle Advanced Security and Related Products
« Configuring SSL on the Client and Server

« Configuring Entrust on the Client

« Configuring Entrust on the Server

« Creating Database Users

« Logging Into the Database

Creating Entrust Profiles

This section describes how to create Entrust profiles. Entrust profiles can be created
by either administrators or users. On UNIX platforms, administrators create the
Entrust profiles for all clients. On Windows platforms, users can be permitted to
create their own Entrust profiles.

Administrator-Created Entrust Profiles
Administrators create Entrust profiles as follows:

1. The Entrust administrator adds the Entrust user using the Entrust/RA tool.

See Also: The Entrust administration documentation for
information about creating Entrust Users

2. The administrator enters the user’s name and password.

3. The Entrust Authority creates the profile, or. epf file.

4. The administrator securely sends all profile-related files to the user. The preset
password can be changed by the user.
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User-Created Entrust Profiles
Entrust users create their own Entrust profiles as follows:

1. The Entrust administrator adds the Entrust user using the Entrust/RA tool. In
the New User dialog box, the Create Profile option should be deselected.

See Also: The Entrust administration documentation for
information about creating Entrust profiles

2. The user receives a secure e-mail notification from the administrator that
contains a reference number, authorization code, and expiration date.

3. The user navigates to the Create Entrust Profiles screen in Entrust/Entelligence
as follows:

Start > Programs > Entrust > Entrust Profiles > Create Entrust Profiles

4. The user enters the reference number, authorization code, and expiration date
provided in the e-mail notification, creating a profile, or. epf file, and the
Entrust initialization file.

Installing Oracle Advanced Security and Related Products

For Oracle Advanced Security Release 2 (9.2), Entrust support installs in Typical
mode. A single Oracle installation supports the use of both Oracle Wallets and
Entrust Profiles.

See Also: Oracle9i operating system-specific installation
documentation

Notes:

« Installing Entrust on a UNIX server uses different parameters
than in prior releases

« See Also: Configuring Entrust on a UNIX Server on page 8-12
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Configuring SSL on the Client and Server
Configure SSL on the client and server.
See Also: Chapter 7, Configuring Secure Sockets Layer
Authentication, for information about configuring SSL on the client

and server; skip the section that describes the Oracle wallet
location.

Configuring Entrust on the Client

The steps for configuring Entrust on the client vary according to the type of
platform:

« Configuring Entrust on a UNIX Client

« Configuring Entrust on a Windows Client

Configuring Entrust on a UNIX Client
If the client resides on a non-Windows platform, perform the following steps:
1. Setthe JAVA HOME variable to JDK or JRE location.

For example:

>set env JAVA HOME $CRACLE HOMEH JRE

2. Set WALLET LOCATI ON inthe sgl net . ora file.
For example:

WALLET LOCATI O\=
( SOURCE=
(METHDD=ent r)
( METHOD DATA =
(PRCFI LE=profil e_l ocati on)
(INFLE=initialization file_location)
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Configuring Entrust on a Windows Client

If the client resides on a Windows platform, ensure that the Entrust/Entelligence
component is installed on the client and perform the following steps to set up the
Entrust credentials.

1. Setthe WALLET_LOCATI ONparameter in the sql net . ora file.
For example:

WALLET_LQCATI ON\=
(SORCE=
(METHD=ent r)
(METHCD _DATA=
(INFILE=initialization file_|ocation)
)

)
whereinitialization_file_locationisthe pathtothe.ini file.

2. Choose the Entrust icon on the system tray to open the Entrust_Login dialog
box.

3. Log on to Entrust by entering the profile name and password.
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Configuring Entrust on the Server

The steps for configuring Entrust on the server vary according to the type of
platform:

« Configuring Entrust on a UNIX Server

« Configuring Entrust on a Windows Server

Configuring Entrust on a UNIX Server

If the server is a UNIX platform, ensure that the Entrust/Server Login Toolkit
component is installed on the server and perform the following steps:

See Also: System Components on page 8-4 for information about
downloading the Entrust/Toolkit Server Login.

1. Stop the Oracle database instance.

2. Setthe WALLET_LOCATI ON parameter in the sql net . ora and
I i st ener. or a files to specify the paths to the server’s profile and the Entrust
initialization file:

WALLET LOCATI ON =

(SORCE =
(METHD = ENTR
( METHOD DATA =
(PRCFILE = profile_location)
(INFLE =initialization_file_|location)
)
)

3. Set the CLASSPATH environment variable to include the following paths:

$CRACLE HOME/ JRE/ 1 i b/ rt . jar

$CARACLE HOME/ JRE/ i b/ i 18n. j ar

SCRACLE HOME j i b/ewt . jar

$CRACLE HOME j 1 i b/ hel p*. j ar
$CRACLE HOME/ j | i b/ share*. j ar

$CARACLE HOME/ j | i b/ swi ngal | *. j ar

$CRACLE HOME networ k/j i b/ netentrust. jar

4. Enter the et bi nder command to create unattended login credentials, or. ual
files by using the following steps:

a. Setthe PATHenvironment variable to include the path to the et bi nder
command, which is located in the / bi n directory where the Server Login
Toolkit is installed.
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5.

Set the LD _LI BRARY_PATHto include the path to the Entrust libraries.

Set the SSL_ENTRUST | NI environment variable to include the full path to
the Entrust initialization file.

Enter the command as follows:
et bi nder
When prompted to enter the location of the profile file, enter the full path

name, including the name of the file. Then, when prompted, type in the
password.

A message displays indicating that the credentials file (f i | enane. ual )
has been created.

Note: Ensure that the listener has a TCPS listening endpoint, then
start the listener.

Start the Oracle database instance.
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Configuring Entrust on a Windows Server
If the server is on a Windows platform, perform the following steps:

See Also: System Components for information about
downloading Entrust/Entelligence.

1. Stop the Oracle database instance.

2. Setthe WALLET L OCATI ONparameter in the sql net. ora and
I i st ener. or a files to specify the paths to the server’s profile and the Entrust
initialization file:

VALLET LOCATI ON =

(SORCE =
(METHDD = ENTR)
( METHOD DATA =

(PRCFILE = profile_|location)
(INFILE=initialization_ file_|location)

)

3. Run the Entrust binder command to create unattended login credentials, which
are files with a. ual extension. Ensure that the owner of the . ual file is the
same as the owner of the Oracle service.

To run the binder command choose
Start > Programs > Entrust Toolkit > Server Login > Entrust Binder

Enter the path to the profile, the password, and the path to the Entrust
initialization file. A message informs you that you have successfully created a
credential file.

4. Start the Oracle database instance.

Note: For all Windows environments, Oracle Corporation
recommends the following:

« Do notinstall Entrust/Entelligence on the server computer.

« Use the Server Login Toolkit to generate the unattended login
credentials (the . ual file) and access the database from a
Windows client where Entrust/Entelligence is installed.
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Creating Database Users

Create global users in the database based on the distinguished name (DN) of each
Entrust user.

For example:

SQL> create user jdoe identified globally as
' cn=j doe, o=or acl e, c=us’ ;

where "cn=j doe, o=oracle, c=us" isthe Entrust distinguished name of
the user.

Logging Into the Database

1. Use SQL*Plus to connect to the Oracle instance as follows:
sqgl plus / @ns_servi ce_nane
where t ns_ser vi ce_nane is the service name of the Oracle instance.
The Entrust_Login dialog box appears.

2. Enter the path to the profile and the password.

3. If you did not specify a value for the WALLET LOCATI ON parameter, you are
prompted to enter the path to the Entrust initialization file.

Note: Oracle Corporation recommends that the initialization file
be specified in the WALLET_LOCATI ON parameter file.
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Issues and Restrictions

An application must be specifically modified to work with Entrust. If a product is
designated as Entrust-ready, then it has been integrated with Entrust by using an
Entrust toolkit.

For example, Oracle has modified its SSL libraries to access an Entrust profile
instead of an Oracle wallet. Accordingly, the Entrust profile is not accessible from
standard SSL libraries.

In addition, the following restrictions apply:

« The use of Entrust components for digital signatures in applications based on
Oracle is not supported.

«  The Entrust-enabled Oracle Advanced Security integration is only supported
with versions of Entrust/PKI Release 5.0.2, 5.1, and 6.0 running on Oracle9i.

« The use of earlier releases of Entrust/Authority with Entrust-enabled Oracle
Advanced Security is not supported.

« Interoperability between Entrust and non-Entrust PKIs is not supported.

« Entrust has certified Oracle Internet Directory version 2.1.1 for Release 8.1.7 and
subsequent releases.
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Troubleshooting Entrust In Oracle Advanced Security

This section describes how to diagnose errors returned from Entrust to Oracle
Advanced Security users.

Note: Entrust returns the following generic error message to
Oracle Advanced Security users:

ORA- 28890 "Entrust Login Fail ed"

This troubleshooting section describes how to get more details
about the underlying error, and how to diagnose the problem.

Error Messages Returned When Running Entrust on Any Platform

You may encounter the following error messages regardless of what platform you
are running Entrust on.

ORA-28890 Entrust Login Failed

Cause: SQL*Plus login on an Entrust-enabled Oracle client errors out with this
generic error message. This error can be caused by a number of problems,
including the following causes:

Entrust /Authority is not online

Invalid Entrust profile password specified
Invalid path to the Entrust profile specified
Invalid Entrust initialization file specified

Entrust Server Login program has not executed on the server

Action: To get more detail on the Entrust error, turn on tracing for SQL*Plus
and the trace output should indicate the Entrust failure code. Enable tracing by
specifying the following parameters in the sql net . or a file:

On the client:

TRACE_LEVEL_CLI ENT=16

TRACE DI RECTORY_CLI ENT=<valid_client_directory_name>
TRACE_FI LE_CLI ENT=cl i ent

TRACE_UNI QUE_CLI ENT=0ON
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On the server:

« TRACE_LEVEL_SERVER=16

« TRACE DI RECTORY_SERVER=<valid_server_directory hame>
« TRACE_FI LE_SERVER=ser ver

. TRACE_UNI QUE_SERVER=ON

Search for and locate the string | KMP in the generated trace file. Adjacent to this
string, error messages are listed that provide details about the problem you are
encountering. This detailed error code information is returned by the Entrust
API.

Note: The following are examples of valid client directory names
for setting the TRACE_DI RECTORY_CLI ENT or TRACE _
DI RECTORY_SERVER parameters in the sqgl net . or a file:

« (UNIX)/tnmp
«  (Windows) C. \ TEMP

ORA-28890 Entrust Login Failed
(GUI does not display on the client)

Cause: The WALLET _LOCATI ON parameter does not specify the Entrust
initialization file location in the client side sl gnet . or a file.

Action: Ensure that the location of the Entrust initialization file is specified in
the WALLET _LOCATI ON parameter in the sqgl net . or a file on the client.

See Also:
» "Configuring Entrust on a UNIX Client" on page 8-10

« "Configuring Entrust on a Windows Client" on page 8-11
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Error Messages Returned When Running Entrust on Windows Platforms

You may encounter the following error messages if you are running Entrust on a
Windows platform.

The software authentication failed. (error code - 162).

Cause: Due to a known FIPS mode incompatibility, Entrust logins may fail and
return this error message.

Action: Contact Entrust support to resolve this issue.

Algorithm self-test failed. (error code - 176).

Cause: Due to a known symbol conflict between Entrust and Oracle libraries,
Entrust login may fail and return this error message.

Action: Contact Entrust support to resolve this issue.

TNS-12560: TNS protocol adapter error
TNS-00558> Entrust Login Failed
ORACLE SERVER (host_name)

This error may occur in the | i st ener . | og file on the server when you attempt to log
in to Entrust.

Cause: If you configure the client by making the following recommended
changes:

« Remove the . ual file
« De-install the Server Login

« Specify the Entrust initialization file location in the SSL_ ENTRUST _| NI _
FI LE parameter in the client sql net . or a file

then the server may not be able to authenticate the client when you enter the
following command:

sql pl us/ @ns_ser vi ce_nane
Action: Perform the following tasks to enable tracing on the server:

1. Choose Control Panel > Services.

2. Inthe Services dialog box, double click OracleTNSListener and change the
Log On As from the System Account to the account that is currently logged
in. This enables the server process to read the . ual file. Click OK to make
the change and you are returned to the Services dialog box.

In the Services dialog box, make the same changes for OracleService.

Configuring Entrust-Enabled SSL Authentication 8-19



Troubleshooting Entrust In Oracle Advanced Security

3. Make the following changes to the | i st ener . or a file:

—  Specify only TCPS as the PROTOCOL in the listener ADDRESS. For
example, change all of the PROTOCOL definitions to TCPS as follows:

|'i stener_nane=
(DESCR PTI ON=
( ADDRESS=( PROTAOAL=TCPS) ( KEY=ext procO0))
( ADDRESS=( PROTAOOL=TCPS) (HOBT=sal es-pc) (PORT=1521)))

Bringing up the listener only using TCPS will show whether there is a
problem accessing the Entrust profile when you turn on tracing.

— Setthe SSL_CLI ENT_AUTHENTI CATI ON parameter to FALSE as
follows:

SSL_ QLI ENT_AUTHENTI CATI ON=FALSE

— Turn on tracing by setting the following parameters:

TRACE LEVEL LI STENER=16
TRACE Dl RECTCRY_LI STENER=C \ t enp

The trace file is created in the C: \ t enp directory.
4. Make the following changes to the sqlnet.ora file to turn on tracing:
TRACE LEVEL._SERVER-16
TRACE D RECTCRY_SERVER=C \'t enp
The trace file is created in the C: \ t enp directory.
5. Ensure that Entrust/Entelligence is not installed on the server.

Search for and locate the string "f ai | " or "nt z* " function calls. Adjacent to these,
error messages are listed that provide details about the problem you are
encountering.
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General Checklist for Running Entrust on Any Platform
The following items apply to all platforms:

1. Confirm that the Entrust/Authority is online.

2. Confirm that the . ual file is generated. These files are created for unattended
login credentials.

Note: Oracle Corporation recommends that you generate an
unattended login credential file (. ual file) for the server only. If
you generate a . ual file for the server only, then when users
attempt to log in, they are presented a GUI that prompts them for
their password and their Entrust profile name. After users supply
this information, the connection request is forwarded to the Entrust
server, which looks up the revocation file and the . ual file to
determine the permissions for granting the request.

3. Confirm that the Entrust initialization file contains the following entry in the
first section that specifies the Entrust Settings:

I dentityLi brary=l ocation
The full path to the location of the | i bi dapi . so file should be specified in the

I denti t yLi br ary parameter. This parameter setting enables generating a
. ual file on the server.

4. Ensure that all Entrust toolkits, including the Entrust IPSEC Negotiator Toolkit
and the Server Login Toolkit, are the same version so they are compatible.

5. Ensure that you have specified TCP/IP with SSL in the
SQLNET. AUTHENTI CATI ON_SERVI CES parameter in the sqgl net . or a file as
shown in the following example:

SQLNET. AUTHENTI CATI ON_SERM CES=(t cps, aut henti cation_typel, authentication_
type2)
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Checklist for Windows NT Installations

The following checklist items apply only to Entrust installations on the Windows
NT platform.

1.
2.

Ensure that you are logged into Entrust/Entelligence and retry.

Choose Windows > Control Panel > Services to confirm that the Entrust Login
Interface service has started and is running.

Confirm that the Entrust initialization file location is specified in the SSL_
ENTRUST_I NI _FI LE parameter of the sql net . or a file. However, if you
choose not to specify the location there, then the Entrust initialization file must
reside in c: \ W NNT.

Ensure that you are not running Entrust/Entelligence if your database is
running on a Microsoft platform. If this is the case, then only the . ual file,
which enables unattended login, is required.

See Also: Step 4 of "Configuring Entrust on a Windows Server"
on page 8-14 for information about creating a . ual file with the
Entrust binder command.

Confirm that Entrust/Authority, as specified in the Entrust Initialization file, is
accessible and running.

Confirm that the profile password is correctly entered.

If an Oracle database server fails to log in to Entrust, confirm that the
unattended login credential file (.ual) is generated using a valid password. Also,
confirm that the versions for Entrust ServerLoginToolkit and Entrust IPSEC
Negotiator Toolkit match (that is, that the IPSEC Toolkit 6.0 works with
ServerLoginToolkit 6.0).

Ensure that the Entrust initialization file has the following entry in the first
section, Entrust Settings:

IdentityLibrary = | ocation

where | ocat i on is the location of | i bi dapi . so, including the file name.
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Configuring Multiple Authentication
Methods

This chapter describes how to configure multiple authentication methods under
Oracle Advanced Security, and how to use conventional user name and password
authentication, even if you have configured another authentication method. This
also chapter describes how to configure your network so that Oracle clients can use
a specific authentication method, and Oracle servers can accept any method
specified.

This chapter contains the following topics:

« Connecting with User Name and Password

« Disabling Oracle Advanced Security Authentication
« Configuring Multiple Authentication Methods

« Configuring Oracle9i for External Authentication
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Connecting with User Name and Password

To connect to an Oracle database server using a user name and password when an
Oracle Advanced Security authentication method has been configured, disable the
external authentication (See: Disabling Oracle Advanced Security Authentication
on page 9-3).

With the external authentication disabled, a user can connect to a database using the
following format:

% sql pl us user nane/ passwor d@et _ser vi ce_nane

For example:

%sql pl us scott/tiger @np

Note: You can configure multiple authentication methods,
including both externally authenticated users and password
authenticated users, on a single database.
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Disabling Oracle Advanced Security Authentication
To disable authentication methods:
1. Start Oracle Net Manager:
«  OnUNIX:
Run net ngr from $ORACLE_HOME/bin
«  On Windows NT:

Select Start>Programs>Oracle-HOME_NAME>Network
Administration>Oracle Net Manager

2. In the Navigator window, expand Local > Profile.

3. From the list in the right window pane, select Oracle Advanced Security; the
Oracle Advanced Security tabbed window appears (Figure 9-1):

Figure 9-1 Oracle Advanced Security Authentication Window

Oracle Advanced Security -

futhentication

fvailable Methods: Selected Methods:

—
NTS

o
RADIUS 2

CYBERSAFE
KERBEROSS

Promote
Demote

4. Choose the Authentication tab.
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5. Sequentially move all authentication methods from the Selected Method list to
the Available Methods list by selecting a method and choosing the left arrow

[<].

6. Choose File > Save Network Configuration.
The sql net . or a file is updated with the following entry:
SQLNET. AUTHENTI CATI ON_SERVI CES = (NONE)
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Configuring Multiple Authentication Methods

Many networks use more than one authentication method on a single security
server. Accordingly, Oracle Advanced Security lets you configure your network so
that Oracle clients can use a specific authentication method, and Oracle database
servers can accept any method specified.

You can set up multiple authentication methods on both client and server systems
either by using Oracle Net Manager, or by using any text editor to modify the
sql net . or a file.

To add authentication methods to both clients and servers:

1.

Start Oracle Net Manager:
« OnUNIX:

Run net ngr from $ORACLE_HOME/bin
«  On Windows NT:

Select Start>Programs>Oracle-HOME_NAME>Network
Administration>Oracle Net Manager

In the Navigator window, expand Local > Profile.

From the list in the right window pane, select Oracle Advanced Security.
The Oracle Advanced Security tabbed window appears (Figure 9-1).
Choose the Authentication tab.

Select a method listed in the Available Methods list.

Sequentially move selected methods to the Selected Methods list by choosing
the right arrow [>].

Arrange the selected methods in order of desired use. To do this, select a
method in the Selected Methods list, and choose Promote or Demote to position
it in the list.

Choose File > Save Network Configuration.

The sql net . or a file is updated with the following entry, listing the selected
authentication methods:

SQLNET. AUTHENTI CATI ON_SERVI CES =
( RADI US| CYBERSAFE| KERBEROS5)
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Note:

« SecurlD functionality is available through RADIUS; RADIUS
support is built into the RSA ACE/Server.

« See Also: Chapter 4, Configuring RADIUS Authentication
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Configuring Oracle9i for External Authentication

This section describes the parameters you must set to configure Oracle9i for
network authentication, using the following tasks:

» Setting the SQLNET.AUTHENTICATION_SERVICES Parameter in sglnet.ora
« Verifying that REMOTE_OS_AUTHENT Is Not Set to TRUE
« Setting OS_ AUTHENT_PREFIX to a Null Value

See Also:

« The corresponding chapter in this guide for information about
configuring a particular authentication method

«  Appendix B, "Authentication Parameters”

Setting the SQLNET.AUTHENTICATION_SERVICES Parameter in sqlnet.ora

The following parameter must be set in the sqgl net . or a file for all clients and
servers to enable each to use a supported authentication method:

SQNET. AUTHENTI CATI ON_SERV CES=( or acl e_aut hent i cat i on_net hod)

For example, for all clients and servers using Kerberos authentication, the
sql net. ora parameter must be set as follows:

SCLNET. AUTHENTI CATI ON_SERVI (ES=( KERBERO)

Verifying that REMOTE_OS_AUTHENT Is Not Set to TRUE

To verify that REMOVE_OS_AUTHENT is not set to TRUE, add the following
parameter to the initialization file—in each database instance—when you configure
the authentication method:

REMOTE_C5 AUTHENT=FALSE

Attention: Setting REMOTE_OS _AUTHENT to TRUE can cause
a security exposure, because it lets someone using a hon-secure
protocol, such as TCP, perform an operating system-authorized
login (formerly referred to as an OPS$ login).
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If REMOTE_OS_AUTHENT is set to FALSE, and the server cannot support any of
the authentication methods requested by the client, the authentication service
negotiation fails and the connection terminates.

If the parameter is set as follows in the sql net . or a file on either the client or server,
the database attempts to use the supplied user name and password to login the
user:

SQNET. AUTHENTI CATI ON_SERVI CES=( NON)

If REMOTE_OS_AUTHENT is set to FALSE, however, the connection fails.

Setting OS_AUTHENT_PREFIX to a Null Value

Authentication service-based user names can be long, and Oracle user names are
limited to 30 characters. Oracle Corporation strongly recommends that you enter a
null value for the OS_AUTHENT_PREFIX parameter in the initialization file used
for the database instance as follows:

G5 AUTHENT_PREF X=""

Note: The default value for OS_ AUTHENT_PREFIX is OPS$;
however, you can set it to any string.

Attention: If a database already has the OS_AUTHENT_PREFIX
set to a value other than NULL (" "), do not change it, since it can
inhibit previously created, externally identified users from
connecting to the Oracle server.

To create a user, launch SQL*Plus and enter the following:

SQ > CREATE USER os_aut hent _prefix usernane | DENTI FH ED EXTERNALLY;

When OS_AUTHENT_PREFIX is set to a null value (" "), enter the following to
create the user king:

SQA > CREATE USER ki ng | DENTI FI ED EXTERNALLY;

The advantage of creating a user in this way is that the administrator no longer

needs to maintain different user names for externally identified users. This is true
for all supported authentication methods.
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See Also:
« Oracle9i Database Administrator’s Guide

«  Oracle9i Heterogeneous Connectivity Administrator’s Guide
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Part |V

Oracle DCE Integration

This part describes Oracle Distributed Computing Environment Integration (DCE).
It contains the following chapters:

Chapter 10, Overview of Oracle DCE Integration

Chapter 11, Configuring DCE for Oracle DCE Integration
Chapter 12, Configuring Oracle9i for Oracle DCE Integration
Chapter 13, Connecting to an Oracle Database in DCE
Chapter 14, DCE and Non-DCE Interoperability

Note: Check Oracle operating system-specific installation
documentation to verify that Oracle Advanced Security supports
Oracle DCE integration for your operating system.
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Overview of Oracle DCE Integration

Oracle DCE Integration enables Oracle applications and tools to access Oracle9i
servers in a distributed computing environment. This chapter briefly describes the
Distributed Computing Environment (DCE) and the Oracle DCE Integration
product. It contains the following topics:

Oracle DCE Integration Requirements
The Distributed Computing Environment
Components of Oracle DCE Integration
Flexible DCE Deployment

Release Limitations

See Also:  Related Documentation on page -xxviii.
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Oracle DCE Integration Requirements

System Requirements

Oracle DCE Integration requires Oracle Net Services and Oracle9i. It is based on the
Open Software Foundation (OSF) DCE protocol (V1.1 and later).

Note that OSF has merged with X/OPEN, another standards group, to form The
Open Group. This group is committed to continuing DCE support.

Backward Compatibility

Oracle servers running DCE Integration 2.3.2 and later are backward compatible
with clients running SQL*Net/DCE 2.1.6 or 2.2.3; however, Release 2.1.6 clients
cannot take advantage of external roles.

A client running DCE Integration 2.3.2 or later cannot connect to a SQL*Net/DCE
2.1.6 or 2.2.3 server. A DCE Integration Release 2.3.2 or later client requires a
Release 2.3.2 or later server in order to connect to a database.

The Distributed Computing Environment

The Distributed Computing Environment (DCE) from the Open Group is a set of
integrated network services that works across multiple systems to provide a
distributed environment. The network services include remote procedure calls
(RPCs), directory service, security service, threads, distributed file service, diskless
support, and distributed time service.

DCE is the middleware between distributed applications and the operating
system/network services and is based on a client/server model of computing. By
using the services and tools that DCE provides, users can create, use, and maintain
distributed applications that run across a heterogeneous environment.
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Components of Oracle DCE Integration

Oracle DCE Integration has two components: DCE Communication/Security and
DCE CDS Native Naming.

« DCE Communication/Security

« DCE Cell Directory Services Native Naming

DCE Communication/Security
This component has three principal features:

Authenticated RPC

Oracle DCE Integration provides authenticated Remote Procedure Call (RPC) as the
transport mechanism that enables multi-vendor interoperability. RPC also uses
some of the other DCE services, including directory and security services, to
provide location transparency and secure distributed computing.

Integrated Security and Single Sign-On

Oracle DCE Integration works with the DCE Security service to provide security
within DCE cells. It enables a user logged onto DCE to securely access any Oracle
database without having to specify a user name or password. This is sometimes
called external authentication to the database, or single sign-on (SSO). Clients and
servers that are not running DCE authentication services can interoperate with
systems that have DCE security by specifying an Oracle password.

Data Privacy and Integrity

Oracle DCE Integration uses the multiple levels of security that DCE provides to
ensure data authenticity, privacy, and integrity. Users have a range of choices, from
no protection to full encryption for each connection, with a guarantee that no data is
modified in transit.
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Note: For parts of the network that do not use DCE, you can use
the other security and authentication services that are part of Oracle
Advanced Security. These services work with SQL*Net release 2.1
and later or with Oracle Net Services. They provide message
integrity and data encryption services in non-DCE environments,
letting administrators ensure that all network traffic is protected
against unauthorized viewing or modification, regardless of the
start or end point.

DCE Cell Directory Services Native Naming

The DCE Cell Directory Services (CDS) Native Naming component includes
naming and location transparency.

DCE Integration registers Oracle9i connect descriptors in the DCE CDS, letting
them be transparently accessed across the entire DCE environment. Users can
connect to Oracle database servers in a DCE environment using familiar Oracle
service names.

The DCE Cell Directory Service offers a distributed, replicated repository service for
name, address, and attributes of objects across the network. Because servers register
their name and address information in the CDS, Oracle clients can make
location-independent connections to Oracle9i servers. Services can be relocated
without any changes to the client configuration. An Oracle utility is provided to
load the Oracle service names with corresponding connect descriptors into CDS.
After this is done, Oracle connect descriptors can be viewed from a central location
with standard DCE tools.

For location of services across multiple cells, either of the following options can be
used:

« DCE Global Directory Service (GDS)

« Internet Domain Naming Service (DNS)
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See Also:

« To configure DCE to use CDS naming, see Chapter 11,
Configuring DCE for Oracle DCE Integration.

« To configure Oracle clients and servers to use CDS, see
Chapter 12, Configuring Oracle9i for Oracle DCE Integration.

« For information about how Oracle Native Naming works with
other Oracle name services, see the Oracle9i Net Services
Administrator’s Guide.
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Flexible DCE Deployment

Oracle Advanced Security provides flexibility in your use of DCE services. You
have the following options:

= You can use full DCE integration in your environment to integrate with all the
DCE Secure Core services (RPC, directory, security, threads).

= You can use only the DCE directory services by using the DCE CDS Native

Naming adapter, along with any conventional protocol adapter, such as
TCP/IP.
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Release Limitations

The following are limitations in Release 2 (9.2) of Oracle Advanced Security:

« Only one listener address that uses the DCE protocol is permitted for each
node.

« Database links must specify a user name and password to connect.

« This release of DCE Integration does not support the Oracle Multi-Protocol
Interchange.

« This release does not work with the Oracle shared server.
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Configuring DCE for Oracle DCE Integration

This chapter describes how to configure the Distributed Computing Environment
(DCE) to use Oracle DCE Integration—after Oracle DCE Integration has been
installed.

See Also: Chapter 10, Overview of Oracle DCE Integration
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To Configure DCE for Oracle DCE Integration:

The following tasks, performed by the DCE cell administrator, assume that a DCE
cell has been configured and the systems being used are part of that cell:

« Task 1: Create New Principals and Accounts
» Task 2: Install the Key of the Server into a Keytab File
« Task 3: Configure DCE CDS for Use by Oracle DCE Integration

Task 1: Create New Principals and Accounts
Use the following procedure model to add server principals:

%dce_| ogi n cel | _admin password

%rgy_edit

Qurrent site is: registry server at /.../cell 1/ subsys/dce/ sec/ naster
rgy_edit=>do p

Donai n changed to: princi pal

rgy_edi t=> add oracl e

rgy_edit=>do a

Donai n changed to: account

rgy_edit=> add oracl e -g none -0 none -pw oracl e_password -np cel | _admn_
passwor d

rgy_edit=> quit

bye

In this example, a DCE principal named or acl e is created. The principal has a
corresponding account with a password set to or acl e_passwor d. The account
does not belong to any DCE group or DCE profile.

Note: Perform this task on the server only once after DCE
Integration has been installed; do not perform this task on client
systems.

11-2 Oracle Advanced Security Administrator’'s Guide



To Configure DCE for Oracle DCE Integration;

Task 2: Install the Key of the Server into a Keytab File

Install the key of the server into a keytab file, dcepa. key. This file contains the
password of the principal under which the Oracle Net listener starts. The Oracle
Net listener reads this file to authenticate itself to DCE. To generate the keytab file,
enter the following:

%dce_| ogi n cell _admn password

%rgy_edit

Qurrent site is: registry server at /.../cell1/ subsys/dce/ sec/ nast er
rgy_edit=> ktadd -p oracle -pw O acl e_password -f

$CRACLE_HOME dcepal adni n/ dcepa. key

rgy_edit=>quit

bye

Note:

« Perform this task on the server only once after DCE Integration
has been installed. Do not perform this task on client systems.

= Remember to substitute the full path name for the §ORACLE_
HOME variable. If the specified directories do not exist, create
them before running the command,; to create the directories.
enter the following:

nkdi r $CRACLE_HOMH dcepa
nkdi r $CRACLE HOME dcepa/ adni n
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Task 3: Configure DCE CDS for Use by Oracle DCE Integration

Step 1: Create Oracle Directories in the CDS Namespace

Enter the following after installing DCE Integration for the first time in a cell; create
directories on all CDS replicas:

%dce login cell _adnmin

Enter Password: (password not di spl ayed)

$ cdscp

cdscp> create dir /.:/subsys/oracl e

cdscp> create dir /.:/subsys/oracl e/ nanes

cdscp> create dir /.:/subsys/oracl e/ service_registry
cdscp> exit

Note:

« Thedirectory/.:/subsys/ oracl e/ nanes contains objects
that map Oracle Net service names to connect descriptors,
which are used by the CDS naming adapter.

« Thedirectory /.:/subsys/oracle/service registry
contains objects that map the service name in DCE addresses to
the network endpoint that is used by both DCE protocol
adapter clients and servers.

Step 2: Give Servers Permission to Create Objects in the CDS Namespace
Enter the following to add the principal or acl e to the CDS-server group:

$ dce login cell _adnin

Enter Password:  (password not di spl ayed)
$rgy edit

rgy_edi t=> domai n group

Donmai n changed to: group

rgy_edi t=> nenber subsys/dce/ cds-server -a oracl e
rgy_edit=> exit

Step 3: Load Oracle Service Names into CDS

Load Oracle service names into the Cell Directory Service, as described in
Chapter 12, Configuring Oracle9i for Oracle DCE Integration.
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Configuring Oracle9i for Oracle DCE
Integration

This chapter describes how to configure Oracle9i and Oracle Net Services to use
Oracle DCE Integration after it has been successfully installed.

This chapter contains the following topics:
« DCE Address Parameters

« Configuring Oracle9i and Oracle Net Services
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DCE Address Parameters

DCE addresses in the | i st ener. or a and t nsnanes. or a configuration files are
defined by DCE parameters, illustrated in the following:

ADDRESS=( PROTO0OL=DCE) ( SERVER PR Nd PAL=ser ver _nane) (CELL_NAME=cel | _nane)
(SERV CE=dce_ser vi ce_nane) )

These parameters are described by Table 12-1:

Table 12-1 DCE Address Parameters and Definitions

Component

Description

PROTOCOL

A mandatory field that identifies the DCE RPC protocol.

SERVER_PRINCIPAL

A mandatory field for the server and an optional field for the
client. The server authenticates itself to DCE as this principal.
This field is mandatory in the listener configuration file

(I'i st ener. ora) and specifies the principal the server will
start under. This field is optional in your local naming
configuration file (t nsnanes. or a) and specifies the principal
of the server the client must connect to. If not specified, then
one-way authentication is used. In this case, the client does not
care what principal the server is running under.

CELL_NAME

An optional parameter. If present, it specifies the DCE cell
name of the database. If this parameter is not set, the cell name
defaults to the local cell (useful for single-cell environments).
Optionally, the SERVICE parameter (described in the
following section) may specify the complete path (including
the cell name) to the service, making this parameter
unnecessary.

SERVICE

A mandatory field for both server and client. For the server,
this is the service registered with CDS. For the client, this is the
service name used when querying CDS for the location of the
Oracle DCE servers. The default directory for storing service
namesin CDSis /... /cell nane/ subsys/oracl e

/ servi ce_regi stry. This service name can fully specify the
path in CDS.
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You can specify a service as follows:

SERV CE=/ . . ./ cel | _name/ subsys/ or acl e/ servi ce_regi stry/ dce_servi ce_nane

Alternatively, you can specify:

SERVI CE=dce_ser vi ce_nane

if CELL_NAME=cel | _nane is also specified.

In this case, the cell name defaults to the local cell. However, this way of specifying
service names only works if you are operating within a single cell.

Note: Thedce_servi ce_nane in the service field might not be
the same as that used by Oracle Net Services. The service name
used by Oracle Net is mapped to the connect descriptor in a local
naming configuration file (t nsnanmes. ora). The dce_servi ce_
nane is part of the address within the connect descriptor.
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Configuring Oracle9i and Oracle Net Services

To configure Oracle9i and Oracle Net Services to use Oracle DCE Integration,
perform the following tasks:

Task 1: Configure the Server
Task 2: Create and Name Externally Authenticated Accounts
Task 3: Set up DCE Integration External Roles

Task 4: Configure DCE for SYSDBA and SYSOPER Connections to Oracle
Databases

Task 5: Configure the Client
Task 6: Configure Clients to Use DCE CDS Naming

Task 1: Configure the Server
To configure a server for DCE Integration, do the following:

12-4

1.

Configure the listener configuration file (1 i st ener . or a) with DCE address
information for all servers.

For servers in distributed systems that require database link connections to
other servers, configure the sql net . or a and pr ot ocol . or a files with DCE
address information.

Note: In this release, the configuration files | i st ener. or a,
sqgl net.ora, tnsnanes.ora, andprotocol . ora are located
in the SORACLE_HOME/network/admin directory.

For a database server to receive connections from Oracle Net clients in a DCE
environment, there must be an Oracle Net listener active on the server platform.
This process listens for connections on a network address that is defined in the
l'i stener.ora configuration file.

The SERVER_PRINCIPAL parameter designates what DCE principal the
listener should be running under. In the following sample, the listener is
running under principal oracle.
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The following is a sample DCE address as it would appear inthe | i st ener. ora
file.

LS\R DCE=
( ADDRESS=

( PROTAOO.=DCE)
(SERVER PR N PAL=or acl €)
(CELL_NAME=cel | 1)
(SERV CE=dce_svc))

S D LI ST LS\R DCE=
(S D CESC=
(S D NAME=CRAS D)

(CRACLE_HOME=/ pri vat e/ or acl €9) )

Task 2: Create and Name Externally Authenticated Accounts

To use DCE authentication for logging onto an Oracle database, you must create
database accounts that are authenticated externally. To enable secure external
authentication, do the following:

Note: The privileges shown in this section are the minimum access
privileges necessary. The actual set of privileges needed depends
upon the instance or application.

1. Verify that these lines are in the initialization parameter file:

REMOTE_OS_AUTHENT=FALSE
OS_AUTHENT _PREFI X=""

2. Verify that the initialization parameter file does not have a multi-threaded
server (MTS) entry for DCE. For example, an entry such as the following is not
permitted:

ni s_di spat cher s=" ( PROTG00.=dce) (D SPATGHERS=3) "
3. Ensure that you are logged on as a member of the DBA group. Restart the
database instance for the changes to take effect.

4. Atthe SQL*Plus prompt, define users. Before doing so, decide whether you are,
or ever will be, operating in a multi-cell DCE environment in which you let
Oracle access across cell boundaries. The way you define users depends on
whether they are connecting within a single cell or across cell boundaries.
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Local Cell:

If users are connecting within a local cell, use the following format:
SQ > CREATE USER server_princi pal | DENTI Fl ED EXTERNALLY;

SQA > GRANT CREATE ON TO server_princi pal ;

For example:

SQA > CREATE USER oracl e | DENTI Fl ED EXTERNALLY;

SQ> GRANT CREATE SESSI ON TO or acl €;

The entire CELL_NAME/SERVER_PRINCIPAL string must be 30 characters or
less (this is an Oracle9i restriction—not a restriction of the DCE adapter).
For example:

SQ > CREATE USER "CHLLYL CRACLE" | DENTI H ED EXTERNALLY;

SA> RANT CREATE ON TO "CELLY GRACLE,

Multiple Cells:

If connecting to the database across multiple cells, specify both the cell_name and
the server_principal, as illustrated in the following:

SQA> CREATE USER "CHLL_NAME SERVER PR NO PAL" | DENTI Fl ED EXTERNALLY;
SQA> CRANT CREATE SESSI ON TO "CHLL_NAME SERVER PR NO PAL";

You must enclose the externally-identified account name in double quotation
marks, because the slash is a reserved character. Also, if the account (user) name
is double-quoted, it must be capitalized.

For example:

SQ> CREATE USER "CELLL CRACLE' | DENTI Fl ED EXTERNALLY;

SA> RANT CREATE ON TO "CELLY GRACLE,;

When using this format, set the following parameter in the pr ot ocol . ora
configuration file to FALSE:

dce. | ocal _cel | _user nanes=f al se

References to an Oracle account created in this manner must include the
schema/account in the correct format. Consider requests for access to tables

from another account. When a user references the tables in another account
created within a local cell, the command might appear as follows:

SQ > SHECT * FROMoracl e. enp
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If a user wants to access tables in another account created for connections across
cells, the command might appear as follows:

SQA> SHECT * FRAM"CELLY CRACLE' . enp

See Also:  Oracle9i Heterogeneous Connectivity Administrator’s
Guide, for more information about external authentication

Task 3: Set up DCE Integration External Roles

To set up external roles for DCE Integration, and enable connection to an Oracle
database as SYSOPER or SYSDBA with DCE credentials, do the following:

1.

Set the following parameter in the initialization parameter file:
0S_ROLES=TRUE
Restart the database.

Ensure that the DCE groups that map to Oracle roles adhere to the following
syntax:

ORA gl obal _nane_role[ _[a][d]]

Table 12-2 describes the syntax components:

Table 12-2 Setting Up External Role Syntax Components

Component Definition

ORA Designates that this group is used for Oracle purposes

GLOBAL_NAME The global name for the database

ROLE The name of the role, as defined in the data dictionary

Aora Optional character indicating that the user has admin
privileges for this role

Dord Optional character indicating the role is to be enabled by
default at connect time

See Also:  Oracle9i Database Administrator’s Guide for more
information about external roles
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4. Authenticate to DCE a user who is a member of a DCE group by entering the
following commands:

dce_| ogi n
kl'i st
Sample Output:

%dce_| ogi n oracl e

Enter Password:

%Kkl i st

dce identity information:

Warning: ldentity infornation is not certified
Qobal Principal: /.../ilabl/oracl e

Gl l: 001c3f 90- 01f 5- 1f 72- ba65- 02608c2c84f3 /... /il abl
Princi pal : 00000068- 0568- 2f 72- bd00- 02608c2c84f 3 or acl e
G oup: 0000000c- 01f 5- 2f 72- ba01- 02608c2c84f 3 none

Local G oups:

0000000c- 01f 5- 2f 72- ba01- 02608c2c84f 3 none

0000006a- 0204- 2f 72- h901- 02608c2c84f 3 subsys/ dce/ cds- ser ver
00000078- daf 4- 2f e1- a201- 02608c2c84f 3 ora_dce222_dba
00000084- 89c8- 2f €8- a201- 02608c2c84f 3 ora_dce222_connect _d
00000087- 8a13- 2f €8- a201- 02608c2c84f 3 ora_dce222 resource_d
00000080- f 681- 2f e1- a201- 02608c2c84f 3 ora_dce222 rol el _ad

5. Connect to the database as usual.

The following sample output lists external roles (DBA, CONNECT,
RESOURCE, and ROLE1) that have been mapped to DCE groups:

SQ > SHECT * FROM sessi on_rol es;

SQA> SET RAE al |

Rol e set.
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SQ > SHECT * FROM sessi on_rol es;

EXP_FULL_DATABASE
| MP_FULL_DATABASE
CONNECT

RESOLRCE

ROLEL

6 rows sel ected.

Q> EXT

Task 4: Configure DCE for SYSDBA and SYSOPER Connections to Oracle Databases

To configure DCE so that you can connect to an Oracle database as SYSOPER or
SYSDBA with DCE credentials, do the following:

1.

Create DCE groups that map to Oracle DBA and OPERATOR roles. DCE group
names should adhere to the syntax described by Task 3: Set up DCE Integration
External Roles on page 12-7. Add the externally authenticated user or acl e as a
member of the group(s).

$ dce_login cell _adnin cel | _adm n_password

$rogy edit

rgy_edit=> domai n group

Donai n changed to: group

rgy_edit=> add ora dce222 dba ad

rgy_edit=> add ora_dce222 operator_ad

rgy_edi t=> nenber ora _dce222 dba_ad -a oracle
rgy_edit=> nenber ora_dce222 operator_ad -a oracle

Add the GLOBAL_NAME parameter to the DCE address or TNS service name
in the local configuration file t nsnanes. or a.

CRADCE=
( ADDRESS=
(PROTOOL=DCE)
( SERVER_PR N PAL=or acl e)
(CELL_NAME=cel | 1)
(SERVI CE=dce_svc))
( CONNECT_DATA=
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(S D=CRASI D)
(QLCBAL_NAME=dce222)))

3. Create the database user or acl e as described by Task 2: Create and Name
Externally Authenticated Accounts on page 12-5.

4. Get DCE credentials for the externally authenticated user:

$ dce_|l ogi n oracl e oracl e_password
$Kkli st
DCE I dentity |nfornation:
Warning: ldentity infornation is not certified
Qobal Principal: /.../dce.dl sun685. us. oracl e. conioracl e

Gll: 00af 8052- 7€94- 11d2- b261- 9019b88baa77
/...ldce.dl sun685. us. ora
cle.com
Princi pal : 0000006d- 88b9- 21d2- 9300- 9019b88baa77 oracl e
Q oup: 0000000c- 7e94- 21d2- b201- 9019b88baa77 none
Local G oups:

0000000c- 7€94- 21d2- b201- 9019b88baa77 none

0000006a- 7€94- 21d2- ad01- 9019b88baa77 subsys/ dce/ cds- ser ver
00000076- 8b53- 21d2- 9301- 9019b88baa77 ora_dce222 dba_ad
00000077- 8b53- 21d2- 9301- 9019b88baa77 or a_dce222_operat or _ad

Identity Info Expires: 1999-12-04-10: 28: 22
Account Expires: never
Passwd Expi res: never

Ker ber os Ti cket | nfornation:
Ti cket cache: /opt/dcel ocal / var/security/ creds/ dcecr ed_43ae2600
Defaul t principal: oracl e@ce. dl sun685. us. oracl e. com
Server: krbtgt/dce. dl sun685. us. or acl e. con@ce. dl sun685. us. or acl e. com
valid 1999- 12- 04-00: 28: 22 to 1999- 12- 04- 10: 28: 22
Server: dce-rgy@ce. dl sun685. us. or acl e. com
valid 1999- 12- 04-00: 28: 22 to 1999- 12- 04- 10: 28: 22
Server: dce-pt gt @ce. dl sun685. us. or acl e. com
valid 1999- 12- 04- 00: 28: 26 to 1999- 12- 04- 02: 28: 26
Qient: dce-ptgt@ce. dl sun685. us. or acl e. com Server:
kr bt gt/ dce. dl sun685. us. o
racl e. con@ece. dl sun685. us. or acl e. com
val id 1999- 12- 04-00: 28: 26 to 1999- 12- 04- 02: 28: 26
Aient: dce-ptgt@ece.dl sun685. us. oracl e. com Server:
dce- r gy@lce. dl sun685. us.
oracl e.com
valid 1999- 12- 04- 00: 28: 27 to 1999- 12- 04- 02: 28: 26
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Note: List output shows the DCE group membership of or acl e.

5. Connect to the Oracle database as SYSBDA or SYSOPER.
For example:
SQ> connect / @radce as SYSDBA

Task 5: Configure the Client

To configure a client for DCE Integration, you must configure the following Oracle
Net files with DCE address and parameter information:

« protocol.ora
« sqlnet.ora

Typically, CDS is used for name resolution. Thus, a local naming configuration file
(t nsnanes. or a) is not used, except when loading names and addresses into CDS.

Parameters in protocol.ora

There are four DCE parameters located in the pr ot ocol . or a file. Each parameter
begins with the prefix DCE. to distinguish it from parameters relevant to other
protocols. If default values are used for these four parameters, DCE Integration
does not require a pr ot ocol . or a file. The parameters and their current defaults
follow:

« DCE.AUTHENTICATION=dce_secret

. DCE.PROTECTION=pkt_integ

« DCE.TNS_ADDRESS OID=1.3.22.15.1

« DCE.LOCAL_CELL_USERNAMES=TRUE

Configuration parameters are not case-sensitive; you can enter them in either
uppercase or lowercase.

DCE.AUTHENTICATION

The DCE.AUTHENTICATION parameter is optional. It indicates the authentication
value to be used for each DCE RPC. The client DCE_AUTHENTICATION value
must be the same as the server DCE_AUTHENTICATION value. If this entry is not
specified, cell-wide default authentication is used. The options follow:
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Option Description

NONE No authentication

DCE_SECRET DCE shared-secret key authentication (Kerberos)
DCE_SECRET Default authentication level and recommended value
DEFAULT Cell default

DCE.PROTECTION

DCE.PROTECTION is an optional field that specifies the data integrity protection
levels for data transmission. The client DCE_PROTECTION level must be equal to
or greater than the server DCE_PROTECTION level. If this entry is not specified,
cell-wide default protection is used. The options follow:

Option Description

NONE Perform no protection for the current connection

DEFAULT Use the default cell-wide protection level

CONNECT Perform protection only when the client establishes a
relationship with the server

CALL Perform protection only at the beginning of each remote
procedure call when the server receives the request

PKT Ensure that all data received is from the expected client

PKT_INTEG Ensure and verify that none of the data transferred between the
client and server has been modified

PRIVACY Perform protection as specified by all of the previous levels and
also encrypt each RPC argument value and all user data in each
call

DCE.TNS_ADDRESS_OID

DCE.TNS_ADDRESS_OID is an optional parameter that enables you to specify an
alternative to the default value as follows:

DCE. TNS_ADDRESS_Ol D=1. 3. 22. 1. x. x

See Also:

Step 2: Modify the CDS Attributes File and Restart the

CDS on page 12-15.
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DCE.LOCAL_CELL_USERNAMES

DCE.LOCAL_CELL_USERNAMES is an optional parameter that defines the format
used to specify the principal name (username), with or without the cell name. The
choice you make for this parameter should be determined by whether or not users
are making connections across cells—with unique names. The default for

DCE. LOCAL_CELL_USERNAMES is now TRUE (it was set to FALSE in the DCE

Integration 2.1.6 release).

The associated options follow:

Option

Description

TRUE

The default value. Select TRUE if using just the SERVER _
PRI NCI PAL format, without the CELL_ NAME.

An example of a user specified in this format is as follows:
oracl e

TRUE is an appropriate option if users are making connections
within a single cell, or if naming conventions in the network
assure that users in different cells do not have duplicate names.

FALSE

Select FALSE when using the CELLNAME/ SERVER_PRI NCI PAL
format. An example of a user specified in this format is as
follows:

CELL1/ ORACLE

FALSE is an appropriate option if users are making connections
across cells and there can be users in different cells with
identical name
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Task 6: Configure Clients to Use DCE CDS Naming

Clients typically use Cell Directory Services (CDS) to resolve Oracle service names
to addresses. Perform the following steps to configure CDS:

« Step 1: Enable CDS for use in Performing Name Lookup
« Step 2: Modify the CDS Attributes File and Restart the CDS

« Step 3: Create a tnsnames.ora File for Loading Oracle Connect Descriptors into
CDS

« Step 4: Load Oracle Connect Descriptors into CDS
« Step 5: Delete or Rename the thsnames.ora File

« Step 6: Modify the sqlnet.ora File to Resolve Names in CDS

Note: Upon completion of this task, you can connect to an Oracle
database in your DCE environment.

Step 1: Enable CDS for use in Performing Name Lookup

To use CDS for name resolution, the DCE Integration CDS Naming Adapter must
be installed on all clients and servers that use CDS. Also, the CDS namespace must
have been configured for use by DCE Integration.

See Also: DCE Integration installation instructions, and Task 3:
Configure DCE CDS for Use by Oracle DCE Integration on
page 11-4.

For example, a service name such as ORADCE and its network address can be stored
in DCE CDS.

Users can typically connect to Oracle services using the familiar Oracle service
name if there are no domains or the database is in the user’s default domain, as in
the following example:

sql pl us / @RADCE

This example assumes that DCE externally-authenticated accounts are in use.

As an alternative name resolution service, use a local naming configuration file,
t nsnanes. or a, when CDS is inaccessible. To do so, locate names and addresses of
all Oracle servers in the local t nsnanes. or a file.
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Step 2: Modify the CDS Attributes File and Restart the CDS

On all DCE machines where CDS haming is used, add the object ID for the CDS
attribute TNS_Address to the CDS attributes file. (The object ID must be the same
across all machines.)

1. Add aline in the following format to the / opt / dcel ocal / et c/ cds_
attributes file:

1.3.22.1.5.1 TNS_Addr ess char

The first four digits of this TNS_Address attribute value, 1. 3. 22. 1. x. y, are
fixed, under DCE naming conventions. If the default TNS_Address object ID
value 1. 3. 22. 1. 5. 1 already exists in the cds_at t ri but es file, you must
specify a value for the object ID that is not already in use.

If you are unable to use the default value for the object ID, then you must
specify the object ID in the pr ot ocol . or a file on the client.

If you had to specify a value other than the default value 1. 3. 22. 1. 5. 1, then
you must add the following parameter to the pr ot ocol . or a file:

DCE. TNS_ADDRESS A D=1. 3.22. 1. x.y

Make sure that the object ID value in the cds_attributes file matches the value
specified in the DCE. TNS_ADDRESS O D parameter in the pr ot ocol . or a file.

2. Restart CDS on the system.

The command to restart CDS varies between different operating systems. On
the Solaris platform, for example, you can use the following command to restart
CDS:

/opt/dcel ocal /etc/rc.dce restart

Step 3: Create a tnsnames.ora File for Loading Oracle Connect Descriptors into
CDS

To load the Oracle service names and addresses into CDS, create or modify a local
naming configuration file, t nsnanes. or a. This file is used to map service names to
addresses for use by Oracle Net.

This section describes the parameters that must be included in the t nsnanes. or a
file. The file contains a list of Oracle service names mapped to connect descriptors of
destinations or endpoints in the network. The sample DCE address in the following
section shows a network address for an Oracle server with the Oracle service name
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ORADCE. It is used to connect to the service registered as DCE_SVCin the CDS

directory

/.../cell _nane/ subsys/ oracl e/ nanes.
CRADCE=( DESCR PTI O\N=( ADDRESS=( PROTG00L=DCE) ( SERVER PR NJ PAL=or acl e) (CELL__
NAME=cel | 1) ( SERVl CE=DCE_SVO) ) (QONNECT_DATA=(SID=CRAS D)) )

Note:

In this example, the Oracle service name and the DCE

service name are different, although they are frequently the same.

Parameter
Name Type Mandatory? | Description
PROTOCOL=DCE keyword Yes Appears in the address sections of (i)
value pair | i st ener. or a, a listener configuration
file, and (ii) t nsnanes. or a, alocal
naming configuration file.
SERVER _ DCE No Appears int nsnanes. or a
PRI NCI PAL Parameter
SERVI CE DCE Yes The value given for the DCE parameter
Parameter (SERVI CE=dce_service_name) must be the
sameinl i stener. oraand
tnsnanes. or a
SID Oracle Yes Identifies the Oracle system ID; each SID
Parameter value must be unique on a node. This
parameter is used locally only, and is not
used in DCE CDS.
See Also:  Oracle9i Net Services Administrator’s Guide, for

information about t nsnanes. or a, the local naming configuration

file.
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Step 4: Load Oracle Connect Descriptors into CDS

A separate utility called t nnf g is provided with Oracle DCE Integration to load
connect descriptors into CDS. If you configure a new service name and address in
t nsnanes. or a, t nnf g adds the new service name and address to CDS. If you
change the address for a particular service name, t nnf g updates the address for a
particular service name.

To load the Oracle service names or aliases fromt nsnanes. or a into CDS, enter
the following at the system prompt:

%dce_login cell _adnmn
%tnnfg dcel oad ful |l _pat hnane_t o_t nsnanes. or a
% Enter Password: (password wi Il not display)

Be sure to enter the full path name of the t nsnanes. or a file, and ensure that the
sqgl net . or a file exists in the same directory as the t nsnanes. or a file.

Step 5: Delete or Rename the tnsnames.ora File

You can keep t nsnanes. or a available as a backup in case CDS becomes
unavailable. To assure that CDS is routinely searched instead of t nsnanes. or a,
configure the NAMES. DI RECTORY_PATH parameter in a profile (sql net . or a), as
described by Step 6: Modify the sqglnet.ora File to Resolve Names in CDS (the next
section).

Step 6: Modify the sqlnet.ora File to Resolve Names in CDS

The parameters required in a profile (sgl net . or a) depend upon the version of
SQL*Net or Oracle Net Services you are using.

For a client or server to use DCE CDS Naming, the administrator must do the
following:

1. Ensure that the CDS Naming Adapter has been installed on that node.
2. Add the following parameter to the sqgl net . or a file:
NAMES. D RECTCRY_PATH=(cds, tnshames, onanes)
The first name resolution service listed as a value for this parameter is used. If it

is unavailable for any reason, the next name resolution service is used, and so
forth.
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Connecting to an Oracle Database in DCE

This chapter describes how to connect to an Oracle database after installing Oracle
DCE Integration, and configuring both DCE and Oracle to use Oracle DCE
Integration.

This chapter contains the following topics:
« Starting the Listener

« Connecting to an Oracle Database Server in the DCE Environment
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Starting the Listener
To start the listener, do the following:
1. Enter the following commands:
%dce_l ogi n princi pal _nane password
%Il snrctl start |istener_nane
For example, if the listener name is LSNR_DCE in the | i st ener . or a file, enter
the following:

%dce_| ogi n oracl e orapwd
%Il snrctl start LSN\R DCE

2. Verify that the server has registered its binding handler with rpcd:
% r pccp show mappi ng
Look for the line that includes the dce_ser vi ce_nane that is part of the
listener address.

3. Verify that the service has been created by searching for the dce_servi ce_
nare as follows:

% cdscp show obj ect "/.:/subsys/ oracl e/ service_regi stry/ dce_servi ce_nane"

For example:

The following command shows you the mapping in the CDS namespace that
the listener has chosen for the endpoint:

% cdscp show obj ect "/.:/subsys/ oracl e/ servi ce_regi stry/dce_svc"

SHOWV
QBIECT /...l subsys/ oracl e/ service_regi stry/ dce_svc
AT 1999-05- 15- 17: 10: 52
RPC d ass\Versi on = 0100

DS _CTS = 1999- 05- 16- 00: 05: 01. 221106100/ aa- 00- 04- 00- 3e- 8¢
DS _UTS = 1999- 05- 16- 00: 05: 01. 443343100/ aa- 00- 04- 00- 3e- 8¢
s dass = RPC Server
6 dassVersion = 1.0
LS Towers = :
Tower = ncacn_i p_tcp: 144. 25. 23. 57[ ]
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Connecting to an Oracle Database Server in the DCE Environment

Method 1

Connect to an Oracle server in the DCE environment using one of the following
methods:

« Method 1
« Method 2

After externally-identified accounts have been set up, you can take advantage of
DCE authentication to log in to Oracle without providing any user name/password
information. To use this single sign-on capability, just log in to DCE using a
command like the following:

%dce_| ogi n princi pal _nane password

For example:

%dce_| ogi n oracl e orapwd

Note: You only need to enter the dce_I ogi n command once. If
you are already logged into DCE, you do not need to log in again.

You can now connect to an Oracle server without using a user name or password.
Enter a command like the following:

% sql pl us / @et _servi ce_nane

where net_service_name is the database service name.
For example:

% sql pl us / @GDRADCE
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Method 2

From a client, you can still connect with a user name/password:

% sql pl us user nane/ passwor d@et _ser vi ce_nane

where net_service_name is the Oracle Net service name.

For example:
%sql pl us scott/ti ger @RADCE
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DCE and Non-DCE Interoperability

This chapter describes how clients outside DCE can connect to Oracle servers in
DCE, and how t nsnanes. or a, a local naming configuration file, can be used for
name lookup when CDS is accessible.

This chapter contains the following topics:
« Connecting Clients Outside DCE to Oracle Servers in DCE
« Sample Parameter Files

« Using thsnames.ora for Name Lookup When CDS Is Inaccessible
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Connecting Clients Outside DCE to Oracle Servers in DCE

Clients without access to DCE and CDS can still connect to Oracle servers in DCE
using TCP/IP or some other protocol if a listener is configured to do this. If a
listener has been configured in the | i st ener. or a file on the server, non-DCE clients
can use normal Oracle9i and Oracle Net Services procedures to connect to an Oracle
server in DCE.

Note: In this case, DCE security is not available to clients. Also,
service names are resolved to network addresses and located in a
t nsnanes. or a file on the client, not using the CDS name server.

The following section includes samples of | i st ener. ora and t nsnanes. or a files as
they would be configured if a client from outside of DCE wanted to connect to
Oracle database servers in a DCE environment.
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Sample Parameter Files

At least the following two Oracle parameter files are needed for successful
client/server communications; create and modify these files using a text editor:

The parameter files are described in the following sections:
« The listener.ora File

=« The tnsnames.ora File

The listener.ora File

Theli st ener. or a file resides on the listener node. It defines listener characteristics
and the addresses at which the listener listens.

In the following example, each element is displayed on a separate line, to show the
file’s structure. This is the recommended format, but you do not have to put each
element on a separate line. Be sure to include all the appropriate parentheses, and to
indent if you must continue an element on the next line.

This example assumes the UNIX operating system and the TCP/IP protocol for one
listener, and the DCE protocol for another listener. A single listener can have
multiple addresses. For example, instead of having two separate listeners for
different database instances on a server node, you could have one listener for both,
listening on both TCP/IP and on DCE. However, performance is improved with
separate listeners.

LS\R TCP=
(ADDRESS LI ST=

( ADCDRESS=
(PROTAOL=1 PO
( KEY=DBL)

)

( ADDRESS=
(PROTQOCL=t cp)
(HOBT=r ose)
(PORT=1521)

)
S D LIST_LS\R TCP=
(S D DESC=
(S D_NAME=CRASI D)
(CRACLE_HOME=/ usr/ j prod/ O acl €9i )

LS\R DCE=
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( ADDRESS=
( PROTOOL=DCE)
(SERVER PR N PAL=or acl e)
(CELL_NAME=cel | 1)
(SERVI CE=dce_svc))
SID LI ST_LS\R DCE=
(S D CESG=
(S D NAVE=CRASI D)
(QRAQLE_HOME=/ usr / pr od/ or acl e8))
#For all listeners, the follow ng paraneters |ist sanple
#def aul t val ues.

PASSWIRDS LI STENER=

STARTUP_VWA T_TI ME_LI STENER-0

CONNECT_TI MEQUT_LI STENER=10

TRACE LEVHEL_LI STENER=CFF

TRACE D RECTQRY_LI STENER=/ usr/ prod/ O acl e€9i / net wor k/ t r ace
TRACE Fil e LI STENER=l i stener.trc

LOG D RECTCRY_LI STENER=/ usr / prod/ O acl e9i / net wor k/ | og
LGG FI LE LI STENER-I i st ener. | og

The tnsnames.ora File

This file resides on both the client and the server nodes. It lists the service names
and addresses of all services on the network.

The following sample t nsnanes. or a file maps the service name ORATCP to the
connect descriptor that includes a TCP/IP address and the service name ORADCE to
a connect descriptor that includes a DCE address.

CRATCP = (DESCR PTI ON=
( ADDRESS=
(PROTQOOL=TCP)
(HOBT=r os€)
(PCRT=1521)
)
( GONNECT_DATA=
(S D=DBL)
))
CRADCE=( DESCR PTI ON=
( ADDRESS=
(PROTG0OL=DCE)
( SERVER PR N PAL=or acl e)
(CELL_NAME=cel | 1)
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(SERVI CE=dce_svc)

)
( CONNECT _DATA=
(S| D=CRASI D)
)
)

To access the DB1 database, a user can use ORATCP to identify the appropriate
connect descriptor.

For example:

sql pl us scott/tiger@ratcp
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Using tnsnames.ora for Name Lookup When CDS Is Inaccessible

Typically, names are resolved into network addresses by CDS. Although the main
purpose of the t nsnanes. or a file (in the context of native naming adapters) is to
load Oracle service names and network addresses into CDS, it could be used
temporarily as a backup name resolution service if CDS is inaccessible.

SQL*Net Release 2.2 and Earlier

To use the t nsnanes. or a file for name lookup and resolution, remove (or comment
out) the "native name" parameters from the sql net . or a file on the client. To
comment out the lines, add a pound sign (#) at the beginning of each line.

For example:

#nat i ve_nanes. use_nati ve=true
#nat i ve_nanes. di rect ory_pat h=(dce)

SQL*Net Release 2.3 and Oracle Net Services

You can use t nsnanes. or a for name lookup and resolution when DCE CDS is
unavailable if you have TNSNAMES listed as a value for the NAVES. DI RECTORY_
PATH parameter in the sql net . or a file on the client.

For example:
nanes. di rect ory_pat h=(dce, tnsnanes)
This parameter enables you to list more than one names resolution method. The

methods are tried in order. In this example, DCE is attempted first. If it is
unsuccessful, TNSNAMES is tried next.
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Oracle9i Enterprise User Security

This part describes Oracle9i directory and security integration functionality, which
enables single sign-on in a client/server environment.

This part contains the following chapters, which describe how to set up enterprise
user security in an Oracle database environment:

Chapter 15, Managing Enterprise User Security

Chapter 16, Migrating Local or External Users to Enterprise Users
Chapter 17, Using Oracle Wallet Manager

Chapter 18, Using Oracle Enterprise Login Assistant

Chapter 19, Using Oracle Enterprise Security Manager
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Managing Enterprise User Security

Enterprise User Security lets you create and administer large numbers of users in a
secure, LDAP-compliant directory service. This chapter describes the configuration
and setup of Enterprise User Security.

This chapter contains the following topics:

Part I: Overview / Concepts:

Overview of Enterprise User Security
Shared Schemas

Current User Database Links
Enterprise User Security Tools

Deployment Considerations

Part II: Initial Configuration for SSL and Password Authentication

Part 1ll: Final Configuration for SSL Authentication

Part IV: Final Configuration for Password Authentication

Part V: Troubleshooting Enterprise User Security

See Also: Chapter 19, Using Oracle Enterprise Security Manager
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Part I: Overview / Concepts

This part introduces Oracle Enterprise User Security, and describes its fundamental
concepts.

Part I contains the following sections:

«  Overview of Enterprise User Security
« Shared Schemas

«  Current User Database Links

« Enterprise User Security Tools

« Deployment Considerations
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Overview of Enterprise User Security
This section describes fundamental concepts related to Enterprise User Security:
« Introduction to Enterprise User Security
« Enterprise Users and Authentication Methods
« Enterprise Users and Password Authentication
« Enterprise User Security Directory Entries
« The Enterprise User Security Process with SSL

» The Enterprise User Security Process with Passwords

Introduction to Enterprise User Security

Administrators must manage complex user information for the entire enterprise,
keeping it both current and secure. This task becomes increasingly difficult as the
use of technology expands and the user turnover rate increases throughout an
enterprise. In a typical enterprise, every user can have multiple accounts on
different databases, requiring users to remember passwords for each of these
accounts. This can produce too many passwords for users to remember, and too
many accounts for administrators to effectively manage.

With thousands of users accessing thousands of database accounts, administrators
must devote substantial resources to user administration. Common information
used by multiple applications, such as usernames, telephone numbers, and system
roles and privileges, is typically fragmented across the enterprise, contributing to
data that is redundant, inconsistent, and difficult to manage.

There are security problems as well. For example, any time a user leaves a company
or changes jobs, that user’s privileges should be changed the same day in order to
guard against their misuse. However, in a large enterprise, with user accounts and
passwords distributed over multiple databases, an administrator may be unable to
make such timely changes. In addition, users may elect to write down their
passwords (making them easy for others to copy), or make them easy to remember
(making them easy for others to guess), or simply choose the same password for
multiple applications. All of these user efforts to keep track of their multiple
passwords compromise the security of the enterprise.

Enterprise User Security addresses these user, administrative, and security
challenges by centralizing storage and management of user-related information in
an LDAP-compliant directory service. When an employee changes jobs in such an
environment, the administrator needs to modify information in only one
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location—the directory—to make effective changes in multiple databases and
systems. This centralization can substantially lower administrative costs while
materially improving enterprise security.

Enterprise users benefit from Enterprise User Security as well, through single
sign-on (SSO) or single password authentication, depending on the configuration
chosen by the administrator.

Using single sign-on users need to authenticate only once and subsequent
authentications take place transparently. It addresses the multiple password
problem, and provides stronger, PKI-based authentication, combined with an
improved user experience.

Single password authentication lets enterprise users authenticate to multiple
databases with a single global password although each database requires a separate
authentication. The password is securely stored in the centrally located,
LDAP-compliant directory, and protected with security mechanisms including
encryption and an Access Control List (ACL). This approach improves usability by
reducing the number of passwords to remember and eliminating the overhead of
setting up SSL.

Oracle9i, Release 2 (9.2) Enterprise User Security supports the following
LDAP-compliant directory services:

« Oracle Internet Directory Release 9.2

« Microsoft Active Directory
(supports Oracle8i functionality only)

Oracle Advanced Security also provides a tool, Oracle Enterprise Security Manager,
to create user entries in the directory and manage authorizations for those users.

See Also: Chapter 19, Using Oracle Enterprise Security Manager

Note: Microsoft Active Directory is only supported for Oracle
databases on Windows platforms.
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Enterprise Users and Authentication Methods

Enterprise User Security lets administrators manage two types of users in a single
LDAP-compliant directory:

« Password-authenticated enterprise users
« SSL-authenticated enterprise users
Password-authenticated enterprise users use single password authentication.

SSL-authenticated users use single sign-on (SSO) and strong authentication, using
industry-standard, interoperable X.509 v3 certificates over Secure Sockets Layer
(SSL) v3.

Each authentication method has its own set of selection criteria, as summarized by
Table 15-1:

Table 15-1 Enterprise User Authentication: Selection Criteria

Selection Criteria, Applicable to:

Password Authentication SSL-Authentication

Supports password-based logins. Provides stronger, systemwide security.
Does not support PKI, or PKI Supports PKI, certificate-based
certificate-based client authentication. authentication.

Does not employ SSL, wallets, or X.509 Supports PKI, SSL, and industry-standard
certificates. X.509 certificates.

Supports single, global user passwords, Supports single sign-on (SSO) using SSL.

with separate authentications required for
each database and application (single
password authentication).

Provides faster processing, because there is | Somewhat slower connection processing,
no SSL processing required between but with higher network security.

clients and servers (supports Oracle
Advanced Security native encryption).

From the user/client point of view, SSL is more difficult to configure initially
password authentication may be viewed because PKI credentials must be generated
as easier-to-use, particularly for notebooks | for all users, but it provides stronger

and home workstations. security.
Password authentication is compatible SSL-authentication is compatible with
with either a two-tier or three-tier either a two-tier or three-tier environment.

environment.
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Table 15-1 Enterprise User Authentication: Selection Criteria

Selection Criteria, Applicable to:

Password Authentication SSL-Authentication

Password authentication supports Oracle | SSL-authentication supports Oracle8i or
Release 7.3 or 8.0 clients, with an Oracle9i | Oracle9i clients with an Oracle9i database.
database.

Note: Enterprise User Security supports three-tier environments.
Oracle9i proxy authentication features enable (i) proxy of user
names and passwords through multiple tiers, and (ii) proxy of
X.509 certificates and distinguished names through multiple tiers.

See Also:  Oracle9i Application Developer’s Guide - Fundamentals

Enterprise Users and Password Authentication

Oracle8i releases of Oracle Advanced Security use SSL processing to establish
secure channels between (i) the client and the server, and (ii) the database server
and the LDAP-compliant directory. The client authentication mechanism uses SSL
and X.509 v3 certificates, which requires installed Oracle wallets on both the client
and the server.

Oracle9i complements certificate-based authentication with password-based
authentication for enterprise users, including the following principal features:

« Password-based logins are enabled for enterprise users. Enterprise users can
use a single enterprise username and password to connect to multiple
databases.

« User credentials are stored in an LDAP-compliant directory. Enterprise user
credentials and authorizations are stored in a centralized LDAP-compliant
directory. This includes the username and encrypted password verifier,
enterprise roles, and mappings to individual schemas on each database to
which the user has access rights.

« Client-side SSL and wallets are not required. Implementation of
password-based authentication for enterprise users eliminates the requirement
to install SSL and credential management tools on the client.
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Note: Installation and use of both SSL and Oracle wallets are still
required on the server side—to establish a secure channel between
the database and the LDAP-compliant directory, and between
databases for current user database links.

Enterprise User Security Directory Entries
The following directory entries relate to Enterprise User Security:

« Enterprise Users

« Enterprise Roles

« Enterprise Domains

« Database Server Entries
« User-Schema Mappings

« Administrative Groups

Enterprise Users

An enterprise user is one that is defined and managed in a directory. Each
enterprise user has a unique identity across an enterprise. Enterprise user entries
can reside at any location within the directory.

The entries described in the following sections can only reside within an Oracle
Context.

Enterprise Roles

Enterprise users can be assigned an enterprise role, which determines their access
privileges on databases. These enterprise roles are also stored and managed in a
directory. Figure 15-1 shows an example of an enterprise role called Manager under
the OracleDefaultDomain.

An enterprise role can consist of one global role or many, each one of which is
defined in a specific database. A global role includes privileges contained in a
database, but the global role is managed in a directory. An enterprise role is thus a
container of global roles. For example, the enterprise role USER could contain the
global role HRCLERK with its privileges on the Human Resources database, and the
ANALYST role with its privileges on the Payroll database.
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An enterprise role can be assigned to one or more enterprise users. For example,
you could assign the enterprise role USER to a number of enterprise users who hold
the same job. This information is protected in the directory, and only the
administrator can manage users and assign their roles. A user can be granted local
roles and privileges in a database in addition to enterprise roles.

An enterprise domain subtree includes enterprise role entries, each of which
contains information about associated global roles on each server and authorized
enterprise users. These are created and managed by the Domain Administrator by
using Oracle Enterprise Security Manager.

See Also: Administering Enterprise Roles on page 19-42

Note: The database obtains a user’s global roles when the user
logs in. If you change a user’s global roles in the directory, those
changes do not take effect until the next time the user logs in.

Enterprise Domains

An enterprise domain is a group of databases and enterprise roles. An example of a
domain could be the engineering division in an enterprise or a small enterprise
itself. Figure 15-1 show an example of an enterprise domain called Services that
resides under the OracleDBSecurity entry in an Oracle Context. It is here, at the
enterprise domain level, that the Domain Administrator, using Oracle Enterprise
Security Manager, assigns enterprise roles to users and manages enterprise security.
An enterprise domain subtree in a directory is composed of three types of entries:
enterprise role entries (discussed by Enterprise Roles on page 15-7), User-Schema
Mappings, and the Domain Administrator’s group for that domain.

Database Server Entries

A database server entry (represented as "Sales" in Figure 15-1) contains information
about a database server. It is created by the Database Configuration Assistant or
Oracle Enterprise Security Manager during database registration. A database server
entry is the parent of database level mapping entries that contain mapping
information between full or partial DNs and Oracle shared schema names.
Database-level mapping entries are created by the Database Administrator by
using Oracle Enterprise Security Manager. A Database Administrator’s group,
containing administrators for that database, is located under the server entry:.
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Figure 15-1 Related Entries in an Oracle Context
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User-Schema Mappings

A user-schema mapping entry contains mapping information between a DN and
an Oracle database user name. The users referenced in the mapping are connected
to the specified schema when they connect to the database. User-schema mapping
entries can apply only to one database or they can apply to all databases in a
domain.

See Also: Mapping Enterprise Users to Schemas on page 15-22

Administrative Groups

The Oracle Context contains administrative groups that are related to Enterprise
User Security. Figure 15-1 shows these administrative groups in the Oracle Context.
Each administrative group includes an Access Control List (ACL) that controls
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access to the group itself. ACLs elsewhere in the directory may refer to these
groups, which allows directory administrators access to perform necessary
administrative tasks. The user who creates the Oracle Context with Oracle Net
Configuration Assistant automatically becomes the first member of each of these
groups.

You can also have a Domain Administrator responsible for managing a single
enterprise domain. Similarly, you can have a Database Administrator responsible
for a single database directory entry. These administrative groups reside directly
under the relevant database or domain entry.

The OracleContext creator is a member of each group by default, but can be
removed. Note: every group must have at least one member according to LDAP
restrictions.

Note: Do not modify the ACLs for the objects contained in an
Oracle Context. Use only Oracle tools, such as Oracle Enterprise
Security Manager and Database Configuration Assistant, to modify
Enterprise User Security directory entries. Using other methods
may break the security configuration for these objects and may
break enterprise user functionality as well.

The relevant administrative groups in an Oracle Context are described in Table 15-2
on page 15-11.
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Table 15-2 Administrative Groups in an Oracle Context

Administrative Group

Description

OracleDBCreators

Members of the OracleDBCreators group

(cn=Cr acl eDBCr eat or s, cn=0r acl eCont ext . . . ) are in charge of creating
new databases, and this includes registering each database in the directory by
using the Database Configuration Assistant or Oracle Enterprise Security
Manager. They have cr eat e and nodi f y access to database service objects and
attributes. They can also modify the Default Domain.

Oracle Net Configuration Assistant establishes these access rights during Oracle
Context creation.

Members of the OracleContextAdmins group can add users to this group by
using Oracle Enterprise Security Manager

Oracle Enterprise Security Manager calls this group Database Registration
Admins.

OracleContextAdmins

OracleContextAdmins can modify any group.
Oracle Enterprise Security Manager calls this group Full Context Management.

OracleDBSecurityAdmins

Members of OracleDBSecurityAdmins

(cn=Cr acl eDBSecuri t yAdm ns, cn=0r acl eCont ext . . . ) have root
privileges for the OracleDBSecurity subtree. They have cr eat e, nodi f y, and
r ead access for Enterprise User Security. They have permissions on all of the
domains in the enterprise and are responsible for:

« Administering the OracleDBSecurityAdmins group
«  Creating new enterprise domains
« Moving databases from one domain to another within the enterprise

Oracle Net Configuration Assistant sets up these access rights during Oracle
Context creation.

In addition to OracleContextAdmins, members of this group can add other users
to this group by using Oracle Enterprise Security Manager.

Oracle Enterprise Security Manager calls this group Database Security
Management.

OracleUserSecurity-
Admins

Members of OracleUserSecurityAdmins
(cn=OracleUserSecurityAdmins,cn=Groups,cn=0OracleContext...) are responsible
for Oracle user security. For example, by default they can read wallet password
hints and modify user passwords. The relevant ACL is set at the root of the
directory by default in Oracle Internet Directory.

Oracle Enterprise Security Manager calls this group Directory User
Management.

OraclePasswordAccessible
Domains

Members of this group are enterprise domains that contain databases enabled for
password-authorized enterprise users.
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Security of User Database Login Information

Overview In all secure password-based authentication methods, a server
authenticates a client with a password verifier, typically a hashed version of the
password that must be rigorously protected. Password-based authentication to an
Oracle database is no different. There is an Oracle proprietary password verifier,
and it must be protected as well. This is true if the verifier is stored locally in the
database or centrally in the directory. Note that a password verifier cannot be used
to derive its original password.

In the current release an enterprise user’s database password can be stored in a
central directory service for access by multiple databases, and is viewable and
shared by all trusted databases to which the user has access. Although the
password verifier stored in the directory is not the cleartext password, it is still
necessary to protect it from casual or unauthorized access. It is therefore extremely
important to define password-related ACLs in the directory that are as restrictive as
possible, while still enabling necessary access and usability.

Oracle tools help set up ACLs in the directory to protect these password verifiers.
The approach that Oracle Corporation recommends is intended to balance security
and usability considerations. If you require maximum security and can set up
wallets for all users, you should require only SSL connections from users to
databases. This SSL-only approach circumvents the entire directory password
protection issue.

Setting Up ACLs The OraclePasswordAccessibleDomains group in each Oracle
Context is created automatically when the context is created, and can be managed
using Oracle Enterprise Security Manager. Enterprise domains with member
databases that must view users’ database password verifiers in the directory are
placed into this group. Enterprise Security Manager can be used to place an
appropriate ACL on user subtrees, so that databases in this group can read the
password verifier for users in that subtree.

There are two steps involved in this approach:

1. For aselected Oracle Context, determine which databases can accept
password-authenticated connections. Use Oracle Enterprise Security Manager
to place the domains containing those databases into the
OraclePasswordAccessibleDomains group.

2. For aselected Oracle Context, use Oracle Enterprise Security Manager to select
the user search bases that contain users that require connection to databases in
this context using password authentication. For user entries under these search
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bases, grant access to the password verifier to authorized domains only by
selecting Allow Logon.

This step places an ACL on the selected user search base entry in the directory
that permits access to the attribute that holds the Oracle database password
verifier as follows:

Members of the OraclePasswordAccessibleDomains group in the selected
Oracle Context have read-only access to the attribute. All databases in the
member domains can thus read the password verifier in order to
authenticate enterprise users. Note that databases in domains excluded
from membership in the OraclePasswordAccessibleDomains group cannot
accept password-authenticated connections.

If the user search base is referenced by two different Oracle Contexts, and
domains in both contexts require access from password-authenticated
users, the OraclePasswordAssessibleDomains groups from both contexts
appear in the ACL.

All other users are denied access to this attribute. The ACL that enforces
this is actually at the root of the directory tree.

These ACLs allow access to the Oracle database password verifier value only
(the orcldbpassword attribute). No other attributes in the user entries are
affected.

See Also: Oracle9i Directory Service Integration and Deployment
Guide for more information about the LDAP schema for Enterprise
User Security
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Enterprise User Security Elements
Figure 15-2 displays the Enterprise User Security elements for SSL authentication:

Figure 15-2 Enterprise User Security Elements (SSL-Authentication)
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Figure 15-3 displays the Enterprise User Security elements for password
authentication:

Figure 15-3 Enterprise User Security Elements (Password Authentication)
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The Enterprise User Security Process with SSL

Figure 15-4 shows the operation of the Enterprise User Security process. For an SSL
processing environment, the following assumptions apply:

« A wallet has been set up and configured for the user.

« The user is authenticated to the database through SSL.

Figure 15-4 How Enterprise User Security Works
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1. Anadministrator uses Oracle Net Configuration Assistant to (i) select the
Oracle Context in the directory, or to (ii) create an Oracle Context as necessary.

2. A member of the OracleDBCreators group uses the Database Configuration
Assistant or Oracle Enterprise Security Manager to register the database with
the directory.

3. Anadministrator uses Oracle Enterprise Security Manager to set up both
enterprise users and enterprise roles in the directory and relevant domains.

4. A user initiates an SSL connection to the database by logging on with "connect
/", and the database uses SSL to authenticate the user.

15-16 Oracle Advanced Security Administrator’s Guide



Overview of Enterprise User Security

The database searches locally on the database for a schema exclusively owned
by this user.

If no appropriate user schema is found locally, the database searches for one in
the directory (see step 2 in Figure 15-4). If it finds one, the database retrieves the
user’s enterprise roles from the directory, and enables any associated global
roles applicable to that database.

The Enterprise User Security Process with Passwords

This section describes the operation of the Enterprise User Security process, with
password-based authentication. The following step numbers correspond to the
steps shown in Figure 15-4 on page 15-16:

1.

An administrator uses Oracle Net Configuration Assistant to (i) select the
Oracle Context in the directory, or to (ii) create an Oracle Context as necessary.

A member of the OracleDBCreators group uses the Database Configuration
Assistant to register the database with the directory.

An administrator uses Oracle Enterprise Security Manager to set up both
enterprise users and enterprise roles in the directory and relevant domains, and
to configure attributes in the context.

A user authenticates to the database by logging on with a username and
password.

As part of the authentication process, the database performs the following
steps:

« Itlooks up the username and retrieves the distinguished name (DN) and
password verifier from the directory.

« It authenticates the user based on the retrieved password verifier, and
searches locally on the database for a schema exclusively owned by this
user.

« Ifit does not find an exclusive schema on the database, it searches for a
shared schema in the directory (similarly to Step 6 in the previous section).

« ltretrieves the user’s enterprise roles, and enables any associated global
roles applicable to that database.
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Note: In athree-tier environment, enterprise users can
authenticate to the database through any middle tier using proxy
authentication.
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Shared Schemas

Overview

The following sections describe shared schemas, and how to set them up:
«  Overview

« Configuring Shared Schemas

« Creating a Shared Schema

= Shared Schemas

« Mapping Enterprise Users to Schemas

Users do not necessarily require individual accounts or schemas set up in each
database. Alternatively, they can be granted access to a shared schema that is
associated with target applications. For example, suppose that users Tom, Dick, and
Harriet require access to the Payroll application on the Finance database. They do
not need to create unique objects in the database, and therefore do not need their
own schemas, but they do need access to the Payroll schema.

Oracle9i Release 2 (9.2) supports mapping multiple users stored in an enterprise
directory to a shared schema on an individual database. This separation of users
from schemas reduces administration costs by reducing the number of user
accounts on databases. It means that you do not need to create an account for each
user, also referred to as a user schema, in addition to creating the user in the
directory. Instead, you can create a user in one location, the enterprise directory, and
map the user to a shared schema that other enterprise users can also be mapped to.
For example, if Tom, Dick and Harriet all access both the Sales and the Finance
databases, you do not need to create an account for each user on each of these
databases. Instead, you can create a single shared schema on each database, such as
SALES APPLI CATI ONand FI NANCE_APPLI CATI ON, respectively, that all three
users can access. A typical environment can have up to 5,000 enterprise users
mapped to one shared schema and each user can be assigned a set of enterprise
roles.

Oracle Corporation recommends that you create a separate shared schema that
contains no objects to use as an entry point. Then grant access to application objects
in other schemas through enterprise roles. Otherwise, application objects can be
inadvertently deleted.

In summary, shared schemas provide the following benefits:
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« Shared schemas eliminate the need to have a dedicated database schema on
each database for each enterprise user.

« Each enterprise user can be mapped to a shared schema on each database the
user needs to access. The user connects to the shared schema when the user
connects to a database.

« Shared schemas lower the cost of managing users in an enterprise.

Configuring Shared Schemas

To configure shared schemas, the local database administrator (DBA) must create at
least one database schema in a database. Enterprise users can be mapped to this
schema.

In the following example, the administrator creates a shared schema and maps
users to it:

« The administrator creates a global shared schema called EMPLOYEE and the
global role HRMANAGER on the HR database.

« The administrator uses Oracle Enterprise Security Manager to create and
manage enterprise users and roles in the directory. For example, the
administrator creates enterprise user Harriet and an enterprise role named
MANAGER. The administrator then assigns the HR database global role of
HRVANAGER to the enterprise role MANAGER

« The administrator assigns enterprise roles to enterprise users in the directory.
For example, the administrator assigns the enterprise role MANAGER to Harriet.

« The administrator uses Oracle Enterprise Security Manager to map the user
Harriet in the directory to the shared schema EMPLOYEE on the HR database.

When Harriet connects to the HR database, she is automatically connected to the
EMPLOYEE schema and is given the global role of HRMANAGER. Multiple enterprise
users can be mapped to the same shared schema. For example, the enterprise
security administrator can create another enterprise user Scott and map Scott to the
EMPLOYEE schema. From that point on, both Harriet and Scott automatically use
the EMPLOYEE schema when connecting to the HR database, but each can have
different roles and can be individually audited.
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Creating a Shared Schema
The syntax for creating a shared schema is:

CREATE USER [ shared schena nane] | DENTI FI ED QLGBALLY AS "'

For example, the administrator for the HR database creates a shared schema for the
user EMPLOYEE as follows:

CREATE USER enpl oyee | DENTI F ED GLCBALLY AS "'

Note: There is no space between the single quotation marks in the
syntax for creating a shared schema.
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Shared Schemas
A discussion of the schema identification process follows:

« The database checks internal database tables to see if a user with that DN owns
an exclusive schema (not shared).

« If the database does not find an exclusive schema locally, then it looks for an
appropriate user-schema mapping in the directory. This user-schema mapping
object in the directory associates a user DN with a database schema. The
database may find one or more of the following DN mapping entries:

— Full DN (entry-level) mapping
— Partial DN (subtree-level) mapping

Mapping Enterprise Users to Schemas

Global schemas (those created with CREATE USER | DENTI FI ED GLOBALLY AS
" ") can be owned by one enterprise user (private schema) or shared among
multiple enterprise users (shared schema). The mapping between a single
enterprise user and his or her private schema is stored in the database as an
association between the user DN and the schema name. The mapping between
enterprise users and a shared schema is done in the directory by means of one or
more mapping objects. A mapping object is used to map the distinguished name
(DN) of a user to a database schema that the user will access. You create a mapping
object by using Oracle Enterprise Security Manager. This mapping can be one of the
following:

« AFull DN (entry-level) mapping

This method associates the DN of a single directory user with a particular
schema on a database. It results in one mapping entry for each user.

« Partial DN (subtree-level) mapping

This method lets multiple enterprise users share part of their DN to access the
same shared schema. This method is useful if multiple enterprise users are
already grouped under some common root in the directory tree. The subtree
that these users share can be mapped to a shared schema on a database. For
example, you can map all enterprise users in the subtree for the engineering
division to one shared schema, BUG_APPLICATION, on the bug database.
Note that the root of the subtree is not mapped to the specified schema.
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When an enterprise user connects to a database, the database retrieves a DN for
the user, either from the network (in the case of SSL) or from the directory (in
the case of password-authenticated enterprise users).

When determining which schema to connect the user to, the database uses the
user DN and the following precedence rules:

— It looks for a private schema locally (in the database).

— If itdoes not find a private schema locally, then it searches the directory.
Within the directory, it looks under the server entry, first for a full DN
mapping, then for a partial DN mapping.

— If itdoes not find a mapping entry under the server entry, then it looks
under the enterprise domain entry;, first for a full DN mapping, then for a
partial DN mapping.

— If itdoes not find a private schema locally, or an applicable mapping entry
in the database, then the database refuses the connection. Otherwise, the
database connects the user to the appropriate schema.

For example, suppose that Harriet is trying to connect to the HR database, but the
database does not find Harriet’s private schema (in the database). In this case, the
HR database looks up a user schema mapping with Harriet’s DN in the directory.
The directory has a mapping of Harriet to the shared schema EMPLOYEE and
returns this schema. The database logs Harriet in and connects her to the EMPLOYEE
schema.

The database retrieves this user’s global roles for this database from the
directory.

The database also retrieves from its own tables any local roles and privileges
associated with the database schema to which the user is mapped.

The database uses both the global and the local roles to determine the
information that the user can access.

Continuing this example, assume that the enterprise role MANAGER contains the
global roles ANALYST on the HR database, and USER on the Payroll database. When
Harriet, who has the enterprise role MANAGER, connects to the HR database, she
uses the schema EMPLOYEE on that database.

Her privileges on the HR database are determined by:
— The global role ANALYST

— Any local roles and privileges associated with the EMPLOYEE schema on
the HR database
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«  When Harriet connects to the Payroll database, her privileges are determined
by:
— The global role USER

— Any local roles and privileges associated with the EMPLOYEE schema on the
Payroll database

You can grant privileges to a specified group of users by granting roles and
privileges to a database schema. Every user sharing such a schema gets these local
roles and privileges in addition to personal enterprise roles. However, you should
exercise caution when doing this, because every user who is mapped to this shared
schema can exercise the privileges assigned to it. Accordingly, Oracle does not
recommend granting roles and privileges to a shared schema.
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Current User Database Links

Oracle9i supports current user database links for both SSL-authenticated and
password-authenticated enterprise users. Current user database links let you
connect to a second database as yourself, or as another user when used from within
a stored procedure owned by that user. Such access is limited to the scope of the
procedure. The security advantage of current user database links is that the other
user’s credentials are not stored in the database link definition, and are not sent
across the network connection between databases. Instead, security of these links is
based on mutual trust, mutual authentication, and a secure network connection
between the databases themselves.

For example, a current user database link lets Harriet, a user of the Finance
database, procedurally access the Accounts Payable database by connecting as
Scott, and using Scott's credentials.

For Harriet to access a current user database link to connect to the schema Scott,
Scott must be a schema created as | DENTI FI ED GLOBALLY in both databases.
Harriet, however, can be a user identified in one of three ways:

« By apassword
« GLOBALLY
« EXTERNALLY

To create Scott as a global user in both the Accounts Payable and Finance databases,
you must enter the following command in each database:

CREATE USER Scott | DENTIFI ED QGBALLY as ' O\NeScot t, Gennt!

Note that the syntax for creating this kind of schema is slightly different from the
syntax for creating a shared schema described in Creating a Shared Schema on
page 15-21. In this case, the schema is Scott’s alone. In order for the current user
database link to work, the schema created for Scott cannot be shared with other
users.

Current user database links operate only between trusted databases within a single
enterprise domain—databases within the domain trust each other to authenticate
users. You specify an enterprise domain as trusted by using Oracle Enterprise
Security Manager. By default, if current user database links are enabled for a
domain by using Enterprise Security Manager, they will work for all databases
within that domain. To specify a database as untrusted that is part of a trusted
enterprise domain, use the PL/SQL package DBM5_DI STRI BUTED _TRUST _

ADM N. To obtain a list of trusted servers, use the TRUSTED SERVERS view.
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See Also:

«  Oracle9i Heterogeneous Connectivity Administrator’s Guide, for
additional information about current user database links

«  Oracle9i SQL Reference, for more information about syntax

«  Oracle9i Supplied PL/SQL Packages and Types Reference, for
information about the PL/SQL package DBMS DI STRI BUTED _
TRUST_ADM N

« Oracle9i Database Reference, for information about the
TRUSTED SERVERS view

« Chapter 7, "Configuring Secure Sockets Layer Authentication"

« Chapter 17, "Using Oracle Wallet Manager"
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Enterprise User Security Tools
Enterprise User Security functionality uses the following administration tools:
« Oracle Enterprise Security Manager
» Oracle Enterprise Login Assistant

« Oracle Wallet Manager

Oracle Enterprise Security Manager

Oracle Enterprise Security Manager is an administration tool that provides a
graphical user interface to help you manage

« Enterprise users

« Enterprise domains

« Enterprise roles

« SSL-based and password-based user authentication and authorization

« Oracle Context, database, security, and enterprise domain administrators

« User-schema mappings

See Also: Chapter 19, Using Oracle Enterprise Security Manager

Oracle Enterprise Login Assistant

Use Oracle Enterprise Login Assistant to enable autologin, to upload wallets to or
download them from a directory, and to change wallet, directory, and database
passwords. This tool lets enterprise users use SSL to connect to multiple services
with a single sign-on. Oracle Enterprise Login Assistant masks the complexity of
SSL, wallets, enterprise users, and the process of authenticating to multiple
databases.

Oracle Enterprise Login Assistant also supports password authentication, letting
users securely access multiple databases and applications using a single password,
entered once for each session.
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See Also: Chapter 18, Using Oracle Enterprise Login Assistant

Oracle Wallet Manager

Oracle Wallet Manager is a standalone Java application that wallet owners and
security administrators use to manage and edit the security credentials in their
Oracle wallets.

Note: Although password-authenticated enterprise users do not
require client-side wallets, Oracle Wallet Manager is still required to
support secure connections between the databases and the
directory (server-to-server connections require SSL and server-side
wallets).

See Also: Chapter 17, Using Oracle Wallet Manager, for detailed
information about using this application
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Deployment Considerations
Consider the following before deploying Enterprise User Security:
« Security Aspects of Centralizing Security Credentials

« Database Membership in Enterprise Domains

Security Aspects of Centralizing Security Credentials

Beyond the general benefits that flow from the centralization of enterprise users and
their associated credentials, there are a number of security-related benefits and risks
that should be reviewed.

One security benefit is that centralizing management makes it easier and faster to
administer users, credentials, and roles, and to quickly revoke a user’s privileges on
all applications and databases across the enterprise. With centralized management,
the administrator can delete a user in one place to revoke all global privileges,
minimizing the risk of retaining unintended privileges.

Another security benefit is that it can be more secure to centrally control security
information, because you can centralize the organization’s security expertise.
Specialized, security-aware administrators can manage all aspects of enterprise user
security, including directory security, user roles and privileges, and database access.
This is a substantial improvement over the traditional model, where Database
Administrators are typically responsible for everything on the databases they
manage, including security.

The downside is that, while Oracle Internet Directory is a secure repository, there is
a security challenge and inherent risk in centralizing credentials in any publicly
accessible repository. Although centralized credentials can be protected at least as
securely as distributed credentials, the very nature of centralization increases the
consequences of inadvertent credential exposure to unauthorized parties. It is
therefore imperative to limit the privileges of administrators, to set restrictive
Access Control Lists (ACLSs) in the directory, and to implement good security
practices in the protection of security credentials when they are temporarily outside
of the directory.
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Database Membership in Enterprise Domains

Consider the following criteria when defining the database membership of a
domain:

« Current user database links operate only between databases within a single
enterprise domain.

« Accepted authentication types for enterprise users are defined at the domain
level. Database membership in a domain should therefore be defined
accordingly. If one or more databases are intended to only support SSL-based
certificate authentication, they cannot be combined in the same domain with
password-authenticated databases.

« Enterprise roles are defined at the domain level. To share an enterprise role
across multiple databases, the databases must be members of the same domain.
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Part II: Initial Configuration for SSL and Password Authentication

This part describes the initial Enterprise User Security configuration tasks for both
SSL and password authentication.

This part contains the following tasks:

« Prerequisites

« Task 1: Configure the Database for SSL

« Task 2: Create the Wallet and Start the Listener
« Task 3: Verify Database Installation

« Task 4: Create Global Schemas and Roles
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Prerequisites

The following prerequisites are required:
« Prerequisite A: Install or Identify a Certificate Authority
« Prerequisite B: Install and Configure a Directory Service

« Prerequisite C: Complete Directory Usage Configuration

Prerequisite A: Install or Identify a Certificate Authority

To create valid wallets, you must have a certificate authority (CA) in your
environment. You can use a CA vendor’s certificates, or you can use your own CA
that can process PKCS#10 certificate requests in Base 64 format and return X509v3
certificates—also in Base 64 format.

See Also: Chapter 17, Using Oracle Wallet Manager, for a
description of certificate authorities and Oracle Wallet Manager

Prerequisite B: Install and Configure a Directory Service

Oracle9i Enterprise User Security, Release 2 (9.2) requires Oracle Internet Directory,
Release 9.2. This installs with the required version of the Oracle schema. Install and
configure Oracle Internet Directory. Note that Enterprise User Security requires an
Oracle Internet Directory SSL instance, which in turn requires that the directory
have a wallet.

Caution: For security reasons, do not store the wallet password in
the configuration set in Oracle Internet Directory. Instead, enable
autologin for the directory wallet.

Ensure that the directory has an Oracle9i, Release 2 (9.2) schema and an appropriate
Oracle Context installed. The Oracle9i, Release 2 (9.2) version schema is backward
compatible.

Upgrading the Oracle Context Oracle Internet Directory is shipped with a pre-installed
Oracle Context at the directory root. You can use Oracle Net Configuration
Assistant to create additional Oracle Contexts.

You must upgrade an Oracle8i Oracle Context before registering an Oracle9i
database with that context in the directory. You can use this upgraded Oracle
Context to register any Oracle8i databases that are created in the future. If you have
a combination of Oracle8i and Oracle9i databases deployed, set the
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VERS| ONCOMPATI BI LI TY parameter to 8i and 9i, using Oracle Enterprise Security
Manager. Oracle recommends that you set this to 9i if you deploy only Oracle9i
databases. This parameter determines if some of the database security attributes
must be represented in the directory in two places to support both Oracle8i and
Oracle9i databases. If you are deploying only Oracle8i databases, there is no
requirement to upgrade the Oracle Context—and no requirement to set this
parameter.

Note:

« If Oracle Enterprise User Security has been set up with an
Oracle8i Oracle Context, then the associated security
information (enterprise users, roles, privileges, domains...)
cannot be upgraded when the Oracle8i context is upgraded. In
this case, you must create a fresh Oracle9i Oracle Context and
re-create the security information.

« If you have never used Oracle Enterprise User Security in an
Oracle8i Oracle Context, then you can upgrade at the Oracle
Context to an Oracle9i context and proceed with setup and
configuration.

Create Administrative Users, If Necessary If they do not already exist, create enterprise
users in the directory who are authorized to perform the following functions:

« Register databases
« Administer database security

« Create and manage enterprise domains
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Note: Itis possible to perform all Enterprise User Security
administrative functions as a single administrator. If you choose
this approach, you need only create one administrative user entry.

However, Oracle Enterprise User Security provides the capability to
create many different kinds of administrators so security functions
can be assigned to different people. Separating security functions in
this way results in a more secure enterprise environment.

See Also:
«  Oracle9i Directory Service Integration and Deployment Guide
« Chapter 17, "Using Oracle Wallet Manager"

« Appendix E, "Using Enterprise User Security with Microsoft
Active Directory" for information about using Microsoft Active
Directory as the LDAP directory for enterprise user security.
Note that Active Directory is supported for Oracle8i
functionality only.

Prerequisite C: Complete Directory Usage Configuration

Set up directory access for an Oracle home using Oracle Net Configuration
Assistant and register the database in the directory using Database Configuration
Assistant or Oracle Enterprise Security Manager.

About Registering the Database in the Directory When a database is properly registered
in the directory, the following changes occur:

« A new database service object is created and assigned a DN in the directory
under the specified Oracle Context, and the database is made a member of the
default enterprise domain.

« The newly created database DN is added to the database spfi | e. or a file as
an RDBMS_SERVER DNinitialization parameter value.

A database can be registered in the directory using either Oracle Enterprise Security
Manager or Database Configuration Assistant. However, each tool performs a
different set of automatic configurations. These differences are summarized in
Table 15-3.
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Table 15-3 Differences between Using Oracle Enterprise Security Manager or Database Configuration
Assistant to Register a Database in the Directory

Creates Adds Creates Sets

Database Database Placeholder RDBMS Creates

DN Entry  to the Database SERVER_ Valid

in the Default Wallet in the DN Database
Oracle Tool Directory  Domain Directory Parameter Wallet
Oracle Enterprise Security Manager Yes Yes Yes No No
Database Configuration Assistant Yes Yes No Yes No

Note: Either tool can be used to register databases, but you cannot
partially register a database with one tool and complete the
registration process with the other tool. For example, if Oracle
Enterprise Security Manager is used to register a database, then
you cannot use Database Configuration Assistant to register the
same database and set the RDBMS_SERVER_DN parameter in the
spfil e. orafile.

About Using Database Configuration Assistant to Register a Database in the Directory This
tool requires that individual local DBAs be granted access to the directory by
adding the DBA to the Database Registration Admins group in Oracle Enterprise
Security Manager.

See Also: Oracle9i Directory Service Integration and Deployment
Guide for information about using Database Configuration
Assistant to register a database in the directory.

About Using Oracle Enterprise Security Manager to Register a Database in the Directory This
tool can be used to register a database with the directory from a centralized location
without granting directory access privileges to individual local DBAs. If you use
Oracle Enterprise Security Manager to register databases in the directory, then after
registration, you must

« setthe RDBMS_SERVER DN parameter in the spfi | e. or a file for the database
using the ALTER SYSTEMcommand

« Create a database wallet with Oracle Wallet Manager to store and manage
certificates for each database that is registered in the directory
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See Also: Chapter 19, "Using Oracle Enterprise Security
Manager" for information about using Oracle Enterprise Security
Manager to register a database in the directory.

Notes:

« The RDBMS_SERVER_DN parameter in the spfi | e. or a file
must be consistent with the actual DN in the directory.

« Use your directory administration tool to verify that a database
entry and subtree exist under your Oracle Context in the
directory.

« If you get an error message, use Oracle Enterprise Security
Manager to check that the user you are providing credentials
for is in the Database Registration group.

« If you use Oracle Enterprise Security Manager to register the
database, then the SID of the database must be equal to the
short database name. If it is not, then you must use Database
Configuration Assistant to register the database in the
directory.
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Task 1: Configure the Database for SSL
To configure the database for SSL.:

« Step 1. Configure Oracle Net for Listener and Database SSL Support
« Step 2: Configure SSL Service Name

« Step 3: Configure the Listener

« Step 4: Review the .ORA Files

Step 1: Configure Oracle Net for Listener and Database SSL Support

Oracle Net must be configured for SSL on both the listener and the database. The
listener must have a listening endpoint that is configured for the TCP/IP with SSL
protocol, and the location of the database wallet must be specified. Use Oracle Net
Manager to do this (See: Enabling SSL on page 7-14):

1. Start Oracle Net Manager
2. Configure Profile:
« Inthe SSL tab, choose the Server button.
« Add the database name to the end of the wallet location.

« SelectFil e>Save the network configuration;yoursql net.ora
file is updated.

Note: You can select a location for the database other than the
default, if desired.

Suggested Wallet Locations for a database:
« Windows: <user profi |l e>\ ORACLE\ WALLETS

= UNIX: /et c/ ORACLE/ WALLETS/ DATABASES/ dat abase_
name

Step 2: Configure SSL Service Name
Configure the SSL service name using Oracle Net Manager.

Do not test this connection when asked. It will fail because (i) you have not set up
the listener to listen for SSL connections, and (ii) if you have used the database
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configuration assistant to register a database with the directory, then you have not
set up the database wallet.

See Also: ,"Enabling SSL" on page 7-14 for information about
using Oracle Net Manager to configure an SSL service name (Step
2) and to configure the listener (Step 3).

Step 3: Configure the Listener
Use Oracle Net Manager to configure the listener to have an SSL listening endpoint.

Notes:

« Do not attempt to start the listener until you have set up a
wallet for SSL connections.

« Do not modify the value of SSL_CLI ENT_AUTHENTI CATI ON
inli stener. ora, which should be FALSE. The listener is not
performing the authentication. Rather, the database uses SSL to
authenticate the client.
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Step 4: Review the .ORA Files
To facilitate review of your . or a files, some Windows NT examples follow:

Example: The SQLNET.ORA File

NAVES. DEFALLT_DOMAI N = VWER.D
WALLET LOCATI ON =

(SORCE =
(METHD = FILE)
( METHCD DATA =

(D RECTARY = C\WNNN Prof i | es\ DATABASES\ 0€)

)
)

SQNET_AUTHENTI CATI ON_SERVI CES = (TGPS, NTS)
SSL QLI ENT_AUTHENTI CATI ON = TRUE

SSLVERS ON =0

Note: The wallet location matches the one you entered in Oracle
Net Manager for the database.
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Example: The TNSNAMES.ORA File:

(ESSL. WRD =
(DESCRPTION =
(ADDRESS LI ST =
(ADDRESS = (PROTGOL = TAPS) (HCBT = host 1) (PCRT = 5000)
)
(QONNECT_DATA =
(SERV CE_NAME = fi nance)
)
(SEOR TY = ( AUTHENTI CATI ON_SERV CE = TCPS)
(SSL_SERVER (ERT_DN\="cn=f i nance, cn=Q acl eCont ext , 0=Q acl e, c=us")
)
)

CE WRD =
(DESCRPTION =
(ACDRESS LI ST =
(ADDRESS = (PROTAOL = TAP) (HOST = host1) (PCRT = 1521)
)
(QO\NECT_DATA =
(SERVI CE_NAME = oe. worl d)
)
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Example: The LISTENER.ORA File:

VALLET LOCATI N =
(SORCE =
(METHD = FI LB
(METHOD DATA =
(D RECTARY = C\WNNN Prof i | es\ DATABASES\ oe)
)

LI STENER =
(DESCR PTI QN LI ST =
(DESCR PTI ON =
( ACDRESS = ( PROTQOCL

TCP) (host = HOBT1) (port = 1521)
)
(DESCR PTICN =

( ADDRESS = (PROTOOL

TQPS) (HOBT = host1) (PCRT = 5000))
)
)

SID LI ST_LI STENER =
(SIDLIST =
(SIDDESC =
(Q.CBAL_DBNAME = oe. wor | d)
(CRACLE_ HOME = D\ Q acl e\ O a8l)
(S D_NAME = oe)

SSL QLI ENT_AUTHENTI CATI ON = FALSE
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Task 2: Create the Wallet and Start the Listener

To create and configure the database wallet:

« Step 1. Create a Database Wallet

« Step 2: Enable Autologin

« Step 3: Start the Listener

« Step 4. Perform Database Logout for Security (optional)

Step 1: Create a Database Wallet
Create a database wallet.

See Also: "Managing Wallets" on page 17-11 for information
about creating a database wallet.

When you select New from the wallet menu, do not create a new default directory
when asked—this is for user wallets. During certificate request creation, type the
distinguished name (DN) of the database exactly:

cn=si npl e_dat abase_nane, cn=Q acl eContext, <l ocati on of Q acl econt ext >

It is found in the initialization parameter file, in the parameter
ROBVE SERVER DN

Note: The Distinguished Name is case-sensitive.

For example:

If the global database name chosen during installation is sal es. us. nnt . com
and the location selected within Oracle Net Configuration Assistant for the
Oracle Context is o=nnt, the complete DN of the database that you enter into
Oracle Wallet Manager is:

cn=sal es, cn=Q acl eCont ext , o=nm

Note: cn=0Or acl eCont ext must be included in the DN
immediately after the simple database name.
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Step 2: Enable Autologin

For the database to communicate securely with Oracle Internet Directory, autologin
must be enabled for the database wallet. If users will be authenticated with SSL,
then the database listener needs to be started. The listener reads the cwal | et . sso
file created when autologin is enabled for the database. To enable database
autologin:

1.
2.
3.

Use Oracle Wallet Manager.

For verification, check that there isa cwal | et . sso file in the wallet directory.

Stop the listener.

To stop the listener, enter the following at the command line:

Windows: | snrctl stop
UNIX: I snrctl stop

Notes:

« You must use Oracle Wallet Manager to enable autologin for a
database wallet. You cannot use Oracle Enterprise Login
Assistant.

« End users never have to use Oracle Wallet Manager, because
Oracle Enterprise Login Assistant can be used to enable
autologin.

Change Oracle Services Login (Windows only). Because the database and the
listener services are running as system (with few privileges in NT), and the
wallets are opened under your user name, the database and the listener are not
able to read the wallet. In order for them to read their wallet, they must be
changed to log on as the user who enabled autologin for the database wallet.

To change the Oracle Services login:

Shut down the database by opening the Services control panel and selecting
O acl eServi ce <dat abase nane>; choose the St op button; choose
Yes to confirm.

Choose the St ar t up button.

Inthe Log On As region of the Service window, Choose Thi s Account
and enter <donmai n>\ < NT user | ogi n> for the user who enabled
autologin for the database wallet.
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Alternatively, you can choose the browse button (...) to select from a list;
enter your password in the Passwor d and Conf i r m Passwor d fields;
choose OK. The Oracle Service window is shown in Figure 15-5 on

page 15-44.

Figure 15-5 The Oracle Service Window

Service
Service: OracleS erviceOE
—Startup Type
. ak
' Automatic
' Marual Cancel |

" Dizabled Help |

—Log On As:
' System Accaount

™ llow Service to lnteract with Desktop

& This Account; |MEYDUNG-LAF'\mey0ung |_|

Pazsward: | ******

LConfirm I xxxxxx
Pazsword:

« Choose St art to start up the Oracle database.

« Repeat these steps (starting with Choose the Startup Button) for
Oracl e- <ORACLE_HOVE_NAME>- >TNSLi st ener ; do not start the listener
service.

« Close the Services window.
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Step 3: Start the Listener

Notes:

« If the Listener starts correctly, it confirms that it is listening on
TCPS, on the command line.

« If there are errors when you attempt to start the Listener, you
may not have selected autologin, or the wallet may be in the
wrong location.

« Under Windows, you can use the OracleListener Service under
the services control panel to start and stop the listener—but
without the command line response that confirms listener
activity.

The database wallet is now open, and the database is able to participate in
authenticated communications using SSL; on Windows, the
Oracl eTNSLi st ener service is also started.

See Also: Chapter 17, Using Oracle Wallet Manager, for detailed
instructions about creating a wallet

Step 4: Perform Database Logout for Security (optional)

If the database is to be shut down for an extended period of time, then disable use
of the database wallet for security purposes by disabling autologin with Oracle
Wallet Manager.
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Task 3: Verify Database Installation
To verify that the database has been successfully configured:

1. Verify that there isa cwal | et. sso file located in the database wallet directory. If
not, autologin was not successfully enabled. If this happens, go back to the
Oracle Wallet Manager, open the wallet, select the Autologin check box, and
save the wallet.

2. \Verify that there is an | dap. or a file located in
$ORACLE_HOVE/ net wor k/ adni n

If there is no | dap. or a file, Oracle Net Configuration Assistant failed to
configure directory access. Verify that the ORACLE_HQOVE is set and rerun the
network configuration assistant.

3. Use the directory administration tool to verify that a database entry and subtree
exist under the Oracle Context you specified when you ran the network
configuration assistant. If you do not find the database entry, verify that the
directory is running, the Oracle Context is set up, and the | dap. or a file exists
and is correct. Then register the database again, using Database Configuration
Assistant or Oracle Enterprise Security Manager.

Task 4: Create Global Schemas and Roles

Although this task can be completed using Oracle Enterprise Manager, the
following examples use SQL*Plus directly.

To create global schemas and roles:

« Step 1. Create a Global Schema

« Step 2: Grant a Create Session Privilege
« Step 3: Create Global Roles

« Step 4: Associate Privileges
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Step 1: Create a Global Schema

Using SQL*Plus, create a shared schema for enterprise users. For example, to create
a shared schema called guest , enter the following:

CREATE USER guest | DENTI FI ED QLGBALLY AS '’
Note the two single quotation marks with no space between them at the end of the

line. If you enter a specific distinguished name (DN) between the quotation marks,
only that user is able to connect to that schema, and it is not shared.

Step 2: Grant a Create Session Privilege

Users connecting to this schema require a CREATE SESSI ON privilege. You can
grant the CREATE SESSI ON privilege either to the global schema, or to a global
role which you grant to specific users through an enterprise role.

Step 3: Create Global Roles

Create global roles for the database to hold relevant privileges. These roles are
associated with enterprise roles to be created later. Enterprise roles are allocated to
users.

For example:

CREATE RCLE enprol e | DENTIFI ED Q.CRALLY;
CREATE ROLE custrol e | DENTI FI ED Q.CBALLY;

Step 4: Associate Privileges
Associate privileges with the new global roles.

For example:

GRANT sel ect ON products TO custrol e, enprol e;

Note: Oracle Advanced Security can be configured to authenticate
enterprise users using SSL or password authentication, or both.

« To configure SSL authentication, continue with Part Il1: Final
Configuration for SSL Authentication, which follows.

« To configure password authentication, go to Part IV: Final
Configuration for Password Authentication on page 15-56.
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Part IlI: Final Configuration for SSL Authentication

This section describes the final steps to complete the installation and configuration
of Enterprise User Security for SSL authentication. The required tasks (numbered in
sequence from Part 1) follow:

« Task 5: Configure Database Clients
« Task 6: Configure an Enterprise Domain
« Task 7: Configure Enterprise Users

« Task 8: Log In as an Enterprise User

Note: The configuration tasks for Enterprise User Security are
numbered consecutively, and continue in sequence from Part I1.
This part includes Task 5 through Task 8.

« For Tasks 1 through 4, See: Part II: Initial Configuration for SSL
and Password Authentication on page 15-31

« For Tasks 9 through 12, See: Part IV: Final Configuration for
Password Authentication on page 15-56.
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Task 5: Configure Database Clients

Once you have installed Oracle9i clients, configure Oracle Net on the clients by
using Oracle Net Manager. You may complete this step during or after installation
of Oracle9i Release 2 (9.2).

Because you will be using an LDAP directory service for enterprise security, you
may also want to use Oracle Net directory naming. Oracle Net directory naming
lets the client connect to the database using the database entry registered with the
directory by Database Configuration Assistant. Alternatively, you can use one of the
other Oracle Net naming methods, such as local naming (t nsnanes. or a file), to
configure a net service name for the database.

To configure database clients:

1.

Use Oracle Net Manager to configure an SSL net service name, as described in
"Enabling SSL" on page 7-14.

Configure the client profile. Do not enter a wallet location when configuring a
client profile. The lack of a specific wallet location indicates that SSL should find
the default wallet for the current operating system user. In this way, the

sqgl net . or a file can be shared by enterprise users, providing easier
administration and deployment. Each user whose wallet is in a nondefault
wallet location must have a separate sql net . or a file that contains that user’s
wallet location.

Note: If you do not install clients, and ORACLE _HOME is setto a
database server ORACLE HOVE, and that ORACLE_HOVME has a
sqgl net . or a file with a wallet location, you must create at least
one new TNS_ADM Ndirectory with a sqgl net . or a file—with no
wallet location. This ensures that SSL uses the default location of
the wallet for the operating system user.

Default Wallet Directories for the User Wallets:

Windows:

<user profil e>\ ORACLE\ WALLETS

UNIX:

/ et ¢/ ORACLE/ WALLETS/ <oper ati ng_syst em user nane>
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Note: Wallets for specific users are set up when you create
enterprise users. See Chapter 19, Using Oracle Enterprise Security
Manager, for instructions about creating enterprise users.

See Also:
« Oracle9i Net Services Administrator’s Guide

« Chapter 7, Configuring Secure Sockets Layer Authentication,
for information about configuring SSL

Task 6: Configure an Enterprise Domain

Oracle Enterprise Security Manager is installed automatically as part of the Oracle9i
installation, and is used to configure an enterprise domain. Note that the Oracle
default domain is created by default when the Oracle Context is created in the
directory, and databases are automatically added as members of that domain when
they are registered by Database Configuration Assistant or Oracle Enterprise
Security Manager. Table 154 lists the steps required to set up an enterprise domain,
and cross-references related instructions. If you are using the Oracle default
domain, you can skip steps 1 and 4.

Table 15-4 Setting up an Enterprise Domain

Step Related Instructions

1. Create an enterprise domain.

Administering Enterprise Domains on
page 19-35.

2. Enable or disable current user database
links between member databases.

Administering Enterprise Domains on
page 19-35.

3. Select authentication type for the
domain. Must be (i) SSL only, or (ii) both
password and SSL.

"Managing Database Security Options for
an Enterprise Domain" on page 19-39.

4. Enroll the database as a member of the
desired enterprise domain.?

Defining Database Membership of an
Enterprise Domain on page 19-37

5. (Optional) Add domain administrators
for the domain.

Chapter 19, Using Oracle Enterprise
Security Manager.

6. Configure user-schema mappings for the
domain; alternatively, you can configure
database-specific user-schema mappings.

Chapter 19, Using Oracle Enterprise
Security Manager.
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Table 15-4 Setting up an Enterprise Domain

Step Related Instructions
7. Create enterprise roles in the domain. Administering Enterprise Roles on
page 19-42.

8. Create global roles on the databases. The |«  Oracle9i SQL Reference
* S
SQL*Plus command is: « See Also: Step 3: Create Global Roles

CREATE ROLE rol enane | DENTI FI ED on page 15-47

GLOBALLY

9. Assign global roles to each enterprise Administering Enterprise Roles on
role. page 19-42

1 A database can be a member of no more than one domain at a time. If you change a database’s
domain membership, then you need to restart the database.

Task 7: Configure Enterprise Users
To create a new enterprise user:

« Step 1. Add a New Enterprise User to the Directory
« Step 2: Create a User Wallet

« Step 3: Authorize the User

« Step 4. Map the User to a Schema

Step 1: Add a New Enterprise User to the Directory

Any directory user can be an enterprise user. You can add users to the directory by
using one of the following tools:

« Oracle Enterprise Security Manager
« The administration tool for your directory service
« The standard LDAP command line tools

If you do not use Oracle Enterprise Security Manager to populate the directory with
users, then you need to add the or cl user objectclass to their user entries in the
directory.

If Oracle Enterprise Security Manager is used to prepare existing user entries for
Oracle use (provision), the or cl user objectclass is added to the existing entry.
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Note: You must use Oracle Enterprise Security Manager or Oracle
Enterprise Login Assistant to set the database password for users in
the directory. The database password in the or cl passwor d
attribute cannot be correctly set using a directory manager tool or
an LDAP command line tool.

See Also:

« Creating New Enterprise Users on page 19-8 for instructions
about adding new enterprise users to the directory by using
Oracle Enterprise Security Manager

« Documentation for your directory service for information about
using the directory administration tools

Step 2: Create a User Wallet
To create a user wallet, See: Chapter 17, Using Oracle Wallet Manager.

Note: Store the user wallet in the default user wallet location, or
in the directory (if it is stored only in the directory, it must be
downloaded to the client before use):

«  Windows: x: \wi nnt\ profil es\<os
user >\ ORACLE\ WALLETS

On Windows, the default wallet location is always under the
userprofile location. The userprofile location can be configured
using set userprofil e=location.

« UNIX:/ et c/ ORACLE/ WALLETS/ <os user >

Step 3: Authorize the User
You can do either or both of the following:

« Local Oracle role authorization:

Use Oracle Enterprise Manager or SQL*Plus to grant local roles and privileges
to the database schema. This step is optional.
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Note: Oracle Corporation recommends that you do not grant any
roles or privileges to a shared schema because those roles and
privileges would be enabled for any user connecting to (or mapped
to) that schema.

« Enterprise role authorization:

Use Oracle Enterprise Security Manager to grant enterprise roles to the
enterprise user in the directory.

Step 4: Map the User to a Schema

If you are using a shared schema, use Oracle Enterprise Security Manager to map
the user to a schema. You can choose either of the following mapping options:

« Database:

Applies to one database.
« Enterprise domain:

Applies to all databases in the enterprise domain.
For example:

If you are creating a domain mapping from three users to a shared schema called
guest, and you have more than one database in the domain, each database must
have a shared schema (called guest) that all three users can access. These three users
cannot connect to any database in the domain that does not have a shared schema
called guest.

Alternatively, you can create a mapping under a particular database. If you do it
this way, the mapping applies only to that database, and not to all databases in the
domain. If you have mappings in both places, the database mapping takes
precedence.

See Also:

« Task 6: Configure an Enterprise Domain, for information about
setting up an enterprise domain

« Administering Enterprise Users on page 19-7

« Mapping Enterprise Users to Schemas on page 15-22
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Task 8: Log In as an Enterprise User
To log in as an Enterprise User:
« Step 1: Download the User Wallet
« Step 2: Enable Autologin
« Step 3: Connect to the Database

Step 1: Download the User Wallet
To download a user wallet from the directory:

1. Log in to the operating system as the appropriate user.

2. Download the wallet using Oracle Enterprise Login Assistant.

See Also: "Connecting to LDAP Directory and Downloading
New Wallet" on page 18-6 for information about downloading the
wallet from the directory by using Oracle Enterprise Login
Assistant.

Step 2: Enable Autologin

The enterprise user must enable autologin for the user wallet (created in Task 10) in
order to connect to the database. Enabling autologin generates a single sign-on file
and enables authentication to the SSL adapter.

To enable autologin, use Oracle Enterprise Login Assistant.

See Also: Chapter 18, Using Oracle Enterprise Login Assistant,
for information about downloading a user wallet and enabling
autologin.

Step 3: Connect to the Database
1. Set ORACLE HOME.

If the ORACLE_HQOME is set to a server ORACLE_HOME, you must set the TNS
ADM N environment variable to address the directory where you placed the
client sql net . or a file—that you created in Task 5: Configure Database Clients
on page 15-49.

If you have a separate client ORACLE_HQOVE, you do not need to set the TNS
ADM N environment variable.

2. Launch SQL*Plus and enter:
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sql pl us/ @onnect _i dentifier
where connect _i dent i fi er is the net service name you set up in Task 5:
Configure Database Clients on page 15-49.

If you are successful, the system responds Connect ed t o: ...; this is the principal
confirmation of a successful connection and setup. If an error message is displayed,
see: "Part V: Troubleshooting Enterprise User Security" on page 15-56.

If you do connect successfully, check that the appropriate global roles were
retrieved from the directory by entering:

sel ect * fromsession_rol es

Using Oracle Enterprise Login Assistant, choose the Logout button (Figure 18-2) to
disable authentication with the SSL adapter.

See Also: Chapter 18, Using Oracle Enterprise Login Assistant,
for instructions about using Oracle Enterprise Login Assistant

Note: You have competed the configuration of Enterprise User
Security for SSL authentication, then do not proceed to Section 1V,
which describes the configuration of password authentication only.
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Part IV: Final Configuration for Password Authentication

At this point, you should already have a directory server and a database that are
SSL-enabled. In addition, you should already have created global schemas and roles
on the database.

This section describes how to set up password authentication for enterprise users.
The required tasks (humbered in sequence from Part I11) follow:

« Task 9: Configure the Enterprise Domain
« Task 10: Configure Oracle Context
« Task 11: Configure Enterprise Users

« Task 12: Connect as Password Authenticated Enterprise User

Note: The configuration tasks for Enterprise User Security are
numbered consecutively, and continue in sequence from Part IIl.
This part includes Task 9 through Task 12.

« For Tasks 1 through 4, See: Part II: Initial Configuration for SSL
and Password Authentication on page 15-31

« For Tasks 5 through 8, See: Part I1l: Final Configuration for SSL
Authentication on page 15-48.

« To configure SSL authentication for enterprise users, complete
the tasks in Part Il and Part 11l only. To configure password
authentication for enterprise users, complete the tasks in Part |1
and Part IV only.
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Task 9: Configure the Enterprise Domain
Configure the enterprise domain for password authentication.

Oracle Enterprise Security Manager is used to manage enterprise domains, users,
roles, and databases. It can be used to configure an enterprise domain. Note that the
Oracle default domain is created by default when the Oracle Context is created in
the directory, and databases are automatically added as members of that domain
when they are registered by Database Configuration Assistant or Oracle Enterprise

Security Manager.

Table 15-5 lists the steps required to set up an enterprise domain, and
cross-references related instructions. If you are using the Oracle default domain,

you can skip step 1 and step 4.

Table 15-5 Setting up an Enterprise Domain

Step

Related Instructions

1. Create an enterprise domain.

Administering Enterprise Domains on
page 19-35.

2. Enable or disable current user database
links between member databases.

Administering Enterprise Domains on
page 19-35.

3. Choose the Enterprise Domain

Administration tab; select Oracle Wallet
(SSL) And Password from the Enterprise
User Authentication drop-down menu.

"Managing Password Accessible Domains"
on page 19-30.

4. Use Oracle Enterprise Security Manager
to make the database a member of the
desired enterprise domain.

Defining Database Membership of an
Enterprise Domain on page 19-37.

5. (Optional) Add domain administrators
for the domain.

Chapter 19, Using Oracle Enterprise
Security Manager.

6. Configure user-schema mappings for the
domain. Alternatively, you can configure
database-specific mappings.

User-Schema Mappings on page 15-9.

7. Create enterprise roles in the domain.

Administering Enterprise Roles on
page 19-42.

8. Create global roles on the databases. The
SQL*Plus command is:

CREATE ROLE rol enane | DENTI FI ED
GLOBALLY

«  Oracle9i SQL Reference

« See Also: Step 3: Create Global Roles
on page 15-47
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Table 15-5 Setting up an Enterprise Domain

Step Related Instructions

9. Assign global role(s) to each enterprise Administering Enterprise Roles on
role. page 19-42.

Task 10: Configure Oracle Context

« Step 1. Configure User Search Bases
« Step 2: Enable Database Access

« Step 3: Configure UserID Attribute
« Step 4: Configure Administrators

« Step 5: Configure Password-Accessible Domains

Step 1: Configure User Search Bases

In the General tab of the Oracle Context Properties Window add the user search
bases under which the databases are to search for user entries. A user search base is
the root of a subtree under which you have stored your enterprise user entries in
the directory.

Note: When you enter user search bases, Oracle Enterprise
Security Manager attempts to grant access permissions in the user
search base subtree so the appropriate databases can read users’
login credentials.

If the current enterprise administrator (the user of Oracle
Enterprise Security Manager) does not have permission in the
directory to modify the Access Control List (ACL) on the user
search base entry, then Oracle Enterprise Security Manager will fail
with an error message in this part of the user search base setup. If
this happens, then an enterprise administrator with the appropriate
directory privileges must use Oracle Enterprise Security Manager
to enable database access on this user search base. See: "Step 2:
Enable Database Access" on page 15-59.
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Step 2: Enable Database Access

The user entry must reside in a directory subtree of users that has been enabled for
Oracle database access. You can set Oracle Database Access permissions for a
selected subtree to let databases within a domain in the Password-Accessible
Domains group of a particular Oracle Context read the user’s login credentials.

To enable database access:

Under an Oracle Context, select a user search base on a selected subtree of directory
users, set Oracle Database Access permissions to permit databases in the
Password-Accessible Domains group to access the user’s database login credentials:

« Select the target user subtree under Users, by Search Base.
« Select the Enable Database Access tab.

« Select Enable Logon to Authorized Enterprise Domains for that subtree.

Step 3: Configure UserID Attribute

Choose the General tab in the Root Oracle Context Properties window. In the
Context Attribute Settings region, enter the name of the user entry attribute that
holds the User | D (nickname) that uniquely identifies each enterprise user.

If you do not want to have the user nicknames (User | D) stored in the cn attribute
(which is the default), then this must be configured for the entire directory in the
Root Oracle Context.

Example:

« Assume that all enterprise users in your organization can be
uniquely identified by their enpl oyeei d.

« Ifenpl oyeei d values are stored in an attribute called ei d,
you enter ei d in the User | Dfield.
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Step 4: Configure Administrators

Choose the Administrators tab in the Root Oracle Context Properties window. Set
up necessary administrators for this Oracle Context, if you haven’t already done so.
« A Context Administrator has full privileges for the Oracle Context.

« A Database Security Administrator can create and delete enterprise domains
and roles, and assign databases to domains.

« A User Security Administrator manages security for the user entries in the
directory, by setting passwords, viewing password hints, and other similar
actions.

Step 5: Configure Password-Accessible Domains
In order to accept password-authenticated connections, a database must belong to a
domain in the Password Accessible Domains group.

In a selected Oracle9i Oracle Context, put your database into the
Password-Accessible Domains group. Choose Add and select one of the current
enterprise domains from the resulting dialog. To remove an enterprise domain from
the group, select it in the Accessible Domains window and choose Remove.

See Also:

« "Managing Password Accessible Domains" on page 19-30 for
information about using Oracle Enterprise Security Manager to
configure password-accessible domains.

« Security of User Database Login Information on page 15-12
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Task 11: Configure Enterprise Users
« Step 1: Create Enterprise Users

« Step 2: Authorize Users

« Step 3: Create Enterprise UserIDs

« Step 4: Create Enterprise User Passwords

Step 1. Create Enterprise Users

Any directory user can be an enterprise user. You can add users to the directory by
using one of the following tools:

« Oracle Enterprise Security Manager

« The administration tool for your directory service

« Thestandard LDAP command line tools

Note:

If you populate the directory with users before using Oracle
Enterprise Security Manager, then you must add the or cl user
obj ect cl ass to their user entries.

You must use Oracle Enterprise Security Manager or Oracle
Enterprise Login Assistant to set the database password for
users in the directory. The database password in the

or cl passwor d attribute cannot be correctly set using a
directory manager tool or an LDAP command line tool.

See Also:

Administering Enterprise Users on page 19-7 for instructions
about adding new enterprise users to the directory by using
Oracle Enterprise Security Manager

Documentation for your directory service for information about
using the directory administration tools
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Step 2: Authorize Users
You can do any of the following:

=« Grant local Oracle roles.

Use Oracle Enterprise Manager or SQL*Plus to grant local roles and privileges
to the database user or schema; this step is optional.

« Grant enterprise roles.

Use Oracle Enterprise Security Manager to grant enterprise roles to the
enterprise user in the directory. User authorizations are the aggregate of both
local database roles and enterprise roles.

=« Map the users to a schema.

If you are using a shared schema, use Oracle Enterprise Security Manager to map
the user to a schema. You can choose either of the following mapping options:

«» Database:

Applies to one database.
« Domain:

Applies to all databases in the domain.
For example:

If you are creating a domain mapping from three users to a shared schema called
guest, and you have more than one database in the domain, each database must
have a shared schema (called guest) that all three users can access. These three users
cannot connect to any database in the domain that does not have a shared schema
called guest.

Alternatively, you can create a mapping under a particular database. If you do it
this way, the mapping applies only to that database, and not to all databases in the
domain. If you have mappings in both places, the database mapping takes
precedence.

See Also:

« Task 6: Configure an Enterprise Domain on page 15-50 for
information about setting up an enterprise domain

« Administering Enterprise Users on page 19-7

« Mapping Enterprise Users to Schemas on page 15-22
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Step 3: Create Enterprise UserIDs

For each user, define a User | D that is unique across the enterprise. The default
User | Dis the value in the conmon name (cn) attribute defined in the LDAP
directory.

Choose a User | Dthat conforms to the following:

« Itis unique across the directory, or at least across the subtrees under the user
search bases entered under Step 1. For example, if you choose cn to be the
UserID attribute, and Scott’s cn attribute value is Scot t . us, there can be no
other cn=Scot t . us defined in any of the users specified in the user search
base field.

« Itisshortand easy to enter. A UserlID is intended to be an easy-to-use
abbreviation of the distinguished name (DN).

Step 4: Create Enterprise User Passwords

Choose the Password tab of the Create User Window to create a password for each
enterprise user. Oracle Enterprise Security Manager automatically creates the
associated password verifiers and stores them in the or cl Passwor d attribute of
the user entry.

Note: You can use Oracle Enterprise Login Assistant to change
passwords at any time. However, you cannot use the directory
manager tools or LDAP command line calls to set users’ database
passwords.

See Also: Defining a New Enterprise User Password on
page 19-11
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Task 12: Connect as Password Authenticated Enterprise User

For an enterprise user whose User | Dis hscor t ea and whose password is
wel cone, enter the following to connect using sql pl us:

SQ@.>connect hscort ea/ wel cone@TNS Servi ce Nane>
The database authenticates the enterprise user (hscor t ea) by verifying the

username/password combination against the directory entry associated with this
user. If successful, the connection to the database is established.

Note: You have completed the configuration of Enterprise User
Security for password authentication.
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Part V: Troubleshooting Enterprise User Security

This section describes potential problems and associated corrective actions in the
following topics:

= ORA-# Errors in Connection to the Database

« User-Schema Error Checklist

» DOMAIN-READ-ERROR Checklist

« Decryption of Encrypted Private Key Fails (Windows Only)
« Enabling Tracing
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ORA-# Errors in Connection to the Database

If you receive an ORA-# error, locate the error in Table 15-6 and take the
recommended action.

Table 15-6 ORA-# Errors in Connection to the Database

Error

Action

ORA-1017: Invalid
Username/password; login denied

See "User-Schema Error Checklist” on page 15-68

ORA-28271: No permission to read
user entry in LDAP directory
service

1. Use Oracle Enterprise Security Manager to check that the user search
base containing this user is listed in the Oracle Context that you are
using.

2. Check that there is no user-defined ACL above the user in the

directory tree that prevents user entries from being publicly
readable.

Try:

| dapsearch -h <directory _host> -p <directory port> -b
<user_sear ch_base_DN> "obj ect cl ass=per son"

If you can’t see the user entry, then modify the ACL on the user
search base to allow read access to user entries to all, or at least to

the database DN or password-accessible domains group in your
context.

3. Check that the enterprise domain is in the password-accessible
domains group for that Oracle Context.

ORA-28272: Domain policy does
not allow password-authenticated
GLOBAL users

Use Oracle Enterprise Security Manager to set the user authentication
policy for this enterprise domain to "Oracle Wallet (SSL) And Password."

ORA-28273: No mapping for user
nickname to LDAP distinguished
name exists.

1. Use Oracle Enterprise Security Manager to check that the user search
base containing this user is listed in the Oracle Context that you are
using.

2. Check that a user entry exists in Oracle Internet Directory for your
user.
3. Check that the user entry contains the right UserID:

A. Find the UserID attribute that is configured for the directory in
the root context, and

B. Check that the name provided during the attempted user
database login is the value for that attribute in the user directory
entry.
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Table 15-6 ORA-# Errors in Connection to the Database (Cont.)

Error

Action

ORA-28274: No ORACLE
password attribute corresponding
to user nickname exists.

1. Use Oracle Enterprise Security Manager to check that the user search
base containing this user is listed in the Oracle Context that you are
using.

2. Check that the "allow DB access" box is checked for the user search
base under the Oracle Context.

3. Check that the user entry in the directory has the or cl user
objectclass.

If it does not have the or cl user objectclass, then:

A. Was the user created using Oracle Enterprise Security Manager?
If so, then check that:

1. There is root Oracle Context with version greater than 90000.

2. The version of the BASE schema (under
cn=Cr acl eSchenaVer si on) is greater than 90000.

B. If the user entry was not created with Oracle Enterprise Security
Manager, then you need to add that objectclass with Oracle
Enterprise Security Manager or LDAP command line tools. Users
that are created by Oracle Enterprise Security Manager get this
objectclass automatically.

If it does have the or cl user objectclass, then:

A. Check that the enterprise domain is in the password-accessible
domains group for that Oracle Context, and

B. There is a value set for that user’s database password in the
directory in the or cl passwor d attribute.

ORA-28275: Multiple mappings for
user nickname to LDAP
distinguished name exist.

This means that there are multiple user DNs in the directory within the
user search base whose nickname/UserID for the user matches what was
provided during the database connection. Use Oracle Enterprise Security
Manager to make the nickname/UserID value unique (no two users
share the same nickname) within all user search bases associated with
the Oracle Context listed in the | dap. or a file.

ORA-28277: LDAP search, while
authenticating global user with
passwords, failed.

Check that the directory SSL instance is up and running.
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Table 15-6 ORA-# Errors in Connection to the Database (Cont.)

Error

Action

ORA-28278: No domain policy
registered for password-based
GLOBAL users.

This means that the database cannot read the enterprise domain
information that it needs. See: "DOMAIN-READ-ERROR Checklist" on
page 15-70

ORA-28279: Error reading r dbns_
server _dn parameter in
I NI T. ORA.

Check that the RDBMS_SERVER DN parameter is in the spfil e. ora

(i ni t. or a not relevant). If it is, then restart the database so it can read
the parameter. If the parameter is not in the spfi | e. or a, then that
implies that database registration failed. Register the database in the
directory by using Database Configuration Assistant or Oracle Enterprise
Security Manager.

ORA-28030: LDAP problems

Possible reasons:

«  The database belongs to more than one domain. (Using Oracle
Enterprise Security Manager usually prevents this.) If this happens,
then there should be a warning in the database log file.

«  The database wallet DN is different from what is specified in the
RDBMS_SERVER DN parameter in the spfi | e. or a. These need to
match.

User-Schema Error Checklist

If you receive a User-Schema error, then check the following:

1. Isthis an SSL user?

— Ifyes, then check that the correct wallet is being used by checking that

*  There is no WALLET _LOCATI ON parameter value in the client
sgl net . or a file, and

*  The TNS_ADM N parameter is set properly so that the correct
sqgl net . or a file is being used. If okay, then continue.

— If no, then continue.

2. Did you create the schema in the database as a GLOBAL user?

— If yes, then continue.

— If no, then create a global user/schema in the database using the CREATE

USER. .

. | DENTI FI ED GLOBALLY syntax. Then, continue.
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Is the database schema a private schema (not shared)? That is, was the schema
created as | DENTI FI ED GLOBALLY AS ' <full DN of user>'?

— If yes, then ensure that the DN in the user wallet matches the DN that was
used in the CREATE USER statement. Stop here, because the following
items address shared schemas.

— If no, then continue.

Is the relevant user-schema mapping under the database entry in the directory?
That is, was the mapping intended to apply to this database, and not to the
entire enterprise domain of databases?

— If yes, then check that the database can read its own entry and subtree in
the directory. To check this, try the following:

| dapsearch -h <directory host> -p <directory SSport>-U3 -W
"fil e:<dat abase wal | et _pat h>" -P <dat abase wal | et _password> -b
"<dat abase DN\>" "obj ect cl ass=*"

You should see the database entry and the relevant mapping, at least. Stop
here.
— If no, then continue.

Is the relevant user-schema mapping under the domain entry in the directory?
That is, was the mapping intended to apply to the entire enterprise domain of
databases?

— Ifyes, then see "DOMAIN-READ-ERROR Checklist" on page 15-70.

— If no, then there is no user-schema mapping, and that is the problem. Create
one by using Oracle Enterprise Security Manager, or alter the user to
contain a private schema by using the following syntax:

ALTER USER <user nane> | CENTI F ED Q.GBALLY AS ' <ful | _DN of _user>'
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DOMAIN-READ-ERROR Checklist
If you receive a DOVAI N- READ- ERROR, then check the following:

1.

Check the SSL connection between the database and the directory by binding to
the directory using the database wallet with the following command:

| dapbi nd -h <directory _host> -p <directory SSport> -U3 -W"file:<wallet_
I ocati on>" -P <wal | et_passwor d>

If this fails, then ensure that the directory has a running SSL instance.

See Also: Oracle Internet Directory Administrator’s Guide for
information about managing a directory SSL instance.

Check that the RDBMS_SERVER DN parameter in the spfi | e. or a file matches
the DN in the database wallet. Note that the attribute identifiers [those that are
located to the left of the equals (=) signs] are not case-sensitive, but the attribute
values [those that are located to the right of the equals (=) signs] are
case-sensitive. For example, cn=dat abasel and CN=dat abasel are the same
(match), but cn=dat abasel and cn=DATABASEL1 are different (do not match).
If these do not match, then you need to get a new certificate in the database
wallet.

Check that the database is a member of the enterprise domain in Oracle
Enterprise Security Manager. If the database is not a member of the enterprise
domain, then add it to the enterprise domain by using Oracle Enterprise
Security Manager.

Set or reset the user authentication policy for this domain by using Oracle
Enterprise Security Manager.

Check that the database can see its domain by using the following command:

| dapsearch -h <directory host> -p <directory SSport>-U3 -W
"file: <dat abase wal | et _path>" -P <database wal | et _password> -b

"cn=C acl eCont ext, <adm n_cont ext >" "obj ect ¢l ass=or cl DBEnt er pri seDonai n"

If this fails, then try restarting the database to update the cached value for the
enterprise domain.

Check that the database can read the enterprise domain subtree, and thus read
its enterprise roles by using the following command:

| dapsearch -h <directory host> -p <directory SSport>-U3 -W
"fil e: <dat abase wal | et _pat h>" -P <dat abase wal | et _password> -b
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"cn=Q acl eCont ext, <admin_cont ext>" "obj ect cl ass=or ¢l DBt er pri seRol e"

You should see all of the enterprise roles that you have created for this domain.

7. If all of these checks pass, but you are still getting a DOVAI N- READ- ERROR,
then restart the directory SSL instance and the database.

Decryption of Encrypted Private Key Fails (Windows Only)
Applies to Window NT only.

This error occurs when you attempt to open a wallet that you are not permitted to
open.

For Example:

= You are logged into the system as user - x, but you do not have a local
sgl net . or a file that identifies
c:\wi nnt\profil es\user-x\oracl e\wal | ets asyour wallet location.

« SSL uses the sqgl net . or a file in the default location to find the wallet location,
and then tries to open the database wallet to get your login credentials.

« This attempt fails, because user - x does not have permission to open the
database wallet.

Enabling Tracing

You can use tracing to help debug. This is appropriate if the | dapbi nd fails,
indicating that the directory's SSL instance is not working properly.

Oracle Internet Directory

If you are using Oracle Internet Directory as your LDAP directory, use the following
tracing procedure:

1. Turn on debugging flags in Oracle Internet Directory.

Note: See Also: Oracle Internet Directory Administrator’s Guide

2. Start up the SSL Oracle Internet Directory instance in full debug mode. Log files
will be written to $ORACLE_HOVE\ | dap\ | og. Look at the file with your SSL
directory instance number and an s in its filename. The log files without the s
are for the monitor process (oi dnon) and the dispatcher. Look at the end of the
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log file immediately after you have tried your connect / @onnect _
i denti fi er.One thing to look for is the string Di st i ngui shed Nane to
ensure that it matches the DN of your user.

3. Turn off Oracle Internet Directory tracing.
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Migrating Local or External Users to
Enterprise Users

This chapter describes the User Migration Utility, which can be used to perform
bulk migrations of database users to an LDAP directory where they are stored and
managed as enterprise users. It contains the following topics:

Benefits of Migrating Local or External Users to Enterprise Users
Introduction to the User Migration Utility

Prerequisites for Performing Migration

User Migration Utility Command Line Syntax

Accessing Help for the User Migration Utility

List of User Migration Utility Parameters

User Migration Utility Usage Examples

Troubleshooting Using the User Migration Utility
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Benefits of Migrating Local or External Users to Enterprise Users

Migrating from a database user model to an enterprise user model provides
solutions to administrative, security, and usability challenges in an enterprise
environment. In an enterprise user model, all user information is moved to an
LDAP directory service.

Enterprise user security provides the ability to easily and securely manage
enterprise-wide users by providing the following benefits:

Centralized storage of user credentials, roles, and privileges in an LDAP
version 3-compliant directory server

Provides the infrastructure to enable single sign-on using X.509v3-compliant
certificates, which is typically deployed where end-to-end SSL is required

Enhanced security

Because an enterprise user model is easier to manage, security administrators
can perform necessary maintenance changes to user information immediately
so they have better control over access to critical network resources. In addition,
an enterprise user model is easier for users to use because they have fewer
passwords to remember so they are less likely to choose easily guessed
passwords or write them down where others can copy them.

See Also: "Overview of Enterprise User Security” on page 15-3 for
detailed conceptual information about enterprise user security.
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Introduction to the User Migration Utility

The User Migration Utility is a command-line utility that is used when enterprise
user administrators decide to move their users from a local database model to an
enterprise user model. This utility makes it easy to migrate thousands of local and
external database users to an enterprise user environment in an LDAP directory
where they can be managed from a central location.

Enterprise user administrators can select for migration any combination of the
following subsets of users in a database:

»  List of users specified on the command line or in afile
« All external users
« All global users

In addition, enterprise user administrators can specify values for utility parameters
that determine how the users are migrated such as

= Where to put the migrated users in the LDAP directory tree

« Map a user with multiple accounts on various databases to a single directory
user entry

» Randomly generate new passwords for migrated users

. Copy the database password verifier’ from the database to the directory for
local users so they can retain the use of their database passwords.

The following sections explain the migration process and the changes that occur to
users’ schemas.

Note: After external users are migrated, their external
authentication and authorization mechanisms are replaced by
directory-based mechanisms.

! A database password verifier is an irreversible value that is derived from the user’s
database password. This value is used during password authentication to the database to
prove the identity of the connecting user.
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Overview of the Bulk User Migration Process

Bulk user migration is a two-phase process. In phase one, you start the migration
process by populating user information into an interface database table, where
enterprise user administrators can verify that the information is accurate before
committing the changes to the database and the directory in phase two. The process
is described in the following steps:

« Step 1. Phase One Preparing for the Migration
« Step 2: Verify User Information
« Step 3: Phase Two Completing the Migration

Step 1: Phase One Preparing for the Migration

In the first part of the migration process, the utility checks for the existence of the
ORCL_G.OBAL_USR_M GRATI ON_DATA interface table in the enterprise user
administrator’s schema. If it exists, then the administrator can choose to reuse the
table (clearing its contents), reuse the table and its contents, or re-create the table.
Phase one of the utility can be run multiple times, each time adding to the interface
table. If the table does not exist, then the utility creates it in the administrator’s
schema. The interface table is populated with information about the migrating users
from the database and the directory. The type of information that is populated into
this table is determined by the command line options which are used.

Passwords are randomly generated and populated into the interface table for users
who were EXTERNAL or GLOBAL. For users who were LOCAL, their database
password verifier is copied to the directory from the database. If there is an existing
directory entry for the user with an existing database password verifier, then the
utility runs successfully if both database password verifiers match. If they do not
match, then the utility produces an error for that user.

Note: The utility will not create the interface table in the SYS
schema.

Step 2: Verify User Information

This is an intermediate step to allow the enterprise user administrator to verify that
the user information is correct in the interface table before committing the changes
to the database and the directory.
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Step 3: Phase Two Completing the Migration

After the interface table is populated with user information and the enterprise user
administrator has verified the information, then in phase two the utility retrieves
the information from the interface table and updates the directory and the database.
The utility generates random database passwords for external and global users, and
it also generates random passwords for directory entries, which it then stores in the
DBPASSWORD and DI RPASSWORD columns of the interface table. The enterprise user
administrator can read these passwords from the interface table and inform
migrating users.

See Also: "List of User Migration Utility Parameters" on
page 16-14 for a list of command line options and their
descriptions.

About the ORCL_GLOBAL_USR_MIGRATION_DATA Table

This is the interface table which is populated with information about the migrating
users during phase one of the bulk user migration process. The information that
populates this table is pulled from the database and checked against existing entries
in the directory. If there is corresponding information in the directory, then that is
marked in the table for that user. After enterprise user administrators verify the
information in this table, changes are made to the directory and the database in
phase two.

Caution: The ORCL_G.OBAL_USR M GRATI ON_DATA interface
table contains very sensitive information. Access to it should be
tightly controlled using database privileges.

The table columns are listed in Table 16-1.
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Table 16-1 ORCL_GLOBAL_USR_MIGRATION_DATA Table Schema

Column Name DataType Null Description

USERNANME (Primary Key) VARCHAR2(30) NOT NULL | Database user name.

OLD_SCHEMA_TYPE VARCHARZ2(10) - Old schema type in the database before
migration.

PASSWORD VERI FI ER VARCHAR2(30) - This contains the database password
verifier from the database for local users.

USERDN VARCHAR2(4000) | - Distinguished Name (DN) of the user in
the directory (new or existing).

USERDN_EXI ST_FLAG CHAR(1) - Flag indicating whether the DN already
exists in the directory.

SHARED SCHEMA VARCHARZ2(30) - Shared schema name, if users are to be
mapped to a shared schema during phase
two.

MAPPI NG_TYPE VARCHAR2(10) - Mapping type (database or domain).

MAPPI NG_LEVEL VARCHAR2(10) - Mapping level (entry or subtree).

CASCADE_FLAG CHAR(1) - Cascade flag used when dropping a user
(for shared schema mapping only).

DBPASSWORD_EXI ST_FLAG CHAR(1) - Flag indicating whether the database
password verifier already exists in the
directory for this user.

DBPASSWORD VARCHAR2(30) - Randomly generated database password
verifiers that are to be stored in the
directory.

DI RPASSWORD VARCHAR2(30) - Randomly generated directory password
for new entries.

PHASE _COWMPLETED VARCHAR2(10) - Information about the phase that has
completed successfully.

NEEDS_ATTENTI ON_FLAG CHAR(1) - Flag indicating whether the row contains
abnormalities that require administrator
attention.

ATTENTI ON_DESCRI PTI ON VARCHAR2(100) | - Textual hint for the administrator if the

attention flag is set.
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Which Interface Table Column Values Can Be Modified between Phase One and
Phase Two?

After running phase one of the utility, if necessary, enterprise user administrators
can change the columns of the interface table that are listed in Table 16-2.

Table 16—2 Interface Table Column Values That Can Be Modified between Phase One and Phase Two

Column Name Valid Values Restrictions

USERDN DN of user If this value is changed, then the administrator should verify
that the USERDN_EXI ST_FLAGand the DBPASSWORD _

EXI ST_FLAGvalues are set accordingly.

USERDN _EXI ST _FLAG T/F If the value for the USERDN column is changed, then the
value for this column should also be changed to reflect the
status of the new USERDN.

DBPASSWORD EXI ST T/F If the value for the USERDN column is changed, then the

FLAG

value for this column should also be changed to reflect
whether a database password exists for the new USERDN.

SHARED SCHEMA

Shared schema name

Specify only if a shared schema exists in the database.

MAPPI NG _TYPE DB/DOVAI N Set this value only if SHARED_SCHEMA is not set to NULL.

MAPPI NG_LEVEL ENTRY/SUBTREE Set this value only if SHARED SCHEMA is not set to NULL.

CASCADE_FLAG T/F Set this value only if SHARED SCHEMA is not set to NULL. If
this column is set to true (T), then the users’ schema objects
are forcibly deleted. If this column is set to false (F), then the
administrator must delete all of the user schema objects
before running phase two.

PHASE _COMPLETED ZERO/ONE/TWO If the administrator can resolve the conflicts or ambiguities

that are specified with the NEEDS_ATTENTI ON_FLAG, then
this column value can be changed to ONE so phase two can
be run with the utility.
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Migration Effects on Users’ Old Database Schemas

If shared schema mapping is not used, then users retain their old database schemas.
If shared schema mapping is used, then users’ local schemas are dropped from the
database and they are mapped to a shared schema that the enterprise user
administrator creates for this purpose before performing the migration. When
migrated users own database objects in their old local database schemas,
administrators can specify that the schema and objects are not to be dropped by
setting the CASCADE parameter to NO When the CASCADE parameter is set to NO,
users who own database objects in their old local schemas do not migrate
successfully so their objects are not dropped.

If some users want to retain the objects in their local database schemas and be
mapped to a shared schema, then the administrator can manually migrate those
objects to the shared schema before performing the bulk user migration. However,
when objects are migrated to a shared schema, they are shared among all users who
share that new schema.

Table 16-3 summarizes the effects of setting the MAPSCHENMA and CASCADE
parameters.

Table 16-3 Effects of Choosing Shared Schema Mapping with CASCADE Options

MAPSCHEMA CASCADE User Migration User Schema
Parameter Setting Parameter Setting Successful? Objects Dropped?
PRIVATE NO (default setting) Yes No

SHARED NO Yes! No

SHARED YES Yes? Yes

1 Users migrate successfully only if they do not own objects in their old database schemas; otherwise, they fail.
2 Users migrate successfully and their old database schemas are dropped.

See Also: "List of User Migration Utility Parameters"” on
page 16-14 for detailed information about the MAPSCHENMA,
CASCADE, and other parameters that can be used with this utility.
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Migration Process

Enterprise users, those that are defined and managed in the directory, can be
authenticated to the database either with a password or with a certificate. Users that
authenticate with a password require an Oracle database password, which is stored
in the directory. Users that authenticate with a certificate must have a valid X.509 v3
certificate.

This utility performs the following steps during migration:
1. Selects the users from the database for migration.
2. Creates corresponding user entries or uses existing entries in the directory.

3. Takes database password verifiers from the database or creates new ones, and
copies them to the directory for migrating users.

4. Puts the schema mapping information for the migrating users’ entries in the
directory. (optional)

5. Drops or alters the migrating users’ local database schemas. (optional)

Note: In the current release, the utility migrates users with
certificate-based authentication and makes them ready for
password authentication. Previously SSL-based authenticated users
should reset their Oracle database passwords. User wallets are not
created as part of this process.

See Also:

« Chapter 17, "Using Oracle Wallet Manager" for information
about creating and managing Oracle wallets.

« Chapter 18, "Using Oracle Enterprise Login Assistant" for
information about using wallets.
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Prerequisites for Performing Migration

The User Migration Utility is automatically installed in the following location when
you install Oracle9i Client:

$CRACLE_HOWE r dbns/ bi n/ unu

The following sections describe what programs must be running and what user
privileges are required to successfully migrate users with the User Migration
Utility.

Required Database Privileges

To successfully use this utility, enterprise user administrators must have the
following database privileges:

« ALTER USER

« DROP USER

« CREATE TABLE

« SELECT_CATALOG_ROLE

These privileges enable the enterprise user administrator to alter users, drop users,
look at dictionary views, and create the interface table that is used by this utility.

Required Directory Privileges

In addition to the required database privileges, enterprise user administrators must
have the directory privileges which allow them to perform the following tasks:

« Create entries in the directory under the specified user base and Oracle context
location

« Browse the user entries under the search bases
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Required Setup to Run the User Migration Utility

Perform the following steps before using the User Migration Utility:

1.

Ensure that the directory server is running with SSL enabled for no
authentication.

Ensure that the database server is running with encryption and integrity
enabled.

Ensure that the database listener has a TCP listening endpoint.
Create an Oracle context in the directory, if it does not already exist.

Create the parent context for the user entries in the directory, if it does not
already exist.

Set up directory access for the database Oracle home using Oracle Net
Configuration Assistant if you want to use the default | dap. or a parameters.

Note:

« If you plan to use shared schema mapping when migrating
users, then you must create the shared schema before running
this utility.

« Thesamel dap. or a file must be used for both phase one and
phase two of a user migration.

See Also:
« Oracle Internet Directory Administrator’s Guide

» Chapter 15, "Managing Enterprise User Security" for detailed
information about setting up enterprise user authentication
after the user migration is finished.
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User Migration

To perform a bulk migration of database users to enterprise users, use the following

Utility Command Line Syntax

syntax:

umu

For parameters that take a single value use the following syntax:

paraneterl paraneter? ...

keywor d=val ue

For parameters that take multiple values, use a colon (;) to separate the values as in

the following syntax:

keywor d=val uel: val ue2: . ..

Example 16-1 shows the syntax used to run the utility through both phases of the

bulk user migration process.

Example 16-1 User Migration Utility Command Line Syntax

umu

unu

PHASE=ONE

DBADM N=dba_user nane: passwor d

ENTADM Neent er pri se_adm n_DN passwor d
USERS{ALL_Q.(RAL | ALL EXTERNAL | LIST | FLH
DCBLOCATI ON=dat abase_host : dat abase_port : dat abase_si d
D RLQCATI ONHl dap_directory_host: | dap_directory_port
USERSLI ST=user nanel: user nane2: user nane3: . . .

USERSH LE=f i | enane

MAPSCHEVAS] PR VATE | SHARED) : schena_nane
MAPTYPES[DB | DOMAI N : [ ENTRY | SUBTRER]

CASCADES[ YES | NJ

QONTEXT=user _entries_parent | ocation

LO& LE=fi | enane

PARFI LE=f i | enane

PHASE=TVD

DBADM N=dba_user nane: passwor d

ENTADM Neent er pri se_adm n_DN passwor d

DBLQOCATI ON=dat abase_host : dat abase _port : dat abase_si d
D RLQCATI ONHl dap_directory_host : | dap_di rectory_port
LOGH LE=fi | enane

PARFI LE=f i | enare
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Note: If the enterprise user administrator does not specify the
mandatory parameters on the command line, then the utility will
prompt the user for those parameters interactively.

See Also:

« "List of User Migration Utility Parameters" on page 16-14 for a
complete list of all available parameters and detailed
information about them.

« "User Migration Utility Usage Examples" on page 16-24 for
examples of typical uses of this utility.

Accessing Help for the User Migration Utility

To display the command-line syntax for using the User Migration Utility, enter the
following command at the system prompt:

umu HELP=YES

While the HELP parameter is set to YES, the utility cannot execute.
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List of User Migration Utility Parameters

The following sections list the available parameter keywords and the values that
can be used with them when running this utility. The keywords are not

case-sensitive.

Keyword: HELP

Valid Values:
Default Setting:

Syntax Examples:

Description:

Restrictions:

Keyword: PHASE

Valid Values:
Default Setting:

Syntax Examples:

Description:

Restrictions:

YES or NO (These values are not case-sensitive.)
NO
HELP=YES

This keyword is used to display help for the utility. A value of
YES displays the complete command-line syntax. To execute a
command, set the value to NO, or do not specify a value for
the parameter to accept the default.

None

ONE or TWO (These values are not case-sensitive.)
ONE

PHASE=ONE

PHASE=TWD

Indicates the phase for the utility. If it is ONE, then the utility
populates the interface table with the information specified in
the command-line arguments and the existing user entries in
the directory. If it is TWO, then the utility uses the information
that is available in the interface table and updates the
directory and the database.

None
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Keyword: DBLOCATION

Valid Values:
Default Setting:
Syntax Examples:
Description:

Restrictions:

host: port:sid
No default setting.
DBLOCATI ON=ny_or acl e. us. oracl e. com 7777: or a902

Provides the host name, port number, and SID for the
database instance.

« This parameter is mandatory.

« The value for this parameter must be the same for both
phase one and phase two.

« The database should be configured for encryption and
integrity.

Keyword: DIRLOCATION

Valid Values:
Default Setting:

Syntax Examples:
Description:

Restrictions:

host : port

This value is automatically populated from the | dap. or a file
by default.

DI RLOCATI ON=ny_or acl e. us. or acl e. com 636

Provides the host name and port number for the directory
server where the LDAP server is running on SSL with no
authentication.

The value for this parameter must be the same for both phase
one and phase two.
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Keyword: DBADMIN

Valid Values:
Default Setting:
Syntax Examples:
Description:

Restrictions:

user nane: passwor d
No default setting.
DBADM N=syst em nmanager

Username and password for the database administrator with
the required privileges for connecting to the database.

« This parameter is mandatory.

« Theuser nane value for this parameter must be the same
for both phase one and phase two.

Keyword: ENTADMIN

Valid Values:
Default Setting:
Syntax Examples:

Description:

Restrictions:

user DN: password
No default setting.
ENTADM N=cn=j aneadni n, dc=acmne, dc=com wel cone

User Distinguished Name (UserDN) and the directory
password for the enterprise directory administrator with the
required privileges for logging in to the directory. UserDN can
also be specified within double quotation marks ("...").

This parameter is mandatory.
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Keyword: USERS

Valid Values:

Default Setting:
Syntax Examples:

Description:

Restrictions:

val uel: val ue2. ..
Values can be:

« ALL_EXTERNAL to select all external users, including
those who use Kerberos and RADIUS authentication

« ALL_GLOBAL to select all global users

« LI ST to specify users on the command line with the
"Keyword: USERSLIST"

« USERSFI LE for selecting users from the file that is
specified with the "Keyword: USERSFILE"

This parameter takes multiple values. Separate values with a
colon (3).

(These values are not case-sensitive.)
No default setting.
« USERS=ALL_EXTERNAL: ALL_G.OBAL

This usage instructs the utility to migrate all external
users and all global users.

» USERS=ALL_EXTERNAL: FI LE

This usage instructs the utility to migrate all external
users and all users that are specified in the USERSFI LE.

Specifies which users are to be migrated. If multiple values
are specified for this parameter, then the utility uses the union
of these sets of users.

This parameter is mandatory for phase one only, and it is
ignored in phase two.
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Keyword: USERSLIST

Valid Values:

Default Setting:
Syntax Examples:
Description:

Restrictions:

user 1l:user2:...
Separate user names with a colon ().
No default setting.
USERSLI ST=j doe: t chi n: adesali

Specifies a list of database users for migration. The users in
this list are migrated with other users that are specified with
the USERS parameter.

This optional parameter is effective only when LI ST is
specified with the USERS parameter.

Keyword: USERSFILE

Valid Values:
Default Setting:
Syntax Examples:

Description:

Restrictions:

File name and path.
No default setting.
USERSFI LE=/ hone/ or ahone/ usersli st/ hr_users.txt

Specifies a file that contains a list of database users (one user
listed for each line) for migration. The users in this file are
migrated with other users that are specified with the USERS
parameter.

This optional parameter is effective only when FI LE is
specified with the USERS parameter.
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Keyword: MAPSCHEMA

Valid Values: schema_t ype: schema_nane
Schema type can be:
« PRI VATE

Retains users’ old local schemas. Schema name is ignored
when schema type is PRI VATE. No mapping entries are
created in the directory.

« SHARED

Maps users to a shared schema. Mapping entries are
created in the directory. Schema name specifies the shared
schema name. During shared schema mapping, whether
users’ local schemas are dropped from the database is
determined by the "Keyword: CASCADE" setting.

(These values are not case-sensitive.)
Default Setting: PRI VATE
Syntax Examples: MAPSCHEMA=SHARED: HR ALL

Description: Specifies whether the utility populates the interface table with
schema mapping information.
Restrictions: « See the SHARED option under Valid Values.

« This parameter is only valid for phase one.
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Keyword: MAPTYPE

Valid Values: mappi ng_t ype: mappi ng_| evel
Mapping type can be:
« DB
« DOMAIN
Mapping level can be:
« ENTRY
« SUBTREE
Separate mapping type from mapping level with a colon (}).
(These values are not case-sensitive.)
Default Setting:  DB: ENTRY
Syntax Examples: MAPTYPE=DOVAI N: SUBTREE

Description: Specifies the type of schema mapping that is to be applied
when "Keyword: MAPSCHEMA" is set to SHARED. If DB is
specified as the mapping type, then the utility creates a
mapping in directory for the database. If DOVAI Nis specified
as the mapping type, then the utility creates a mapping in the
directory for the domain containing the database. For domain
mapping, the utility determines the domain that contains the
database by an LDAP search in the relevant Oracle context.

Restrictions: This parameter is effective only when MAPSCHEMA is set to
SHARED.

See Also: "About Using the SUBTREE Mapping Level Option" on
page 16-29 for more information about using this mapping level
option.
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Keyword: CASCADE

Valid Values:

Default Setting:
Syntax Examples:
Description:

Restrictions:

NO

When users are mapped to a shared schema, the utility
tries to drop their local schemas from the database. If this
parameter is set to NO, then users are migrated only if
they do not own objects in their local schema. Users who
own objects in their old local schemas do not migrate and
produce an error message in the migration log file.

YES

If this parameter is set to YES, then users are migrated by
dropping all of their schema objects along with their local
schemas. Privileges and roles that were previously
granted to the users are also revoked.

(These values are not case-sensitive.)

NO

CASCADE=YES

Specifies whether a user’s local schema is dropped when the
user is mapped to a shared schema.

This parameter is effective only when MAPSCHEMA is set to
SHARED.
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Keyword: CONTEXT

Valid Values:

Default Setting:

Syntax Examples:
Description:

Restrictions:

Distinguished Name (DN) of the parent for user entries.

Parent DN can also be specified within double quotation
marks ("...").

This value is automatically populated from the DEFAULT _
ADM N_CONTEXT setting in the | dap. or a file by default.
This places new user entries directly under the parent of the
Oracle Context. Refer to Figure 15-1, "Related Entries in an
Oracle Context" on page 15-9 for a diagram of a directory
information tree that contains an Oracle Context.

CONTEXT="c=us"

Specifies the DN of the parent entry under which user entries
are created in the directory if there is no directory entry that
matches the userID for the user.

« In UNIX, the Oracle home environment variable must be
set so the utility can get the administrative context value
(c=us) from the DEFAULT_ADM N_CONTEXT setting in
the | dap. or a file.

« This parameter is only valid for phase one.
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Keyword: LOGFILE

Valid Values:
Default Setting:
Syntax Examples:
Description:

Restrictions:

Keyword: PARFILE

Valid Values:
Default Setting:
Syntax Examples:
Description:

Restrictions:

File name and path.
$ORACLE_HOWVE/ net wor k/ | og/ uru. | og
LOGFI LE=hon®/ or ahone/ net wor k/ | og/ fi | enane. | og

Specifies the log file where details about the migration for
each user are written.

None

File name and path.
No default setting.
PARFI LE=hon®e/ or ahone/ net wor k/ usr/ par . t xt

Specifies a text file which contains a list of these parameters
that are intended to be used in a user migration. Each
parameter must be listed on a separate line in the file. If a
parameter is specified in both the parameter file and on the
command line, then the one specified on the command line
takes precedence.

None
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User Migration Utility Usage Examples

The following sections contain examples of the syntax for some typical uses of this
utility.

Migrating Users While Retaining Their Own Schemas

To migrate users while retaining their old database schemas, set the MAPSCHEMA
parameter to PRI VATE, which is the default setting. For example, to migrate users
scottl,scott 2, and all external database users, while retaining their old
schemas, to the directory at c=us with the newly generated directory passwords,
the syntax shown in Example 16-2 is used.

Example 16—2 Migrating Users with MAPSCHEMA=PRIVATE (Default)
unu PHASE=ONE

DBLQOCATI ON=nachi nel: 1521: ora_si d

DBADM N=syst em nanager

USERS=ALL_EXTERNAL: LI ST

USERSLI ST=scot t 1: scott 2

D RLACATI O\N=nachi ne2: 636

QONTEXT=" c=us"

ENTADM NE" cn=j aneadni n": wel cone

unu PHASE=TVO
DBLQCATI ON=nachi nel: 1521: ora_si d
DBADM N=syst em nanager
D RLCCATI ON\=nachi ne2: 636
ENTADM NE" cn=j aneadmi n": wel cone

After phase one completes successfully, the interface table is populated with the
user migration information. Then the enterprise user administrator can review the
table to confirm its contents. Because no value was specified for the MAPSCHENVA
parameter, the utility runs phase one using the default value of PRI VATE so all
users’ old database schemas and objects are retained.
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Migrating Users and Mapping to a Shared Schema

To migrate users and map them to a new shared schema, dropping their old
database schemas, set the MAPSCHEMA parameter to SHARED. The shared schema
must already exist or the enterprise user administrator must create it before running
the utility with this parameter setting. In the following example, users scot t 1,
scott 2, and all external database users are migrated to the directory at c=us with
newly generated directory passwords, while mapping all migrated users to a new
shared schema in the database.

Use the syntax shown in Example 16-3 to run the migration process with
MAPSCHEMA set to SHARED.

Example 16-3 Migrating Users with MAPSCHEMA=SHARED
umu PHASEFONE

DBLOCATI ON=nachi nel: 1521: ora_si d

DBADM N=syst em nanager

USERS=ALL_EXTERNAL: LI ST

USERSLI ST=scot t 1: scott 2

MAPSCHEIVA=SHARED schena_32

D RLCCATI ON\=nachi ne2: 636

QONTEXT="c=us"

ENTADM NE" cn=j aneadm n": wel cone

umu PHASE=TWD
DBLQOCATI ON=nachi nel: 1521: ora_si d
DBADM N=syst em nanager
D RLACATI O\N=nachi ne2: 636
ENTADM N=" cn=j aneadm n" : wel cone

After phase one completes successfully, the interface table is populated with the
user migration information. Then the administrator can review the table to confirm
its contents. Users scot t 1 and scot t 2 retain their old database passwords, but
the external users, who had no old database passwords, are assigned new randomly
generated ones. Because no value was specified for the CASCADE parameter, the
utility runs phase one using the default value of NO which means that migrating
users who own database objects in their old database schemas will fail and their
schemas will not be automatically dropped. To determine which users have failed,
review the log file that is located at $ORACLE_HOVE/ net wor k/ | og/ urmu. | og by
default.

Migrating Local or External Users to Enterprise Users 16-25



User Migration Utility Usage Examples

Mapping Users to a Shared Schema Using Different CASCADE Options

The CASCADE parameter setting determines whether users’ old database schemas
are automatically dropped when mapping to a shared schema during migration.
CASCADE can be used only when MAPSCHENMA is set to SHARED.

Mapping Users to a Shared Schema with CASCADE=NO

By default, the CASCADE parameter is set to NO. This setting means that when
mapping migrating users to a shared schema, users who own database objects in
their old schemas are not migrated. For users who do not own database objects,
their old database schemas are automatically dropped and they are mapped to the
new shared schema.

See Also: Example 16-3 on page 16-25 for an example of the
syntax used to map users to a shared schema with CASCADE set to
NO. Note that because NOis the default setting for CASCADE this
parameter does not have to be specified in the utility command
syntax.

Mapping Users to a Shared Schema with CASCADE=YES

If it is known that no migrating users own database objects or want to retain the
objects that they own in their old database schemas, then setting the CASCADE
parameter to YES automatically drops all users’ schemas and schema objects and
maps them to the new shared schema. Example 16-4 shows the syntax to use when
setting CASCADE to YES. In this example, users scott 1, scot t 2, and all external
database users are migrated to the directory at c=us, while mapping all migrating
users to a new shared schema in the database.
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Example 16—-4 Migrating Users with Shared Schema Mapping and CASCADE=YES

umu

umu

PHASE=ONE

DBLQOCATI ON=nachi nel: 1521: ora_si d
CBADM N=syst em nanager

USERS=ALL EXTERNAL: LI ST

USERSLI ST=scot t 1: scott 2
MAPSCHEVA=SHARED: schena_32
CASCADE=YES

D RLCCATI ON\=nachi ne2: 636
QONTEXT="c=us"

ENTADM N=" cn=j aneadm n": wel cone

PHASE=TVD

DBLQOCATI ON=nachi nel: 1521: ora_si d
DBADM N=syst em nanager

D RLCCATI ON\=nachi ne2: 636

ENTADM NE" cn=j aneadm n": wel cone

After phase one completes successfully, the interface table is populated with the
user migration information. Then the administrator can review the table to confirm
its contents. Because the CASCADE parameter is set to YES, all migrated users’ old
database schemas are automatically dropped, including those who own database
objects.

Caution: If you set the CASCADE parameter to YES, then Oracle
Corporation recommends that enterprise user administrators back
up the database or take an export dump of the users being
migrated before running this utility. Then if migrated users want
their old database objects, they can retrieve them from the export

dump.
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Mapping Users to a Shared Schema Using Different MAPTYPE Options

When MAPSCHEMA is set to SHARED, the type of mapping can be set by specifying a
value for the MAPTYPE parameter. This parameter takes two values, which are the
type of mapping and the level of mapping.

Mapping type can be set at DB, for database, or DOVAI N, for enterprise domain.
When mapping type DB is specified, the mapping is applied only to the database
where the shared schema is stored. When DOMAI N is specified as the mapping type,
then the mapping is applied to the enterprise domain that contains the database
where the shared schema is stored and also applies to all databases in that domain.

Mapping level can be set to ENTRY or SUBTREE. When ENTRY is specified then
users are mapped to the shared schema using their full distinguished name (DN).
This results in one mapping for each user. When SUBTREE is specified then groups
of users who share part of their DNs are mapped together. This results in one
mapping for groups of users who are already grouped under some common root in
the directory tree. Example 16-5 shows the syntax to use when using the MAPTYPE
parameter. In this example, users scott 1, scot t 2, and all external database users
are migrated to the directory at c=us, while mapping all migrated users to a new
shared schema in the database. In this example, the mapping will apply to the
enterprise domain that contains the database and the mapping will be performed at
the entry level, resulting in a mapping for each user.

Example 16-5 Migrating Users with Shared Schema Mapping Using the MAPTYPE
Parameter

unu PHASE=ONE
DBLQOCATI ON=nachi nel: 1521: ora_si d
DBADM N=syst em nanager
USERS=ALL EXTERNAL: LI ST
USERSLI ST=scot t 1: scott 2
MAPSCHEVA=SHARED schena_32
MAPTYPE=DOVA N ENTRY
D RLCCATI ON\=nachi ne2: 636
QONTEXT=" c=us"
ENTADM NE" cn=j aneadm n": wel cone

unu PHASE=TVO
DBLQOCATI ON=nachi nel: 1521: ora_si d
DBADM N=syst em nanager
D RLCCATI ON\=nachi ne2: 636
ENTADM NE" cn=j aneadm n": wel cone
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About Using the SUBTREE Mapping Level Option If a user (scot t, for example) who is
being migrated will have future user entries in a subtree under it, then it makes
sense to create a subtree level mapping from this user entry (cn=scott)toa
schema. However, the database does not interpret the user to be in the subtree so
the mapping does not apply to scot t himself. For example, if you are migrating
the user scot t with the DN cn=scott, o=acn®e, and you choose SUBTREE as the
mapping level when you run the utility, then a new mapping is created from
cn=scot t, o=acne to the shared schema, but the user scot t is not mapped to
that schema. Only new users who are created under the scot t directory entry are
mapped to the shared schema. Consequently, the SUBTREE mapping level should
only be specified when user directory entries are placed under other user directory
entries, which would be an unusual directory configuration.

If you want an arbitrary subtree user to be mapped to a single shared schema with
only one mapping entry, then you must use Oracle Enterprise Security Manager to
create that mapping.

See Also: "Managing Database Schema Mappings" on page 19-32
for information about using Oracle Enterprise Security Manager.
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Migrating Users Using the PARFILE, USERSFILE, and LOGFILE Parameters

It is possible to enter user information and User Migration Utility parameters into a
text file and pass the information and parameters to the utility using the PARFI LE
and USERSFI LE parameters. The LOGFI LE parameter sets the directory path for
the log file where details about the migration for each user are written.

The PARFI LE parameter tells the utility where a text file is located that contains the
parameters for a bulk user migration. The USERSFI LE parameter works like the
PARFI LE parameter. Instead of listing parameters in the specified file, it contains a
list of database users. The parameters and users lists contain one parameter or user
for each line of their respective text files. The LOGFI LE parameter tells the utility
where to write the system events that occur during a user migration, such as errors.
The USERSFI LE parameter is used during phase one of the migration process. The
PARFI LE and LOGFI LE parameters can be used in both phases.

Example 16-6 shows the syntax for a typical parameter text file to migrate users
scott1,scott 2, and all external database users, while retaining their old
schemas, to the directory at c=us. In this example a log of migration events is
written to the file er ror fi | el in the directory where the utility is run. If another
location is desired, then include the path with the file name.

Example 16—-6 Parameter Text File (par . t xt ) to Use with the PARFILE Parameter

DBLQOCATI ON=nachi nel: 1521: ora_si d
CBADM N=syst em nanager

USERS=ALL EXTERNAL: LI ST: H LE
USERSLI ST=scot t 1: scott 2

USERSH LE=usr s. t xt

D RLCCATI ON\=nachi ne2: 636
QONTEXT=" c=us"

ENTADM NE" cn=j aneadm n": wel cone
LOXH LE=errorfil el
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Example 16-7 shows the syntax for a typical users list text file.

Example 16—7 Users List Text File (usrs. t xt ) to Use with the USERSFILE Parameter

user 1
user 2
user 3

To execute phase one of the migration process with these parameters and users list
text files, use the syntax shown in Example 16-8.

Example 16-8 Migrating Users Using the PARFILE, USERSFILE, and LOGFILE
Parameters
unu PHASE=ONE

DBADM N=syst em nanager

PARF| LE=par . t xt

LOH LE=errorfil e2

Note: Although the LOGFI LE parameter is specified twice, once in
the parameter text fileaserror fi | el (shown in Example 16-6)
and once on the command lineaserrorfil e2 (show in

Example 16-8), command-line parameters take precedence over
those specified inside the parameter file. Consequently, in

Example 16-8 the log file will be written to er r or f i | €2 because
that value is specified on the command line.
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Troubleshooting Using the User Migration Utility

Migration failures are reported to the enterprise user administrator with error
messages and log messages. The following sections describe common error and log
messages and what administrators can do to resolve them.

See Also: "Summary of User Migration Utility Error and Log
Messages" on page 16-44 for an alphabetical listing of error and log
messages and links to where they are described in this section.

Common User Migration Utility Error Messages

When the utility encounters any error while running, it displays an error message
and stops running. The following sections describe these messages and explain how
to resolve the errors:

Resolving Error Messages Displayed for Both Phases

Resolving Error Messages Displayed for Phase One

Resolving Error Messages Displayed for Both Phases

The following error messages may display while the utility is running either phase
one or phase two of the migration:

Attribute value missing : : orclCommonNicknameAttribute

Database connection failure

Database error:; < database_error_message >

Database not in any domain : : DB-NAME = < database_name >
Database not registered with the directory : : DB-NAME = < dbName >
Directory connection failure

Directory error : : < directory_error_message >

Multiple entries found : : uniqueMember = < database_ DN >
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Attribute value missing : : orclCommonNicknameAttribute
Cause: The nickname attribute is not set in the directory at the root context.

Action: Use Enterprise Security Manager to set the nickname attribute for the
root context.

Database connection failure
Cause: The utility was unable to connect to the database.

Action: Perform these steps:

1. Check the database status to determine whether it is configured for
encryption and integrity.

2. Check the privileges and credentials of the enterprise user administrator
who is running the utility.

Database error: < database_error_message >
Cause: The utility encountered a database error.
Action: Check the database error message details for the database.

See Also: Oracle9i Database Error Messages for information about
resolving database error messages.

Database not in any domain : : DB-NAME = < database_name >
Cause: The database is not a member of any enterprise domain.

Action: Use Enterprise Security Manager to add the database to an enterprise
domain in the directory.

Database not registered with the directory : : DB-NAME = < dbName >
Cause: There is no entry for the database in the Oracle context that the Idap.ora
file points to.

Action: Use Database Configuration Assistant or Enterprise Security Manager
to register the database in the directory.

Directory connection failure
Cause: The utility was unable to connect to the directory.

Action: Perform these steps:

1. Check the directory server status to determine whether the directory server
port is configured for SSL with no authentication.
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2. Check the privileges and credentials of the enterprise user administrator
who is running the utility.
Directory error : : < directory_error_message >
Cause: The utility encountered a directory error.

Action: Check the directory error message details for the directory.

See Also: Oracle Internet Directory Administrator’s Guide for
information about resolving error messages for Oracle Internet
Directory.

Multiple entries found : : uniqueMember = < database_ DN >

Cause: The database belongs to more than one enterprise domain in the
directory.

Action: Use Enterprise Security Manager or Oracle Directory Manager to
ensure that the database belongs to only one enterprise domain.
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Resolving Error Messages Displayed for Phase One

While the utility is running phase one of the migration, syntax or other types of
errors may occur. The following error messages may display while the utility is
running phase one of the migration:

Argument missing or duplicated : : < parameter >

Database object missing : : SHARED-SCHEMA = <shared_schema_name >
Error reading file : : Idap.ora: : DEFAULT_ADMIN_CONTEXT
Error reading file : : Idap.ora: : DIRECTORY_SERVERS

Error reading file : : <file_name >:: <io_error_message >

Error reading file : : PARFILE = < file_name > :: <io_error_message>

Getting local host name failed

Interface table creation in SYS schema not allowed

Invalid argument or value : : < argument >

Invalid arguments for the phase

Invalid value : :
Invalid value : :
Invalid value : :

Invalid value : :

<user > [ USERSFILE ]
< user > [ USERSFILE ] {== DBADMIN }
<user >[ USERSLIST ]
< user > [ USERSLIST ] { = = DBADMIN }

Logging failure : : <io_error_message >

Nickname attribute exists : : CONTEXT = < context > :
orclCommonNicknameAttribute = <nickname_attribute>

No entry found : : CONTEXT = < context >

Not under search bases : : CONTEXT = < context > :
orclCommonUserSearchBase = < user_search_bases >

Migrating Local or External Users to Enterprise Users 16-35



Troubleshooting Using the User Migration Utility

Argument missing or duplicated : : < parameter >

Cause: Syntax error. A parameter is missing or has been entered multiple
times.

Action: Check the usage syntax.

Database object missing : : SHARED-SCHEMA = <shared_schema_name >
Cause: The shared schema is not present in the database.

Action: Create the shared schema.

Error reading file : : Idap.ora: : DEFAULT_ADMIN_CONTEXT

Cause: Syntax error. The DEFAULT_ADMIN_CONTEXT parameter value has
an invalid format in the Idap.ora file.

Action: Use Oracle Net Configuration Assistant to create a new ldap.ora file.

Error reading file : : Idap.ora: : DIRECTORY_SERVERS

Cause: Syntax error. The DIRECTORY_SERVERS parameter value has an
invalid format in the Idap.ora file.

Action: Use Oracle Net Configuration Assistant to create a new ldap.ora file.
Error reading file : : < file_name >:: <io_error_message >

Cause: Syntax error. The utility cannot read the file that contains the users list
that is specified in the USERSFILE parameter.

Action: Perform these steps:

1. Check to ensure that the file exists.

2. Check to ensure that the file has the correct permissions so the utility can
read it.

Error reading file : : PARFILE = < file_name >:: <io_error_message>

Cause: Syntax error. The utility cannot read the file that contains the list of
parameters that is specified in the PARFILE parameter.

Action: Perform these steps:

1. Check to ensure that the file exists.

2. Check to ensure that the file has the correct permissions so the utility can
read it.
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Getting local host name failed

Cause: Syntax error. The utility is unable to read the local host name for the
database location or the directory location.

Action: Explicitly enter the hostname information with the DBLOCATI ONand
DI RLOCATI ON parameters.

See Also:

« "Keyword: DBLOCATION" on page 16-15

« "Keyword: DIRLOCATION" on page 16-15

For information about how to use these parameters.

Interface table creation in SYS schema not allowed
Cause: The interface table cannot be created in the SYS schema.

Action: Specify another user in the DBADM N parameter.

See Also: "Keyword: DBADMIN" on page 16-16 for information
about setting the DBADM N parameter.

Invalid argument or value ; : <argument >
Cause: Syntax error. The argument name or value has been entered incorrectly.
Action: Check the usage syntax.

See Also:

« "User Migration Utility Command Line Syntax" on page 16-12
"Accessing Help for the User Migration Utility" on page 16-13
"List of User Migration Utility Parameters" on page 16-14

For information about using the command line syntax for this

utility.

Invalid arguments for the phase

Cause: Syntax error. This occurs when you have used a command line
argument that is only intended for phase one, but you are running phase two.

Action: Check the usage syntax.
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Invalid value : : < user > [ USERSFILE ]

Cause: Syntax error. The user that is specified in this error message is invalid
because they are not a user in the database that is specified in the DBLOCATI ON
parameter.

Action: Remove the invalid user from the file that is specified with the
USERSFI| LE parameter.

Invalid value : : < user > [ USERSFILE ] {== DBADMIN }

Cause: Syntax error. The file that is specified in the USERSFI LE parameter
contains the user who is running the migration utility.

Action: Remove that user from the file.

Invalid value : : < user > [ USERSLIST ]

Cause: Syntax error. The user that is specified in this error message is invalid
because they are not a user in the database that is specified in the DBLOCATI ON
parameter.

Action: Remove the invalid user from the USERSLI ST parameter.

Invalid value : : < user > [ USERSLIST ] { == DBADMIN }

Cause: Syntax error. The USERSLI ST parameter contains the user who is
running the migration utility.

Action: Remove that user from the USERSLI ST.

Logging failure : : <io_error_message >
Cause: Syntax error. The utility cannot find the log file or it cannot open the file
to write to it.

Action: Perform these steps:

1. Check to ensure that the log file exists.

2. Check to ensure that the log file has the correct permissions so the utility
can write information to it.

Nickname attribute exists : : CONTEXT = < context > :
orclCommonNicknameAttribute = <nickname_attribute>
Cause: The CONTEXT value contains the nickname attribute setting and it
should not. Only the root Oracle Context contains this setting.

Action: Specify another CONTEXT value that is not the root Oracle Context, and
therefore does not contain the nickname attribute setting.
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No entry found : : CONTEXT = < context >
Cause: The CONTEXT entry is not present in the directory.

Action: Perform one of the following options:

« Use the directory management tool or the LDAP command line utility to
create an entry in the directory for the context value.

« Specify another valid context value.

Not under search bases : : CONTEXT = < context > : orclCommonUserSearchBase
=< user_search_bases >
Cause: The CONTEXT value is not under the user search bases.

Action: Use Enterprise Security Manager to add an appropriate user search
base or give the appropriate CONTEXT value.

Resolving Error Messages Displayed for Phase Two

Most of the error messages that you encounter while running this utility occur in
phase one. After phase one has completed successfully, and while phase two is
running, the following error may occur:

Database object missing : : TABLE = ORCL_GLOBAL_USR_MIGRATION_
DATA
Cause: The utility cannot find the interface table.

Action: Perform one of the following options:

« Run phase one of the utility to create the interface table.

« Check to ensure that the user who is specified in the DBADM N parameter is
the same user who was specified for that parameter for phase one.

Migrating Local or External Users to Enterprise Users 16-39



Troubleshooting Using the User Migration Utility

Common User Migration Utility Log Messages

Typically, log messages are written to the log file for each user who is migrated,
whether the user was migrated successfully or not. The following sections describe
these messages and explain how to resolve the errors:

Common Log Messages for Phase One

While the utility is running phase one of the migration, messages that indicate a
user’s information has not been successfully populated in the interface table may be
written to the log file. After the utility completes phase one, review the log file to
check for the following messages:

« Multiple entries found : : < nickname_attribute > = < username >

« Noentry found : : < nickname_attribute > = < username > : : Entry found : DN
=<dn>

« Value mismatch : orclPassword : PASSWORD_VERIFIER

Multiple entries found : : < nickname_attribute > = < username >

Cause: The nickname attribute matches multiple users or the user matches
with multiple nickname attributes.

Action: Resolve the multiple matches and run the utility again for the users
whose log file entry displayed this message.

No entry found : : < nickname_attribute > = < username > : : Entry found : DN =<
dn >

Cause: No entry was found for the nickname matching, but an entry already
exists for the DN in the directory.

Action: Specify a different DN for the user.
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Value mismatch : orclPassword : PASSWORD_VERIFIER

Cause: A DN already exists with the or cl Passwor d populated for this local
user, but its value is not equal to the verifier in the database.

Action: Check the user’s entry in the directory and the user’s database account
to resolve the value mismatch.

Common Log Messages for Phase Two

While the utility is running phase two of the migration, messages that indicate a
user has not successfully migrated may be written to the log file. After the utility
completes phase two, review the log file to check for the following messages:

Attribute exists : : orclPassword

Attribute value missing : : orclPassword

Database object missing : : SHARED-SCHEMA = < shared_schema >
Entry found : : DN = < user_DN >

Invalid value : : <interface_table_column_name> = < interface_table_column_
value >

No entry found : : DN = < user_DN >
Value mismatch : : < nickname_attribute > : : USERNAME
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Attribute exists : : orclPassword
This message typically occurs with the message | nval i d val ue: : <col umm_
nane>=<col um_val ue>.
Cause: The entry already contains a value for the or cl Passwor d attribute.
Action: Check the DBPASSWORD EXI ST_FLAGcolumn in the interface table
for a T/ F value that correctly reflects whether a database password exists for
this user.

Attribute value missing : : orclPassword
This message typically occurs with the message | nval i d val ue: : <col umm_
nane>=<col um_val ue>.
Cause: The or cl Passwor d attribute of this user’s entry has a null value.
Action: Check the DBPASSWORD EXI ST_FLAGcolumn in the interface table
for a T/ F value that correctly reflects whether a database password exists for
this user.

Database object missing : : SHARED-SCHEMA = < shared_schema >
Cause: The shared schema that was specified for this user does not exist in the
database.

Action: Perform one of the following options:

« Check to ensure that the correct shared schema was specified for this user. If
the shared schema name was incorrectly specified, then edit the SHARED _
SCHEMA column of the interface table and run phase two of the utility for
this user again.

= Create the shared schema in the database and run phase two of the utility
for this user again.

Entry found :: DN = < user_DN >
This message typically occurs with the message | nval i d val ue: : <col umm_
nanme>=<col unm_val ue>.

Cause: An entry already exists for the specified user DN.
Action: Check the USERDN_EXI ST_FLAGcolumn in the interface table for a

T/ F value that correctly reflects whether a user entry already exists in the
directory for this DN.
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Invalid value : : <interface_table _column_name> = < interface_table_column_
value >

Cause: The value in the interface table column for this user is invalid. Typically,
this message is accompanied by additional log messages for this user.

Action: Check to ensure that the correct value has been entered for this user.

No entry found : : DN = < user_DN >

This message typically occurs with the message | nval i d val ue: : <col unmm__
nanme>=<col um_val ue>.

Cause: The entry for the DN is missing in the directory.

Action: Check the USERDN_EXI ST_FLAGcolumn in the interface table for a
T/ F value that correctly reflects whether a user entry already exists in the
directory for this DN.

Value mismatch : : < nickname_attribute > : : USERNAME

Cause: The USERNAME column value in the interface table and the nickname
attribute value in the directory for the USERDN entry are not equal.

Action: Perform the following steps:

1. Use Oracle Enterprise Security Manager to check the user’s entry in the
directory and make any appropriate changes to resolve this value
mismatch.

2. Run phase two of the utility for this user again.
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Summary of User Migration Utility Error and Log Messages

Table 16-4 and Table 16-5 list all of the error and log messages in alphabetical order
and provides links to the section in this chapter that describes the message and how
to resolve it.

Table 16—4 Alphabetical Listing of User Migration Utility Error Messages

User Migration Utility Error Message Phase
Argument missing or duplicated : : < parameter > on page 16-36 1
Attribute value missing : : orclCommonNicknameAttribute on page 16-33 Both
Database connection failure on page 16-33 Both
Database error: < database_error_message > on page 16-33 Both
Database not in any domain : : DB-NAME = < database_name > on page 16-33 Both
Database not registered with the directory : : DB-NAME = < dbName > on page 16-33 Both
Database object missing : : SHARED-SCHEMA = <shared_schema_name > on page 16-36 1
Database object missing : : TABLE = ORCL_GLOBAL_USR_MIGRATION_DATA on page 16-39 2
Directory connection failure on page 16-33 Both
Directory error : : < directory_error_message > on page 16-34 Both

Error reading file : : < file_name > :: <io_error_message > on page 16-36
Error reading file : : Idap.ora: : DEFAULT_ADMIN_CONTEXT on page 16-36
Error reading file : : Idap.ora : : DIRECTORY_SERVERS on page 16-36

Error reading file : : PARFILE = < file_name > :: <io_error_message> on page 16-36
Getting local host name failed on page 16-37

Interface table creation in SYS schema not allowed on page 16-37

Invalid argument or value : : <argument > on page 16-37

Invalid arguments for the phase on page 16-37

Invalid value : : <user > [ USERSFILE ] on page 16-38

Invalid value : : < user > [ USERSFILE ] { == DBADMIN } on page 16-38
Invalid value : : < user > [ USERSLIST ] on page 16-38

Invalid value : : <user > [ USERSLIST ] { == DBADMIN } on page 16-38

T = T = T = T N e e S S N

Logging failure : : <io_error_message > on page 16-38
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Table 16—4 Alphabetical Listing of User Migration Utility Error Messages (Cont.)

User Migration Utility Error Message Phase

Multiple entries found : : uniqueMember = < database_DN > on page 16-34 Both

Nickname attribute exists : : CONTEXT = < context > : orclCommonNicknameAttribute = <nickname_ 1
attribute> on page 16-38

No entry found : : CONTEXT = < context > on page 16-39 1

Not under search bases : : CONTEXT = < context > : orclCommonUserSearchBase = < user_search_ 1
bases > on page 16-39

Table 16-5 Alphabetical Listing of User Migration Utility Log Messages

User Migration Utility Log Message Phase

Attribute exists : : orclPassword on page 16-42

Attribute value missing : : orclPassword on page 16-42

Database object missing : : SHARED-SCHEMA = < shared_schema > on page 16-42

Entry found : : DN = < user_DN > on page 16-42

Invalid value : : <interface_table_column_name> = < interface_table_column_value > on page 16-43
Multiple entries found : : < nickname_attribute > = < username > on page 16-40

No entry found : : DN = < user_DN > on page 16-43

No entry found : : < nickname_attribute > = < username > : : Entry found : DN = < dn > on page 16-40

Value mismatch : : < nickname_attribute > : : USERNAME on page 16-43

P N RPN R NN DN NN

Value mismatch : orclPassword : PASSWORD_VERIFIER on page 16-41
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Using Oracle Wallet Manager

Security administrators use Oracle Wallet Manager to manage public key security
credentials on Oracle clients and servers. The wallets it creates are opened by using
either Oracle Enterprise Login Assistant or Oracle Wallet Manager.

This chapter describes Oracle Wallet Manager, and contains the following topics:

Overview

PKCS #12 Support

Multiple Certificate Support
LDAP Directory Support
Managing Wallets

Managing Certificates

See Also: Chapter 18, Using Oracle Enterprise Login Assistant,
for information about how to open and close wallets for secure SSL
communications using Oracle Enterprise Login Assistant
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Overview

Traditional private-key or symmetric-key cryptography requires a single, secret key
that is shared by two or more parties to a secure communication. This key is used to
both encrypt and decrypt secure messages sent between the parties, requiring prior,
secure distribution of the key to each party. The problem with this method is that it
is difficult to securely transmit and store the key.

Public-key cryptography provides a solution to this problem, by employing
public/private key pairs and a secure method for key distribution. The freely
available public key is used to encrypt messages that can only be decrypted by the
holder of the associated private key. The private key is securely stored, together
with other security credentials, in an encrypted container—called a wallet.

Public-key algorithms can guarantee the secrecy of a message, but they don’t
necessarily guarantee secure communications because they don’t verify the
identities of the communicating parties. In order to establish secure
communications, it is important to verify that the public key used to encrypt a
message does in fact belong to the target recipient. Otherwise, a third party can
potentially eavesdrop on the communication and intercept public key requests,
substituting its own public key for a legitimate key (the man-in-the-middle attack).

In order to avoid such an attack, it is necessary to verify the owner of the public key;,
a process called authentication. Authentication can be accomplished through a
certificate authority (CA)—a third party that is trusted by both of the
communicating parties.

The CA issues public key certificates that contain an entity’s name, public key, and
certain other security credentials. Such credentials typically include the CA name,
the CA signature, and the certificate effective dates (From Date, To Date).

The CA uses its private key to encrypt a message, while the public key is used to
decrypt it, thus verifying that the message was encrypted by the CA. The CA public
key is well known, and does not have to be authenticated each time it is accessed.
Such CA public keys are stored in an Oracle wallet.

Wallet Password Management

Oracle Wallet Manager includes an enhanced wallet password management module
that enforces Password Management Policy guidelines, including the following:

«  Minimum password length (8 characters)
«  Maximum password length unlimited

« Alphanumeric character mix required
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Strong Wallet Encryption

Oracle Wallet Manager stores private keys associated with X.509 certificates,
requiring strong encryption. Accordingly, Release 2 (9.2) replaces DES encryption
with 3-key Triple-DES—a substantially stronger encryption algorithm.

Microsoft Windows Registry

Oracle Wallet Manager lets you optionally store multiple Oracle wallets in the user
profile area of the Microsoft Windows System Registry (for Windows
95/98/ME/NT 4.0/2000), or in a Windows file management system. Storing your
wallets in the registry provides the following benefits:

Better Access Control. Wallets stored in the user profile area of the registry are
only accessible by the associated user. User access controls for the system thus

become, by extension, access controls for the wallets. In addition, when a user

logs out of a system, access to that user’s wallets is effectively precluded.

Easier Administration. Since wallets are associated with specific user profiles,
no permissions need to be managed, and the wallets stored in the profile are
automatically deleted when the user profile is deleted. Oracle Wallet Manager
can be used to create and manage the wallets in the registry, and the wallets are
accessible by Oracle Enterprise Login Assistant as well.

Improved Security. Because the wallets are imbedded in the registry, the
wallets associated with a particular user profile are transparent to all other
users. Viewed in combination with better access control and easier administration,
this amounts to an additional security layer for Oracle wallets.

Options Supported:

Open wallet from the Registry

Save wallet to the Registry

Save As to a different Registry location

Delete wallet from the Registry

Open wallet from the file system and save it to the Registry

Open wallet from the Registry and save it to the file system
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See Also:
« Oracle9i Database Administrator’s Guide for Windows

«  Oracle9i Security and Network Integration Guide

Oracle Wallet Functions

Oracle Wallet Manager is a standalone Java application that wallet owners use to
manage and edit the security credentials in their Oracle wallets. These tasks include
the following:

« Generating a public/private key pair and creating a certificate request for
submission to a CA.

« Installing a certificate for the entity.
« Configuring trusted certificates for the entity.
« Opening a wallet to enable access to PKI-based services.

« Creating a wallet that can be accessed by using either Oracle Enterprise Login
Assistant or Oracle Wallet Manager.

« Uploading a wallet to an LDAP directory.
« Downloading a wallet from an LDAP directory.
« Importing wallets.

« Exporting wallets.

Backward Compatibility
Oracle Wallet Manager is backward-compatible to Release 8.1.5.
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PKCS #12 Support

Oracle Wallet Manager stores X.509 certificates and private keys in
industry-standard, PKCS #12 format. This makes the Oracle wallet structure
interoperable with supported third party PKI applications, and provides wallet
portability across operating systems.

Note: Although Oracle Advanced Security and Oracle Wallet
Manager fully comply with PKCS #12, there may be some
compatibility issues using third-party products—such as Netscape
Communicator and Microsoft Internet Explorer.

Importing Third-Party Wallets

Oracle Wallet Manager can import and support the following PKCS #12-format
wallets, subject to product-specific procedures and limitations:

« Netscape Communicator 4.x

« Microsoft Internet Explorer 5.x

« OpenSSL

To import a third-party wallet:

1. Follow the product-specific procedure to export the wallet.

2. Save the exported wallet to an operating system-specific file name in a directory
expected by Oracle Advanced Security.

For UNIX and Windows NT, the file name isewal | et . p12.

For other operating systems, see the Oracle operating system-specific
documentation.

See Also: Importing a Trusted Certificate on page 17-24.
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Notes:

= You must copy the third-party PKCS #12 wallet file name to a
directory expected by Oracle Wallet Manager and change the
name; the UNIX/NT wallet file name isewal | et . p12.

«  Since browsers typically do not export trusted certificates
under PKCS #12 (other than the signer’s own certificate), you
may need to add trust points to authenticate the other party in
the SSL connection. You can use Oracle Wallet Manager to do
this.

Exporting Oracle Wallets

Oracle Wallet Manager can export its own wallets to third party environments. To
export a wallet:

1. Use Oracle Wallet Manager to save the wallet file.

2. Follow the third-party product-specific import procedure to import an
operating system-specific PKCS #12 wallet file created by Oracle Wallet
Manager (called ewal | et . p12 on UNIX and NT platforms).

Note:

« Oracle Wallet Manager supports multiple certificates for each
wallet. However, current browsers typically support import of
single-certificate wallets only. Accordingly, for these browsers,
you must export an Oracle Wallet containing a single key-pair.

«  Wallet export is only supported to (i) Netscape Communicator
Domestic Version, and to (ii) OpenSSL.
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Multiple Certificate Support

Oracle wallet tools (Oracle Wallet Manager, Enterprise Login Assistant) support
multiple certificates for each wallet, supporting the following Oracle PKI certificate
usages:

« SSL

« S/MIME signature

«  S/MIME encryption

» Code-Signing

« CA Certificate Signing

Oracle Wallet Manager supports multiple certificates for a single digital entity, where
each certificate can be used for a set of Oracle PKI certificate usages—but the same
certificate cannot be used for all such usages (See: Tables 17-2 and 17-3 for legal
usage combinations). There must be a one-to-one mapping between certificate
requests and certificates. The same certificate request can be used to obtain multiple
certificates. More than one certificate cannot be installed in the same wallet at the
same time.

Oracle Wallet Manager uses X.509 V3 extension KeyUsage to define Oracle PKI
certificate usages (Table 17-1):

Table 17-1 KeyUsage Values

Value | Usage

0 digitalSignature

nonRepudiation

keyEncipherment

dataEncipherment

keyAgreement

keyCertSign
cRLSign

encipherOnly

Ol Nl W] DN|PFP

decipherOnly
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When installing a certificate (user certificate, trusted certificate), Oracle Wallet
Manager uses Tables 17-2 and 17-3 to map the KeyUsage extension values to Oracle

PKI certificate usages:

Table 17-2 OWM Import of User Certificate to an Oracle Wallet

KeyUsage Value Critical?! | Usage
none na Certificate is importable for SSL or S/MIME
encryption use.
0 alone, or any combination na Accept certificate for S/MIME signature or
including 0 but excluding 5 code-signing use.
and 2
1 alone Yes Not importable.
No Accept certificate for S/MIME signature or
code-signing use.
2 alone, or 2 + any na Accept certificate for SSL or S/MIME encryption
combination excluding 5 use.
5 alone, or any combination na Accept certificate for CA certificate signing use.
including 5
Any settings not listed Yes Not importable.
previously o .
No Certificate is importable for SSL or S/MIME
encryption use.

1 If the KeyUsage extension is critical, the certificate cannot be used for other purposes.

Table 17-3 OWM Import of Trusted Certificates to an Oracle Wallet

combination including 5

KeyUsage
Value Critical?! | Usage
none na Importable.
Any combination Yes Not importable.
excluding 5

No Importable.
5 alone, or any na Importable.

1 If the KeyUsage extension is critical, the certificate cannot be used for other purposes.
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You should obtain certificates from the certificate authority with the correct
KeyUsage value for the required Oracle PKI certificate usage. A single wallet can
contain multiple key pairs for the same usage. Each certificate can support multiple
Oracle PKI certificate usages, as indicated by Tables 17-2 and 17-3. Oracle PKI
applications use the first certificate containing the required PKI certificate usage.

For example: For SSL usage, the first certificate containing the SSL Oracle PKI
certificate usage is used.

Note: SSL Oracle PKI Certificate Usage is the only usage supported
by Oracle PKI applications.
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LDAP Directory Support

Oracle Wallet Manager can upload wallets to—and retrieve them from—an
LDAP-compliant directory.

Storing wallets in a centralized LDAP-compliant directory lets users access them
from multiple locations or devices, ensuring consistent and reliable user
authentication—while providing centralized wallet management throughout the
wallet life cycle. To prevent accidental over-write of functional wallets, only wallets
containing an installed certificate can be uploaded.

See Also:
« Uploading a Wallet to an LDAP Directory on page 17-13.
« Downloading a Wallet from an LDAP Directory on page 17-15

Oracle Wallet Manager requires that enterprise users are already defined and
configured in the LDAP directory, to be able to upload or download wallets. If a
directory contains Oracle8i (or prior) users, they are automatically upgraded to use
the wallet upload/download feature—upon first use.

See Also: Task 11: Configure Enterprise Users on page 15-61.

Oracle Wallet Manager downloads a user wallet using a simple password based
connection to the LDAP directory. However, for uploads it uses an SSL connection if
the open wallet contains a certificate with SSL Oracle PKI certificate usage.

See Also: Multiple Certificate Support on page 17-7, for more
information about Oracle PKI certificate user.

If an SSL certificate is not present in the wallet, password-based authentication is
used.

Note: The directory password and the wallet password are
independent, and can be different. Oracle Corporation recommends
that these passwords are maintained to be consistently different,
where neither one can logically be derived from the other.

17-10 Oracle Advanced Security Administrator’s Guide



Managing Wallets

Managing Wallets

This section describes how to create a new wallet and perform associated wallet
management tasks, such as generating certificate requests, exporting certificate
requests, and importing certificates into wallets, in the following subsections:

Starting Oracle Wallet Manager

Creating a New Wallet

Opening an Existing Wallet

Closing a Wallet

Uploading a Wallet to an LDAP Directory
Downloading a Wallet from an LDAP Directory
Saving Changes

Saving the Open Wallet to a New Location
Saving in System Default

Deleting the Wallet

Changing the Password

Using Auto Login

Starting Oracle Wallet Manager

To start Oracle Wallet Manager:

Windows NT: Select St ar t —=Pr ogr ans—Or acl e- <ORACLE_HOVE
NAME>—>Net wor k Admi ni strati on—Wal | et Manager

UNIX: Enter owmat the command line.

Creating a New Wallet
Create a new wallet as follows:

1.

Choose Wl | et > Newfrom the menu bar; the New Wallet dialog box
appears.

Follow the required guidelines for creating a password and enter a password in
the Wallet Password field.
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Because an Oracle wallet contains user credentials that can be used to
authenticate the user to multiple databases, it is especially important to choose
a strong wallet password. A malicious user who guesses the wallet password
can access all the databases to which the wallet owner has access.

Passwords must contain at least eight characters that consist of alphabetic
characters combined with numbers or special characters.

Caution: It is strongly recommended that users avoid choosing
easily guessed passwords based on user names, phone numbers, or
government identification numbers, such as "admin0," "oraclel," or
"2135551212A." This prevents a potential attacker from using
personal information to deduce the users’ passwords. It is also a
prudent security practice for users to change their passwords
periodically, such as once in each month or once in each quarter.

See Also: Wallet Password Management on page 17-2.

Re-enter that password in the Confirm Password field.
Choose OK to continue.

If the entered password does not conform to the required guidelines, then the
following message appears:

Password must have a minimum length of eight characters, and contain
alphabetic characters combined with numbers or special characters. Do you
want to try again?

An Alert is displayed, and informs you that a new empty wallet has been
created. It prompts you to decide whether you want to create a certificate
request. See: Adding a Certificate Request on page 17-19.

If you choose Cancel, you are returned to the Oracle Wallet Manager main
window. The new wallet you just created appears in the left window pane. The
certificate has a status of Enpt y, and the wallet displays its default trusted
certificates.

Select Val | et > Save I n System Def aul t to save the new wallet.

If you do not have permission to save the wallet in the system default, you can
save it to another location.
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A message at the bottom of the window informs you that the wallet was
successfully saved.

Opening an Existing Wallet

Open a wallet that already exists in the file system directory as follows:

1.

o g &~ w

Closing a Wallet

Choose Wallet > Open from the menu bar; the Select Directory dialog box
appears.

Navigate to the directory location in which the wallet is located, and select
the directory.

Choose OK; the Open Wallet dialog box appears.
Enter the wallet password in the Wallet Password field.
Choose OK.

The message Wl | et opened successf ul | y appears at the bottom of
the window, and you are returned to the Oracle Wallet Manager main
window. The wallet’s certificate and its trusted certificates are displayed in
the left window pane.

To close an open wallet in the currently selected directory:

« Choose\Wal |l et > C ose.

« Themessage Wl | et cl osed successf ul | y appears at the bottom of the
window, to confirm that the wallet is closed.

Uploading a Wallet to an LDAP Directory

To upload a wallet to an LDAP directory, Oracle Wallet Manager uses SSL if a SSL
certificate is contained in the target wallet. Otherwise, it lets you enter the directory
password. Note that both Oracle Wallet Manager and Enterprise Login Assistant
can upload and download wallets interchangeably.

To prevent accidental destruction of your wallet, Oracle Wallet Manager will not
permit you to execute the Upload option, unless the target wallet is currently open
and contains at least one user certificate.
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To upload a wallet:

1.

Choose Wl | et >Upl oad into the Directory Service. Ifthecurrently
open wallet has not been saved, a dialog box appears with the following
message:

Wallet needs to be saved before uploading.
Choose Yes to proceed.

Wallet certificates are checked for key usage SSL. If at least one certificate has
SSL key usage, a dialog box prompts for the server and the port. Enter the
server and port information associated with the LDAP directory and choose
OK. Oracle Wallet Manager attempts connection to the LDAP directory server
using SSL.

If upload fails, the following message appears:
Upload wallet failed

Otherwise, the following message appears:
Wallet uploaded successfully.

If the target wallet does not contain any certificates with key usage SSL, a
dialog box prompts for the user distinguished name (DN) and the LDAP
server and port information. Enter this information and choose OK. Oracle
Wallet Manager attempts connection to the LDAP directory server using Simple
Password Authentication mode, assuming that the wallet password is the same
as the directory password.

If the prior step fails, a dialog box prompts for the directory password. Oracle
Wallet Manager attempts connection to the LDAP directory server using this
password and displays a warning message if the attempt fails. Otherwise,
Oracle Wallet Manager displays a successful status message at the bottom of the
window.
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Downloading a Wallet from an LDAP Directory

When a wallet is downloaded from an LDAP directory, it is resident in working
memory. It is not saved to the file system unless you expressly save it using any of
the Save options described in the following sections.

See Also:
« Saving Changes
« Saving the Open Wallet to a New Location

« Saving in System Default

To download a wallet from an LDAP directory:
1. Choose Wal | et >Downl oad fromthe Directory Service.

2. Adialog box prompts for the user distinguished name, and the directory
password, server and port information associated with the source LDAP
directory. Oracle Wallet Manager uses simple password authentication to connect
to the LDAP directory.

3. Ifthe download operation fails, the following warning message is displayed:
Download wallet failed

4. If the download is successful and there is an existing open wallet, the following
message is displayed:

An opened wallet already exists in memory. Do you wish to overwrite it with
the downloaded wallet?

Choose OK to open the downloaded wallet.

5. Oracle Wallet Manager attempts to open that wallet using the directory
password.

6. If the operation fails (using the directory password), a dialog box prompts for
the wallet password.

7. If Oracle Wallet Manager cannot open the target wallet using the wallet
password, the following message is displayed:

Open downloaded wallet failed
Otherwise the status:

Wallet downloaded successfully
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is displayed at the bottom of the window.

Saving Changes

To save your changes to the current open wallet;
« Choose Wl | et > Save.

« A message at the bottom of the window confirms that the wallet changes were
successfully saved to the wallet in the selected directory location.

Saving the Open Wallet to a New Location
Use the Save As option to save the current open wallet to a new directory location:

1. Choose Wallet > Save As; the select directory dialog box appears.
2. Select a directory location to save the wallet.
3. Choose OK.

The following message appears if a wallet already exists in the selected
directory:

A wal l et already exists in the selected path. Do you
want to overwite it?.

Choose Yes to overwrite the existing wallet, or No to save the wallet to
another directory.

A message at the bottom of the window confirms that the wallet was
successfully saved to the selected directory location.

Saving in System Default

Use the Save i n Syst em Def aul t menu option to save the current open wallet
to the system default directory location.

« ChooseVallet > Save in System Default.

« A message at the bottom of the window confirms that the wallet was
successfully saved in the system default wallet location.

Note: Certain Oracle applications are not able to use the wallet if
it is not in the system default location.
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Deleting the Wallet

To delete the current open wallet:

1.
2.

Choose Wl | et > Del et e; the Del et e Wal | et dialog box appears.

Review the displayed wallet location to verify you are deleting the correct
wallet.

Enter the wallet password.

Choose OK; a dialog panel appears to inform you that the wallet was
successfully deleted.

Note: Any open wallet in application memory will remain in
memory until the application exits. Therefore, deleting a wallet that
is currently in use does not immediately affect system operation.

Changing the Password

A password change is effective immediately. The wallet is saved to the currently
selected directory, with the new encrypted password.To change the password for
the current open wallet:

1.

4.
5.

Choose Wl | et > Change Password; the Change Wl |l et
Passwor d dialog box appears.

Enter the existing wallet password.

Enter the new password.

See Also: Wallet Password Management on page 17-2, for
password policy restrictions.

Re-enter the new password.
Choose OK.

A message at the bottom of the window confirms that the password was
successfully changed.
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Using Auto Login

The Oracle Wallet Manager Auto Login feature creates an obfuscated copy of the
wallet and enables PKI-based access to services without a password until the Auto
Login feature is disabled for the wallet. When Auto Login is enabled for a wallet, it
is only available to the operating system user who created that wallet.

You must enable Auto Login if you want single sign-on access to multiple Oracle
databases (disabled by default).

Enabling Auto Login
To enable Auto Login:

1. Choose Wallet from the menu bar.

2. Choose the check box next to the Autologin menu item; a message at the
bottom of the window displays autologin enabled.

Disabling Auto Login
To disable Auto Login:

1. Choose Wallet from the menu bar.

2. Choose the check box next to the Auto Login menu item; a message at the
bottom of the window displays autologin disabled.
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Managing Certificates

Oracle Wallet Manager uses two kinds of certificates: user certificates and trusted
certificates. This section describes how to manage both certificate types, in the
following subsections:

« Managing User Certificates

« Managing Trusted Certificates

Note: You must first install a trusted certificate from the certificate
authority before you can install a user certificate issued by that
authority. Several trusted certificates are installed by default when
you create a new wallet.

Managing User Certificates
Managing user certificates involves the following tasks:

« Adding a Certificate Request

« Importing the User Certificate into the Wallet
« Removing a User Certificate from a Wallet

« Removing a Certificate Request

« Exporting a User Certificate

« Exporting a User Certificate Request

Adding a Certificate Request

You can use this task to add multiple certificate requests. Note that when creating
multiple requests, Oracle Wallet Manager automatically populates each subsequent
request dialog box with the content of the initial request—which you can then edit.

The actual certificate request becomes part of the wallet. You can reuse any
certificate request to obtain a new certificate. However, you cannot edit an existing
certificate request; store only a correctly filled out certificate request in a wallet.

To create a PKCS #10 certificate request:

1. Choose Operations > Add Certificate Request;the Add
Certificate Request dialog box appears.

2. Enter the following information (Table 17-4):
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Table 17-4 Certificate Request: Fields and Descriptions

Field Name

Description

Common Name

Mandatory. Enter the name of the user’s or service’s identity.
Enter a user’s name in first name /last name format.

Organizational Unit

Optional. Enter the name of the identity’s organizational unit.
Example: Finance.

Organization

Optional.Enter the name of the identity’s organization.
Example: XYZ Corp.

Locality/City

Optional. Enter the name of the locality or city in which the
identity resides.

State/Province

Optional. Enter the full name of the state or province in which
the identity resides.

Enter the full state name, because some certificate authorities do
not accept two-letter abbreviations.

Country

Mandatory. Choose the drop-down list to view a list of country
abbreviations. Select the country in which the organization is
located.

Key Size

Mandatory. Choose the drop-down box to view a list of key
sizes to use when creating the public/private key pair. See
Table 17-5 to evaluate key size.

Advanced

Optional. Choose Advanced to view the Advanced Certificate
Request dialog panel. Use this field to edit or customize the
identity’s distinguished name (DN). For example, you can edit
the full state name and locality.

Table 17-5 Available Key Sizes

Key Size | Relative Security Level

512 Not regarded as secure.

768 Provides some security.

1024 Secure.

3. Choose OK. An Oracle Wallet Manager dialog box informs you that a
certificate request was successfully created. You can either copy the
certificate request text from the body of this dialog panel and paste it into
an e-mail message to send to a certificate authority, or you can export the
certificate request to a file.
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See Also: Exporting a User Certificate Request on page 17-23

4. Choose OK. You are returned to the Oracle Wallet Manager main window;
the status of the certificate is changed to Request ed.

Importing the User Certificate into the Wallet

You will receive an e-mail notification from the certificate authority informing you
that your certificate request has been fulfilled. Import the certificate into a wallet in
either of two ways: copy and paste the certificate from the e-mail you receive from
the certificate authority, or import the user certificate from a file.

Pasting the Certificate
To paste the certificate;

1. Copy the certificate text from the e-mail message or file you receive from
the certificate authority. Include the lines Begin Certifi cate and End
Certificate.

2. Choose Operations > Inport User Certificate fromthe menu
bar; the Import Certificate dialog box appears.

3. Choose the Paste the Certificat e button, and choose OK; an Import
Certificate dialog box appears with the following message:

Pl ease provide a base64 fornmat certificate and paste it
bel ow.

4. Paste the certificate into the dialog box, and choose OK. A message at the
bottom of the window confirms that the certificate was successfully
installed. You are returned to the Oracle Wallet Manager main panel, and
the status of the corresponding entry in the left panel subtree changes to
Ready.

Keyboard shortcuts for copying and pasting certificates:

«  (UNIX) Use Control+Insert to copy, and use Shift+Insert to
paste.

« (Windows) Use Ctrl+c to copy, and use Ctrl+v to paste.
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Selecting a File that Contains the Certificate

To select the file:

1.

Choose Operations > Inport User Certificate fromthe menu
bar.

Choose the Sel ect a file... certificate button, and choose OK; the
Import Certificate dialog box appears.

Enter the path or folder name of the certificate location.
Select the name of the certificate file (for example, cert . t xt).

Choose OK. A message at the bottom of the window appears, to inform you
that the certificate was successfully installed. You are returned to the Oracle
Wallet Manager main panel, and the status of the corresponding entry in
the left panel subtree changes to Ready.

Removing a User Certificate from a Wallet

1.
2.

In the left panel subtree, select the certificate that you want to delete.

Choose Oper ati ons > Renmove User Certifi cate;adialog panel
appears and prompts you to verify that you want to remove the user
certificate from the wallet.

Choose Yes; you are returned to the Oracle Wallet Manager main panel, and
the certificate displays a status of Request ed.

Removing a Certificate Request
To remove a certificate request:

1.

In the left panel subtree, select the certificate request that you want to
delete.

Choose Oper at i ons Menu.

Select menu item Renove Certificate Request.

Note: You must remove a certificate before removing its
associated request.
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Exporting a User Certificate
Save the certificate in a file system directory when you elect to export a certificate:

1.

2.

In the left panel subtree, select the certificate that you want to export.

Choose Oper ati ons > Export User Certificate fromthe menu
bar; the Export Certificate dialog box appears.

Enter the file system directory to save your certificate in, or navigate to the
directory structure under Folders.

Enter a file name to save your certificate, in the Enter File Name field.

Choose OK. A message at the bottom of the window confirms that the
certificate was successfully exported to the file. You are returned to the
Oracle Wallet Manager main window.

Exporting a User Certificate Request

Save the certificate request in a file system directory when you elect to export a
certificate request:

1.

In the left panel subtree, select the certificate request that you want to
export.

Choose Oper ati ons > Export Certificate Request fromthe
menu bar; the Export Certificate Request dialog box appeatrs.

Enter the file system directory in which you want to save your certificate
request, or navigate to the directory structure under Folders.

Enter a file name to save your certificate request, in the Enter File Name
field.

Choose OK. A message at the bottom of the window confirms that the
certificate request was successfully exported to the file. You are returned to
the Oracle Wallet Manager main window.
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Managing Trusted Certificates

Managing trusted certificates includes the following tasks:

Importing a Trusted Certificate

Removing a Trusted Certificate

Exporting a Trusted Certificate

Exporting All Trusted Certificates

Exporting a Wallet

Importing a Trusted Certificate

You can import a trusted certificate into a wallet in either of two ways: paste the
trusted certificate from an e-mail that you receive from the certificate authority, or
import the trusted certificate from a file.

Oracle Wallet Manager automatically installs trusted certificates from VeriSign,
RSA, Entrust, and GTE CyberTrust when you create a new wallet.

Pasting the Trusted Certificate

To paste the trusted certificate:

1.

Choose Operations > Inport Trusted Certificate fromthe
menu bar; the Import Trusted Certificate dialog panel appears.

Choose the Past e the Certifi cate button, and choose OK. An Import
Trusted Certificate dialog panel appears with the following message:

Pl ease provide a base64 format certificate and paste it
bel ow.

Copy the trusted certificate from the body of the e-mail message you
received that contained the user certificate. Include the lines Begi n
Certificateand End Certificate.

Paste the certificate into the window, and Choose OK. A message at the
bottom of the window informs you that the trusted certificate was
successfully installed.

Choose OK; you are returned to the Oracle Wallet Manager main panel, and
the trusted certificate appears at the bottom of the Trusted Certificates tree.
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Keyboard shortcuts for copying and pasting certificates:

«  (UNIX) Use Control+Insert to copy, and use Shift+Insert to
paste.

« (Windows) Use Ctrl+c to copy, and use Ctrl+v to paste.

Selecting a File that Contains the Trusted Certificate

To select the file:

1.

Choose Operations > Inport Trusted Certificate fromthe
menu bar. The Import Trusted Certificate dialog panel appears.

Enter the path or folder name of the trusted certificate location.
Select the name of the trusted certificate file (for example, cert . t xt).

Choose OK. A message at the bottom of the window informs you that the
trusted certificate was successfully imported into the wallet.

Choose OK to exit the dialog panel; you are returned to the Oracle Wallet
Manager main panel, and the trusted certificate appears at the bottom of
the Trusted Certificates tree.

Removing a Trusted Certificate
To remove a trusted certificate from a wallet:

1.
2.

Select the trusted certificate listed in the Trusted Certificates tree.

Choose Oper ati ons > Renove Trusted Certificate fromthe
menu bar.

A dialog panel warns you that your user certificate will no longer be
verifiable by its recipients if you remove the trusted certificate that was
used to sign it.

Choose Yes; the selected trusted certificate is removed from the Trusted
Certificates tree.
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Note: A certificate that is signed by a trusted certificate is no
longer verifiable when you remove it from your wallet.

Also, you cannot remove a trusted certificate if it has been used to
sign a user certificate that is still present in the wallet. To remove
such a trusted certificate, you must first remove the certificates that
it has signed.

Exporting a Trusted Certificate
To export a trusted certificate to another file system location:

1.

In the left panel subtree, select the trusted certificate that you want to
export.

Select Operati ons > Export Trusted Certificate;the Export
Trusted Certificate dialog box appears.

Enter a file system directory in which you want to save your trusted
certificate, or navigate to the directory structure under Folders.

Enter a file name to save your trusted certificate.

Choose OK; you are returned to the Oracle Wallet Manager main window.

Exporting All Trusted Certificates
To export all of your trusted certificates to another file system location:

1.

Choose Operati ons > Export Al Trusted Certificates.The
Export Trusted Certificate dialog box appears.

Enter a file system directory in which you want to save your trusted
certificate, or navigate to the directory structure under Folders.

Enter a file name to save your trusted certificates.

Choose OK; you are returned to the Oracle Wallet Manager main window.
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Exporting a Wallet

You can export a wallet to text-based PKI formats. Individual components are
formatted according to the following standards (Table 17-6). Within the wallet, only
those certificates with key usage SSL are exported with the wallet.

Table 17-6 PKI Wallet Encoding Standards

Component

Encoding Standard

Certificate chains

X509v3

Trusted certificates

X509v3

Private keys

PKCS #8
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Using Oracle Enterprise Login Assistant

Use Oracle Enterprise Login Assistant to manage wallets and passwords, including
those stored locally or in an LDAP directory, and to enable or disable secure SSL
connections.

You can use Oracle Enterprise Login Assistant for both (i) SSL-authenticated
enterprise users, and (ii) password-authenticated enterprise users.

This chapter describes Oracle Enterprise Login Assistant, and contains the
following topics:

« About Oracle Enterprise Login Assistant
« Managing Credentials for Certificate-Authenticated Enterprise Users

« Managing Credentials for Password-Authenticated Enterprise Users
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About Oracle Enterprise Login Assistant

Oracle Enterprise Login Assistant is a client-side tool that can be used by both
certificate-based and password-based enterprise users.

For certificate-based users, it provides easy access to existing wallets and PKI
certificates, while masking their underlying complexity. Once users securely open
their wallets using Enterprise Login Assistant, they can be authenticated to a
centrally-located LDAP directory service with a single sign-on (SSO), and can
thence connect to multiple databases without providing additional database
passwords. They can also use Enterprise Login Assistant to upload encrypted
wallets to and download them from the LDAP directory, and they can update
directory passwords (Oracle Internet Directory only), database passwords, and
wallet passwords.

For password-based users, Enterprise Login Assistant provides the capability to set
up and manage a single, global password for accessing multiple databases thus
obviating the need to set up and manage wallets and certificates. Password-based
users must enter this password for each respective database connection.

For all enterprise users, this provides strong authentication, secure connections, and
enhanced ease-of-use.

Starting Oracle Enterprise Login Assistant

Refer to the Oracle operating system-specific documentation for Oracle Enterprise
Login Assistant startup instructions.
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Managing Credentials for Certificate-Authenticated Enterprise Users

This part contains the following topics:

Opening Existing Wallet on Local System

Connecting to LDAP Directory and Downloading New Wallet
Changing Passwords

Uploading Wallet to LDAP Directory

Logging Out and Disabling SSL Connection

See Also: Chapter 17, Using Oracle Wallet Manager, for
information about managing wallets with Oracle Wallet Manager.

Opening Existing Wallet on Local System

Upon startup, Oracle Enterprise Login Assistant searches for an installed wallet in
the default system location that is defined in the Oracle operating system-specific
documentation. If it finds an installed wallet, the login window appears

(Figure 18-1):
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Figure 18-1 Enterprise Login Assistant Login Window (wallet found)

~| Oracle Enterprise Login Assistant | 2 |J|
4 tn Oracle Wallet has been found in vour default location,
is You can continue and use this Wallet or you can
dow iload a new Wallet from the Directory Service,
- Source of Wallet
® Local Copy
Password: [
’_; Directory Service [None Configured ] (Replaces Local Copy)
User: '
Password: .......................................................................................

| Change passwords.. |
Crack Enterprise Login AsssEnt(Th)
Wersion 9.0.1.0.0

Copyright(c) 2000, 20071 Sracke Corporation
Allrights rezared.

To establish a secure SSL connection using your local wallet:
1. Choose the Local Copy button.
2. Enter the wallet password.

3. To change password(s). choose the Change passwords button ; Figure 18-5
appears. See: Changing Passwords on page 18-7.

4. Choose the Login button.

Enterprise Login Assistant creates a copy of the wallet in the local file system,
and you are returned to the logged-in state; the Logged-In Window appears
(Figure 18-2). This step enables autologin.
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Note: Oracle wallets are always encrypted upon creation in both
the LDAP directory and the local file system. However, when
autologin is enabled, the wallet is obfuscated to enable autologin

access.

See Also: obfuscation

Figure 18-2 Enterprise Login Assistant Logged-In Window

cn=Phil Thorntoc=USE[yow:329]

Change passwaord ] Upload wallet ] Logout ]

Help

If Enterprise Login Assistant does not find a wallet installed on the local system, the

following window appears (Figure 18-3):

Figure 18-3 Enterprise Login Assistant Login Window (wallet not found)

= Oracle Enterprise
/ Enterprise Login Assistant has not detected an
-”31 Oracle Wallet in your envirenment, Please provide

vour Directory Service Username and Password,

Clocal Copy

— Source of walet —m o o — 40—

Passusord: {

® Directory Service [None Configured ]

User: 1
Password: 1
Change passwaords., |
Crack Entetprie Login AssEmntiTh)
“ersion 9.0

Copyright(c) 2000, 2001 Craclke Corporation
Allrights rezened.

Help | Cancel |

To download a new wallet from the LDAP directory see the next section.
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Connecting to LDAP Directory and Downloading New Wallet

Enterprise Login Assistant can download a wallet from an LDAP directory to your
local system.

To connect to an LDAP directory and download a wallet:

1. Choose the Directory Service button (Figure 18-3).

Figure 18-4 Enterprise Login Assistant Directory Login Window

I Oracle Enterprise Login Assistant I
¢ Enterprise Login Assistant has not detected an
-”31 Oracle Wallet in vour envirenment, Please provide

vour Directory Service Username and Password.

Source of wWallet
Cllocal Copy

Passyord: |

® Directory Service [None Configured ]

User: [Mharu.Me

Password: |*******

Change passwaords..,

rack Entetprie Login AssE@ntiTh)
Version 9.0

Copyright(s) 2000, 2001 Craclke Corporation
Allrights rezened.

Help Cancel

2. Enter your distinguished name (DN) or directory UserID and password.
3. Choose the Login button.

Enterprise Login Assistant attempts to connect to the directory and download a
wallet. If there is no directory service, it prompts for the directory service
hostname and port (contact your System Administrator for further details).

4. Enterprise Login Assistant stores the wallet in the default location on the local
system and attempts to decrypt it using the directory password. If the directory
password does not match the wallet password, you are prompted for the wallet
password.
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Note: Default Wallet Location:
« UNX: /etc/oracle/wallets/<usernanme>

« Wndows: c:\winnt\profile
<user>\oracle\wal |l ets

Enterprise Login Assistant creates an obfuscated copy of the wallet in the local
file system, and you are returned to the logged-in state; the Logged-In Window
appears (Figure 18-2). This confirms that the wallet was successfully copied to
the local system and that autologin is enabled.

Changing Passwords
You can use Enterprise Login Assistant to change the following passwords:

The wallet password

This password is used to access your local wallet.

The directory password

This password is used to bind to Oracle Internet Directory.
The database password

This is the single, global password used by enterprise users to authenticate to
multiple databases.

To change a password:

1.

Choose the Change password button from the Logged In Window
(Figure 18-2); the Change Enterprise Password Window appears (Figure 18-5):
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Figure 18-5 Enterprise Login Assistant Change Password Window

~| Change Enterprise Password |

It is recommended that a password follow the following gquidelines :
* Have a minimum of 8 characters
o * Include non—dictionary words that are difficult to guess
# Include numbers
You may alse enter a reminder for yvour new password
should you forget it

Password Change Options
® Directory and Oracle Database Password

1 Directory Password Only
1 Oracle Database Passwaord Only
0 Local wWallet Password Only

User:

Old password:
Mew password:
Confirm password:
Reminder:

Help Ok Cancel

Choose one of the following Password Change Options:

« Directory and Oracle Database Password

« Directory Password Only

« Oracle Database Password Only

« Local Wallet Password Only

Enter your distinguished name (DN) or directory UserID in the User field.
Enter your existing password in the Old password field.

Enter your new password (in accordance with your password policy) in the
New password field, and confirm it by entering it again—in the Confirm
password field.

Enter an optional password hint in the Reminder field (see the Caution note
that follows); choose the OK button.

If the Old password you entered matches the existing password(s), Enterprise
Login Assistant updates the selected password(s) with the new password and
optional hint, displaying the following message to confirm successful update:

Password changed successful ly.
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Choose the OK button to exit the dialog box.

Caution: Although Oracle Enterprise Login Assistant provides
reminders (hints) to aid in the recovery of lost wallets, such
reminders are not encrypted—and should only be used with
restricted access control lists (ACLs). See: Oracle Internet
Directory Administrator’s Guide for information about
configuring ACLs.

Consider the following guidelines for reminders:

« Reminders are not required, and their use should be avoided.
The system is more secure without reminders—the existence of
an unencrypted reminder provides unauthorized third parties
a potential opportunity to surreptitiously derive the password.

« However, if there is an enterprise requirement for wallet
recovery in the event of a lost wallet password, reminders can
be useful—if access is restricted by ACLs (imperative).

« Reminders can only entered for wallets stored in an LDAP
directory. If you choose Local Wallet Password Only, neither a
distinguished name nor a UserID is required, and you cannot
enter a Reminder.

« If reminders are employed, you should formulate
enterprise-wide rules to ensure the quality of the reminder. The
final test of a good reminder is that it is meaningful only to the
intended user, and does not compromise the security of the
associated password.

Note: Your enterprise installation may have special security
requirements. Security Administrators can adjust the access
controls in the LDAP directory to prevent users from updating
certain passwords, or to force users to make all passwords
identical.
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Uploading Wallet to LDAP Directory
To upload a wallet to an LDAP directory:

1.
2.

Choose the Upload Wallet button in the Logged-In Window (Figure 18-2).

If you have already authenticated to the LDAP directory service in the current
session, a copy of the wallet is uploaded to the directory, replacing the existing
wallet.

If you have not yet authenticated to the LDAP directory service in the current
session, Enterprise Login Assistant prompts you for your distinguished name
(DN) or directory UserID and password to connect you to the directory before
Step 2 is performed.

Logging Out and Disabling SSL Connection

Use Oracle Enterprise Login Assistant to disable single sign-on communications
from server-side applications.

To log out and disable the SSL connection:

1.

Choose the Logout button from the Logged-In Window (Figure 18-2).
Enterprise Login Assistant displays the following warning:

If you log out, your applications will no | onger use the
security credentials of your wallet.

Choose the Yes button to continue; you are returned to the Login Window
(Figure 18-1).
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Managing Credentials for Password-Authenticated Enterprise Users
This part contains the following topics:

« Changing Passwords

Changing Passwords
You can use Enterprise Login Assistant to change the following passwords:

« The directory password
This password is used to bind to Oracle Internet Directory.
« The database password

This is the single, global password used by enterprise users to authenticate to
multiple databases.
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Using Oracle Enterprise Security Manager

This chapter describes how to use Oracle Enterprise Security Manager to administer
Enterprise User Security in Oracle9i databases. This chapter contains the following
topics:

« Introduction
« Installing and Configuring Oracle Enterprise Security Manager
« Administering Enterprise Users

« Administering Oracle Contexts

See Also: Oracle Internet Directory Administrator’s Guide
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Introduction

Oracle Enterprise Security Manager, a component of Oracle Enterprise Manager, is
an administration tool employed by Oracle Advanced Security to manage
enterprise users, enterprise domains, databases, and enterprise roles that are held
in an LDAP-compliant directory service.

The directory service is used as a central repository to define user and server access
information for a network. It stores naming information, global password
definitions, PKI credentials, and application access authorizations for the users that
it defines. Such centralized storage of enterprise users and their access privileges

supports single sign-on capability, and provides secure, scalable user
administration.
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Installing and Configuring Oracle Enterprise Security Manager

The following tasks describe how to use Oracle Enterprise Security Manager to
install Oracle Management Server and Oracle Enterprise Manager:

Task 1: Configure an Oracle Internet Directory
Task 2: Install Oracle Enterprise Manager

Task 3: Start Oracle Enterprise Security Manager
Task 4: Log On to the Directory

Task 1: Configure an Oracle Internet Directory

Oracle%i Enterprise User Security is based on an LDAP-compliant directory. The
directory server must be properly installed and configured before Oracle Enterprise
Manager can be used to manage Enterprise User Security. The following elements of
directory configuration must be completed before proceeding:

A compatible LDAP-compliant directory must be installed, running, and
accessible over both standard LDAP and Secure Sockets Layer LDAP
(LDAP/SSL).

See Also:
«  Oracle Internet Directory Administrator’s Guide
« Appendix E, "Using Enterprise User Security with Microsoft

Active Directory"

Oracle Internet Directory must be configured to support Oracle9i directory
schema objects and must include a root Oracle Context. You can use Oracle Net
Configuration Assistant to configure both of these on the directory server.

See Also: Oracle9i Net Services Administrator’s Guide
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Task 2: Install Oracle Enterprise Manager

Oracle Enterprise Manager is automatically installed by the Oracle9i Enterprise
Edition server installation process, and includes all necessary functionality to
support Enterprise User Security. Oracle Enterprise Manager is also installed by
default with the Oracle9i infrastructure installation at the same time as Oracle
Internet Directory. Oracle Enterprise Manager can also be installed separately in its
own ORACLE_HOME, using the custom install option.

See Also:
« Oracle Enterprise Manager Installation

« Oracle Enterprise Manager Administrator’s Guide

Note: Oracle Enterprise Security Manager does not require special
configuration for it to run. However, all Oracle databases in the
enterprise that use Oracle Enterprise Security Manager must be
accessible over Oracle Net from the Oracle Enterprise Manager
ORACLE_HOME.

Task 3: Start Oracle Enterprise Security Manager
To launch Oracle Enterprise Security Manager, use one of the following options:

. (UNIX)

From the Enterprise Manager ORACLE_HOME, enter the following at the
command line:

esm

«  (Windows)

Choose Start > Programs > Oracle - HOME_NAME > Integrated Management
Tools > Enterprise Security Manager

The directory login box appears (Figure 19-1):
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Figure 19-1 Directory Server Login Window

~| Directory Server Login | :

OnacLe ENTERPRISE MIANAGER

® Password suthentication
I8SL Client Aduthentication
) Mative Authentication

User: ch=nmt
Password: sk
Hostname:  |oraldap

Note:

All Oracle Enterprise Security Manager functionality is also

available by entering the following syntax at the command line;

esm-cnmd <opti ons>

To retrieve a full list of options, type the following syntax at the

command line:

esm-cmd

Task 4: Log On to the Directory

Oracle Enterprise Security Manager provides three ways to connect to a directory
server, summarized by Table 19-1:

Table 19-1 Oracle Enterprise Security Manager Authentication Methods

Authentication Method

Description

Password Authentication

Uses simple authentication requiring a distinguished
name (DN) or a known directory UserID and a
password (that is, the user name and password).

SSL Client Authentication

Uses two-way SSL authentication in which both the
client and server use Oracle Wallets containing digital
certificates (that is, the user name and certificate). The
subsequent connection is encrypted.
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Table 19-1 Oracle Enterprise Security Manager Authentication Methods

Authentication Method Description

Native Authentication Applies to Microsoft Windows NT and Windows 2000
only; uses operating system-level authentication to log
on to a Microsoft Active Directory.

To select an authentication method, choose the appropriate option in the Directory
Server Login Window (Figure 19-1).
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Administering Enterprise Users

Oracle Enterprise Security Manager manages one directory server, identified at the
top of the main application tree. It lets you manage users and Oracle Contexts in
the directory. An Oracle Context is a subtree in a directory recognizable to Oracle
products. It provides an administrative hierarchy for management of Oracle data
including installed Oracle products that access the directory.

This section describes how to use Oracle Enterprise Security Manager to administer
enterprise users. It contains the following topics:

« Creating New Enterprise Users

« Defining a Directory Base

« Defining a New Enterprise User Password

« Defining an Initial Enterprise Role Assignment
« Creating a Wallet

« Browsing Users in the Directory

« Browsing Users in the Directory

« Enabling Database Access
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Creating New Enterprise Users
Use Oracle Enterprise Security Manager to create users in the directory.

To create new users, select Create Enterprise User... from the Operations menu. The
Create User window appears (Figure 19-2).

Figure 19-2 Oracle Enterprise Security Manager: Create User Window (User Naming
Tab)

User Maming

Base idc=com _Browse., |

First Name {Richard

Surname [Bentoni

User 1D {Richard.Bentoni
User ID Suffix !

Email Address [Richard.Bentoni@rmycornpany.corm

Comman Name:

cn=  |Richard Bentoni

|

Referring to Table 19-2, enter the appropriate user information required by the User
Naming tabbed window; choose OK to create a new enterprise user.

Table 19-2 Create User Window Fields

Field Name | Mandatory? | Description

base Yes The entry in the directory under which the new user is
created.

First Name Yes Given name.

Surname Yes Surname (last name).

UserlD Yes The user name (Logon Identifier) that the user can use to
connect to the network, databases, and applications.
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Table 19-2 Create User Window Fields (Cont.)

Field Name | Mandatory? | Description

UserlD No The current value of any common UserID suffix that is
Suffix appended to the UserID. For example:
<user| D>. us. acne. com
Email No The new user’s e-mail address.
Address
Common Yes The Common Name component (cn=) of the
Name: Distinguished Name (DN) of the new user in the

directory. By default it is set to the full name of the new
user. However, you can override this value to force a
particular value for the cn portion of the DN.

cn=

Defining a Directory Base

An enterprise user entry can reside at any base within the directory. The base can be
any existing directory entry, such as country entry (c=us), or an organization entry
(o=acme,c=us). Multiple users typically share the same directory base. This base
associates all the users contained under it with the same high level organization in
the hierarchy.

You can enter the base in the base field of the Create User window (Figure 19-2).
Alternatively, you can browse the entire directory to select a suitable base by
choosing the Browse... button (in the same window); the Browse Directory Window
appears (Figure 19-3):
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Figure 19-3 Oracle Enterprise Security Manager: Browse Directory Window

BT e
[

-~

®

E-de cn=Becky Kulven
B cn=Calvin Chen
- cn=Dara Reilly
- cn=Denise Kumar
- cn=Dick Lau

E-de cn=Evelyn Bosch

E-d cn=Harriet Scortea
- cn=lohn Groover

e cn=Kay Cataman
- cn=Kenneth Robhins
- cn=Michael Waong
- cn=CracleContest

T cn=Pana Mrea

Selection|

liziae 1 Canceljl _Help)

The Browse Directory window lets you navigate the directory by drilling down into
each entry from the top of the directory tree. When a directory entry is selected its
distinguished name (DN) is placed in the Selection field. To accept the selected
Distinguished Name choose the OK button. This value is returned as the selected
base for a new directory user, and is preserved for all subsequent operations that
create or search for users in the directory—although you can change it from time to
time.
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Defining a New Enterprise User Password

The Password tab of the Create User Window (Figure 19-4) lets you define and

maintain the enterprise user password:

Figure 19-4 Oracle Enterprise Security Manager: Create User Window (Password

Tab)

® pccept Default loem_temp

 Chogse Random 1

" Enter Manually
hesy passyword 1

Yerify password 1

[ Motify User by Email

C'PatPUSP' _________________________________

I oK Cancel Help

The enterprise user password is used for:

« Directory logon.

« Database logon, to databases that support password authentication for global

users.

« A new Oracle Wallet, if created for the new user at this time.

When creating a new password, you can choose one of the following options:

« Accept the default password that is displayed

« Choose a randomly generated password

« Manually enter a password
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To send the password to the new user by e-mail, select Notify User by Email, and
instruct the new user to change the password after its first use. The e-mail address
from the User Naming tab in Figure 19-2 is used.

Note: By default, Oracle Enterprise Security Manager sets the
directory, database, and wallet passwords to be identical for a given
user, but you may wish to enhance security by setting them to be
difference. Use Oracle Enterprise Login Assistant to reset user
passwords.

See Also: Chapter 18, Using Oracle Enterprise Login Assistant
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Defining an Initial Enterprise Role Assignment

When you create a new enterprise user, you can grant any previously configured
enterprise roles to a new user.

See Also: Administering Enterprise Roles on page 19-42

To select one or more enterprise roles to grant to a new user, choose the Add...
button on the Enterprise Roles tab of the Create User window.

The Add Enterprise Roles window appears (Figure 19-5):

Figure 19-5 Oracle Enterprise Security Manager: Add Enterprise Roles Window

|~ AddEnterpriseRoles |
T R

Oracle Context:|nmt

Enterprise Role EEnterprise Damain
I Manager

Service Admin Services

User Services

Manager Busingss

User Business

Businessadmin Business

[ OK I CanceIJl HeIle

Select the correct Oracle Context, then select any enterprise roles in your Oracle
Context to assign to the new user; choose OK.
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Creating a Wallet

A sample Oracle Wallet containing a new digital certificate, private key, and
certificate trust points may be generated for the new user in an encrypted binary
format. The Oracle Wallet will be stored with the new user in the directory server as
part of the directory entry for the user. To create a sample wallet for new users,
choose the Wallet tab of the Create User window (Figure 19-6).

Note: The Wallet tab appears only if Oracle Enterprise Security
Manager is configured to have a local certificate authority. To create
a simulated local certificate authority, run the following tool:

esm - genca

Follow the prompts that are displayed by the tool. This tool creates
a simulated certificate authority in your Oracle wallet directory.

Figure 19-6 Oracle Enterprise Security Manager: Create User Window (Wallet Tab)

BT

Issued Feor |cn=Sara Singh,o=laurel

lssued By |

Generate Wallet..,

Status Mot Created

I OK Cancel Help

The distinguished name (DN) under which the new User will be created is used by
default as the DN for the digital certificate to be contained in the new user’s Oracle
wallet. The user cannot connect to the database if the DNs of user certificates are not
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equal to their DNs in the directory. However, you may edit the DN to be used for
the certificate before generating the wallet by editing the contents of the Issued For:
field.

A sample Oracle wallet will be created when you click the Generate Wallet... button.
When you select a user from the Edit User window (see Figure 19-8) a

user pkcs12 attribute is visible in the attribute list of that user. The user pkcs12
attribute represents the wallet created in this step.

Note: The wallet generated with this simulated certificate
authority is a sample only. If you require a valid database wallet for
SSL connections between the database and the directory, then you
must use Oracle Wallet Manager to create the wallet.

See Also: Chapter 17, "Using Oracle Wallet Manager"
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Browsing Users in the Directory

Oracle Enterprise Security Manager lets you browse the directory for all users
currently stored.

To browse enterprise users, choose the All Users tab in the main window
(Figure 19-7):

Figure 19-7 Oracle Enterprise Security Manager: Main Window (All Users Tab)

=

& 0racle Contexts

&l Users

acme Search Criteria
4 Default Cracle Context Base[0=nmt ] Browse.. |
% nmt [] Include Subtrees

Show names contai ning::]

| Name |Distinguished Na.. | |
Becky Kulven cn=Becky Kulven,o=i+
Calvin Chen ch=Calvin Chen,o=n
Dara Reilly ch=Dara Reilly,o=n
Denise Kumar cn=Denise Kumar,o

Dick Lau cn=Dick Lau,o=nmt
1 1 S

L.

r L. r n

( Edit...” Report...” Rermoye )

n

To search for users in the directory, define the search criteria and choose the Search
Now button. The window displays the results of the search. Table 19-3 summarizes
the search criteria and their respective effects on the search results:
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Table 19-3 Directory Search Criteria

Search Criteria

Effect on the Search

Base

This is the base entry point in the directory where the search is
performed. Only users under this base are returned by the
search.

Include Subtrees

This determines whether to show all users found in the entire
subtree under the selected base, or to only show only those
users that exist directly under that base location (one level

only).

Show names containing

This limits the search to those users whose directory entries
have a common name that starts with the characters you
specify. This is useful if you do not know the exact name or
base of the target users.
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Example:
Selecting a user from the search results for editing.

To edit one of the returned user names, select the target user name and choose the
Edit... button—or just double-click the target user name in the list (Figure 19-8):

Figure 19-8 Oracle Enterprise Security Manager: Edit User Window

Ceneral

Distinguished Mame | cn=Billy Bragg,cu=Eurcpe,o=IMC,c=Us

Attribute Mame | Attribute Yalue
ohjectclass top

ch Billy Bragg

Sh Bragg

orclglobalid bbragg

orclpkes12hint Billy Bragg

userpkes1z {Binary Content)
arclpassword tu—orcldbpwdil.CEA3SS
userpassword f{MD437S5E3ECASA2DAZ17

€3 EE ED |

When you select a directory user for edit, you can change the password and
enterprise role assignments—and you can modify the user wallet in the same
manner as during its initial creation.
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See Also:
« Creating New Enterprise Users on page 19-8

« Browsing Users in the Directory on page 19-16

Enabling Database Access

The user entry must reside in a directory subtree of users that has been enabled for
Oracle database access. You can set Oracle Database Access permissions for a
selected subtree—to let databases within a domain in the Password-Accessible
Domains group read the user’s login credentials.

To enable database access:

On a selected subtree of directory users, set Oracle Database Access permissions to
permit databases in the Password-Accessible Domains group to access the user’s
database login credentials:

« Select the target user subtree under Users, by Search Base

« Select Allow logon to Databases in Authorized Enterprise Domains
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Administering Oracle Contexts

An Oracle Context is a subtree in a directory that contains the data used by any
installed Oracle product that uses the directory. Oracle Enterprise Security Manager
is one such product. It lets you manage database and security-related information in
the directory, in an Oracle Context.

Note: Oracle Corporation recommends that you do not create
users within an Oracle Context.

See Also: Chapter 15, Managing Enterprise User Security

Oracle Context Versions

Oracle Enterprise Security Manager can support multiple Oracle Contexts in a
directory, including Oracle8i and Oracle9i versions. However, Oracle9i Enterprise
User Security can only be managed using an Oracle9i Oracle Context. Oracle
Enterprise Security Manager for Oracle9i may be used to manage version 9i Oracle
Contexts as well version 8i Oracle Contexts in the directory.

Oracle Enterprise Security Manager displays all existing Oracle Contexts in its main
application tree—including both Oracle8i and Oracle9i versions. In the following
example (Figure 19-9), Oracle Enterprise Security Manager is connected to an
Oracle directory that has been configured to support the Oracle9i directory schema
and an Oracle9i root Oracle Context.
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Defining Properties of an Oracle Context

An Oracle Context has a number of properties that can be viewed and managed in
the Enterprise Security Manager window (Figure 19-9, Table 19-4):

Figure 19-9 Oracle Enterprise Security Manager: General Tab

Enterprise Security Manager
s Help

6‘— dlsunzs
@}DOracIe Contaxts General

e acme Directory Location :]
%Datahases Jersion -

Enterprise Domains Commen User Search Bases
Users, by Search Base QO=nmt

e nmt

Context attribute Settings

Application GUID | orelGlobaliD
Pazswerd Policy  'fu— orcldbpw dhALWAY

Note: The reference to Default Oracle Context in Figure 19-9
should read Root Oracle Context.

To understand the properties of an Oracle Context, refer to Table 19-4:
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Table 19-4 Oracle Context Properties

Property

Description

Directory Location

The parent of the Oracle Context. In the case of the root Oracle
context this value is empty, as the context is at the root of the
directory tree.

\Version

This defines the Oracle Context Version: Oracle8i or Oracle9i.

Versioncompatibility

This defines whether the Oracle Context supports Oracle8i,
Oracle9i, or both of them.

Common User Search

The list of base locations in the directory at which users may

Bases commonly exist. Identifying a list of user search bases lets you
quickly browse the users at those directory locations, and also
indicates to Oracle9i databases in the Oracle Context where
they can find directory users that connect to them.

UseriD The UserlID attribute uniquely identifies users in the

enterprise; a globally unique identifier for each user. Users use
the value in the UserlD attribute to authenticate to Oracle9i
databases, directory servers, or directory enabled applications.
The default value is cn, the common name of the directory
user.

Application GUID

The name of the attribute in a user entry in which unique
application GUID values exist. It cannot be modified in this
release.

Password Policy

The password policy syntax used by Oracle9i databases when
authenticating password authenticated global users. It cannot
be modified in this release.
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Registering a Database in the Directory

Using Oracle Enterprise Security Manager to register a database with the directory
is new in this release. You can also use Database Configuration Assistant to register
a database with the directory. Table 19-5 lists the differences between using these
two Oracle tools.

Table 19-5 Differences between Using Oracle Enterprise Security Manager and Database Configuration
Assistant to Register a Database with the Directory

Creates Creates Sets

Database  Adds Placeholder RDBMS_  Creates

DN Entryin Databaseto Database SERVER_ Valid

the the Default Walletinthe DN Database
Oracle Tool Directory  Domain Directory Parameter Wallet
Oracle Enterprise Security Manager Yes Yes Yes No No
Database Configuration Assistant Yes Yes No Yes No

See Also: "About Registering the Database in the Directory" on
page 15-34 for more information about registering databases in the
directory.

Prerequisites
If you want to generate a placeholder database wallet, then you must first run the
following tool at the command line:

esm - genca

Follow the prompts that this tool displays. This tool creates a simulated certificate
authority in your Oracle wallet directory.

To register a database with the directory:

1. Inthe Enterprise Security Manager main window, select Register Database from
the Operations menu. The Database Registration window appears.

2. Fill in the appropriate values in the fields for the database that you want to
register. Note: to register the database by using Oracle Enterprise Security
Manager, the SID for the database must be equal to the short database name.

If you need to edit the Connect String, then select Store TNS Connect String,
which makes that field available for editing.
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If you want to generate a placeholder wallet for the database that you are
registering, then select Generate Wallet and enter the wallet password.

If you do not see the Generate Wallet option, then ensure that you have run the
esm - genca tool that is described in "Prerequisites” on page 19-23.

After filling in all of the information, click OK to create a database entry in the
directory.

A dialog box instructs you to set the RDBMS_SERVER_DN parameter in the
server parameter file (spfi | e. or a) by entering the following command at a
SQL*Plus prompt:

ALTER SYSTEM SET RCBMVG SERVER DN=SERVER DN SOCPE SPH LE

After entering this command, restart the database so the new parameter setting
can be read by the system.

Defining User Search Bases

Common user search bases can be added to or removed from an Oracle9i Oracle
Context using the General tabbed window (Figure 19-9).

Note: This functionality is not available for Oracle8i Oracle
Contexts.

To remove a user search base from an Oracle Context:

1.

Using the Oracle Enterprise Security Manager General tabbed window
(Figure 19-9), select a search base from the Common User Search Bases list, and
choose the Remove... button.

Choose the Apply button; the user search base is removed from the Oracle
Context in the directory.

To add a new user search base to an Oracle Context:

1.

Using the Oracle Enterprise Security Manager General tabbed window
(Figure 19-9), choose the Add... button; the Browse Directory window appears
(Figure 19-10):
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Figure 19-10 Oracle Enterprise Security Manager: Browse Directory (User Search
Bases)
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2. Navigate the directory tree and select an entry for a user search base.
Alternatively, you can edit the contents of the Selection field in this window to
manually define the user search base.

3. Choose OK; the selected entry is added to the list of user search bases in the
General tabbed window (Figure 19-9).

4. Choose Apply (Figure 19-9); the user search base is added to the Oracle Context
in the directory.
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Defining Oracle Context Administrators

An Oracle Context contains administrative groups that have varying levels of
privileges for operations within an Oracle Context. Some administrative groups are
only available in Oracle9i Oracle Contexts and some are available in both Oracle8i
and Oracle9i Oracle Contexts. The administrative groups for an Oracle Context are

defined by Table 19-6:

Table 19-6 Oracle Context Administrators

Administrative Oracle9i | Oracle8i

Group Definition Version Version

Full Context All possible Administrator privileges for all Yes No

Management product areas in the Oracle Context.

Directory User Can view directory user password Yes No

Management reminders and update passwords.

Database Security Can manage all enterprise domains and Yes Yes

Management roles in the Oracle Context.

Database Registration | Can register a new database in the Oracle Yes Yes
Context.

Oracle Net Can manage Oracle Net objects in the Oracle Yes Yes

Management Context.

Use the Administrators tab of the Oracle Enterprise Security Manager main

window to manage Oracle Context Administrators(Table 19-11):
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Figure 19-11 Oracle Enterprise Security Manager Administrator’s Tab
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To remove a user from a list of Oracle Context Administrators:

1.

Choose the Administrator Category (Table 19-6); a list of administrators within
this category is displayed.

Select a user name from the list.
Choose the Remove button; the selected user is removed from the list.

Choose the Apply button; the selected user is removed as an Oracle Context
Administrator from the selected Administrator Category.
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Figure 19-12 Oracle Enterprise Security Manager: Add Users Window
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To add a new user to the list of Oracle Context Administrators:

1. Choose the Add... button in Figure 19-11; the Add Users screen appears
(Figure 19-12).

Use this window to locate and select users in the directory. There are three
panels in the window:

« Top panel: The directory search tree.

« Middle panel: Search criteria that determine the users returned by the
search.

« Bottom panel: Search results—users found in the directory that match the
search criteria.

2. Navigate the Directory (in the top panel) to select a directory entry as a user
search base. You can edit the contents of the selection field in this window to
manually define the user search base.

3. Check the Include Subtrees option in the middle panel (Search Criteria). This
selection option searches for all users within the search base, including subtrees.
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Enter any known User Name in the Show Names Containing field to which
user names returned by the search must conform. This limits the search to users
in the directory who have a common name value that is or starts with the
specified text.

Choose the Search Now button (middle panel). If there are any users in the
directory at the base you have selected that match your search criteria they are
listed in the window.

Select the desired user name either by selecting it from the list and choosing
OK, or by double-clicking it. Multiple users can be selected from the list by
selecting a range of users and choosing OK. The new users appear in the list of
Administrators under the category you have selected.

Note: This window is commonly used throughout Oracle
Enterprise Security Manager where it is necessary to select users
from the directory.
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Managing Password Accessible Domains

There are three requirements for a database to accept a connection from a
password-authenticated user:

The database must be a member of a domain configured to accept Password
and SSL authentication (See: Table 19-8).

The domain must be a member of a password-accessible domains group, called
the Password-Accessible Domains List, added by an Oracle Context
Administrator or a Database Security Administrator. Domain members of this
list can read the user’s password verifier in the directory, while those excluded
from this list cannot. The domain must be part of an Oracle9i, or later, Oracle
Context.

The user entry must be in a directory subtree of users that has been enabled for
Oracle database access. You can set Oracle Database Access permissions for a
selected subtree that lets databases in the Password-Accessible Domains List
read the users’ database login information.

To configure password accessibility:

1.

Add the target database to an enterprise domain that has been configured to
accept Password and SSL user authentication.

See Also:

« Defining Database Membership of an Enterprise Domain on
page 19-37

« Managing Database Security Options for an Enterprise Domain
on page 19-39

In a selected Oracle9i, or later, Oracle Context, add the domain to the
Password-Accessible Domains List. Choose Add and select one of the current
enterprise domains from the resulting dialog. To remove an enterprise domain
from the list, select it in the Accessible Domains window and choose Remove.

On a selected subtree of directory users, set Oracle database access permissions
to permit databases in the Password-Accessible Domains List to access the
users’ database login information:

« Select the target user subtree under Users, by Search Base.

= Select Allow Logon to Database in Authorized Enterprise Domain for that
subtree.
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See Also: Security of User Database Login Information on
page 15-12

Note: Password accessible domains require an Oracle9i Oracle
Context.

Managing Database Security

Once databases are registered in the directory, you can use Oracle Enterprise
Security Manager to manage user access to those databases. This is achieved using
the following objects in the Oracle Context (Table 19-7):

Table 19-7 Oracle Enterprise Security Manager: Oracle Context Objects

Object Description
Database A directory entry representing a registered database.
Enterprise Domain A grouping of databases registered in the directory, upon

which a common user access model for database security can
be implemented

Enterprise Role An Authorization that spans multiple databases within an
enterprise domain. It is an enterprise role to which individual
roles can be granted on each of the databases in an enterprise
domain.

Mapping A mapping object is used to map the distinguished name
(DN) of a user to a database schema that the user will access.

See Also:
« Oracle9i Database Administrator’s Guide

« Chapter 15, Using Oracle Enterprise Security Manager
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Managing Database Administrators

A Database Administrator is a directory user that has privileges to modify the
database and its subtree in the Oracle Context. Database Administrators may be
managed using the Administrators tabbed window when a database is selected
under an Oracle Context in the main application tree (Figure 19-11).

To remove a user from the list of Database Administrators:
1. Select a user from the list of administrators.
2. Choose Remove; the selected user is removed from the list.

3. Choose Apply; the user is removed as a Database Administrator for that
database in the Oracle Context.

To add a new user to the list of Database Administrators:

1. Choose Add; the Add Users window appears (Figure 19-12). Use this window
to locate and select users in the directory.

2. Select a user or users from the directory to be added as a Database
Administrator; the new user(s) is displayed in the Administrators tabbed
window (Figure 19-11).

3. Choose Apply; the new Administrator(s) is added to the database in the Oracle
Context.
See Also:
« Creating New Enterprise Users on page 19-8

« Browsing Users in the Directory on page 19-16

Managing Database Schema Mappings

Database schema mappings let databases that are registered in the directory accept
connections from users without requiring any dedicated database schemas for
them. For example, when local user Scott connects to a database, a database schema
called Scott must exist—for that logon to be successful. This can be difficult to
maintain if there are thousands of users and perhaps hundreds of databases in a
very large enterprise.

Users that are defined in an LDAP-compliant directory do not require dedicated
schemas on every Oracle8i or later database to which they might connect.
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A database can use a schema mapping to share one database schema between

multiple directory users. The schema mapping is a pair of values: the base in the
directory at which users exist, and the name of the database schema they will use.

You can use the Database Schema Mappings tabbed window to manage database

schema mappings—when a database is selected under an Oracle Context in the

main application tree. This window contains a list of database schema names and
Directory Base pairs (Figure 19-13):

Figure 19-13 Oracle Enterprise Security Manager: Database Schema Mappings Tab
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To remove a mapping from the list of database schema mappings in an enterprise

domain:

1. Select a mapping by selecting from the Database Schema Mapping tabbed

window.

2. Choose Remove. The selected Mapping is removed from the list.

3. Choose Apply; the mapping is removed from the enterprise domain.

Using Oracle Enterprise Security Manager
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To add a new mapping to the list of database schema mappings in the enterprise
domain:

Choose Add...; the Add Database Schema Mappings window appears
(Figure 19-14):

Figure 19-14 Oracle Enterprise Security Manager: Add Database Schema Mappings
Window
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Use this window to locate and select a base in the directory and pair it with a
database schema name, to make a database schema mapping. There are two
components to the window: there is a directory search tree from which to select
a base, and a field in which to enter a schema name.

Navigate the directory to select a desired entry as a base for the database
schema mapping. This can be any directory entry but should be located above
the subtree of users to be mapped. You can also edit the contents of the
Directory Entry field in this window to manually define the base.

Enter the name of the database schema for which this Mapping will be made
into the Schema field, and choose OK. This must be a valid name, for a schema
that already exists on that database.The new database schema mapping appears
in the database schema mappings window (Figure 19-13).

Choose Apply; the new database schema mapping is added to the selected
database in the Oracle Context.
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Administering Enterprise Domains

An Oracle Context contains at least one enterprise domain called

O acl eDef aul t Domai n. The Or acl eDef aul t Domai n is part of the Oracle
Context when it is first created in the directory. When a new database is registered
into an Oracle Context it automatically becomes a member of the

Or acl eDef aul t Domai n in that Oracle Context. You can create and remove your
own enterprise domains but you cannot remove the Or acl eDef aul t Domai n from
an Oracle Context.

To create a new enterprise domain in an Oracle Context, use either of the following
methods:

« Select Create Enterprise Domain from the Operations menu (Figure 19-13).

« Select an Oracle Context from the main application tree with a right
mouse-click.

The Create Enterprise Domain window appears (Figure 19-15):

Figure 19-15 Oracle Enterprise Security Manager: Create Enterprise Domain Window
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To create the new enterprise domain:

1. Select the appropriate Oracle Context from the drop-down list (Figure 19-15).

Note: If you invoked the Create Enterprise Domain window by
right-clicking the Oracle Context in the main application tree, the
name of that Oracle Context is already selected.

2. Enter the name of the new enterprise domain, in the Domain Name field.

3. Choose OK; the new enterprise domain is created in the Oracle Context, and
appears on the main application tree.
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To remove an enterprise domain:

1. Select the target enterprise domain from the main application tree
(Figure 19-13).

2. Use either of the following methods:
« Select Remove Enterprise Domain from the Operations menu.

« Select an enterprise domain from the main application tree with a right
mouse-click.

3. Oracle Enterprise Security Manager asks you to confirm removal of the
enterprise domain from the Oracle Context; choose OK to remove it.

Note: You cannot remove an enterprise domain from an Oracle
Context if that enterprise domain still contains any enterprise roles.
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Defining Database Membership of an Enterprise Domain

Use the application tree of the main Oracle Enterprise Security Manager window to
select a target enterprise domain. You can then use the Databases tab to manage
database membership of an enterprise domain in an Oracle Context (Figure 19-16):

Figure 19-16 Oracle Enterprise Security Manager: Databases Tab (Database
Membership)
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To remove a database from an enterprise domain:

1. Select a target database for removal, and choose Remove...; the database is
removed from the list.

2. Choose Apply; the database is removed from the enterprise domain in the
Oracle Context.

To add a database to an enterprise domain:
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Note: You can only add a database to an enterprise domain if both
the database and the enterprise domain exist in the same Oracle
Context. It follows, therefore, that:

= Anenterprise domain cannot contain a database from a
different Oracle Context.

« A database cannot be added as a member of two different
enterprise domains.

1. Choose Add... (Figure 19-16); the Add Databases window appears. This
window lists all the databases associated with the Oracle Context
(Figure 19-17):

Figure 19-17 Oracle Enterprise Security Manager: Add Databases Window
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2. Select a new target database to be added to the enterprise domain.

3. Choose OK; the selected database is added to the list of databases in the
Databases tabbed window (Figure 19-16).

4. Choose Apply (Figure 19-16); the new database is added to the enterprise
domain in the Oracle Context.
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Managing Database Security Options for an Enterprise Domain

Use the Databases tabbed window (Figure 19-16) to manage database security
options applicable to all databases that are members of the enterprise domain.

Database security options are summarized by Table 19-8:

Table 19-8 Oracle Enterprise Security Manager Database Security Options

Database Security
Option

Description

Enable current user
database links

Any database pair can only permit use of Current User
Database Links if both databases exist in an enterprise domain
in which this setting is enabled.

User authentication

All databases in an enterprise domain must enforce one of the
following types of authentication for its clients:

« Oracle Net SSL Authentication only using Oracle
Wallets.

« Either Password or Oracle Net SSL Authentication
(default).

Managing Enterprise Domain Administrators

An Enterprise Domain Administrator is a directory user with privileges to modify
the content of that domain. You can use the Administrators tabbed window
(Figure 19-11) to manage Enterprise Domain Administrators when an enterprise
domain is selected under an Oracle Context in the main application tree.

To remove a user from the list of Enterprise Domain Administrators:

1. Select a user from the list of Administrators.

2. Choose Remove; the selected user is removed from the list.

3. Choose Apply; the user is removed as an Enterprise Domain Administrator for
that domain in the Oracle Context.

To add a new user to the list of Enterprise Domain Administrators:

1. Choose Add... ; the Add Users window appears. Use this window to locate and
select target users for designation as Enterprise Domain Administrators. The
new users appear in the Administrators tabbed window.
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2. Choose Apply; the new Administrators are added to the enterprise domain in
the Oracle Context.

Managing Enterprise Domain Database Schema Mappings

As previously discussed, database schema mappings can be managed for each
database in an Oracle Context. Schema mappings can also be defined for each
enterprise domain in an Oracle Context, using the database schema mappings
tabbed window with an enterprise domain selected in the main application tree.
These mappings apply to all databases that are members of the enterprise domain.
Therefore, each database in the enterprise domain must have a schema of the same
name used in the mapping for that mapping to be effective on that database.

Figure 19-18 Oracle Enterprise Security Manager: Database Schema Mappings Tab
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To remove a mapping from the list of database schema mappings in the enterprise
domain (Figure 19-18):

1. Select a mapping from the Database Schema Mappings list.
2. Choose Remove; the selected mapping is removed from the list.

3. Choose Apply; the mapping is removed from the enterprise domain.
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To add a new mapping to the list of database schema mappings in the enterprise
domain (Figure 19-18):

1.

Choose Add...; the Add Database Schema Mappings window appears. Use this
window to locate and select a base in the directory for the new mapping, as
discussed previously.

Enter a new database schema mapping to the enterprise domain.

Choose Apply; the new database schema mapping is added to the enterprise
domain selected in the Oracle Context.

See Also:
« Managing Database Schema Mappings on page 19-32
« Defining a Directory Base on page 19-9
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Administering Enterprise Roles

An enterprise domain within an Oracle Context can contain multiple enterprise
roles. An enterprise role is a set of Oracle role-based authorizations across one or
more databases in an enterprise domain.

To create a new enterprise role:

You can create an enterprise role in an enterprise domain either from the Operations
menu on the Oracle Enterprise Security Manager main window (Figure 19-18), or
by right-clicking an enterprise domain in the main application tree. In either case,
the Create Enterprise Role window appears (Figure 19-19):

Figure 19-19 Oracle Enterprise Security Manager: Create Enterprise Role Window
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1. Choose the target Oracle Context from the Oracle Context drop-down list; this
is the Oracle Context containing the target enterprise domain—to hold the new
enterprise role.

Note: If you invoked the Create Enterprise Role window by
right-clicking an enterprise domain, the name of the Oracle Context
is already selected.

2. Select the appropriate enterprise domain for the new enterprise role, from the
Enterprise Domain list.
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Note: If you invoked the Create Enterprise Role window by
right-clicking an enterprise domain, the name of the enterprise
domain is already selected.

3. Enter the name of the new enterprise role in the Role Name field.

4. Choose OK; the new enterprise role is created in the enterprise domain, and
appears on the main application tree.

To remove an enterprise role:
1. Select the target enterprise role from the main application tree (Figure 19-18).

2. Choose Remove Enterprise Role, either from the Operations menu or by
right-clicking the enterprise domain in the main application tree.

3. Oracle Enterprise Security Manager asks you to confirm the removal of the
enterprise role; choose Yes.
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Assigning Database Global Role Membership to an Enterprise Role

Use the Database Global Roles tabbed window (Figure 19-20) of the Oracle
Enterprise Security Manager main window to manage database global role
membership in an enterprise role. This window lists the names of each global role
that belongs to the enterprise role, along with the name of the database on which
that global role exists.

Figure 19-20 Oracle Enterprise Security Manager: Database Global Roles Tab
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When populating an enterprise role with different database roles it is only possible
to reference roles on databases that are configured to be global roles on those
databases. A global role on a database is identical to a normal role, except that the
Database Administrator has defined it to be authorized only through the directory.
A Database Administrator cannot locally grant and revoke global roles to users of
the database.

To remove a database global role from an enterprise role:

1. Select a global role from the list in the main application tree, and choose
Remove...; the global role is removed from the list.
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2. Choose Apply; the global role is removed from the enterprise role in the
enterprise domain.

To add a global role to an enterprise role:

1. Choose Add... (Figure 19-20); the Add Global Database Roles window appears.
This window lists all of the databases in the enterprise domain—from which
global roles can be selected to add to an enterprise role.

2. Select a database from which to obtain global roles. A window appears and
prompts you for logon details to authenticate to the database (and fetch global
roles). Typically, this is a DBA logon to that database.

Figure 19-21 Oracle Enterprise Security Manager: Database Authentication Required
Window
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Note: The name of the database appears in the Service field by
default. You can use this name to connect to the database if your
ORACLE_HOME has LDAP enabled as its Oracle Net naming
method, or if this name appears as a TNS alias in your local Oracle
Net configuration. Otherwise, you can overwrite the content of the
Service field with any other TNS alias configured for that database,
or by a connect string in the format:

<host >: <port >: <or acl e si d>

Example: cart man: 1521: br oncos

Choose OK; Oracle Enterprise Security Manager connects you to the given
database and fetches the list of global roles supported on that database. The list
of values, if any, is displayed in the Add Global Database Roles window.

Select one or more global roles from the list of returned values and choose OK;
these global roles appear in the Database Global Roles tabbed window
(Figure 19-20).

Choose Apply; the new global roles are added to the enterprise role in the
enterprise domain.

Managing Enterprise Role Grantees

An enterprise role grantee is a directory user granted an enterprise role, including
all database global roles contained within that enterprise role. You can use the
Enterprise Users tabbed window (Figure 19-22) to manage enterprise role grantees,
when an enterprise role is selected under an enterprise domain in the main
application tree.

To remove a user from the list of enterprise role grantees (Figure 19-22):

1.
2.
3.

Select a user from the list of grantees.
Choose Remove; the selected user is removed from the list.

Choose Apply; the user is removed as a grantee for that enterprise role in the
enterprise domain.

To add a new user to the list of enterprise role grantees:
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1. Choose Add...; the Add Users window appears (Figure 19-12). Use this
window to locate and select one or more directory users to add as enterprise
role grantees. The new users appear in the Enterprise Users Page
(Figure 19-22):

Figure 19-22 Oracle Enterprise Security Manager: Enterprise Users Tab
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2. Choose Apply; the new grantees are added to the enterprise role in the
enterprise domain.

You can assign enterprise roles to this newly created enterprise user by selecting
the user and choosing the Enterprise Role tab.

See Also: Defining an Initial Enterprise Role Assignment on
page 19-13
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A

Data Encryption and Integrity Parameters

This appendix describes encryption and data integrity parameters supported by
Oracle Advanced Security. It also includes an example of a sgl net . or a file
generated by performing the network configuration described in Chapter 2,
Configuring Data Encryption and Integrity, and Chapter 7, Configuring Secure
Sockets Layer Authentication.

This appendix contains the following topics:
« Sample sqlnet.ora File

« Data Encryption and Integrity Parameters
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Sample sqlnet.ora File

This section contains a sample sqgl net . or a configuration file for a set of clients with
similar characteristics and a set of servers with similar characteristics. The file
includes examples of Oracle Advanced Security encryption and data integrity
parameters.

Trace File Setup

#Trace file setup

trace_| evel _server=16

trace | evel _client=16

trace directory server=/orant/network/trace
trace directory client=/orant/network/trace
trace file client=cli

trace_file_server=srv

trace_uni que_client=true

Oracle Advanced Security Encryption

#ASO Encrypti on

sql net. encrypti on_ser ver =accept ed

sgl net. encrypti on_cl i ent =r equest ed

sgl net . encrypti on_t ypes_server =( RC4_40)

sql net . encrypti on_types_cl i ent =( R4_40)

sql net. crypt o_seed = "-kdj e83kkep39487dvnt gEPThxxe70273"

Oracle Advanced Security Integrity

#ASO Checksum

sgl net . crypt o_checksum ser ver =r equest ed

sql net. crypt o_checksum cl i ent =r equest ed

sql net . crypt o_checksumtypes_server = (MX)
sql net . crypt o_checksumtypes_client = (MX)

SSL

#SSL

WALLET LOCATI On = ( SOURCE=
(METHD = FILE)
( METHCD DATA =

D RECTCRY=/ wal | et)
SSL_A PHER SU TES=(SSL_DH anon_ WTH R4 128 MXb)

SSLVERS O\ 3
SSL_ QLI ENT_AUTHENTI CATI ON=FALSE
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Common

#Conmon
automatic_i pc = of f
sql net . aut henti cati on_servi ces = (beq)

nanes. di rectory_path = ( TNSNAMES)

Kerberos

#Ker ber os

sql net. aut henti cati on_servi ces = (beq, kerberos5)
sgl net . aut hent i cati on_ker ber os5_servi ce = oracl e
sql net . ker ber os5_conf = / kr b5/ kr b. conf

sql net . ker ber 0s5_keyt ab= / kr b5/ v5sr vt ab

sql net . ker ber os5_r eal ns= / krb5/ krb. real m

sgl net . ker ber os5_cc_nane = /kr b5/ krb5. cc

sgl net . ker ber 0s5_cl ockskew=900

sql net . ker ber os5_conf_mt =f al se

CyberSafe

#CGyber Saf e

sql net . aut henti cati on_servi ces = (beq, cybersafe)

sgl net. aut henti cati on_gssapi _servi ce = oracl e/ cyber saf . us. oracl e. com
sgl net . aut henti cati on_ker ber os5_servi ce = oracl e

sql net . ker ber os5_conf = / kr b5/ kr b. conf

sql net . ker ber 0s5_keyt ab= / kr b5/ v5sr vt ab

sql net . ker ber os5_r eal ns= / krb5/ krb. real m

sgl net . ker ber os5_cc_nane = /kr b5/ krb5. cc

sgl net . ker ber 0s5_cl ockskew=900

RADIUS

#Radi us

sgl net . aut henti cati on_services = (beq, RADUS)

sql net . radi us_aut henti cation_tineout = (10)

sql net. radi us_aut hentication retries = (2)

sgl net. radi us_aut hentication port = (1645)

sgl net. radi us_send_accounting = GFF

sql net. radi us_secret = /orant/network/ adm n/radi us. key
sql net. radi us_aut henti cati on = radi us. us. oracl e. com
sql net . radi us_chal | enge_r esponse = CGFF

sql net . radi us_chal | enge_keyword = chal | enge

sql net. radi us_chal | enge_i nterface =

oracl e/ net/radi us/ Def aul t Radi usl nt er f ace

sql net.radi us_classpath = /jrel. 1/
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Data Encryption and Integrity Parameters

If you do not specify any values for Server Encryption, Client Encryption, Server
Checksum, or Client Checksum, the corresponding configuration parameters do not
appear in the sql net . or a file. However, Oracle Advanced Security defaults to
ACCEPTED.

For both data encryption and integrity algorithms, the server selects the first
algorithm listed in its sql net . or a file that matches an algorithm listed in the
clientsqgl net . or a file, or in the client installed list—if the client lists no algorithms
initssql net . or a file. If there are no entries in the server sqgl net . or a file, the
server sequentially searches its installed list to match an item on the client
side—either in the client sgl net . or a file or in the client installed list. If no match
can be made and one side of the connection REQUIRED the algorithm type (data encryption
or integrity), the connection fails. Otherwise, the connection succeeds with the
algorithm type inactive.

Data encryption and integrity algorithms are selected independently of each other;
encryption can be activated without integrity, and integrity can be activated
without encryption, as shown by Table A-1:

Table A—1 Algorithm Type Selection

Encryption Selected? | Integrity Selected?
Yes No
Yes Yes
No Yes
No No

There are three classes of parameters required to enable data encryption and
integrity:

« Encryption and Integrity Level Settings
« Encryption and Integrity Selected Lists

« Seeding the Random Key Generator

See Also:
«  Chapter 2, Configuring Data Encryption and Integrity
« Activating Encryption and Integrity on page 2-7
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Encryption and Integrity Level Settings

Table A-2 summarizes data encryption and integrity level settings:

Table A—2 Encryption and Integrity Level Settings

Algorithm
Type Platform | Item Description

Encryption | Server Purpose | This parameter specifies the desired encryption
behavior when a client or a server acting as a client
connects to this server. The behavior of the server
partially depends on the SQLNET.ENCRYPTION_
CLIENT setting at the other end.

Syntax | SQLNET. ENCRYPTI ON SERVER = val i d_val ue
Values | ACCEPTED, REJECTED, REQUESTED, REQUIRED
Default | ACCEPTED

Client Purpose | This parameter specifies the desired encryption
behavior when this client or server acting as a client
connects to a server. The behavior of the client partially
depends on the value set for SQLNET.ENCRYPTION_
SERVER at the other end of the connection.

Syntax | SQLNET. ENCRYPTI ON QLI ENT = val i d_val ue
Values | ACCEPTED, REJECTED, REQUESTED, REQUIRED
Default | ACCEPTED
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Table A-2 Encryption and Integrity Level Settings

Algorithm
Type Platform | Item Description
Integrity Server Purpose | This parameter specifies the desired data integrity
behavior when a client or another server acting as a
client connects to this server. The behavior partially
depends on the SQLNET.CRYPTO_CHECKSUM_
CLIENT setting at the other end.
Syntax | SQLNET. CRYPTO GHECKSUM SERVER = val i d_val ue
Values | ACCEPTED, REJECTED, REQUESTED, REQUIRED
Default | ACCEPTED
Client Purpose | This parameter specifies the desired data integrity
behavior when this client or server acting as a client
connects to a server. The behavior partially depends on
the SQLNET.CRYPTO_CHECKSUM_SERVER setting
at the other end of the connection.
Syntax | SQLNET. CRYPTO GHECKSUM (LI ENT = val i d_val ue
Values | ACCEPTED, REJECTED, REQUESTED, REQUIRED
Default | ACCEPTED

A-6 Oracle Advanced Security Administrator's Guide




Data Encryption and Integrity Parameters

Encryption and Integrity Selected Lists

Table A-3 Data Encryption and Integrity Selected Lists

Algorithm
Type Platform | Item Description
Encryption | Server Purpose | This parameter specifies a list of encryption algorithms

used by this server, in the order of intended use. This
list is used to negotiate a mutually acceptable algorithm
with the client end of the connection. Each algorithm is
checked against the list of available client algorithm
types until a match is found. If an algorithm that is not
installed is specified on this side, the connection
terminates with error message ORA-12650.

Syntax | SQLNET.ENCRYPTION_TYPES_SERVER = (valid_

encryption_algorithm [,valid_encryption_algorithm])

Values |«

RC4_256: RSA RC4 (256-bit key size).
AES256: AES (256-bit key size).
AES192: AES (192-bit key size).

3DES168: 3-key Triple-DES (168-bit effective key
size).

RC4_128: RSA RC4 (128-bit key size).
AES128: AES (128-bit key size).

3DES112: 2-key Triple-DES (112-hit effective key
size).

RC4_56: RSA RC4 (56-bit key size).
DES: Standard DES (56-bit key size).
RC4_40: RSA RC4 (40-bit key size).
DES40: DES40 (40-bit key size).

Default | If no algorithms are defined in the local sqgl net . ora

file, all installed algorithms are used in a negotiation in
the preceding sequence.
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Table A—3 Data Encryption and Integrity Selected Lists

Algorithm
Type

Platform

Iltem

Description

Encryption

Server

Usage
Notes

You can specify multiple encryption algorithms—either
a single value or a list of algorithm names. For
example, either of the following encryption parameters
is acceptable:

SQLNET.ENCRYPTION_TYPES_SERVER=(RC4_40)

SQLNET.ENCRYPTION_TYPES_SERVER=(DES,RC4_
56,RC4_128,DES40)

Client

Purpose

This parameter specifies a list of encryption algorithms
used by this client or server acting as a client. This list
is used to negotiate a mutually acceptable algorithm
with the other end of the connection. If an algorithm
that is not installed is specified on this side, the
connection terminates with error message ORA-12650.

Syntax

SQLNET. ENCRYPTI ON TYPES CLIENT = (valid_
encryption_al gorithm[,valid_encryption_
al gorithm)

Values

«  RC4_256: RSA RC4 (256-bit key size).
«  AES256: AES (256-bit key size).
«  AES192: AES (192-bit key size).

«  3DES168: 3-key Triple-DES (168-bit effective key
size).

« RC4_128: RSA RC4 (128-bit key size).
«  AES128: AES (128-bit key size).

«  3DES112: 2-key Triple-DES (112-bit effective key
size).

«  RC4_56: RSA RCA4 (56-bit key size).
« DES: Standard DES (56-bit key size).
»  RC4_40: RSA RC4 (40-bit key size).
«  DES40: DES40 (40-bit key size).

Default

If no algorithms are defined in the local sql net . ora
file, all installed algorithms are used in a negotiation.

Usage
Notes

You can specify multiple encryption algorithms—either
a single value or a list of algorithm names. For
example, either of the following encryption parameters
is acceptable:

SQNET. ENCRYPTI ON TYPES QLI ENT=( CES, DES40, R4 _
56, RCA_40)
SQNET. ENCRYPTI ON TYPES QLI ENT=( RC4_40)
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Data Encryption and Integrity Parameters

Table A—-3 Data Encryption and Integrity Selected Lists

Algorithm
Type

Platform

Iltem

Description

Integrity

Server

Purpose

This parameter specifies a list of data integrity
algorithms this server or client to another server uses,
in order of intended use. This list is used to negotiate a
mutually acceptable algorithm with the other end of
the connection. Each algorithm is checked against the
list of available client algorithm types until a match is
found. If an algorithm is specified that is not installed
on this side, the connection terminates with error
message ORA-12650.

Syntax

SQLNET. QRYPTQ CHECKSUM TYPES SERVER = (val i d_
crypto_checksumal gorithm[,valid crypto_
checksumal gorithnj)

Values

«  SHA-1: Secure Hash Algorithm
« MD5: Message Digest 5

Default

If no algorithms are defined in the local sql net . ora
file, all installed algorithms are used in a negotiation in
the preceding sequence.

Client

Purpose

This parameter specifies a list of data integrity
algorithms this client or server acting as a client uses.
This list is used to negotiate a mutually acceptable
algorithm with the other end of the connection. If an
algorithm that is not installed on this side is specified,
the connection terminates with error message
ORA-12650.

Syntax

SQNET. CRYPTO CHEQKSUM TYPES QLI ENT = (valid_
crypto_checksumal gorithm[,valid crypto_
checksum al gorithnj)

Values

«  SHA-1: Secure Hash Algorithm
« MD5: Message Digest 5

Default

If no algorithms are defined in the local sql net . ora
file, all installed algorithms are used in a negotiation.
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Seeding the Random Key Generator
SQANET. CRYPTO SEED = "10- 70 random char act er s"

The characters that form the value for this parameter are used when generating
cryptographic keys. The more random the characters entered into this field are, the
stronger the keys are. You set this parameter by entering from 10 to 70 random
characters into the preceding statement.

Note: Oracle Corporation recommends that you enter as many
characters as possible, up to 70, to make the resulting key more
random and therefore stronger.

This parameter must be present in the sql net . or a file whenever data encryption or
integrity is enabled.
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Authentication Parameters

This appendix illustrates some sample configuration files with the necessary profile
file (sql net . or a) and database initialization file (i ni t . or a) authentication
parameters, when using CyberSafe, Kerberos, RADIUS, or SSL authentication.

This appendix contains the following topics:

« Parameters for Clients and Servers using CyberSafe Authentication
« Parameters for Clients and Servers using Kerberos Authentication
« Parameters for Clients and Servers using RADIUS Authentication

« Parameters for Clients and Servers using SSL
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Parameters for Clients and Servers using CyberSafe Authentication

Following is a list of parameters to insert into the configuration files for clients and
servers using CyberSafe.

Table B-1 CyberSafe Configuration Parameters

File Name Configuration Parameters

sql net.ora SQLNET. AUTHENTI CATI ON_SERVI CES=( cyber saf e)
SQLNET. AUTHENTI CATI ON_GSSAPI _SERVI CE=

oracl e/ dbserver. someco. com@OVECO. COM

SQLNET. AUTHENTI CATI ON_KERBEROS5 _SERVI CES=or acl e
SQLNET. KERBEROS5_CONF=/ kr b5/ kr h. conf

SQLNET. KERBERCSS5_REALMS=/ kr b5/ kr b. r eal s
SQLNET. KERBERCS5_KEYTAB=/ kr b5/ v5sr vt ab

initialization parameter REMOTE_OS_AUTHENT=FALSE
file (init. ora) OS_AUTHENT_PREF X=""
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Parameters for Clients and Servers using Kerberos Authentication

Following is a list of parameters to insert into the configuration files for clients and

servers using Kerberos.

Table B—2 Kerberos Authentication Parameters

File Name

Configuration Parameters

sqgl net.ora

SQLNET. AUTHENTI CATI ON_SERVI CES=( KERBEROS5)
SQLNET. AUTHENTI CATI ON_KERBEROS5_SERVI CE=or acl e
SQLNET. KERBEROS5_CC_NAME=/ ust / t mp/ DCE- CC
SQLNET. KERBEROS5_CLOCKSKEWE1200

SQLNET. KERBEROS5_CONF=/ kr b5/ kr h. conf

SQLNET. KERBEROS5_CONF_M T=( FALSE)

SQLNET. KERBERCSS5_REALMS=/ kr b5/ kr b. r eal s
SQLNET. KERBEROS5_KEYTAB=/ kr b5/ v5sr vt ab

initialization
paraneter file
(init.ora)

REMOTE_OS_AUTHENT=FALSE
OS_AUTHENT_PREFI X=""
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Parameters for Clients and Servers using RADIUS Authentication
The following sections describe the parameters for RADIUS authentication
« sglnet.ora File Parameters
«  Minimum RADIUS Parameters

« Initialization File (init.ora) Parameters

sqlnet.ora File Parameters

SQLNET.AUTHENTICATION_SERVICES

This parameter configures the client or the server to use the RADIUS adapter.
Table B-3 describes this parameter’s attributes.

Table B-3 SQLNET.AUTHENTICATION_SERVICES Parameter Attributes

Attribute Description
Syntax SQLNET. AUTHENTI CATI ON_SERVI CES=r adi us
Default setting None

SQLNET.RADIUS_AUTHENTICATION

This parameter sets the location of the primary RADIUS server, either host name or
dotted decimal format. If the RADIUS server is on a different machine from the
Oracle server, you must specify either the host name or the IP address of that
machine. Table B-4 describes this parameter’s attributes.

Table B-4 SQLNET.RADIUS_AUTHENTICATION Parameter Attributes

Attribute Description
Syntax SQLNET. RADI US_AUTHENTI CATI ON=RADI US_server | P_address
Default setting | ocal host
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SQLNET.RADIUS_AUTHENTICATION_PORT

This parameter sets the listening port of the primary RADIUS server. Table B-5
describes this parameter’s attributes.

Table B-5 SQLNET.RADIUS_AUTHENTICATION_PORT Parameter Attributes

Attribute Description
Syntax SQLNET. RADI US_AUTHENTI CATI ON_PORT=port _nunber

Default setting 1645

SQLNET.RADIUS_AUTHENTICATION_TIMEOUT

This parameter sets the time to wait for response. Table B-6 describes this
parameter’s attributes.

Table B-6 SQLNET.RADIUS_AUTHENTICATION_TIMEOUT Parameter Attributes

Attribute Description
Syntax SQLNET. RADI US_AUTHENTI CATI ON_TI MEQUT=t i me_i n_seconds
Default setting 5

SQLNET.RADIUS_AUTHENTICATION_RETRIES

This parameter sets the number of times to re-send. Table B-7 describes this
parameter’s attributes.

Table B-7 SQLNET.RADIUS_AUTHENTICATION_RETRIES Parameter Attributes

Attribute Description

Syntax SQLNET. RADI US_AUTHENTI CATI ON_RETRI ES=n_t i nes_to_
resend

Default setting 3
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SQLNET.RADIUS_SEND_ACCOUNTING

This parameter turns accounting on and off. If you enable accounting, packets will
be sent to the active RADIUS server at the listening port plus one. By default,
packets are sent to port 1646. You need to turn this feature on only when your
RADIUS server supports accounting and you want to keep track of the number of
times the user is logging on to the system. Table B-8 describes this parameter’s
attributes.

Table B-8 SQLNET.RADIUS_SEND_ACCOUNTING Parameter Attributes

Attribute Description
Syntax SQLNET. RADI US_SEND_ACCOUNTI NG=on
Default setting of f

SQLNET.RADIUS_SECRET

This parameter specifies the file name and location of the RADIUS secret key.
Table B-9 describes this parameter’s attributes.

Table B-9 SQLNET.RADIUS_SECRET Parameter Attributes

Attribute Description
Syntax SQLNET. RADI US_SECRET=pat h_t o_RADI US_secr et _key
Default setting $ORACLE_HOVE/ net wor k/ securi ty/ radi us. key

SQLNET.RADIUS_ALTERNATE

This parameter sets the location of an alternate RADIUS server to be used in case
the primary server becomes unavailable for fault tolerance. Table B-10 describes
this parameter’s attributes.

Table B-10 SQLNET.RADIUS_ALTERNATE Parameter Attributes

Attribute Description

Syntax SQLNET. RADI US_ALTERNATE=al t er nat e_ RADI US_server _
host nanme_or _| P_addr ess

Default setting of f
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SQLNET.RADIUS_ALTERNATE_PORT

This parameter sets the listening port for the alternate RADIUS server. Table B-11
describes this parameter’s attributes.

Table B-11 SQLNET.RADIUS_ALTERNATE_PORT Parameter Attributes

Attribute Description

Syntax SQLNET. RADI US_ALTERNATE_PORT=al t er nat e_RADI US_
server _l i stening_port_numnber

Default setting 1645

SQLNET.RADIUS_ALTERNATE_TIMEOUT

This parameter sets the time to wait for response for the alternate RADIUS server.
Table B-12 describes this parameter’s attributes.

Table B-12 SQLNET.RADIUS_ALTERNATE_TIMEOUT Parameter Attributes

Attribute Description
Syntax SQLNET. RADI US_ALTERNATE_TI MEQUT=t i ne_i n_seconds
Default setting 5

SQLNET.RADIUS_ALTERNATE_RETRIES

This parameter sets the number of times that the alternate RADIUS server re-sends
messages. Table B-13 describes this parameter’s attributes.

Table B—13 SQLNET.RADIUS_ALTERNATE_RETRIES Parameter Attributes

Attribute Description
Syntax SQLNET. RADI US_ALTERNATE_RETRI ES=n_t i mes_t o_r esend
Default setting 3
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SQLNET.RADIUS_CHALLENGE_RESPONSE

This parameter turns on or turns off the challenge-response, or asynchronous, mode
support. Table B-14 describes this parameter’s attributes.

Table B-14 SQLNET.RADIUS_CHALLENGE_RESPONSE Parameter Attributes

Attribute Description
Syntax SQLNET. RADI US_CHALLENGE_RESPONSE=0n
Default setting of f

SQLNET.RADIUS_CHALLENGE_KEYWORD

This parameter sets the keyword to request a challenge from the RADIUS server.
User types no password on the client. Table B-15 describes this parameter’s
attributes.

Table B-15 SQLNET.RADIUS_CHALLENGE_KEYWORD Parameter Attributes

Attribute Description
Syntax SQLNET. RADI US_CHALLENGE_KEYWORD=keywor d
Default setting chal | enge

SQLNET.RADIUS_AUTHENTICATION_INTERFACE

This parameter sets the name of the Java class that contains the graphical user
interface when RADIUS is in the challenge-response (asynchronous) mode.
Table B-16 describes this parameter’s attributes.

Table B-16 SQLNET.RADIUS_AUTHENTICATION_INTERFACE Parameter Attributes

Attribute Description

Syntax SQLNET. RADI US_AUTHENTI CATI ON_| NTERFACE=Java_cl ass_
name

Default setting Def aul t Radi usl nt erface

(oracl e/ net/radi us/ Def aul t Radi usl nt erf ace)
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SQLNET.RADIUS_CLASSPATH

If you decide to use the challenge-response authentication mode, RADIUS presents
the user with a Java-based graphical interface requesting first a password, then
additional information—for example, a dynamic password that the user obtains
from a token card. Add the SQLNET. RADI US_CLASSPATH parameter in the

sgl net . or a file to set the path for the Java classes for that graphical interface, and
to set the path to the JDK Java libraries. Table B-17 describes this parameter’s
attributes.

Table B—17 SQLNET.RADIUS_CLASSPATH Parameter Attributes

Attribute Description
Syntax SQLNET. RADI US_CLASSPATH=pat h_t o_QGUl _Java_cl asses
Default setting $ORACLE _HOVE/ j | i b/ netradi us.jar: SORACLE _

HOVE/ JRE/ | i b/ sparc/ native_t hreads

Minimum RADIUS Parameters

sgl net. aut hentication_services = (radius)
sql net. aut hentication = | P-address- of - RADI US- server
sqgl net. radi us_chal | enge_response = ON

Initialization File (init.ora) Parameters

REMOTE_OS_AUTHENT=FALSE
OS_AUTHENT_PREFI X=""
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Parameters for Clients and Servers using SSL
There are two ways to configure a parameter:
« Static: The name of the parameter that exists in the sql net . or a file.

« Dynamic: The name of the parameter used in the security subsection of the
Oracle Net address.

SSL Authentication Parameters
This section describes the static and dynamic parameters for configuring SSL on the
server.
Parameter Name SQLNET.AUTHENTICATION_SERVICES
(static):

Parameter Name AUTHENTICATION
(dynamic):

Parameter Type:  String LIST
Parameter Class:  Static
Permitted Values: Add TCPS to the list of available authentication services.

Default Value: No default value.

Description: To control which authentication services a user wants to use.
Note: The dynamic version supports only the setting of one
type.

Existing/New

Parameter Existing

Syntax (static): SQLNET.AUTHENTICATION_SERVICES = (TCPS, selected
method_1, selected_method_2)

Example (static): SQLNET.AUTHENTICATION_SERVICES = (TCPS, cybersafe)
Syntax (dynamic): AUTHENTICATION = string
Example

(dynamic): AUTHENTICATION = (TCPS)
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Cipher Suite Parameters

This section describes the static and dynamic parameters for configuring cipher
suites.

Parameter Name  SSL_CIPHER_SUITES
(static):

Parameter Name  SSL_CIPHER_SUITES
(dynamic):

Parameter Type:  String LIST

Parameter Class:  Static

Permitted Values: Any known SSL cipher suite

Default Value: No default

Description: Controls the combination of encryption and data integrity
used by SSL.

Existing/New Existing

Parameter

Syntax (static): SSL_CIPHER_SUITES=(SSL_cipher_suitel[, SSL_cipher_suite2,

... SSL_cipher_suiteN])

Example (static):  SSL_CIPHER_SUITES=(SSL_DH_DSS_WITH_DES_CBC_

SHA)

Syntax (dynamic): SSL_CIPHER_SUITES=(SSL_cipher_suitel

[, SSL_cipher_suite2, ...SSL_cipher_suiteN])

Example SSL_CIPHER_SUITES=(SSL_DH_DSS WITH_DES_CBC_
(dynamic); SHA)

Supported SSL Cipher Suites
Oracle Advanced Security supports the following cipher suites:

SSL_RSA WITH_3DES_EDE_CBC_SHA
SSL_RSA WITH_RC4 128 SHA

SSL_RSA WITH_RC4 128 MD5

SSL_RSA_ WITH_DES_CBC_SHA
SSL_DH_anon_WITH_3DES_EDE_CBC_SHA
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. SSL_DH_anon_WITH_RC4_128_MD5
. SSL_DH_anon_WITH_DES_CBC_SHA

. SSL_RSA_EXPORT WITH_RC4 40 _MD5

. SSL_RSA_EXPORT WITH_DES40_CBC_SHA

. SSL_DH_anon_EXPORT WITH_RC4 40_MD5

. SSL_DH_anon_EXPORT WITH_DES40_CBC_SHA

SSL Version Parameters

This section describes the static and dynamic parameters for configuring the version

of SSL to be used.
Parameter Name
(static):

Parameter Name
(dynamic):

Parameter Type:
Parameter Class:
Permitted Values:
Default Value:
Description:

Existing/New
Parameter

Syntax (static):
Example (static):
Syntax (dynamic):

Example
(dynamic):

SSL_VERSION

SSL_VERSION

string

Static

Any version which is valid to SSL. (0, 3.0)
g

To force the version of the SSL connection.
New

SSL_VERSION=version
SSL_VERSION=3.0
SSL_VERSION=version
SSL_VERSION=3.0
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SSL Client Authentication Parameters
This section describes the static and dynamic parameters for configuring SSL on the

client.
Parameter Name
(static):

Parameter Name
(dynamic):

Parameter Type:
Parameter Class:
Permitted Values:
Default Value:

Description:

Existing/New
Parameter

Syntax (static):
Example (static):
Syntax (dynamic):

Example
(dynamic);

SSL_CLIENT_AUTHENTICATION

SSL_CLIENT_AUTHENTICATION

Boolean

Static
TRUE/FALSE
TRUE

To control whether a client, in addition to the server, is
authenticated using SSL.

New

SSL_CLIENT_AUTHENTICATION={TRUE | FALSE}
SSL_CLIENT_AUTHENTICATION=FALSE
SSL_CLIENT_AUTHENTICATION={TRUE | FALSE}
SSL_CLIENT_AUTHENTICATION=FALSE
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SSL X.509 Server Match Parameters

This section describes the parameters that are used to validate the identity of a
server that the client connects to.

SSL_SERVER_DN_MATCH

Parameter Name
Where stored

Purpose

Values

Default

Usage Notes

SSL_SERVER_DN_MATCH
sqgl net.ora

Use this parameter to force the server’s distinguished name
(DN) to match its service name. If you force the match
verifications, SSL ensures that the certificate is from the server.
If you choose to not enforce the match verification, SSL
performs the check but permits the connection, regardless if
there is a match. Not forcing the match lets the server potentially
fake its identity.

yes| on| t r ue—Specify to enforce a match. If the DN
matches the service name, the connection succeeds; otherwise,
the connection fails.

no| of f | f al se—Specify to not enforce a match. If the DN
does not match the service name, the connection is successful,
but an error is logged to the sql net . | og file.

Oracle8i and Oracle9i:.FALSE. SSL client (always) checks
server DN. If it does not match the service name, the
connection succeeds but an error is logged to sql net . | og
file.

Additionally configure the tnsnames.ora parameter SSL_
SERVER_CERT_DNto enable server DN matching.
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SSL_SERVER_CERT DN

Parameter Name
Where stored

Purpose

Values
Default
Usage Notes

Example

SSL_SERVER_CERT_DN

tnsnanes. or a—Can be stored on the client, for every server
it connects to, OR it can be stored in the LDAP directory, for
every server it connects to, updated centrally.

This parameter specifies the distinguished name (DN) of the
server. The client uses this information to obtain the list of
DNis it expects for each of the servers—to force the server’s
DN to match its service name.

Set equal to distinguished name (DN) of the server.
n/a

Additionally configure the sqlnet.ora parameter SSL_
SERVER DN MATCHto enable server DN matching.

dbal i as=(descri pti on=address_

i st=(address=(protocol =t cps) (host=host nane) (
port=portnum)) (connect _

dat a=(si d=Fi nance)) (security=(SSL_SERVER

DN=" CN=Fi nance, CN=COr acl eCont ext , C=US, O=Acne"))
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Wallet Location

For any application that must access a wallet for loading the security credentials
into the process space, you must specify the wallet location parameters defined by
Table B-18 in each of the following configuration files:

« sqglnet.ora

« listener.ora

Table B—-18 Wallet Location Parameters

Static Configuration Dynamic Configuration
WALLET_LOCATI ON = MY_WALLET_DI RECTORY
( SOURCE= = your_wal l et _dir

( METHOD=Fi | e)
( METHOD_DATA=

(Dl RECTORY=your wal | et
| ocati on)

)

The default wallet location is the $ORACLE_HOVE directory.
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Integrating Authentication Devices Using
RADIUS

This appendix describes how third party authentication vendors customize the
RADIUS challenge-response user interface to fit their particular device.

This appendix contains the following topics:
« About the RADIUS Challenge-Response User Interface
« Customizing the RADIUS Challenge-Response User Interface

See Also:  Chapter 4, Configuring RADIUS Authentication
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About the RADIUS Challenge-Response User Interface

You can set up any authentication device that supports the RADIUS standard to
authenticate Oracle users. When your authentication device uses the
challenge-response mode, a graphical interface prompts the user first for a
password, then for additional information—for example, a dynamic password that
the user obtains from a token card. This interface is Java-based to provide optimal
platform independence.

Third party vendors of authentication devices must customize this graphical user
interface to fit their particular device. For example, a smart card vendor customizes
the Oracle client to issue the challenge to the smart card reader. Then, when the
smart card receives a challenge, it responds by prompting the user for more
information, such as a PIN.

C-2 Oracle Advanced Security Administrator's Guide



Customizing the RADIUS Challenge-Response User Interface

Customizing the RADIUS Challenge-Response User Interface

You can customize this interface by creating your own class to support the
functionality described in Table C-1. You can then open the sql net . or a file, look
up the SQLNET.RADIUS_AUTHENTICATION_INTERFACE parameter, and
replace the name of the class listed there (Def aul t Radi usl nt er f ace), with the
name of the new class you have just created. When you make this change in the
sql net . or a file, the class is loaded on the Oracle client in order to handle the
authentication process.

The third party must implement the Oracle RADIUS Interface, which is located in
the ORACLE.NET.RADIUS package.

public interface O acl eRadi usl nterface {
public void radi usRequest ();
public void radi usChal | enge(Sring chall enge);
public String getUser Nanme();
public Sring getPassword();

}

Table C-1 Server Encryption Level Setting

Parameter Description

radiusRequest Generally, this prompts the user for a user name and password
which will later be retrieved through getUserName and
getPassword.

getUserName Extracts the user name the user enters. If this method returns

an empty string, it is assumed that the user wants to cancel the
operation. The user then receives a message indicating that the
authentication attempt failed.

getPassword Extracts the password the user enters. If getUserName returns
a valid string, but getPassword returns an empty string, the
challenge keyword is replaced as the password by the
database. If the user enters a valid password, a challenge may
or may not be returned by the RADIUS server.

radiusChallenge Presents a request sent from the RADIUS server for the user to
respond to the server’s challenge.

getResponse Extracts the response the user enters. If this method returns a
valid response, that information then populates the
User-Password attribute in the new Access-Request packet. If
an empty string is returned, the operation is aborted from both
sides by returning the corresponding value.
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Oracle Advanced Security FIPS 140-1
Settings

Oracle Advanced Security Release 8.1.6 has been validated under Federal
Information Processing Standard (FIPS) 140-1 at the Level 2 security level. This
appendix describes the formal configuration required for Oracle Advanced Security
to comply with the FIPS 140-1 standard. Refer to the NIST Cryptographic Modules
Validation list at the following Web site address:

http://csrc.nist.gov/cryptval/140-1/1401lval . htm
This appendix contains the following topics:

« Configuration Parameters

« Post Installation Checks

« Status Information

« Physical Security

Note: The information contained in this appendix should be used
with the information provided in Appendix A, Data Encryption
and Integrity Parameters.
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Configuration Parameters

This appendix contains information on the Oracle Advanced Security parameters
required in the sqgl net . or a files that ensure that any connections created between a
client and server are encrypted under the control of the server.

Configuration parameters are contained in the sql net . or a file that is held locally
for each of the client and server processes. The protection placed on these files
should be equivalent to the level of a DBA.

The following configuration parameters are described in this appendix:
« ENCRYPTION_SERVER

« ENCRYPTION_CLIENT

« ENCRYPTION_TYPES_SERVER

« CRYPTO_SEED

« CRYPTO SEED CLIENT

. FIPS_140

Server Encryption Level Setting

The server side of the negotiation notionally controls the connection settings. The
following parameter in the server file is mandatory:

SQLNET. ENCRYPTI ON_SERVER=REQU RED
Setting the encryption as REQUIRED on the server side of the connection ensures

that a connection is only permitted if encryption is used, irrespective of the
parameter value on the client.

Client Encryption Level Setting

The BENORYPTI ON QLI ENT parameter specifies the connection behavior for the client.
One of the following parameter settings in the client file is mandatory:

SQNET. ENCRYPTI ON (LI ENT=( ACCEPTED| REQUESTED| REQU RED)

A connection to the server is only possible if there is agreement between client and
server for the connection encryption. The server has this set to REQUIRED,
therefore the client must not reject encryption for a valid connection to be the result.
Failure to specify one of these values results in error when attempting to connect to
a FIPS 140-1 compliant server.
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Server Encryption Selection List

The BENORYPTI ON_TYPES SERVER parameter specifies a list of encryption algorithms that
the server is permitted to use when acting as a server in the order of required usage.
The specified algorithm must be installed or the connection terminates. For FIPS
140-1 compliance, only DES encryption is permitted and therefore the following
parameter setting is mandatory:

SQLNET. ENCRYPTI QN _TYPES SERVER=( DES| DEA0)

Client Encryption Selection List

The ENORYPTI ON _TYPES QLI ENT parameter specifies the list of encryption algorithms
which the client is prepared to use for the connection with the server. In order for a
connection to be successful, the algorithm must first be installed and the encryption
type must be mutually acceptable to the server.

To create a connection with a server that is configured for FIPS 140-1, the following
parameter setting is mandatory:

SQNET. ENCRYPTI QN TYPES QLI ENT=( DES| DEA40)

Cryptographic Seed Value

The QRYPTO SEED parameter contains characters which are part of the seed for the
random number generator. There are no explicit requirements for the value of this
parameter within the FIPS 140-1 standard, however it is suggested that a large set of
random characters, up to 70, is chosen as follows:

SQNET. RYPTO SEED=10_to_70_random char acters

FIPS Parameter

The default setting of the FI PS_140 parameter is FALSE. Setting the parameter to
TRUE is mandatory for both client and server to ensure Oracle Advanced Security
complies with the standards defined in FIPS 140-1 as follows:

SQANET. A PS_140=TRUE

Note: Use a text editor to set the FI PS 140 parameter in the
sql net . or a file. You cannot use Oracle Net Manager to set this
parameter.
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Post Installation Checks

After the installation, the following permissions must be verified in the operating
system:

«  Execute permissions must be set on all Oracle Advanced Security executable
files so as to prevent execution of Oracle Advanced Security by users who are
unauthorized to do so in accordance with the system security policy.

« Read and write permissions must be set on all executable files so as to prevent
accidental or deliberate reading or modification of Oracle Advanced Security
files by any user.

To comply with FIPS 140-1 Level 2 requirements, the security policy must include
procedures to prevent unauthorized users from reading or modifying executing
Oracle Advanced Security processes and the memory they are using in the
operating system.
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Status Information

Status information for Oracle Advanced Security is available after the connection
has been established. The information is contained in the RDBMS virtual table

v$session_connect_info.

Running the query SELECT * from V$SESSI ON_CONNECT_I NFOdisplays all of the

product banner information for the active connection. Table D-1 shows an example
of a connection configuration where both DES encryption and MD5 data integrity is
defined:

Table D-1 Sample Output from v$session_connect_info

SID AUTHENTICATION OSUSER NETWORK_SERVICE_BANNER

7

DATABASE

DATABASE

DATABASE

DATABASE

DATABASE

oracle

oracle

oracle

oracle

oracle

Oracle Bequeath operating system adapter for
Solaris, v8.1.6.0.0

Oracle Advanced Security: encryption service for
Solaris

Oracle Advanced Security: DES encryption service
adapter

Oracle Advanced Security: crypto-checksumming
service

Oracle Advanced Security: MD5
crypto-checksumming service adapter.
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Physical Security

To comply with FIPS 140-1 Level 2 requirements, tamper-evident seals must be
applied to the cover of each machine—to ensure that removal of the cover is
detectable.
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Using Enterprise User Security with

Microsoft Active Directory

This appendix describes how to configure and use Microsoft Active Directory as the
LDAP directory for Oracle Advanced Security Enterprise User Security in the
following topics:

Oracle9i Directory Server Features That Support Active Directory
Integration with Active Directory

Requirements for Using Oracle9i with Active Directory
Configuring Oracle9i To Use Active Directory

Testing Connectivity

Access Control List Management for Oracle Directory Objects

Creating Enterprise Domains
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Oracle9i Directory Server Features That Support Active Directory

Oracle9i provides two features which make use of a directory server. These features
are briefly described in the following sections:

« Directory Naming
« Enterprise User Security

Both features have been enabled to work with Microsoft’s Active Directory.

Directory Naming

This feature enables clients to connect to the database server making use of
information stored centrally in an LDAP-compliant directory server such as Active
Directory. For example, any net service name previously stored in the tnsnames.ora
file can now be stored in Active Directory.

Note: Database service and net service name entries stored in an
Oracle Names Server can be migrated to a directory server using
the Oracle Names Server Control utility. See Oracle9i Net Services
Administrator’s Guide for more information.

Enterprise User Security

This feature enables you to create and store Oracle9i database information as
directory objects in an LDAP-compliant directory server. For example, an
administrator can create and store enterprise users and roles for the Oracle9i
database in the directory, which helps centralize the administration of users and
roles across multiple databases.

This appendix assumes you are familiar with enterprise user security terms and
concepts. If any of the following terms are unfamiliar to you, then you should
review Chapter 15, "Managing Enterprise User Security" and Chapter 19, "Using
Oracle Enterprise Security Manager".

« Enterprise users, roles, domains, and related concepts

« Enterprise user security and management

« Location for enterprise user security entries in a directory server
« Installing and configuring enterprise user security

« Creating and managing enterprise users, roles, and domains
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Note: You must license Oracle Advanced Security to use Active
Directory to manage an enterprise role.

Note: Oracle Enterprise Security Manager cannot create or delete
Windows 2000, Windows NT, Windows 95, or Windows 98
operating system usernames. Instead, Oracle Enterprise Security
Manager creates a contact name in Active Directory. You cannot log
in with a contact name; it is just defined for external purposes. You
can then assign roles to this "user."
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Integration with Active Directory

In addition to directory naming and enterprise user security integration with a
directory server, the following Oracle9i features have been specifically integrated
with Active Directory:

«  Overview of Active Directory

« Automatic Discovery of Directory Servers

« Integration with Microsoft Tools

« User Interface Extensions for Oracle Net Directory Naming
« Enhancement of Directory Object Type Descriptions

« Integration with Windows Login Credentials

« Oracle Directory Objects in Active Directory

Overview of Active Directory

Active Directory is the LDAP-compliant directory server included with Windows
2000. Active Directory stores all Windows 2000 information, including users,
groups, and policies. Active Directory also stores information about network
resources (such as databases) and makes this information available to application
users and network administrators. Active Directory enables users to access network
resources with a single login. The scope of Active Directory can range from storing
all the resources of a small computer network to storing all the resources of several
wide areas networks (WANS).

When using Oracle features that support Active Directory using LDAP, ensure that
the Active Directory computer can be successfully reached using all of the TCP/IP
hostname forms possible to reach the domain controller. For example, if the
hostname of the domain controller is ser ver 1 in the domain acne. com then
ensure that you can ping that computer using all of the following:

« Serverl.acne.com
« acne.com
« Serverl

Active Directory often issues referrals back to itself in one or more of these forms,
depending upon the operation being performed. If all of the forms cannot be used
to reach the Active Directory computer, then some LDAP operations may fail.
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Automatic Discovery of Directory Servers

Oracle Net Configuration Assistant enables you to configure client computer and
Oracle9i database server access to a directory server. When Oracle Net
Configuration Assistant starts at the end of Oracle9i database installation or is
manually started after installation, it prompts you to specify a directory server type
to use. When you select Active Directory as the directory server type, Oracle Net
Configuration Assistant automatically:

« Discovers the Active Directory server location
« Configures access to the Active Directory server
« Creates the Oracle context (also known as your domain)

If the Active Directory server through which client connections are accessing an
Oracle9i database is shut down, another Active Directory server is automatically
discovered and begins providing connection information. This minimizes client
connection downtime.

Note: Regardless of the Oracle client and database releases you
are using, you must be running in a Windows 2000 domain to take
advantage of the automatic directory server discovery features of
Oracle Net Configuration Assistant. If you are not running in a
Windows 2000 domain, Oracle Net Configuration Assistant does
not automatically discover your directory server, and instead
prompts you for additional information, such as the Active
Directory location.
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When using the Oracle Net Configuration Assistant to complete directory usage
configuration against Active Directory, Oracle schema creation can fail due to
Active Directory display not being populated with all 24 default languages. Before
running the Oracle Net Configuration Assistant to complete directory access
configuration, verify that display specifiers for all 24 languages are populated by
entering the following at the command prompt:

I difde -p OneLevel -d cn=DisplaySpecifiers, cn=Configuration, domain
context -f tenp file

where:

« donai n cont ext isthe domain context for this Active Directory server. For
example dc=acne, dc=com

« tenp fileisafile where you want to put the output.

If the command reports that less than 24 entries were found, you can still use the
Oracle Net Configuration Assistant. However, it will report that Oracle schema
creation failed when all that happened was that display specifiers for some
languages were not created.

Integration with Microsoft Tools

Oracle9i database services, net service names, and enterprise role entries in Active
Directory can be displayed and tested in two Windows 2000 tools:

«  Windows Explorer
« Active Directory Users and Computers

Windows Explorer displays the hierarchical structure of files, directories, and local
and network drives on your computer. It can display and test Oracle9i database
service and net service name objects.

Active Directory Users and Computers is an administrative tool installed on
Windows servers configured as domain controllers. This tool enables you to add,
modify, delete, and organize Windows 2000 accounts and groups and publish
resources in your organization’s directory. Like Windows Explorer, it can display
and test Oracle9i database service and net service name objects. But it can also
manage access control.
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See Also:
« "Testing Connectivity from Microsoft Tools" on page E-20

«  "Access Control List Management for Oracle Directory Objects”
on page E-23

User Interface Extensions for Oracle Net Directory Naming

The property menus of Oracle9i database service and net service name objects in
Windows Explorer and Active Directory Users and Computers have been enhanced.
When you right-click these Oracle directory objects, you now see two new options
for testing connectivity:

« Test
« Connect with SQL*Plus

The Test option starts an application that tests whether the username, password,
and net service name you initially entered can actually connect to the Oracle9i
database. The Connect with SQL*Plus option starts SQL*Plus, which enables you to
perform database administration, run scripts, and so on.

See Also: "Testing Connectivity from Microsoft Tools" on
page E-20 for more information
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Enhancement of Directory Object Type Descriptions

Oracle directory object type descriptions in Active Directory have been enhanced to

make them easier to understand. In the right pane of Figure E-1, for example, the
Type column reveals that ss2 is an Oracle NetService.

Figure E-1 Directory Object Type Descriptions in Active Directory
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[+-{s3] Domain Controllers

EI%E Products
- =23 OracleDESecurity
% OracleDef aultDarmain
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Integration with Windows Login Credentials

The Oracle9i database and configuration tools can use the login credentials of the
currently logged on Windows user to connect to Active Directory automatically
(that is, without having to re-enter the login credentials). This feature has two
benefits:

« Oracle9i clients and databases can securely connect to Active Directory and
retrieve net service name, enterprise user, and enterprise role information.

« Oracle configuration tools can connect automatically to Active Directory and
configure the Oracle9i database and net service name objects. The enabled tools
include Oracle Enterprise Security Manager, Oracle Net Configuration
Assistant, and Database Configuration Assistant.

Oracle Directory Objects in Active Directory

If the Oracle9i database and Oracle Net Services are installed and configured to
access Active Directory, then Active Directory Users and Computers will display
Oracle directory objects, as illustrated in Figure E-2;

Using Enterprise User Security with Microsoft Active Directory E-9



Integration with Active Directory

Figure E-2 Oracle Directory Objects in Active Directory Users and Computers
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Table E-1 describes the Oracle directory objects appearing in Figure E-2.

Table E-1 Oracle Directory Objects

Object

Description

j cl-nt50. us. oracl e. com

O acl eCont ext

orcl

Product s

O acl eDBSecurity

O acl eDef aul t Domai n

sal es

Users

The domain in which you created your Oracle Context. This domain (also
known as the administrative context) contains various Oracle entries to support
directory naming and enterprise user security. Oracle Net Configuration
Assistant automatically discovers this information during Oracle9i database
integration with Active Directory.

The top-level Oracle entry in the Active Directory tree. It contains Oracle9i
database service and net service hame object information. All Oracle software
information is placed in this folder.

This example’s Oracle9i database service name
A folder for Oracle product information.
A folder for database security information.

The default enterprise domain created. You can create additional enterprise
domains with Oracle Enterprise Security Manager.

This example’s net service name object

The folder for the three Oracle security groups. See section "Access Control List
Management for Oracle Directory Objects” on page E-23 for more information.
Enterprise users and roles created with Oracle Enterprise Security Manager also
appear in this folder.
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Requirements for Using Oracle9i with Active Directory

If you want to use Net Directory Naming or Enterprise User Security with Active
Directory, then you must have certain Microsoft and Oracle software releases, and
you must create an Oracle Schema and an Oracle Context. These requirements are
discussed in the following sections:

Oracle Schema Creation
Oracle Context Creation
Directory Naming Software Requirements

Enterprise User Security Software Requirements

Note: The Oracle schema and Oracle Context can both be created
by running Oracle Net Configuration Assistant.

Note: Regardless of the Oracle client and Oracle database server
releases you are using, you must be running in a Windows 2000
domain to integrate Net Directory Naming and Enterprise User
Security with Active Directory.

If you are using Active Directory with Oracle on Windows 2000 or Windows NT,
then ping the DNS domain name of your Windows 2000 domain. If this does not
work, then perform either of the following tasks:

Set your Windows 2000 primary domain controller's IP address as your DNS.

For example, if your Windows 2000 domain is sal es, the DNS domain name
for this domain is sal es. acne. com The IP address is of the form
001.002.003.0.

Add the DNS domain name of your Windows 2000 domain and your domain
controller's IP address to your host s or | mhost s file.

On the Windows 2000 computer, either 001.002.003.0 can be set as the DNS, or
001.002.003.0 sal es. acne. comcan be added to the host s or | mhost s file.
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If this step is not performed, then errors such as the following are returned when
using Active Directory:

Cannot Chase Referrals

On Windows NT and Windows 2000, the Oracle database service runs in the
security context of the LocalSystem or a specific local or domain user. When using
Oracle8i release 8.1.7 with Active Directory, if the database service runs in the
security context of LocalSystem, manually add the computer name in which the
database service is running. This enables you to access control entries on the
OracleDBSecurity container object in the Active Directory with read permissions on
the OracleDBSecurity container object.

For example, if the database service Or acl eSer vi ceORCL is running in the
security context of LocalSystem in the computer mypc1, then add nmypc1 with
READ permissions ON OracleDBSecurity object to the access control entries on the
OracleDBSecurity container object.

Oracle Schema Creation

You must create an Oracle schema to use net directory naming and enterprise user
security features with Active Directory. A schema is a set of rules for Oracle Net
Services and Oracle9i database entries and their attributes stored in Active
Directory. The following restrictions apply to creating an Oracle schema to use with
Active Directory:

= You can create only one Oracle schema for each forest.
« Perform schema creation on a Windows 2000 domain controller.

«  The Windows 2000 domain controller must be the operations master that allows
schema updates. See your Windows operating system documentation for
instructions.

To create an Oracle schema:

1. Login as amember of the Schema Administrator group. Domain
administrators are in the Schema Administrator group by default.

2. Use Oracle Net Configuration Assistant to create the Oracle schema. You can
create your schema during or after database installation.
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See Also:

«  Oracle9i Net Services Administrator’s Guide for configuration
procedures

« Oracle9i Database Installation Guide for Windows for a
configuration overview

Oracle Context Creation

You must create an Oracle Context to use net directory naming and enterprise user
security features with Active Directory. Oracle Context is the top-level Oracle entry
in the Active Directory tree. It contains Oracle9i database service and Oracle Net
service name object information.

= You can create only one Oracle Context for each Windows 2000 domain
(administrative context).

= You must have the right to create domain objects in order to create the Oracle
Context in Active Directory with Oracle Net Configuration Assistant. If you are
a domain administrator, you automatically have these rights.

« Use Oracle Net Configuration Assistant to create your Oracle Context. You can
create the Oracle Context during Oracle9i Database Custom install or after
installation.

See Also:

. Oracle9i Database Installation Guide for Windows for
installation procedures

«  Oracle9i Net Services Administrator’s Guide for configuration
procedures
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Directory Naming Software Requirements

For client computers from which you want to manage Oracle9i enterprise users,
roles and domains, you must have Oracle8i Client release 8.1.6 or later and one of
the following Microsoft products:

«  Windows 2000
« Windows NT 4.0 with Active Directory Service Interfaces (ADSI)
«  Windows 95 or 98 with the Distributed Systems Client upgrade

For the database server you must have Oracle8i Database release 8.1.6 or later. This
is required for registering the database service as an object in Active Directory. The
database server can use either of the following Microsoft products:

«  Windows 2000
«  Windows NT 4.0 with ADSI

In addition to these software requirements, both the client computers and the
database server must be running in a Windows 2000 domain.

Enterprise User Security Software Requirements

For the database server you must have Oracle8i Database release 8.1.6 or later. This
is required for registering the database service as an object in Active Directory. The
database server can use either of the following Microsoft products:

«  Windows 2000
=« Windows NT 4.0 with ADSI

The remote computer must have Oracle Enterprise Manager Console release 2.1 or
later, which includes:

« Oracle Enterprise Security Manager
« Oracle Net Services
The remote computer can use either of the following Microsoft products;

=  Windows 2000
= Windows NT 4.0 with ADSI

In addition to these software requirements, both the remote computer and the
database server must be running in a Windows 2000 domain.
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Note: Oracle Enterprise Security Manager is required if you want
to create and manage enterprise users, roles, and domains. If Oracle
Enterprise Security Manager uses Native Authentication to connect
to Active Directory, the host computer should be in a Windows
2000 domain and the user should be logged into the host computer
as a Windows 2000 domain user.
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Configuring Oracle9i To Use Active Directory

Oracle9i integration with Active Directory enables you to take advantage of
operating system user authentication and role authorization. Perform the following
tasks to integrate Oracle components with Active Directory:

« Task 1: Install and Configure Components
» Task 2: Set the OSAUTH_X509 _NAME Registry Parameter

« Task 3: Start and Use Oracle Enterprise Security Manager

Note: Operating system user authentication and role
authorization are available only if you are running in a Windows
2000 domain.

Task 1: Install and Configure Components

Read "Integration with Active Directory" on page E-4, "Requirements for Using
Oracle9i with Active Directory" on page E-12, and the Oracle9i Database Installation
Guide for Windows for information on pre-installation and configuration issues.

Task 2: Set the OSAUTH_X509_NAME Registry Parameter

Set the OSAUTH_X509_NANME registry parameter to t r ue to enable client users to
access the Oracle9i database as X.509-compliant enterprise users. Active Directory
will then be used to identify the client username and authorize roles. This
parameter setting is required only if you want to use enterprise users and roles.

When the parameter is set to f al se (the default setting), the client user is identified
as an external user, and the user’s role authorization uses the Oracle9i database data
dictionary.

To set the OSAUTH_X509_ NAME registry parameter:
1. Go to the computer on which the Oracle9i database is installed.
2. Choose Start > Run.
3. Enterregedt 32 in the Open field, and click OK.
The Registry Editor window appears.
4. Goto HKEY_LOCAL_MACHI NE\ SOFTWARE\ ORACLE\ HOVEI D.

where | D is the Oracle home that you want to edit.
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5. If the registry value OSAUTH_ X509 NANME exists, double-click OSAUTH_X509
NANME.

A String Editor dialog box appears.

Otherwise, add OSAUTH_X509_NAME as a registry value of type REG_EXPAND _
SZ.

Click Enter.
Set the value to t r ue in the String field.
Click OK.

© © N o

Click Exit from the Registry menu.

The registry editor exits.

Task 3: Start and Use Oracle Enterprise Security Manager

Oracle Enterprise Security Manager is included as an integrated application with
Oracle Enterprise Manager. You can use Oracle Enterprise Security Manager to
create and manage enterprise users, roles, and domains. You can also use it to
assign enterprise users and groups to enterprise roles.

See Also: for information on using the Oracle Enterprise Security
Manager

The administrator using Oracle Enterprise Security Manager must be a member of
the security group OracleDBSecurityAdmin. By default, the administrator who
created the Oracle Context (that is, configured the Oracle9i database to work with a
directory server) is a member of this security group. Only members of this security
group are authorized to use all features of Oracle Enterprise Security Manager. To
add additional users manually, see "Access Control List Management for Oracle
Directory Objects” on page E-23.

Select Login from the Directory Server main menu to access a dialog box for
selecting the authentication protocol appropriate to your environment. Choose NT
Native Authentication if you are running an Oracle9i database on a Windows NT
4.0 or Windows 2000 computer in a Windows 2000 domain with Active Directory.
Oracle Enterprise Security Manager automatically uses Windows native
authentication if running in a Windows 2000 domain.

Choose Simple Authentication if the other available selections do not work. Simple
authentication can be used with either Oracle Internet Directory or Active
Directory, but it is less secure.
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Testing Connectivity

This section describes how to connect to an Oracle9i database through Active
Directory. This section contains these topics:

» Testing Connectivity from Client Computers

« Testing Connectivity from Microsoft Tools

Testing Connectivity from Client Computers

When using Oracle Net directory naming, client computers connect to a database by
specifying the database or net service name entry that appears in the Oracle
Context. For example, if the database entry under the Oracle Context in Active
Directory is or cl , and the client and Oracle9i database are in the same domain,
then a user connects to the database through SQL*Plus by entering the following
connect string:

SQL> CONNECT scott/tiger@rcl

If the client and Oracle9i database are in different domains, a user connects to the
database through SQL*Plus by entering:

SQL> CONNECT scott/tiger@rcl.domain

where domai n is the domain in which the Oracle9i database is located.

These connect strings follow DNS-style conventions. While Active Directory also
supports connections using X.500 naming conventions, Oracle recommends
DNS-style conventions because they are easier to use.

DNS-style conventions enable client users to access an Oracle9i database through a
directory server by entering minimal connection information, even when the client
computer and Oracle9i database are in separate domains. Names following the
X.500 convention are longer, especially when the client and Oracle9i database are
located in different domains (also known as administrative contexts).

See Also: "Configuration Management Concepts" in the Oracle9i

Net Services Administrator’s Guide for more information about X.500
naming conventions

Using Enterprise User Security with Microsoft Active Directory E-19



Testing Connectivity

Testing Connectivity from Microsoft Tools
Oracle directory objects in Active Directory are integrated with two Microsoft tools:

«  Windows Explorer
« Active Directory Users and Computers
You can perform the following tasks from within these Microsoft tools:
« Connect with SQL*Plus to an Oracle9i database
« Test Oracle9i database connectivity
To test connectivity:
1. Start Windows Explorer or Active Directory Users and Computers.
To start Windows Explorer:
a. Choose Start > Programs > Accessories > Windows Explorer
b. Expand My Network Places
c. Expand Entire Network
d. Expand Directory
To start Active Directory Users and Computers:

Choose Start > Programs > Administrative Tools > Active Directory Users and
Computers

Note: All clients accessing an Oracle9i database through Active
Directory require read access on all net service name objects in the
Oracle Context and must be able to authenticate anonymously with
Active Directory. Oracle Net Configuration Assistant automatically
sets this up.

2. Expand the domain in which your Oracle Context is located.
3. Expand your Oracle Context.
4. Right-click a database service or Oracle Net Service hame object.

A menu appears with several options. The two that concern us here are Test and
Connect with SQL*Plus:
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5.
choose Test.

If you want to test the database connection without actually connecting to it,

A status message appears describing the status of your connection attempt:
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&Dracle Met Connectivity Teskting ﬂ
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6. If you want to test the database connection by connecting to it, choose Connect
with SQL*Plus.

The Oracle SQL*Plus Login dialog appears:

&Dracle SQL*Plus Logon

[x

Uzer Mame IS,:,:,H

Paszword I’“‘"""

Ok I Cancel

7. Enter your username and password.

A status message appears describing the status of your connection attempt.
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Access Control List Management for Oracle Directory Objects
Access Control Lists provide Active Directory security by specifying:
« The user that can access the object attributes in the object
« Authentication method to access the entry

« Access rights, or what the user can do with the object (read/write) attributes in
the object

Security Groups

Three security groups are automatically created when the Oracle Context is created
in Active Directory. The user configuring access (and thus creating the Oracle
Context) is automatically added to each group. The groups are:

« OracleDBSecurityAdmin
« OracleDBCreator
« OracleNetAdmins

OracleDBSecurityAdmin

The OracleDBSecurityAdmin group is for the creator of the Oracle Context. Users in
this group can also:

« Manage the group membership for all three security groups
« Manage any object in the Oracle Context

« Use Oracle Enterprise Security Manager to create enterprise domains

OracleDBCreator

The OracleDBCreator group is for the creator of the Oracle9i database. The domain
administrator is automatically a member of this group.Users in this group can:

« Create new Oracle9i database objects in the Oracle Context
« Modify the Oracle9i database objects that they create
« Read, but not modify, the membership for this group
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OracleNetAdmins
Users in the OracleNetAdmins group can:

« Create, modify, and read Oracle Net Services objects and attributes

« Read the group membership of this group

Accessing the Security Groups

You can add or remove users or change permission settings in all three security
groups with Active Directory Users and Computers. You can also use Oracle
Enterprise Security Manager with OracleDBSecurityAdmin and OracleDBCreator
but not with OracleNetAdmins.

This section describes how to use Active Directory Users and Computers.

Note: Use Active Directory Users and Computers to perform the
procedures described in this section. Windows Explorer does not
provide the necessary functionality.

To add or remove users or change permission settings:

1. Choose Start > Programs > Administrative Tools > Active Directory Users and
Computers.

2. Choose Advanced Features from the View main menu.
This enables you to view and edit information that is normally hidden.

3. Expand the domain (administrative context) in which your Oracle Context is
located.

4. Expand Users.

The three security groups appear in the right window pane:
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5. Right-click the Oracle security group that you want to view or modify.

A menu appears with several options.

6. Choose Properties.

7. If you want to change permissions, skip to step 13.

If you want to add or remove users, proceed to step 8.

8. Choose the Members tab.

The Properties dialog for the group you selected appears (in this example,
OracleDBSecurityAdmins):
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9. To add users, choose Add.
The Select Users, Contacts, Computers, or Groups dialog appears.
10. Select the users or groups you want to add and choose Add.

Your selections appear in the Select Users, Contacts, Computers, or Groups
dialog.

11. To remove a user, select the user name from the Members list and choose
Remove.

12. When you are finished adding and removing users, choose OK.
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13. To change user permissions, choose the Security tab of the Properties dialog.
14. Choose Advanced.
15. Choose View/Edit.

The Permission Entry dialog for the security group you selected appears:
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16. Make your desired changes to group permissions.

17. Choose OK.
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Creating Enterprise Domains

A default enterprise domain, OracleDefaultDomain, is created in your Oracle
Context. If you do not want to use this domain or if you want to create another
domain, then use Oracle Enterprise Security Manager to create additional enterprise
domains. These domains are added under the OracleDBSecurity folder.
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Oracle Implementation of Java SSL

This appendix describes the Oracle implementation of Java Secure Socket Extension
(JSSE), in the following sections:

« Prerequisites

« Oracle Java SSL Features

« Oracle Java SSL Examples

« Troubleshooting Oracle Java SSL

« Oracle Java SSL API

Note: This appendix assumes that you are familiar with the basic
principles of Java socket programming and the SSL protocol.

See Also: Java documentation from Sun Microsystems, Inc., for
further information about Java SSL packages located at:

http://java. sun. conf products/jsse
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Prerequisites

To use the Oracle Java SSL implementation, perform the following tasks:

ssl.
ssl.

Install JDK version 1.1 or later

Ensure that the CLASSPATH environment variable includes the following jar
files:

— ForJDK1.1: javax-ssl-1_1.jar, jssl-1_1.jar
— ForJDK1.2or later: javax-ssl-1_2.jar, jssl-1_2.jar

Add the Oracle Java SSL shared library to the shared library path for your
platform:

— ForUNIX: i bnj ssl 9. so must be included in the library path specified
by the LD _LI BRARY_PATHenvironment variable.

— For Windows: nj ssl 9. dl | must be included in the path specified by the
PATH environment variable.

If JSSE version 1.0.2 is in your CLASSPATH, thenusej ssl -1 1.jar and set
the ssl . Socket Fact ory. provi der and the ssl . Ser ver Socket Fact ory
Java security properties as follows:

Socket Fact ory. provi der =oracl e. securi ty. ssl. O acl eSSLSocket Fact oryl npl
Server Socket Fact ory. provi der =or acl e. security.ssl. O acl eSSLSer ver Socket Fact oryl npl

Ifj sse.jar orjcert.jar areinstalled in the Java extensions folder, then
jssl-1 1.jar mustalso be installed in the extensions folder.

See Also: Your operating system-specific documentation
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Oracle Java SSL Features

Oracle Java SSL is a commercial-grade implementation of Java Secure Socket
Extension (JSSE). In order to create a secure, fast implementation of SSL, Oracle Java
SSL uses native code to improve the performance.

In addition to the functionality included in the JSSE specifications, Oracle Java SSL
supports the following:

«  Multiple cryptographic algorithms
« Certificate and key management by using Oracle Wallet Manager

«  SSL session capabilities, including authentication, that can be used by
applications built on top of Oracle Java SSL

Oracle Java SSL features are described in further detail in the following sections:
« SSL Cipher Suites Supported by Oracle Java SSL
« Certificate and Key Management with Oracle Wallet Manager

«  Security-Aware Applications Support
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SSL Cipher Suites Supported by Oracle Java SSL

Before data can flow through an SSL connection, both sides of the connection must
negotiate common algorithms to be used for data transmission. A set of such
algorithms combined to provide a mix of security features is called a cipher suite.
Selecting a particular cipher suite lets the participants in an SSL connection
establish the appropriate level for their communications.

Oracle Java SSL supports cipher suites with the following options:

« Key exchange of 512, 768, or 1024 bit asymmetric keys that uses the following
algorithms:

- RSA
— Diffie-Hellman

« NULL encryption, or symmetric key encryption with 40 and 128 bit symmetric
keys that uses the following algorithms:

— RC4 stream cipher
— DES, DES40, and 3DES-EDE, in Cipher Block Chaining (CBC) mode

Note: With NULL encryption, SSL is only used for authentication
and data integrity purposes.

« Message Authentication Code that uses MD5 or SHA1 data integrity
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Certificate and Key Management with Oracle Wallet Manager

You can use Oracle Wallet Manager to generate a public/private key pair and a
certificate request. A signed certificate request and the appropriate trusted
certificates must be added to produce a complete Oracle wallet.

You can export a complete wallet with a certificate in Ready status, in a
BASE64-formatted file, by choosing Operation > ExportWallet from the Oracle
Wallet Manager menu. This file can be used to add SSL credentials in a Java
SSL-based program.

If you are not using Oracle Wallet Manager, then you can manually add individual
components to a file:

« Add the certificate first, followed by the private key.

« Add the certificate authority certificate and other trusted certificates
subsequently:.

See Also:

= "Public Class: OracleSSLCredential" on page F-19 for
information about setting the credentials in Java SSL

« Chapter 17, "Using Oracle Wallet Manager"

Security-Aware Applications Support

Some security-aware applications do not set trust points. In order to let these
applications perform their own validation, Oracle Java SSL lets handshakes
complete if no security credentials are set and a complete certificate chain is sent by
the peer. This feature is useful when there is a large number of trust points stored in
a database, and the application is constrained from passing all of them to the SSL
layer.

Once the handshake is complete, it is possible to obtain the peer certificate chain
and extract individual peer certificates. These certificates can be used for
application-specific validation, such as matching the certificate’s distinguished
name (DN) against a user database.

Security-unaware applications that need the trust point check must ensure that trust
points are set in the application.

See Also: "Public Class: OracleSSLCredential" on page F-19 for
more information about checking peer credentials
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Oracle Java SSL Examples

The examples in this section illustrate the use of Oracle Java SSL. For purposes of
the examples, we created a model server and client named SSLSer ver Exanpl e
and SSLCl i ent Exanpl e, respectively. Together, they demonstrate some common
features of Oracle Java SSL, as well as the basics of socket communication. In
addition, SSLPr oxyd i ent Exanpl e demonstrates one of the possible ways to
implement firewall tunnelling connections.

The complete code for each program is presented, and some of its more important
sections are discussed.

Note: This example does not cover every feature that is available
in Oracle Java SSL.

Oracle Java SSL examples are described in the following sections:
« Example: SSLServerExample Program
« Example: SSLClientExample Program

« Example: SSLProxyClientExample Program

See Also:

« Later sections of this appendix for detailed information about
different security options that are available with this package.

« "Public Class: OracleSSLServerSocketFactorylmpl" on
page F-22 for general information about socket programming.

« Java documentation for the j ava. net package, for
information about sockets and socket streams.
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Example: SSLServerExample Program

SSLSer ver Exanpl e is a simple SSL server. It uses a wallet exported from Oracle
Wallet Manager to set up its security credentials. When the server is started it waits
for a client to initiate a connection. After the SSL handshake is complete, the server
sends a short message to the client and closes the connection.

The program contains the following code:

inport oracle.security.ssl.*;
inport java.net.*;

inport java.io.*;

inport java.util.*;

inport javax.net.*;

inport javax.net.ssl.?*;

public class SSL.Server Exanpl e

{
private Q acl eSSLServer Socket Fact oryl npl _socket Fact ory;
private Qacl eSSL.Qedential _credential ;
private SSLServer Socket _svrSoc;

private void initGedential (Sring wtPath, Sring password)
throws java.io. | CException

{
_credential = new Qacl eSSLQ edential ();
_credential .setVdl | et (wtPath, password);

}

private void initSocket Factory()
throws javax. net.ssl.SS Exception

{
_socket Fact ory
= (O acl eSSLSer ver Socket Fact or y) SSLSer ver Socket Fact ory. get Defaul t () ;
_socket Fact ory. set SSLPr ot ocol Ver si on(
Q acl eSSLProt ocol Version. SSL_Version 3 0 Wth 2 0 Hello);
_socket Fact ory. set SSLOredent i al s(_credential);
}

private voi d initServerSocket (int port)
throws java.io. | CException
{
_svrSoc = (SSLServer Socket) _socket Fact ory. cr eat eSer ver Socket (port);
_svrSoc. set Used i ent Mbde(f al se) ;
_svrSoc. set Needd i ent Aut h(f al se);
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_svr Soc. set Enabl edd pher Sui tes(new String[]{"SSL_RSA WTH R4 128 SHA',
"SSL_RSA WTH RA_128 MX%"});
}

public SSLServerExanpl e(String wtPath, String password, int port)
throws java.io. | CException, javax.net.ssl.SS.Exception

{
initQedential (wWtPath, password);
i ni t Socket Factory();
i ni t Server Socket (port);
}
public void runServer ()
{
Sring nessage = "Hello! Qurrent Server Tine is " + newDate() + "\n";
Socket csocket = null;
Qutput SreanWiter out = null;
try
{
csocket = _svrSoc. accept();
out = new Qut put S reanWit er (csocket . get Qut put Sreant));
out.wite(nessage);
Systemout . println("Gonnection Succeeded");
}
cat ch(1 CException €)
{
Systemout . println("CGonnection Failed");
e. printStackTrace();
}
finally
{
try
{
if(out '=null)
out.close();
i f(csocket = null)
csocket . cl ose();
_svrSoc. cl ose();
}
cat ch(1 Cexception e){}
}
}

public static void nmain(String[] argv)

{
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System get Properties() . put (" SSLSer ver Socket Fact oryl npl d ass",
"oracl e.security.ssl.Qacl eSSLSer ver Socket Fact oryl npl ") ;

try
{
SSLSer ver Exanpl e nyServer = new SSLServer Exanpl e("nywal | et . txt",
"wel conel", 19978);
nySer ver . runServer () ;
}
cat ch(|1 Cexception i)
{
Systemout. printIn("Failied to start up server");
i.printSackTrace();
}

Initializing the Credentials

SSLSer ver Exanpl e uses a wallet created by Oracle Wallet Manager, so the job of
setting up the credential object is quite easy. To read the wallet located at
(W tPath), initQedential () calls

_credential = new Qacl eSSLO edential ();
_credential.setVéllet(wtPath, password);

The private key, user certificate, certificate and trust points located in the wallet are
used in the connection. An IOException is returned if an error occurs while
accessing the wallet.

If you do not elect to use the wallet, then you can install the necessary security
credentials manually.

See Also: "Public Class: OracleSSLCredential” on page F-19 for
more information about addTr ust edCert (), addCert Chai n(),
and set Pri vat eKey()

Oracle Implementation of Java SSL  F-9



Oracle Java SSL Examples

Initializing the Socket Factory

To create SSL sockets, you must access the proper socket factory. For Oracle Java
SSL,oracl e. security.ssl.O acl eSSLSocket Fact oryl nmpl is the name of
the class that implements j avax. net . Ser ver Socket Fact ory. In orderto
make sure it is accessed correctly, set up the system properties in the mai n()
function by using the following settings:

Systemget Properti es(). put (" SSLSer ver Socket Fact oryl npl d ass", "oracl e. security. ss
| . O acl eSSLSer ver Socket Fact oryl npl ") ;

Once the system properties are set, you can obtain an instance of the socket factory
and customize it. Ini ni t Socket Fact or y(), specify the SSL protocol that the
sockets created by this factory are to support, and install the security credentials to
be used by all sockets created by this factory.

Initializing Server Socket

The method i ni t Ser ver Socket () uses the socket factory to create a new server
socket that listens in server mode on the specified port:

_svrSoc = (SSLServer Socket) _socket Fact ory. cr eat eSer ver Socket (port);
_svrSoc. set Used i ent Mbde(f al se) ;

Once the socket is created, you can change some of its attributes by modifying the
following properties:

_svrSoc. set Needd i ent Aut h(f al se);
_svr Soc. set Enabl edd pher Sui tes(new Sring[]{"SSL_RSA WTH RG4_128 SHAT
"SSL RSA WTH RA_128 MX%"});

For this example, the clients are not required to authenticate themselves to the
server. However, instead of using the default enabled cipher suites, only clients that
support RSA W TH_RC4_128_SHAor SSL_RSA W TH_RC4_128_ND5 cipher
suites are allowed to connect.

Use Or acl eSSLSer ver Socket Fact ory. get Support edC pher Suites() to
determine which cipher suites are supported by Java SSL.
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See Also:
« "SSL Cipher Suites Supported by Oracle Java SSL" on page F-4

« "Public Class: OracleSSLServerSocketFactorylmpl" on
page F-22

Waiting for the Connection and Sending Data

SSLSer ver Exanpl e waits until the client connects to the server. The method
accept () blocks until a connection is established. Once the client connects, the
output stream for the socket is obtained by calling get Qut put St r ean() . This
output stream is used to send information to the client. When the server has no
more data to send to the client, the server closes the corresponding output stream
and socket. To stop accepting connections, the server must close the corresponding
server socket. The server closes the socket when it cannot accept any further
connections.

See Also: Java documentation about the j ava. net package, for
information about sockets and socket streams.

Example: SSLClientExample Program

The SSLA i ent Exanpl e is a simple program used to connect to the

SSLSer ver Exanpl e program by using JDK, version 1.1. The initialization of the
SSLA i ent Exanpl e is very similar to that of the server. However, certain
differences are included in this example to demonstrate some of the features of
Oracle Java SSL. The explanations focus on these differences whenever appropriate.
The example program contains the following code:

inport oracle.security.ssl.*;
inport java.net.*;

inport java.io.*;

inport java.util.*;

inport javax.net.*;

inport javax.net.ssl.?*;
inport javax.security.cert.*;

public class SSLA i ent Exanpl e

{
protected O acl eSSL.Socket Fact oryl npl _socket Fact ory;

private Qacl eSS edential _credential ;
protected SS.Socket _socket;

private void initGedential (Sring wtPath, String password)
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throws java.io. | CException

_credential = new Qacl eSSLO edential ();
_credential.setVdllet(wtPath, password);

}

private voi d initSocket Factory()
throws javax. net.ssl.SS_Exception

{
_socket Fact ory
= (O acl eSSLSocket Fact or yl npl ) SSLSocket Fact ory. get Defaul t () ;
_socket Fact ory. set SSLPr ot ocol Ver si on(
Q acl eSSLProt ocol Version. SSL_Version_3 0);
_socket Fact ory. set SSLOredent i al s(_credential );
}

private void initSocket (String host, int port)
throws java.io. | CException

{
_socket = (SSLSocket)_socket Fact ory. cr eat eSocket (host, port);
_socket . set Used i ent Mbde(true);

}

public SSLAientExanple(Sring wtPath, Sring pass, Sring host, int port)
throws java.io. | CException, javax.net.ssl.SS Exception

{ initQedential (wtPath, pass);
i ni t Socket Factory();
i ni t Socket (host, port);
}
publ i ¢ voi d connect Socket ()
{
try
{
_socket . st art Handshake() ;
getData();
E:at ch(1 CException e)
{

Systemout . println("Connection Failed");
e. printStackTrace();

}
finally

{
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try
{
_socket . cl ose();
}
cat ch(| Cexception e){}
}
}
public void getData()
{
I nput SreankReader in = null;
try
{

int ch;
SSLSessi on sessi on = _socket . get Session() ;

Systemout. println("Negotiated d pher Suite " +
session. get d pherSuite());
X509Certificate[] peerCerts = session. getPeerCertificateChain();
for(int i =0; i < peerCerts.length; i++)
{

}

Systemout . printl n("Server Response:");

in = new | nput &t r eanReader (_socket . get | nput Sreanf));
ch = in.read();

while((char)ch !I'="\n")

Systemout . println(peerCerts[i]);

if(ch!=-1)
Systemout . print ((char)ch);
ch=in.read();

}
Systemout. println();
}
cat ch(| CException e)
{
Systemout . println("Connection Failed");
e. print StackTrace();
}
finally
{
try
{

if(in!=null)
in.close();
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}
cat ch(| Cexception e){}
}
}
public static void main(String[] argv)
{
System get Properti es() . put (" SSLSocket Fact oryl npl A ass",
"oracl e. security. ssl. QO acl eSSLSocket Fact oryl npl ") ;
try
{
SSLd i ent Exanpl e nydient = new
SSLd i ent Exanpl e("nywal | et. txt", "wel conel", "l ocal host", 19978);
nyd i ent . connect Socket () ;
}
cat ch(1 CException i)
{
Systemout.printin("Failied to start up client");
i.printSackTrace();
}
}

Note: If you use JDK, version 1.2, then change i nport
javax.security.cert.*; toinport java. security.cert.*;

Initializing the Credentials

The client initializes the credentials in the same way as the server. For purposes of
the example, the client and the server use the same wallet. However, in production
applications, the client and the server must have different security credentials. In
order for an SSL connection to complete successfully it is important that the proper
trusted certificates are present in the wallets.

See Also: Chapter 17, "Using Oracle Wallet Manager", for more
information about trusted certificates
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Initializing the Socket Factory

The socket factory class used to create client sockets is similar to the one used by the
server. As with the SSLSer ver Exanpl e program, it is necessary to set the system
properties to obtain the correct socket factory before configuring it in

i ni t Socket Fact ory() . The correct socket factory is set in mai n() by using the
following syntax:

System get Properties(). put (" SSLSocket Fact oryl npl Q ass",
"oracl e.security.ssl.Qacl eSSLSocket Fact oryl npl ");

Initializing and Connecting the Client Socket

Client sockets are created by the socket factory just as server sockets are created by
the server socket factory. However, to connect the client socket to a specific server,
you must supply the server’s name and the port number at creation. In addition,
ensure that the socket connects in client mode by specifying the following settings:

_socket = (SSLSocket)_socket Fact ory. cr eat eSocket (host, port);
_socket . set Used i ent Mbde(t rue);

After the socket is created, it can connect to the server using:
_socket . st art Handshake() ;

Viewing Peer Credentials

After the socket connects to the server, information about the connection can be
accessed. The information is stored in the Or acl eSSLSessi on class, an instance of
which can be obtained by using _socket . get Sessi on().

In this example, the cipher suite negotiated between the client and the server as
well as the security credentials of the server is printed. This information can be used
by security-aware applications to determine whether it should trust the connection.
For example, most browsers check to confirm that the common name in the server
certificate matches the URL that was accessed, and they display a warning if it does
not. However, this check is not required by the SSL protocol.
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Receiving Data

Receiving and sending data through an SSL socket is no different than receiving
data through any other socket. In this example, the socket's input stream is accessed
and read until an end-of-line character occurs.

See Also: Java documentation about their j ava. net package for
information about sockets and socket streams.

Example: SSLProxyClientExample Program

This example uses firewall tunneling to establish a secure connection to the server.
Note that this program may not work for all firewalls. For example, some firewalls
do not permit a connection to non-standard ports, such as port 19978 that is used
here. In this case you have to set up a secure server on port 443 and modify the
client appropriately.

inport oracle.security.ssl.*;
inport java.net.*;

inport java.io.*;

inport java.util.*;

inport javax.net.*;

inport javax.net.ssl.*;
inport javax.security.cert.*;

public class SSLProxyd i ent Exanpl e extends SSLA i ent Exanpl e

{
private Sring _proxyNane;

private int _proxyPort;

protected void initSocket (String host, int port)
throws java.io. | CException

{
final Sring connSring = "CONNECT* + host + ":" + port +
" HITP/ 1.0 \n" + "Wser-Agent: Qacle Proxy Enabl ed SSL Socket\n\n";
Socket nor mal Socket = new Socket (_proxyNanme, _proxyPort);
Qut put S reanWiter out
= new Qut put StreanWi t er (nor nal Socket . get Qut put Streant) ) ;
out.wite(conn&ring, 0, conn&ring.length());
_socket = (SSLSocket)_socket Fact ory. creat eSocket (nor mal Socket ) ;
}

public SSLProxyQ i ent Exanpl e(Sring wtPath, String password, Sring host,
int port, Sring proxyNane, int proxyPort)
throws java.io. | CException, javax.net.ssl.SS Exception
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{
super (w tPath, password, host, port);
_proxyName = proxyNane;
_proxyPort = proxyPort;
}
public static void nmain(String[] argv)
{
System get Properti es(). put (" SSLSocket Fact oryl npl Q ass",
"oracl e. security. ssl. O acl eSSLSocket Factory");
try{
SSLd i ent Exanpl e nyd i ent
= new S Proxyd i ent Exanpl e("nywal l et.txt", "wel conel”,
"l ocal host", 19978, "waw proxy”, 80);
nyd i ent . connect Socket () ;
}
cat ch(| CException i)
{
Systemout. printin("Failed to start up client");
i.printSackTrace();
}
}

Note: If you use JDK, version 1.2, then change i nport
javax.security.cert.*; toinport java. security.cert.*;

Initializing and Connecting the Client Socket

The only significant difference between SSLPr oxyCl i ent Exanpl e and its
superclass, SSLO i ent Exanpl e, lies in the method i ni t Socket (). Tosetup a
tunnelling connection, it is necessary to create a plain socket. This socket is used to
send a special message, connSt ri ng, to the firewall, by setting up the connection
to the actual server. Once this connection is set up, use the plain socket to initialize
an SSL Socket by using the following syntax:

_socket Fact ory. cr eat eSocket ( nor nal Socket )
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Troubleshooting Oracle Java SSL
This section describes some typical Java SSL errors.

SSLException X509CertExpiredErr

During the handshake the program fails with an SSLExcept i on and returns the mes-
sage X509Cer t Expi r edEr r. The program worked previously and no changes were
made.

Cause: Your user certificate has expired.
Action: You must obtain a new user certificate.

See Also: Chapter 17"Using Oracle Wallet Manager"

SSLException X509CertChainlnvalidErr
The handshake fails on the client side with SSLExcept i on and returns the message
X509Cer t Chai nl nval i dEr r. A Web browser can connect to the server success-
fully.
Cause: Either your server or your client does not have the proper credentials.

Action: If the client program sets trusted certificates, then you must ensure that
the list includes at least one of the certificates in the server’s certificate chain. In
addition, you must ensure that the server sends the complete certificate chain to
the client because Oracle Java SSL cannot build the certificate chain itself. If you
are using an Apache server, then you must set the variables SSLCer ti fi cat -
eChai nFi |l eand SSLCer ti fi cat eFi | e correctly. This is especially impor-
tant if the client program does not set trusted certificates.

See Also: Your Web server documentation for more information

Client Connection with No Credentials

The handshake succeeds even though no Or acl eSSLCr edent i al s are set in the cli-
ent program.

Cause: To enable security-aware applications to perform their own validation,
Oracle Java SSL permits a connection if no credentials are set by the client, but
only if the server sends a complete certificate chain.

Action: To avoid this behavior, you must set at least one trusted certificate in
your application.

See Also: "Public Class: OracleSSLCredential” on page F-19
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Oracle Java SSL API

This section describes the public classes and interfaces used in Oracle Java SSL.
Since Oracle Java SSL is an implementation of JSSE, only the Oracle additions to the
JSSE package are described.

This section describes the following Oracle Java SSL classes and interfaces:

Public Class: OracleSSLCredential

Public Interface: OracleSSLProtocolVersion
Public Class: OracleSSLServerSocketFactorylmpl
Public Class: OracleSSLSession

Public Class: OracleSSLSocketFactorylmpl

Public Interface: OracleX509TrustManagerinterface

See Also:
A description of JSSE classes located at:

http://java. sun. con products/jsse/ doc/ api doc/i ndex. ht m

Public Class: OracleSSLCredential

This public class extends j ava. | ang. Qbj ect .

Credentials are used to authenticate the server and the client to each other. The
Oracl eSSLCr edent i al class is used to load user certificates, trusted certificates
(trust points), and private keys from Base64 or der encoded certificates.

Constructor
public Oracl eSSLCredential ()

Creates an empty Or acl eSSCr edent i al credential. An empty credential lets
the socket connect to any peer that sends a complete certificate chain during the

handshake.
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Methods
public void addTrustedCert(java.lang.String b64TrustedCert)
Adds a trusted certificate to the credential

Parameters: b64Tr ust edCer t - A Base64 encoded X.509 certificate.

public void addTrustedCert (byte[] trustedCert)

Adds a trusted certificate to the credential

Parameters: t rust edCert - A der encoded X.509 trusted certificate.

public void setPrivateKey(java.lang.String b64PvtKey, j ava. | ang. String password)

Adds a private key to the credential.
Parameters: b64Pvt Key - A Base64 encoded X.509 private key

passwor d - The password needed to decipher the private key

public void setPrivateKey(byte[] pvtKey, java.lang.String password)

Adds a private key to the credential.
Parameters: b64Pvt Key - A der encoded X.509 private key

passwor d - The password needed to decipher the private key

public void addCert Chain(java.lang. String b64cert Chai nCert)

Adds a certificate to the certificate chain. The certificate chain is sent along with
the user certificate during the SSL handshake. It is used by the peer to verify the
user certificate. The first certificate added to the certificate chain must be the
Root CA certificate. Each subsequent certificate added must be signed by its
immediate predecessor.

Parameters: b64cer t Chai nCert - A Base64 encoded X.509 certificate
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public void addCert Chai n(byte[] certChainCert)

Adds a certificate to the certificate chain.

Parameters: cer t Chai nCert - A der encoded X.509 certificate

public void setVallet(java.lang. String wtPath, java.lang.String password)
throws java.io. | OException

If Oracle Wallet Manager is used to create a wallet, the wallet can be exported in
text format and used by Oracle Java SSL. The text file must contain the user
certificate, followed by the private key, the certificate chain, and any other
trusted certificates. The method throws a j ava. i 0. | OExcept i on if the wallet
cannot be opened.

Parameters: W t Pat h - The path name of the wallet

passwor d - The password needed to decrypt the private key

Public Interface: OracleSSLProtocolVersion
This interface defines the available SSL protocol versions.

Fields

public static final int SSL_Version_Undeterm ned

SSL protocol version undetermined

public static final int SSL_Version_3 0 Wth_2 0 Hello

SSL protocol version 3.0 with 2.0 hello

public static final int SSL_Version_3 0 _Only

SSL protocol version 3.0 only

public static final int SSL_Version_2_0

SSL protocol version 2.0
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public static final int SSL_Version_3 0

SSL protocol version 3.0

Public Class: OracleSSLServerSocketFactorylmpl

This public class extends j avax. net . ssl . SSLSer ver Socket Fact ory. Itis used
to create SSL server sockets.

This class implements j avax. net . ssl . SSLSer ver Socket Fact or y methods
that are needed to create server sockets. In addition, it provides extra methods that
are necessary to configure options specific to Oracle Java SSL.

Constructor
public Oracl eSSLServer Socket Factoryl npl ()

Creates a socket factory that may be used to create sockets. However, setting the
system property SSLSer ver Socket Fact oryl npl Cl ass to

oracl e. security.ssl O acl eSSLSer ver Socket Fact oryl npl is the
preferred method for creating socket factories. For example:

System get Properties(). put (" SSLServer Socket Fact oryl npl O ass",
"oracl e.security.ssl.Oacl eSSLServer Socket Fact oryl npl ") ;
SSLServer Socket Factory factory = Oracl eSSLSer ver Socket Fact oryl npl . get Defaul t ();

Methods

public void set SSLCredential s(Oracl eSSLCredenti al ssl Credenti al )t hr ows
j avax. net.ssl.SSLException

Sets the Or acl eSSLCr edent i al (holding private keys, certificate chains, and

similar data) that is to be used for the SSL connection. The method returns a
j avax. net. ssl . SSLSocket Except i on if an error occurs.

public void set SSLProtocol Version(int version)throws javax.net.ssl.SSLException

Sets the SSL protocol version. The method throws a
j avax. net. ssl . SSLSocket Except i on if the SSL version is not supported.
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Public Class: OracleSSLSession

This public class extends the j ava. | ang. Obj ect class. It implements the
j avax. net. ssl . SSLSessi on interface.

This class implements most methods specified inj avax. net . ssl . SSLSessi on.
However, the following methods are not implemented with this class:

get Peer Host ()
get Val ue()

i nval i date()
removeVal ue()

get Val ueNames()

This class provides extra methods that are specific to Oracle Java SSL, which are
described in the following sections.

Methods

public byte[][] getPeerRawCertificateChain() throws
javax. net.ssl . SSLPeer Unverifi edException

Returns the certificate chain presented by the peer as an array of peer X.509
certificates in der format. The peer’s certificate is first in the chain, and the root
CA is last. The method returns a

j avax. net. ssl . SSLPeer Unveri fi edExcepti on if the peer certificate
cannot be verified.

public java.lang. String getNegoti atedProtocol Version()

Returns the SSL protocol version used for this session.
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Public Class: OracleSSLSocketFactorylmpl

This public class extends j avax. net . ssl . SSLSocket Fact ory.

This class implements j avax. net . ssl . SSLSocket Fact or y methods that are
needed to create server sockets. In addition it provides extra methods, described in
the following sections, that are necessary to configure options specific to Oracle Java
SSL.

Constructor
public Oracl eSSLSocket Fact oryl npl ()

Creates a socket factory that may be used to create sockets. However, setting the
system property SSLSocket Fact oryl npl d ass to

oracl e. security.ssl Oracl eSSLSocket Fact oryl npl is the preferred
method for creating socket factories. For example:

System get Properties(). put("SSLSocket Fact oryl npl O ass",
"oracl e.security.ssl.Oacl eSSLSocket Factoryl npl");
SSLSocket Factory factory = Oracl eSSLSocket Fact oryl npl . get Defaul t();

Methods

public java.net.Socket createSocket(java.net.Socket socket) throws
java.io. | CException

Returns a new instance of an SSL socket that reads and writes by using an
existing socket. This is particularly useful when tunneling through firewalls.
The method returns aj ava. i 0. | OExcept i on if an error occurs while
creating the socket.

Parameters: socket - asocket object through which data will be transferred

public void set SSLCredential s(Oracl eSSLCredenti al ssl Credential) throws
j avax. net.ssl . SSLException

Sets the OracleSSL Credential (holding private keys, certificate chains, and
similar data) that is to be used for the SSL connection. This method also creates
and sets a default Or acl eX509Tr ust Manager with the same trust points as in
the Or acl eSSLCr edent i al . The method throws a

j avax. net. ssl . SSLSocket Except i on if an error occurs.
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public void set SSLProtocol Version(int version) throws javax.net.ssl.SSLException

Sets the SSL protocol version. The method throws a
j avax. net . ssl . SSLSocket Except i on if the SSL version is not supported.

public void setTrust Managers(Oracl eX509Tr ust Manager I nterface[] tnm

Sets the Or acl eX509Tr ust Manager s that are to be used for sockets created
by this factory.

Parameter: t m- an array of trust managers

public Oracl eX509Trust Manager I nterface[] get Trust Managers()

Returns the X509TrustManagers that are set for this factory.

Public Interface: OracleX509TrustManagerinterface

This public interface extends j avax. net. ssl . Tr ust Manager. It is based on
j avax. net. ssl . X509Tr ust Manager, but it does not inherit from that interface.

This interface builds a valid certificate chain and manages which X.509 certificates
may be used to authenticate the remote side of a secure socket. Decisions may be
based on trusted certificate authorities, certificate revocation lists, online status
checking or by other means that are specified. This function is called if trusted
certificates are set and one of the following conditions are met:

« Peer certificate chain contains trusted certificates
« Peer certificate chain does not contain trusted certificates

= Peer certificate chain contains expired certificates

Note: If customized behavior is required for these cases, then an
implementation of this interface designed to meet your specific
requirements is recommended.

Methods

public abstract void checkd ientTrusted(X509Certificate[] chain)
throws CertificateException
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Given the partial or complete certificate chain that is provided by the peer, this
method builds a certificate path to a trusted root and returns if it can be
validated and is trusted for client SSL authentication. The method throws a
javax.net.ssl.CertificateExcepti on if the certificate chain is not
trusted by this trust manager.

Parameters: chai n - an ordered array of peer X.509 certificates with the peer’s
own certificate listed first and followed by any certificate authorities

public abstract void checkServerTrusted(X509Certificate[] chain) throws
CertificateException

Given the partial or complete certificate chain that is provided by the peer, this
method builds a certificate path to a trusted root and returns if it can be
validated and is trusted for server SSL authentication. This method throws a
javax. net.ssl . Certificat eExcepti on if the certificate chain is not
trusted by this trust manager.

Parameters: chai n - an ordered array of peer X.509 certificates with the peer’s
own certificate listed first and followed by any certificate authorities

public abstract X509Certificate[] getAcceptedlssuers()

This method returns an array of certificate authority certificates that are trusted
for the authenticating peers. It returns a non-null (possibly empty) array of
acceptable certificate authority issuer certificates.
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Abbreviations and Acronyms

This appendix defines abbreviations and acronyms used in the Oracle Advanced
Security Administrator’s Guide (Table G-1):

Table G-1 Abbreviations and Acronyms

Abbreviation / Acronym

Description

3DES

A version of the DES encryption algorithm that provides
triple-encryption; see Triple-DES.

ACL Access Control List

CA Certificate Authority

CBC Cipher-Block-Chaining

CDs Cell Directory Service

CORBA Common Object Request Broker Architecture

DCE Distributed Computing Environment

DES Data Encryption Standard (U.S.)

DES40 Data Encryption Standard with 40-bit encryption keys
DES56 Data Encryption Standard with 56-bit encryption keys
DIT Directory Information Tree

DN Distinguished Name

DNS Domain Naming Service

FIPS Federal Information Processing Standard

GDS Global Directory Service

GSSAPI Generic Security Services Application Programming Interface
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Abbreviation / Acronym | Description

HTTP Hypertext Transfer Protocol

HTTPS HTTP combined with underlying SSL layer

1HOP Internet Inter-ORB Protocol

ISM Bull Integrated System Management

ISP Internet Service Provider

JDBC Java Database Connectivity

JDK Java Development Kit

JRE Java Runtime Environment

LAN Local Area Network

LDAP Lightweight Directory Access Protocol

MD4 Message Digest 4; a checksumming algorithm that produces
al28-bit hash total (checksum); see MD5.

MD5 Message Digest 5; a checksumming algorithm that produces a
128-bit hash total (checksum); stronger successor to MDA4.

NIST National Institute of Standards and Technology

OCl Oracle Call Interface

OSF Open Software Foundation

PIN Personal Identification Number

PKE Public Key Encoding

PKI Public Key Infrastructure

RADIUS Remote Authentication Dial-In User Service

RC4 IAsymmetric encryption algorithm from RSA Data Security,

nc.

RPC Remote Procedure Call

RSA RSA Data Security, Inc.; refers to the RSA encryption module

SASL Simple Authentication and Security Layer

SHA Secure Hash Algorithm

SSL Secure Sockets Layer
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Abbreviation / Acronym

Description

SSO

Single Sign-on

Triple-DES

A version of the DES encryption algorithm that provides
triple-encryption; see 3DES

WAN

Wide Area Network
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access control

The ability of a system to grant or limit access to specific data for specific clients or
groups of clients.

Access Control List (ACL)

The group of access directives that you define. The directives grant levels of access
to specific data for specific clients, or groups of clients, or both.

Active Directory Service Interfaces (ADSI)

A client-side product based on the Component Object Model (COM). ADSI defines
a directory service model and a set of COM interfaces that enable Windows 2000,
Windows NT, Windows 98, and Windows 95 client applications to access several
network directory services, including Active Directory. ADSI allow applications to
communicate with Active Directory.

administrative context

A directory entry under which an Oracle Context resides. An administrative
context can be a directory naming context. During directory access configuration,
clients are configured with an administrative context in the directory configuration
file (Idap.ora). The administrative context specifies the location of the Oracle
Context in the directory whose entries a client expects to access.

Advanced Encryption Standard

Advanced Encryption Standard (AES) is a new cryptographic algorithm that has
been approved by the National Institute of Standards and Technology as a
replacement for DES. The AES standard is available in Federal Information
Processing Standards Publication 197. The AES algorithm is a symmetric block
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cipher that can process data blocks of 128 bits, using cipher keys with lengths of
128, 192, and 256 bits.

AES
See Advanced Encryption Standard

attribute

An item of information that describes some aspect of an entry. An entry comprises a
set of attributes, each of which belongs to an object class. Moreover, each attribute
has both a type, which describes the kind of information in the attribute, and a value,
which contains the actual data.

authentication

The process of verifying the identity of a user, device, or other entity in a computer
system, often as a prerequisite to granting access to resources in a system. A
recipient of an authenticated message can be certain of the message’s origin (its
sender). Authentication is presumed to preclude the possibility that another party
has impersonated the sender.

authorization

Permission given to a user, program, or process to access an object or set of objects.
In Oracle, authorization is done through the role mechanism. A single person or a
group of people can be granted a role or a group of roles. A role, in turn, can be
granted other roles. The set of privileges available to an authenticated entity.

base

The entry point in an LDAP-compliant directory.

CDSs
See Cell Directory Services (CDS).

Cell Directory Services (CDS)

An external naming method that enables users to use Oracle tools transparently and
applications to access Oracle9i databases in a Distributed Computing Environment
(DCE).

certificate

An ITU x.509 v3 standard data structure that securely binds an identify to a public
key.



A certificate is created when an entity’s public key is signed by a trusted identity, a
certificate authority. The certificate ensures that the entity’s information is correct
and that the public key actually belongs to that entity.

A certificate contains the entity’s name, identifying information, and public key. It is
also likely to contain a serial number, expiration date, and information about the
rights, uses, and privileges associated with the certificate. Finally, it contains
information about the certificate authority that issued it.

certificate authority

A trusted third party that certifies that other entities—users, databases,
administrators, clients, servers—are who they say they are. When it certifies a user,
the certificate authority first seeks verification that the user is not on the certificate
revocation list (CRL), then verifies the user’s identity and grants a certificate,
signing it with the certificate authority’s private key. The certificate authority has its
own certificate and public key which it publishes. Servers and clients use these to
verify signatures the certificate authority has made. A certificate authority might be
an external company that offers certificate services, or an internal organization such
as a corporate MIS department.

certificate chain

An ordered list of certificates containing an end-user or subscriber certificate and its
certificate authority certificates.

checksumming

A mechanism that computes a value for a message packet, based on the data it
contains, and passes it along with the data to authenticate that the data has not been
tampered with. The recipient of the data recomputes the cryptographic checksum
and compares it with the cryptographic checksum passed with the data; if they
match, it is "probabilistic” proof the data was not tampered with during
transmission.

Cipher Block Chaining (CBC)

An encryption method that protects against block replay attacks by making the
encryption of a cipher block dependent on all blocks that precede it; it is designed to
make unauthorized decryption incrementally more difficult. Oracle Advanced
Security employs outer cipher block chaining because it is more secure than inner
cipher block chaining, with no material performance penalty.
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cipher suite

A set of authentication, encryption, and data integrity algorithms used for
exchanging messages between network nodes. During an SSL handshake, for
example, the two nodes negotiate to see which cipher suite they will use when
transmitting messages back and forth.

cipher suite name

Cipher suites describe the kind of cryptographics protection that is used by
connections in a particular session.

ciphertext
Message text that has been encrypted.

cleartext
Unencrypted plain text.

client

A client relies on a service. A client can sometimes be a user, sometimes a process
acting on behalf of the user during a database link (sometimes called a proxy).

confidentiality

A function of cryptography. Confidentiality guarantees that only the intended
recipient(s) of a message can view the message (decrypt the ciphertext).

connect descriptor

A specially formatted description of the destination for a network connection. A
connect descriptor contains destination service and network route information. The
destination service is indicated by using its service name for Oracle9i or Oracle8i
databases or its Oracle system identifier (SID) for Oracle8 release 8.0 databases.
The network route provides, at a minimum, the location of the listener through use
of a network address.

connect string

Information the user passes to a service to connect, such as username, password
and net service name. For example:

CONNECT user nane/ passwor d@et _servi ce_nane



CORBA

Common Object Request Broker Architecture. An architecture that enables pieces of
programs, called objects, to communicate with one another regardless of the
programming language in which they are written or the operating system on which
they are running. CORBA was developed by an industry consortium known as the
Object Management Group (OMG).

credentials
A username, password, or certificate used to gain access to the database.

cryptography
The practice of encoding and decoding data, resulting in secure messages.

data dictionary
A set of read-only tables that provide information about a database.

Data Encryption Standard (DES)
The U.S. data encryption standard.

Database Administrator

(1) A person responsible for operating and maintaining an Oracle Server or a
database application. (2) An Oracle username that has been given DBA privileges
and can perform database administration functions. Usually the two meanings
coincide. Many sites have multiple DBAs.

database alias
See net service name.

Database Installation Administrator

Also called a database creator. This administrator is in charge of creating new
databases. This includes registering each database in the directory using the
Database Configuration Assistant. This administrator has create and modify access
to database service objects and attributes. This administrator can also modify the
Default domain.

database link

A network object stored in the local database or in the network definition that
identifies a remote database, a communication path to that database, and optionally,
a username and password. Once defined, the database link is used to access the
remote database.
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A public or private database link from one database to another is created on the
local database by a DBA or user.

A global database link is created automatically from each database to every other
database in a network with Oracle Names. Global database links are stored in the
network definition.

database method
See Oracle database method.

database password verifier

A database password verifier is an irreversible value that is derived from the user’s
database password. This value is used during password authentication to the
database to prove the identity of the connecting user.

Database Security Administrator

Has create, modify, and read access for enterprise user security. This administrator
has permissions on all of the domains in the enterprise and is responsible for:

« Administering the Oracle DBSecurityAdmins and OracleDBCreators groups.
« Creating new enterprise domains.

« Moving databases from one domain to another within the enterprise.

DCE
See Distributed Computing Environment (DCE).

decryption

The process of converting the contents of an encrypted message (ciphertext) back
into its original readable format (plaintext).

DES
See Data Encryption Standard (DES).

dictionary attack

A common attack on passwords. the attacker creates a dictionary of many possible
passwords and their corresponding verifiers. Through some means, the attacker
then obtains the verifier corresponding to the target password, and obtains the
target password by looking up the verifier in the dictionary.



Diffie-Hellman key negotiation algorithm

This is a method that lets two parties communicating over an insecure channel to
agree upon a random number known only to them. Though the parties exchange
information over the insecure channel during execution of the Diffie-Hellman key
negotiation algorithm, it is computationally infeasible for an attacker to deduce the
random number they agree upon by analyzing their network communications.
Oracle Advanced Security uses the Diffie-Hellman key negotiation algorithm to
generate session keys.

digital signature

A digital signature is created when a public key algorithm is used to sign the
sender’s message with the sender’s private key. The digital signature assures that
the document is authentic, has not been forged by another entity, has not been
altered, and cannot be repudiated by the sender.

directory information tree (DIT)
A hierarchical tree-like structure consisting of the DNs of the entries.

directory naming context

A subtree which is of significance within a directory server. It is usually the top of
some organizational subtree. Some directories only permit one such context which
is fixed; others permit none to many to be configured by the directory
administrator.

Distributed Computing Environment (DCE)

A set of integrated network services that works across multiple systmes to provide
a distributed environment. The middleware between distributed applications and
the operating system or networkservices; based on a client/server computing
model. DCE is supported by the Open Group.

distinguished name (DN)

The unique name of a directory entry. It comprises all of the individual names of the
parent entries back to the root.

domain

Any tree or subtree within the Domain Name System (DNS) namespace. Domain
most commonly refers to a group of computers whose host names share a common
suffix, the domain name.
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Domain Name System (DNS)

A system for naming computers and network services that is organized into a
hierarchy of domains. DNS is used in TCP/IP networks to locate computers
through user-friendly names. DNS resolves a friendly name into an IP address,
which is understood by computers.

In Oracle Net Services, DNS translates the host name in a TCP/IP address into an
IP address.

encrypted text

Text that has been encrypted, using an encryption algorithm; the output stream of
an encryption process. On its face, it is not readable or decipherable, without first
being subject to decryption. Also called ciphertext. Encrypted text ultimately
originates as plaintext.

encryption

The process of disguising a message rendering it unreadable to any but the
intended recipient.

enterprise domain

A directory construct that consists of a group of databases and enterprise roles. A
database should only exist in one enterprise domain at any time. Enterprise
domains are different from Windows 2000 domains, which are collections of
computers that share a common directory database.

Enterprise Domain Administrator

User authorized to manage a specific enterprise domain, including the authority to
add new enterprise domain administrators.

enterprise role

Access privileges assigned to enterprise users. A set of Oracle role-based
authorizations across one or more databases in an enterprise domain. Enterprise
roles are stored in the directory and contain one or more global roles.

enterprise user

A user defined and managed in a directory. Each enterprise user has a unique
identify across an enterprise and uses a wallet to store its login credentials.



entry

The building block of a directory, it contains information about an object of interest
to directory users.

external authentication

Verification of a user identity by a third party authentication service, such as
Kerberos or RADIUS.

file system method

Storing fingerprint templates in files when configuring Identix Biometric
authentication. The alternative is to use the Oracle database method.

Federal Information Processing Standard (FIPS)

A U.S. government standard that defines security requirements for cryptographic
modules—employed within a security system protecting unclassified information
within computer and telecommunication systems. Published by the National
Institute of Standards and Technology (NIST).

FIPS
See Federal Information Processing Standard (FIPS).

forest

A group of one or more Active Directory trees that trust each other. All trees in a
forest share a common schema, configuration, and global catalog. When a forest
contains multiple trees, the trees do not form a contiguous namespace. All trees in a
given forest trust each other through transitive bidirectional trust relationships.
GDS

See Global Directory Service (GDS).

Global Directory Service (GDS)

GDS is the DCE directory service that acts as an agent between DCE CDS and any
X.500 directory service. Both GDS and CDS are obsolete; they are only used by
DCE.

global role

A role managed in a directory, but its privileges are contained within a single
database.
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HTTP

Hypertext Transfer Protocol: The set of rules for exchanging files (text, graphic
images, sound, video, and other multimedia files) on the World Wide Web. Relative
to the TCP/IP suite of protocols (which are the basis for information exchange on
the Internet), HTTP is an application protocol.

HTTPS

The use of Secure Sockets Layer (SSL) as a sublayer under the regular HTTP
application layer.

identity

The combination of the public key and any other public information for an entity.
The public information may include user identification data such as, for example,
an e-mail address. A user certified as being the entity it claims to be.

initial ticket

In Kerberos authentication, an initial ticket or ticket granting ticket (TGT) identifies
the user as having the right to ask for additional service tickets. No tickets can be
obtained without an initial ticket. An initial ticket is retrieved by running the kinit
program and providing a password.

instance

Every running Oracle database is associated with an Oracle instance. When a
database is started on a database server (regardless of the type of computer), Oracle
allocates a memory area called the System Global Area (SGA) and starts an Oracle
process. This combination of the SGA and an Oracle process is called an instance.
The memory and the process of an instance manage the associated database's data
efficiently and serve the one or more users of the database.

integrity

The guarantee that the contents of the message received were not altered from the
contents of the original message sent.

IOP

Internet Inter-ORB Protocol. A protocol developed by the Object Management
Group (OMG) to implement CORBA solutions over the World Wide Web. IIOP
enables browsers and servers to exchange integers, arrays, and more complex

objects, unlike HTTP, which supports only transmission of text.



java code obfuscation

Java code obfuscation is used to protect Java programs from reverse engineering. A
special program (an obfuscator) is used to scramble Java symbols found in the code.
The process leaves the original program structure intact, letting the program run
correctly while changing the names of the classes, methods, and variables in order
to hide the intended behavior. Although it is possible to decompile and read
non-obfuscated Java code, the obfuscated Java code is sufficiently difficult to
decompile to satisfy U.S. government export controls.

Java Database Connectivity (JDBC)

An industry-standard Java interface for connecting to a relational database from a
Java program, defined by Sun Microsystems.

JDBC
See Java Database Connectivity (JDBC).

KDC/TGS

Key Distribution Center/Ticket Granting Service. In Kerberos authentication, the
KDC maintains a list of user principals and is contacted through the Kinit program
for the user’s initial ticket. The Ticket Granting Service maintains a list of service
principals and is contacted when a user wants to authenticate to a server providing
such a service.

The KDC/TGS is a trusted third party that must run on a secure host. It creates
ticket-granting tickets and service tickets. The KDC and TGS are usually the same
entity.

Kerberos

A network authentication service developed under Massachusetts Institute of
Technology’s Project Athena that strengthens security in distributed environments.
Kerberos is a trusted third-party authentication system that relies on shared secrets
and assumes that the third party is secure. It provides single sign-on capabilities
and database link authentication (MIT Kerberos only) for users, provides
centralized password storage, and enhances PC security.

key

When encrypting data, a key is a value which determines the ciphertext that a given
algorithm will produce from given plaintext. When decrypting data, a key is a value
required to correctly decrypt a ciphertext. A ciphertext is decrypted correctly only if
the correct key is supplied.

Glossary-11



Glossary-12

With a symmetric encryption algorithm, the same key is used for both encryption
and decryption of the same data. With an asymmetric encryption algorithm (also
called a public-key encryption algorithm or public-key cryptosystem), different
keys are used for encryption and decryption of the same data.

key pair
A public key and its associated private key.
See public/private key pair.

kinstance

An instantiation or location of a service. This is an arbitrary string, but the host
machine name for a service is typically specified.

kservice
An arbitrary name of a Kerberos service object.

LDAP
See Lightweight Directory Access Protocol (LDAP).

Lightweight Directory Access Protocol (LDAP)

A standard, extensible directory access protocol. It is a common language that
LDAP clients and servers use to communicate. The framework of design
conventions supporting industry-standard directory products, such as the Oracle
Internet Directory.

listener

A process that resides on the server whose responsibility is to listen for incoming
client connection requests and manage the traffic to the server.

Every time a client requests a network session with a server, a listener receives the
actual request. If the client information matches the listener information, then the
listener grants a connection to the server.

listener.orafile
A configuration file for the listener that identifies the:

« Listener name
« Protocol addresses that it is accepting connection requests on

« Services itis listening for



Thel i st ener. or a file typically resides in $ORACLE_HOVE/ net wor k/ admi n on
UNIX platforms and ORACLE_HQOVE\ net wor k\ adni n on Windows NT.

man-in-the-middle

A security attack characterized by the third-party, surreptitious interception of a
message, wherein the third-party, the man-in-the-middle, decrypts the message,
re-encrypts it (with or without alteration of the original message), and re-transmits
it to the originally-intended recipient—all without the knowledge of the legitimate
sender and receiver. This type of security attack works only in the absence of
authentication.

MD5

An algorithm that assures data integrity by generating a 128-bit cryptographic
message digest value from given data. If as little as a single bit value in the data is
modified, the MD5 checksum for the data changes. Forgery of data in a way that
will cause MD5 to generate the same result as that for the original data is
considered computationally infeasible.

message authentication code

Also known as data authentication code (DAC). A checksumming with the
addition of a secret key. Only someone with the key can verify the cryptographic
checksum.

message digest
See checksumming.

network authentication service

A means for authenticating clients to servers, servers to servers, and users to both
clients and servers in distributed environments. A network authentication service is
a repository for storing information about users and the services on different
servers to which they have access, as well as information about clients and servers
on the network. An authentication server can be a physically separate machine, or it
can be a facility co-located on another server within the system. To ensure
availability, some authentication services may be replicated to avoid a single point
of failure.

National Institute of Standards and Technology (NIST)

An agency within the U.S. Department of Commerce responsible for the
development of security standards related to the design, acquisition, and
implementation of cryptographic-based security systems within computer and
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telecommunication systems, operated by a Federal agency or by a contractor of a
Federal agency or other organization that processes information on behalf othe
Federal Government to accomplish a Federal function.

net service name

The name used by clients to identify a database server. A net service name is
mapped to a port number and protocol. Also known as a connect string, or
database alias.

network listener

A listener on a server that listens for connection requests for one or more databases
on one or more protocols. See listener.

NIST
See Federal Information Processing Standard (FIPS).

non-repudiation

Incontestable proof of the origin, delivery, submission, or transmission of a
message.

obfuscation

A process by which information is scrambled into a non-readable form, such that it
is extremely difficult to de-scramble if the algorithm used for scrambling is not
known.

obfuscator
A special program used to obfuscate Java source code. See: obfuscation.

object class

A named group of attributes. When you want to assign attributes to an entry, you
do so by assigning to that entry the object classes that hold those attributes. All
objects associated with the same object class share the same attributes.

Oracle Context

An entry in an LDAP-compliant internet directory called cn=0r acl eCont ext ,
under which all Oracle software relevant information is kept, including entries for
Oracle Net Services directory naming and enterprise user security. A top-level
directory entry that contains the data used by any installed Oracle product that uses
the directory.



There can be one or more Oracle Contexts in a directory. An Oracle Context is
located under an administrative context.

Oracle database method

Using an Oracle database to store fingerprint templates when configuring Indentix
Biometric authentication. The alternative is to use the file system method.

Oracle Net Services

An Oracle product that enables two or more computers that run the Oracle server
or Oracle tools such as Designer/2000 to exchange data through a third-party
network. Oracle Net Services support distributed processing and distributed
database capability. Oracle Net Services is an open system because it is independent
of the communication protocol, and users can interface Oracle Net to many network
environments.

Oracle PKI certificate usages

Defines Oracle application types that a certificate supports.

Password-Accessible Domains List

A group of enterprise domains configured to accept connections from
password-authenticated users.

peer identity

SSL connect sessions are between a particular client and a particular server. The
identity of the peer may have been established as part of session setup. Peers are
identified by X.509 certificate chains.

PKCS #12

A public key encryption standard (PKCS). RSA Data Security, Inc. PKCS #12 is an
industry standard for storing and transferring personal authentication
credentials—typically in a format called a wallet.

PKI
See public key infrastructure (PKI).

plaintext
Message text that has not been encrypted.
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principal

A uniquely-identified client or server. A Kerberos object, consisting of
kservice/kinstance@REALM. See also kservice, kinstance, and realm.

private key

In public-key cryptography, this key is the secret key. It is primarily used for
decryption but is also used for encryption with digital signatures. See
public/private key pair.

proxy authentication

A process typically employed in an environment with a middle tier such as a
firewall, wherein the end user authenticates to the middle tier, which thence
authenticates to the directory on the user’s behalf—as its proxy. The middle tier logs
into the directory as a proxy user. A proxy user can switch identities and, once
logged into the directory, switch to the end user’s identity. It can perform
operations on the end user’s behalf, using the authorization appropriate to that
particular end user.

public key

In public-key cryptography, this key is made public to all. It is primarily
used for encryption but can be used for verifying signatures. See public/private key
pair.

public key encryption

The process where the sender of a message encrypts the message with the public
key of the recipient. Upon delivery, the message is decrypted by the recipient using
its private key.

public key infrastructure (PKI)

Information security technology utilizing the principles of public key cryptography.
Public key cryptography involves encrypting and decrypting information using a
shared public and private key pair. Provides for secure, private communications
within a public network.

public/private key pair

A set of two numbers used for encryption and decryption, where one is called the
private key and the other is called the public key. Public keys are typically made
widely available, while private keys are held by their respective owners. Though
mathematically related, it is generally viewed as computationally infeasible to
derive the private key from the public key. Public and private keys are used only



with asymmetric encryption algorithms, also called public-key encryption
algorithms, or public-key cryptosystems. Data encrypted with either a public key or
a private key from a key pair can be decrypted with its associated key from the
key-pair. However, data encrypted with a public key cannot be decrypted with the
same public key, and data enwrapped with a private key cannot be decrypted with
the same private key.

realm

A Kerberos object. A set of clients and servers operating under a single key
distribution center/ticket-granting service (KDC/TGS). kservices that are in different
realms that share the same name are unique.

registry
A Windows repository that stores configuration information for a computer.

remote computer
A computer on a network other than the local computer.

root key certificate
See trusted certificate.

schema

A named collection of objects, such as tables, views, clusters, procedures, packages,
attributes, object classes, and their corresponding matching rules, which are
associated with a particular user.

schema mapping

A pair of values in a database: the base in an LDAP-compliant directory at which
users exist, and the name of the database schema to which they are mapped.

Secure Hash Algorithm (SHA)

An algorithm that assures data integrity by generating a 160-bit cryptographic
message digest value from given data. If as little as a single bit in the data is
modified, the Secure Hash Algorithm checksum for the data changes. Forgery of a
given data set in a way that will cause the Secure Hash Algorithm to generate the
same result as that for the original data is considered computationally infeasible.

An algorithm that takes a message of less than 264 bits in length and produces a
160-bit message digest. The algorithm is slightly slower than MD5, but the larger
message digest makes it more secure against brute-force collision and inversion
attacks.
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Secure Sockets Layer (SSL)

An industry standard protocol designed by Netscape Communications Corporation
for securing network connections. SSL provides authentication, encryption, and
data integrity using public key infrastructure (PKI).

server
A provider of a service.

service
1. A network resource used by clients; for example, an Oracle database server.

2. An executable process installed in the Windows NT registry and administered by
Windows NT. Once a service is created and started, it can run even when no user is
logged on to the computer.

service name
For Kerberos-based authentication, the kservice portion of a service principal.

service principal
See principal.

service table

In Kerberos authentication, a service table is a list of service principals that exist on
a kinstance. This information must be extracted from Kerberos and copied to the
Oracle server machine before Kerberos can be used by Oracle.

service ticket

Trusted information used to authenticate the client. A ticket-granting ticket, which
is also known as the initial ticket, is obtained by directly or indirectly running

oki ni t and providing a password, and is used by the client to ask for service
tickets. A service ticket is used by a client to authenticate to a service.

session key

A key shared by at least two parties (usually a client and a server) that is used for
data encryption for the duration of a single communication session. Session keys
are typically used to encrypt network traffic; a client and a server can negotiate a
session key at the beginning of a session, and that key is used to encrypt all network
traffic between the parties for that session. If the client and server communicate
again in a new session, they negotiate a new session key.



session layer

A network layer that provides the services needed by the presentation layer entities
that enable them to organize and synchronize their dialogue and manage their data
exchange. This layer establishes, manages, and terminates network sessions
between the client and server. An example of a session layer is Network Session.

SHA
See Secure Hash Algorithm (SHA).

shared schema

Database or application schemas that can be used by multiple enterprise users.
Oracle Advanced Security supports the mapping of multiple enterprise users to the
same shared schema on a database, which lets an administrator avoid creating an
account for each user in every database. Instead, the administrator can create a user
in one location, the enterprise directory, and map the user to a shared schema that
other enterprise users can also map to. Sometimes called user/schema separation.

single key-pair wallet

A PKCS #12-format wallet that contains a single user certificate and its associated
private key. The public key is imbedded in the certificate.

single password authentication

The ability of a user to authenticate with multiple databases by using a single
password. After users authenticate to one database or application with a single
password, they can then authenticate to other databases or applications with the
same password. In the Oracle Advanced Security implementation, the password is
stored in an LDAP-compliant directory and protected with encryption and Access
Control Lists. Using single password authentication, users use a single password to
authenticate multiple times (to multiple databases and applications). Single
password, multiple authentications.

single sign-on (SSO)

The ability of a user to authenticate once, combined with strong authentication
occurring transparently in subsequent connections to other databases or
applications. Single sign-on lets a user access multiple accounts and applications
with a single password, entered during a single connection. Single password, single
authentication. Oracle Advanced Security supports Kerberos, CyberSafe, DCE, and
SSL-based single sign-on.
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smart card

A plastic card (like a credit card) with an embedded integrated circuit for storing
information, including such information as user names and passwords, and also for
performing computations associated with authentication exchanges. A smart card is
read by a hardware device at any client or server.

A smartcard can generate random numbers which can be used as one-time use
passwords. In this case, smartcards are synchronized with a service on the server so
that the server expects the same password generated by the smart card.

sniffer

Device used to surreptitiously listen to or capture private data traffic from a
network.

sqlnet.ora file
A configuration file for the client or server that specifies:

« Client domain to append to unqualified service names or net service names
«  Order of naming methods the client should use when resolving a name

« Logging and tracing features to use

= Route of connections

= Preferred Oracle Names servers

« External naming parameters

« Oracle Advanced Security parameters

The sql net . or a file typically resides in $ORACLE_HOVE/ net wor k/ adm n on
UNIX platforms and ORACLE_HOVE\ net wor k\ adni n on Windows platforms.
SSO

See single sign-on (SSO).

System Global Area (SGA)

A group of shared memory structures that contain data and control information for
an Oracle instance.

system identifier (SID)

A unique name for an Oracle instance. To switch between Oracle databases, users
must specify the desired SID. The SID is included in the CONNECT DATA parts of



the connect descriptor in a tnsnames.ora file, and in the definition of the network
listener in a listener.orafile.

ticket
A piece of information that helps identify who the owner is. See service ticket.

tnsnames.ora

A file that contains connect descriptors; each connect descriptor is mapped to a net
service name. The file may be maintained centrally or locally, for use by all or
individual clients. Thisfile typically resides in the following locations depending on
your platform:

«  (UNIX) ORACLE_HOWE/ net wor k/ admi n
« (Windows) ORACLE BASE\ ORACLE HOVE\ net wor k\ admi n

token card

A device for providing improved ease-of-use for users through several different
mechanisms. Some token cards offer one-time passwords that are synchronized
with an authentication service. The server can verify the password provided by the
token card at any given time by contacting the authentication service. Other token
cards operate on a challenge-response basis. In this case, the server offers a
challenge (a number) which the user types into the token card. The token card then
provides another number (cryptographically-derived from the challenge), which
the user then offers to the server.

transport layer

A networking layer that maintains end-to-end reliability through data flow control
and error recovery methods. Oracle Net Services uses Oracle protocol supports for
the transport layer.

trusted certificate

A trusted certificate, sometimes called a root key certificate, is a third party identity
that is qualified with a level of trust. The trusted certificate is used when an identity
is being validated as the entity it claims to be. Typically, the certificate authorities
you trust are called trusted certificates. If there are several levels of trusted
certificates, a trusted certificate at a lower level in the certificate chain does not need
to have all its higher level certificates reverified.

trusted certificate authority
See certificate authority.
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trust point
See trusted certificate.

username
A name that can connect to and access objects in a database.

user/schema separation
See shared schema.

views

Selective presentations of one or more tables (or other views), showing both their
structure and their data.

wallet

A wallet is a data structure used to store and manage security credentials for an
individual entity. It implements the storage and retrieval of credentials for use with
various cryptographic services. A Wallet Resource Locator (WRL) provides all the
necessary information to locate the wallet.

wallet obfuscation

Wallet obfuscation is used to store and access an Oracle wallet without querying
the user for a password prior to access (supports single sign-on (SSO)).Certain
machine-specific information is used to generate a secret key that is used to encrypt
the wallet.

Wallet Resource Locator

A wallet resource locator (WRL) provides all necessary information to locate a
wallet. It is a path to an operating system directory that contains a wallet.

WRL

See Wallet Resource Locator.

X.509
An industry-standard specification for digital certificates.
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to an Oracle database
to verify roles, 12-8
to an Oracle server in DCE, 13-3
with username and password, 13-4
without username and password, 13-3
with username and password, 9-2

12-11
12-14

Index-2

6-5

creating
Oracle directories in CDS, 11-4
principals and accounts, 11-2
creating a certificate authority with esm -genca
tool, 19-23
CyberSafe, 1-12
authentication parameters, B-2
configuring authentication, 5-2
kinstance, 5-3
realm, 5-3
sqlnet.ora file sample, A-3
system requirements, 1-18
CyberSafe Challenger
system requirements, 1-18

D

Data Encryption Standard (DES), 2-3
DES encryption algorithm, 1-6
DES40 encryption algorithm, 2-3
Triple-DES encryption algorithm,

data integrity, 1-7

data privacy, 1-5

database
changing password, 18-7

database administrators, 19-32

Database Configuration Assistant
registering a database object in a directory

server, E-9
database domain membership, 19-37
database password verifier, 16-3

1-6, 2-3

database schema mappings, 19-32, 19-40
database security, 19-31
database security options, 19-39

DBPASSWORD column, 16-6
DBPASSWORD_EXIST_FLAG column,
DCE. See Distributed Computing Environment
(DCE)
DCE.AUTHENTICATION parameter,
DCE.LOCAL_CELL_USERNAMES
parameter, 12-11
DCE.PROTECTION parameter, 12-11
DCE.TNS_ADDRESS_OID parameter,
DCE.TNS_ADDRESS.OID parameter
modifying in protocol.ora file, 12-15

12-11

12-11

16-6, 16-7



DES. See Data Encryption Standard (DES)
Diffie-Hellman key negotiation algorithm, 2-6
digital signatures, 8-2
directory
changing password, 18-7
directory base
defining, 19-9
directory servers
automatic discovery of directory servers, E-5
creating security domains, E-28
enhancement of directory object type
descriptions, E-8
features integrated with Oracle9i, E-2
how Oracle directory objects display in Active
Directory, E-9
integration with Active Directory, E-19
integration with Microsoft tools, E-6
integration with Windows login credentials, E-9
requirements for creating enterprise user security
in Active Directory, E-15
requirements for creating Oracle Net directory
naming in Active Directory, E-15
requirements for using Oracle with Active
Directory, E-19
user interface extensions, E-7
DIRPASSWORD column, 16-6
Distributed Computing Environment (DCE)
backward compatibility, 10-2
CDS naming adapter components, 10-4
communication and security, 10-3
components, 10-3
configuration files required, 12-4
configuring a server, 12-4
configuring clients for DCE integration, 12-11
configuring clients to use DCE CDS
naming, 12-14
configuring server, 12-4
configuring to use DCE Integration, 11-2
connecting
to an Oracle database, 13-1
connecting clients without access to DCE and
CDS, 14-2
connecting to an Oracle server, 13-3
externally authenticated accounts, 12-5
listener.ora parameters, 12-2

mapping groups to Oracle roles,syntax, 12-7
Multi-Protocol Interchange, 10-7
overview, 10-2
protocol.ora file parameters, 12-11
REMOTE_OS_AUTHENT parameter, 12-5
sample address in tnsnames.ora file, 12-15
sample listener.ora file, 14-3
sample parameter files, 14-3
sample tnsnames.ora file, 14-3
Secure Core services, 10-6
setting up external roles, 12-7
starting the listener, 13-2
tnsnames.ora files, 12-2
verifying DCE group mapping, 12-8
verifying dce_service_name, 13-2
DNS-style naming convention, E-19
domain administrators, 19-39
domain database schema mappings, 19-40
domain membership, 19-37
Domain Naming Service (DNS), 10-4
domains, 19-30, 19-35, 19-39

E

ELA. See Oracle Enterprise Login Assistant (ELA)
encryption, 1-17
encryption and checksumming
activating, 2-7
client profile encryption, A-10
negotiating, 2-9
parameter settings, 2-11
server encryption level setting, A-5
server encryption selected list, A-7
enterprise domain administrators, 19-39
enterprise domains, 15-57,19-35
viewing in Active Directory, E-11
Enterprise Login Assistant. See Oracle Enterprise
Login Assistant (ELA)
enterprise role grantees, 19-46
enterprise roles, 19-42, 19-44
viewing in Active Directory, E-11
enterprise user security
administrators, 15-60
autologin, 15-43
certificate authority, 15-32
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components, 15-27
creation requirements, E-15
database clients, 15-49
directory entries, 15-7
directory service, 15-32
enterprise domains, 15-8, 15-50, 15-57
enterprise roles, 15-7
enterprise users, 15-7,15-51, 15-54
add, 15-51
authorize, 15-52,15-62
configure, 15-61
create, 15-61
create passwords, 15-63
create userids, 15-63
create wallet, 15-52
enable database access, 15-59
mapping, 15-22, 15-53
final password configuration, 15-56
final SSL configuration, 15-48
global roles, 15-7, 15-47
groups
OracleDBCreators, 15-11
OracleDBSecurity, 15-11
listener, 15-38, 15-42, 15-45
Oracle Context, 15-58
Oracle Enterprise Security Manager, 15-4
overview, 15-3
password-accessible domains, 15-60
private key decryption fails, 15-71
privileges, 15-47
roles, 15-46
schemas, 15-46
session privilege, 15-47
shared schemas, 15-19
configuring, 15-20
creating, 15-21
SSL, 15-22
SSL, 15-37
SSL service name, 15-37
troubleshooting, 15-65
tracing, 15-71
user search bases, 15-58
UserlID attribute, 15-59
enterprise users
administering, 19-7
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creating, 19-8
defining password, 19-11
viewing in Active Directory, E-11
Entrust Technologies, Inc., 8-2
Entrust/PKI for Oracle, 8-4
Entrust/PKI Software, 1-11, 8-1, 8-2
authentication, 8-7, 8-8
authority, 8-5
certificate revocation, 8-3
components, 8-4
configuring
client, 8-10
server, 8-12
creating database users, 8-15
Entelligence, 8-5
etbinder command, 8-12
IPSEC Negotiator Toolkit, 8-6
issues and restrictions, 8-16
key management, 8-3
profiles, 8-8
administrator-created, 8-8
user-created, 8-9
RA, 8-5
toolkit server login, 8-6
versions supported, 8-4
error messages
ORA-12650, 2-7,2-9, A-7, A-8, A-9
ORA-28890, 8-17
Oracle Enterprise Security Manager, 15-36,
15-55
tracing, 15-71
esm -genca tool, 19-14, 19-23
ESM. See Oracle Enterprise Security Manager (ESM)
etbinder command, 8-12

F

Federal Information Processing Standard
configuration, xxvii
Federal Information Processing Standard
(FIPS), 1-7,D-1
sqlnet.ora parameters, D-2
FIPS. See Federal Information Processing Standard
(FIPS)



G

GDS. See Global Directory Service (GDS)

generic documentation references
Windows NT-specific authentication

methods, E-17

Global Directory Service (GDS), 10-4

global roles, 15-47,19-44

global schema, 15-47

grantees, 19-46

H

handshake
SSL, 7-6

hints, 18-9

HTTPS, 7-7

initialization parameter file
parameters for clients and servers using
CyberSafe, B-2
parameters for clients and servers using
Kerberos, B-3
parameters for clients and servers using

RADIUS, B-4
parameters for clients and servers using
SSL, B-10
installing
key of server, 11-3
internet, 7-7

Internet Inter-ORB Protocol (1IOP)
secured by SSL, 7-7

J

Java Byte Code Obfuscation, 3-4

Java Database Connectivity (JDBC)
configuration parameters, 3-5
Oracle extensions, 3-2
Oracle O3LOGON, 3-3
thin driver features, 3-3

Java Database connectivity (JDBC)
implementation of Oracle Advanced

Security, 3-2

JDBC. See Java Database Connectivity

K

Kerberos, 1-12
authentication adapter utilities, 6-13
configuring authentication, 6-2, 6-5
kinstance, 6-3
kservice, 6-3
realm, 6-3
sqglnet.ora file sample, A-3
system requirements, 1-18
kinstance (CyberSafe), 5-3
kinstance (Kerberos), 6-3
kservice (Kerberos), 6-3

L

LAN environments
vulnerabilities of, 1-2
LDAP. See Lightweight Directory Access Protocol
(LDAP)
Lightweight Directory Access Protocol
(LDAP), 18-1,18-2,18-5, 18-6, 18-9, 18-10
Listener, 15-37
listener, 15-38, 15-42, 15-45
endpoint
SSL configuration, 7-34
listener.ora file, 15-41
starting in the DCE environment, 13-2
listener.ora file, 15-41
parameters for DCE, 12-4
logging into Oracle
using DCE authentication, 13-3
logging out, 18-10

M

managing roles with RADIUS server, 4-24
mapping DCE groups

to Oracle roles, 12-7
MAPPING_LEVEL column, 16-6, 16-7
MAPPING_TYPE column, 16-6, 16-7
mappings, 19-40
MD5 message digest algorithm, 2-5
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membership, 19-37

N

NAMES.DIRECTORY_PATH parameter, 12-17
NEEDS_ATTENTION_FLAG column, 16-6
Netscape Communications Corporation, 7-2
network protocol boundaries, 1-17

@)
obfuscation, 3-4
okdstry

Kerberos adapter utility, 6-13
okinit

Kerberos adapter utility, 6-13
oklist

Kerberos adapter utility, 6-13
OLD_SCHEMA_TYPE column, 16-6
operating systems

authentication overview, E-17
ORA-12650 error message, A-8
Oracle Advanced Security

checksum sample for sglnet.ora file, A-2

configuration parameters, 3-5

disabling authentication, 9-3

encryption sample for sqlnet.ora file, A-2

Java implementation, 3-2, 3-4

SSL features, 7-2
Oracle Connection Manager, 1-17
Oracle Context, 15-58, 19-7, 19-20, 19-26, 19-31

defined, E-11
Oracle Enterprise Login Assistant (ELA), 15-27,

18-1

and LDAP directory, 18-6

certificate-authenticated enterprise users, 18-3

changing passwords, 18-7, 18-11

disabling SSL connection, 18-10

downloading wallet, 18-6

logging out, 18-10

opening local wallet, 18-3

password-authenticated users, 18-11

starting, 18-2

uploading wallet, 18-10
Oracle Enterprise Manager, 19-2, 19-4
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Oracle Enterprise Security
initial configuration, 15-31

Oracle Enterprise Security Manager (ESM), 15-20,

19-1

administering enterprise domains, 19-35
browsing for users, 19-16
command line syntax, 19-5
concepts, 15-2
configuring, 19-3
creating a certificate authority, 19-14
creating security domains, E-28
database access, 19-19
database administrators, 19-32
database domain membership, 19-37
database schema mappings, 19-32
database security, 19-31
database security options, 19-39
defining a directory base, 19-9
defining enterprise user password, 19-11
defining role, 19-13
domain database schema mappings, 19-40
enterprise domain administrators, 19-39
enterprise role grantees, 19-46
enterprise roles, 19-42
esm -genca tool, 19-14, 19-23
global role membership, 19-44
installing, 19-3
introduction, 19-2
Oracle Context, 19-20, 19-26
Oracle Context Administrators, 19-26
password accessible domains, 19-30
RDBMS_SERVER_DN parameter, 19-24
spfile.ora, 19-24
starting, 19-4
user search bases, 19-24
userpkcsl? attribute, 19-15
using, E-18

Oracle Java SSL

cipher suite, F-4
features, F-3

Oracle Net, 15-37
Oracle Net Configuration Assistant

automatically discovering directory server
information, E-11
configuring Oracle software with a directory



server, E-5,E-9
creating the Oracle schema, E-12
Oracle Net directory naming
connecting to a database through a directory
server, E-19
creation requirements, E-15
testing connectivity from client computers, E-20
testing connectivity with Microsoft tools, E-20
Oracle parameters
authentication, 9-7
Oracle Password Protocol, 3-4
Oracle schema
creating with Oracle Net Configuration
Assistant, E-12
Oracle service names, 10-4
loading into CDS, 12-17
Oracle Wallet Manager, 8-2, 15-28, 15-42, 15-46
key management, F-5
Oracle Wallet manager, 15-42
ORACLE_BASE
explained, xxxv
ORACLE_HOME
explained, xxxv
OracleDBCreator security group
defined, E-23
OracleDBCreators group, 15-11
OracleDBSecurity group, 15-11
OracleDBSecurityAdmin security group
defined, E-23
OracleDefaultDomain
directory server security domain, E-28
OracleNetAdmins security group
defined, E-23
ORCL_GLOBAL_USR_MIGRATION_DATA
interface table, 16-4
access to, 16-5
ATTENTION_DESCRIPTION column, 16-6
CASCADE_FLAG column, 16-6, 16-7
DBPASSWORD column, 16-6
DBPASSWORD_EXIST_FLAG column, 16-6,
16-7
DIRPASSWORD column, 16-6
MAPPING_LEVEL column, 16-6, 16-7
MAPPING_TYPE column, 16-6, 16-7
NEEDS_ATTENTION_FLAG column, 16-6

OLD_SCHEMA _TYPE column, 16-6
PASSWORD_VERIFIER column, 16-6
PHASE_COMPLETED column, 16-6, 16-7
SHARED_SCHEMA column, 16-6, 16-7
USERDN column, 16-6, 16-7
USERDN_EXIST_FLAG column, 16-6, 16-7
USERNAME column, 16-6

OS_AUTHENT_PREFIX parameter, 9-8
CyberSafe authentication, 5-8

OS_ROLES parameter
setting, 12-7

OSS.SOURCE.MY_WALLET parameter, 7-19, 7-27

P

parameters
authentication
CyberSafe, B-2
Kerberos, B-3
RADIUS, B-4
Secure Sockets Layer (SSL), B-10
configuration for JDBC, 3-5
encryption and checksumming, 2-11
password accessible domains, 19-30
password hints, 18-9
password reminders, 18-9
PASSWORD_VERIFIER column, 16-6
password-authenticated enterprise users, 18-2,
18-11
changing passwords, 18-11
PHASE_COMPLETED column, 16-6, 16-7
PKI. See public key infrastructure
privileges, 15-47
protocol.ora file
DCE.AUTHENTICATION parameter, 12-11
DCE.LOCAL_CELL_USERNAMES
parameter, 12-11
DCE.PROTECTION parameter, 12-11
DCE.TNS_ADDRESS_OID parameter, 12-11
parameter for CDS, 12-12
public key infrastructure (PKI), 1-11, 8-2, 18-2
public/private key pair, 8-2
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R

RADIUS, 1-11
accounting, 4-22
asynchronous authentication mode, 4-6
authentication modes, 4-4
authentication parameters, B-4
challenge-response
authentication, 4-6, C-1, D-1
user interface, C-1, C-2,C-3,D-1
configuring, 4-10
location of secret key, 4-16
smartcards and, 1-11, 4-8, 4-17, C-2
sqglnet.ora file sample, A-3
synchronous authentication mode, 4-4
system requirements, 1-18
RC4 encryption algorithm, 1-6, 2-3
RDBMS_SERVER_DN parameter, 19-24
realm (CyberSafe), 5-3
realm (Kerberos), 6-3
reminders, 18-9
REMOTE_OS_AUTHENT parameter
CyberSafe authentication, 5-8
requirements
for creating enterprise user security in Active
Directory, E-15
for creating Oracle Net directory naming in
Active Directory, E-15
for using Oracle with Active Directory, E-19
restrictions, 1-19
revocation, 8-3
role grantees, 19-46
roles, 15-47,19-13, 19-42, 19-44, 19-46
managing with RADIUS server, 4-24
roles, external, mapping to DCE groups, 12-7
RSA Security, Inc. (RSA), 1-6

S

schema mappings, 19-32, 19-40
secret key
location in RADIUS, 4-16
Secure Sockets Layer (SSL), 1-11,7-1, 8-1, 8-2,
15-37, 18-1, 18-4, 18-10
architecture, 7-9
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authentication parameters, B-10
authentication process in an Oracle
environment, 7-6
authorization, 7-13
certificate, 7-4
certificate authority, 7-4
cipher suites, B-11
client authentication parameter, B-13
client configuration, 7-14
combining with other authentication
methods, 7-8
components in an Oracle environment,
configuring, 7-14
configuring on the client, 8-10
disabling connection, 18-10
enabling, 7-14, 8-8
handshake, 7-6
industry standard protocol, 7-2
privileges, 7-13
requiring client authentication, 7-32
roles, 7-13
server configuration, 7-26
shared schemas, 15-22
sqglnet.ora file sample, A-2
system requirements, 1-18
version parameter, B-12
wallet, 7-4
wallet location, parameter, B-16
SecurlD, 4-5
token cards, 4-5
security
between clients and servers, 7-7
Internet, 1-2
Intranet, 1-2
threats, 1-2
data tampering, 1-3
dictionary attacks, 1-3
eavesdropping, 1-2
falsifying identities, 1-3
password-related, 1-3
security groups
accessing, E-24
security implications
hints, 18-9
reminders, 18-9

7-4



security options, 19-39
session privilege, 15-47
shared schemas, 15-20, 15-47
SSL, 15-22
SHARED_SCHEMA column, 16-6, 16-7
single sign-on (SSO), 1-11, 8-3, 13-3, 18-2
smartcards, 1-12
and RADIUS, 1-11, 4-8, 4-17, C-2
spfile.ora, 15-34, 15-35, 15-36, 15-68, 15-70, 19-24
SQL*Plus
connecting to a database through Active
Directory, E-7
SQLNET.AUTHENTICATION_GSSAPI_SERVICE
parameter, 5-7,B-2
SQLNET.AUTHENTICATION_KERBEROS5
SERVICE parameter, 6-8
SQLNET.AUTHENTICATION_SERVICES
parameter, 4-12,5-7, 6-8, 7-25, 7-34, 9-4, 9-5,
B-2
SQLNET.CRYPTO_CHECKSUM_CLIENT
parameter, 2-15, A-6
SQLNET.CRYPTO_CHECKSUM_SERVER
parameter, 2-15, A-6
SQLNET.CRYPTO_CHECKSUM_TYPES_CLIENT
parameter, 2-15, A-9
SQLNET.CRYPTO_CHECKSUM_TYPES_SERVER
parameter, 2-15, A-9
SQLNET.CRYPTO_SEED parameter, 2-13, A-10

SQLNET.ENCRYPTION_CLIENT parameter, 2-13,

A-5

SQLNET.ENCRYPTION_SERVER parameter, 2-13,

A-5
SQLNET.ENCRYPTION_TYPES_CLIENT

parameter, 2-13, A-8
SQLNET.ENCRYPTION_TYPES_SERVER

parameter, 2-13, A-7
SQLNET.FIPS_140 parameter, D-3
SQLNET.KERBEROS5_CC_NAME parameter, 6-9
SQLNET.KERBEROS5_CLOCKSKEW

parameter, 6-9
SQLNET.KERBEROS5_CONF parameter, 6-9

SQLNET.KERBEROS5_CONF_MIT parameter, 6-9

SQLNET.KERBEROS5_KEYTAB parameter, 6-10
SQLNET.KERBEROS5_REALMS parameter, 6-10
sqglnet.ora file, 15-39

Common sample, A-3
CyberSafe sample, A-3
FIPS 140-1 parameters, D-2
Kerberos sample, A-3
modifying so CDS can resolve names, 12-17
NAMES.DIRECTORY_PATH parameter, 12-17
Oracle Advanced Security checksum
sample, A-2
Oracle Advanced Security encryption
sample, A-2
OSS.SOURCE.MY_WALLET parameter, 7-19,
7-27
parameters for clients and servers using
CyberSafe, B-2
parameters for clients and servers using
Kerberos, B-3
parameters for clients and servers using
RADIUS, B-4
parameters for clients and servers using
SSL, B-10
RADIUS sample, A-3
sample, A-2
SQLNET.AUTHENTICATION_GSAPPI_
SERVICE parameter, B-2
SQLNET.AUTHENTICATION_GSSAPI_
SERVICE parameter, 5-7
SQLNET.AUTHENTICATION_KERBEROS5_
SERVICE parameter, 6-8
SQLNET.AUTHENTICATION_SERVICES
parameter, 5-7,6-8, 7-25, 7-34, 9-4, 9-5, B-2
SQLNET.CRYPTO_CHECKSUM_CLIENT
parameter, 2-15, A-6
SQLNET.CRYPTO_CHECKSUM_SERVER
parameter, 2-15, A-6
SQLNET.CRYPTO_CHECKSUM_TYPES_
CLIENT parameter, 2-15, A-9
SQLNET.CRYPTO_CHECKSUM_TYPES _
SERVER parameter, 2-15, A-9
SQLNET.CRYPTO_SEED parameter, 2-13, A-10
SQLNET.ENCRYPTION_CLIENT
parameter, A-5
SQLNET.ENCRYPTION_SERVER
parameter, 2-13, A-5
SQLNET.ENCRYPTION_TYPES_CLIENT
parameter, 2-13, A-8
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SQLNET.ENCRYPTION_TYPES_SERVER
parameter, 2-13, A-7
SQLNET.FIPS_140 parameter, D-3
SQLNET.KERBEROS5_CC_NAME
parameter, 6-9
SQLNET.KERBEROS5_CLOCKSKEW
parameter, 6-9
SQLNET.KERBEROS5_CONF parameter, 6-9
SQLNET.KERBEROS5_CONF_MIT
parameter, 6-9
SQLNET.KERBEROS5_KEYTAB
parameter, 6-10
SQLNET.KERBEROS5_REALMS
parameter, 6-10
SSL sample, A-2
SSL_CLIENT_AUTHENTICATION
parameter, 7-33
SSL_CLIENT_AUTHETNICATION
parameter, 7-19
SSL_VERSION parameter, 7-24,7-31
Trace File Set Up sample, A-2
SQLNET.RADIUS_ALTERNATE parameter, 4-19
SQLNET.RADIUS_ALTERNATE_PORT
parameter, 4-19
SQLNET.RADIUS_ALTERNATE_RETRIES
parameter, 4-19
SQLNET.RADIUS_ALTERNATE_TIMEOUT
parameter, 4-19
SQLNET.RADIUS_SEND_ACCOUNTING
parameter, 4-22
SSL. See Secure Sockets Layer (SSL)
SSL_CLIENT_AUTHENTICATION
parameter, 7-19, 7-33
SSL_VERSION parameter, 7-24,7-31
SSO. See single sign-on (SSO)
synchronous authentication mode, RADIUS, 4-4
SYS schema, 16-4
system requirements, 1-18
CyberSafe, 1-18
DCE integration, 10-2
Kerberos, 1-18
RADIUS, 1-18
SSL, 1-18
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thin JDBC support, 3-1
tnsnames.ora file, 15-40
loading into CDS using tnnfg, 12-17
modifying to load connect descriptors into
CDs, 12-15
renaming, 12-17
token cards, 1-13
trace file
set up sample for sglnet.ora file, A-2
tracing, 15-71
Triple-DES encryption algorithm, 1-6
troubleshooting, 5-11, 6-22, 8-17, 15-65
trust points, 8-2

U

user migration utility
access to interface table, 16-5
accessing help, 16-14
ATTENTION_DESCRIPTION column, 16-6
CASCADE parameter, 16-8
CASCADE_FLAG column, 16-6, 16-7
certificate authenticated users, 16-9
database password verifier, 16-3
DBPASSWORD column, 16-6
DBPASSWORD_EXIST_FLAG column, 16-6,
16-7

directory location of utility, 16-10
DIRPASSWORD column, 16-6
example

parameter text file (par.txt), 16-30

users list text file (usrs.txt), 16-31

using CASCADE=NO, 16-25

using CASCADE=YES, 16-27

using MAPSCHEMA=PRIVATE, 16-24

using MAPSCHEMA=SHARED, 16-25

using MAPTYPE options, 16-28

using PARFILE, USERSFILE, and LOGFILE

parameters, 16-31

LOGFILE precedence, 16-31
MAPPING_LEVEL column, 16-6, 16-7
MAPPING_TYPE column, 16-6, 16-7
MAPSCHEMA parameter



PRIVATE, 16-19
SHARED, 16-19
MAPTYPE parameter
DB mapping type, 16-20
DOMAIN mapping type, 16-20
ENTRY mapping level, 16-20
SUBTREE mapping level, 16-20, 16-29
NEEDS_ATTENTION_FLAG column, 16-6
OLD_SCHEMA _TYPE column, 16-6
ORCL_GLOBAL_USR_MIGRATION_DATA
interface table, 16-4
password authenticated users, 16-9
PASSWORD_VERIFIER column, 16-6
PHASE_COMPLETED column, 16-6, 16-7
retrieving dropped schema objects, 16-27
shared schema mapping, 16-8
SHARED_SCHEMA column, 16-6, 16-7
SSL authentication for current release, 16-9
SYS schema, 16-4
USER parameter
ALL_EXTERNAL, 16-17
ALL_GLOBAL, 16-17
LIST, 16-17
USERSFILE, 16-17
USERDN column, 16-6, 16-7
USERDN_EXIST_FLAG column, 16-6, 16-7
USERNAME column, 16-6
X.509 v3 certificates, 16-9
user search bases, 15-58, 19-24
USERDN column, 16-6, 16-7
USERDN_EXIST_FLAG column, 16-6, 16-7
UserlID attribute, 15-59
USERNAME column, 16-6
userpkesl2 attribute, 19-15

Vv

viewing mapping in CDS namespace, for listener
endpoint, 13-2

w

wallet, 7-5
changing password, 18-7
downloading, 18-6

opening on local system, 18-3
uploading, 18-10
wallets
changing a password, 17-17
closing, 17-13
creating, 17-11
deleting, 17-17
managing, 17-11
managing certificates, 17-19
managing trusted certificates, 17-24
opening, 17-13
saving, 17-16
setting location, 7-18, 7-27
Windows 2000 domains
required domains for Oracle clients and server to
use directory server features, E-12
Windows Explorer
accessing directory server objects, E-20
integration with Oracle objects in Active
Directory, E-6
Windows native authentication
benefits, E-17
installation of, E-17
methods and use of, E-17
overview, E-17

X

X.500 naming convention, E-19
X.509 PKI certificate standard, 8-3
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